Safety

Your press and the recommended supplies have been designed and tested to meet strict safety requirements. Attention to the following information ensures the continued safe operation of your Xerox® Press.

Product Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
</tr>
</thead>
</table>
| !      | Caution
This symbol indicates a mandatory action to take in order to avoid damage to these areas. |
| !      | Warning
This symbol alerts users to areas where there is the possibility of personal injury. |
| 🤠      | Hot Warning
This symbol alerts users to areas where there are heated surfaces which should not be touched. |
| 🤠      | Laser Warning
This symbol indicates a laser is being used and alerts the user to refer to the appropriate safety information. |
| 🔄      | Pinch Hazard
This warning symbol alerts users to areas where there is the possibility of personal injury. |
<p>| 🔒      | Lock |
| 🔓      | Unlock |
| ⚠️      | Do Not Touch |</p>
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
</tr>
</thead>
</table>
| ![No Touch](image) | **Do Not Touch the Drum Cartridge**  
To avoid damage, do not touch the surface of the Drum Cartridge. |
| ![No Flame](image) | **Do Not Dispose into an Open Flame or Incinerate** |
| ![No Burn](image) | **Do Not Incinerate the Dry Ink/Toner Cartridge**  
Always refer to the recycling instructions for your region or marketplace for correct disposal information and procedures. |
| ![No Burn](image) | **Do Not Incinerate the Dry Ink/Toner Waste Bottle**  
Always refer to the recycling instructions for your region or marketplace for correct disposal information and procedures. |
| ![No Burn](image) | **Do Not Incinerate the Drum Cartridge**  
Always refer to the recycling instructions for your region or marketplace for correct disposal information and procedures. |
| ![Ground](image) | **Ground, Common, or Earth Terminal** |
| ![LAN](image) | **LAN**  
Local Area Network |
| ![USB](image) | **USB**  
Universal Serial Bus |
| ![Keep Area Clear](image) | **Keep Area Clear**  
Do not store any objects in this location. |
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
</tr>
</thead>
</table>
| ![Symbol](77x705) | Keep Area Clear  
Do not store any objects in this location. |
<p>| <img src="77x685" alt="Symbol" /> | Do Not Use Transparencies with a White Strip or Overhead Projector Sheets with a White Strip |
| <img src="77x667" alt="Symbol" /> | Do Not Use Envelopes with Open Flaps |
| <img src="77x667" alt="Symbol" /> | Do Not Use Folded, Creased, Curled, or Wrinkled Paper |
| <img src="77x603" alt="Symbol" /> | Do Not Use Ink Jet Paper |
| <img src="77x547" alt="Symbol" /> | Do Not Load Postcards in the Indicated Direction |
| <img src="77x498" alt="Symbol" /> | Do Not Use Media Attached with Staples or Paper or Metal Clips |
| <img src="77x347" alt="Symbol" /> | Do Not Copy Money |</p>
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Symbol" /></td>
<td>Tray Guides Must Touch Media</td>
</tr>
<tr>
<td><img src="image2" alt="Symbol" /></td>
<td>Load Postcards in the Indicated Direction</td>
</tr>
<tr>
<td><img src="image3" alt="Symbol" /></td>
<td>Load Hole-punched Paper as Indicated</td>
</tr>
<tr>
<td><img src="image4" alt="Symbol" /></td>
<td>Load Media and Documents Face Down</td>
</tr>
<tr>
<td><img src="image5" alt="Symbol" /></td>
<td>IC Card Reader</td>
</tr>
<tr>
<td></td>
<td>Integrated Circuit Card Reader, Smart Card Reader and Chip Card Reader</td>
</tr>
<tr>
<td><img src="image6" alt="Symbol" /></td>
<td>On</td>
</tr>
<tr>
<td></td>
<td>This symbol indicates the main power switch is in the ON position.</td>
</tr>
<tr>
<td><img src="image7" alt="Symbol" /></td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td>This symbol indicates the main power switch is in the OFF position.</td>
</tr>
<tr>
<td><img src="image8" alt="Symbol" /></td>
<td>Standby</td>
</tr>
<tr>
<td></td>
<td>This symbol indicates the secondary power switch is in the Standby position.</td>
</tr>
<tr>
<td><img src="image9" alt="Symbol" /></td>
<td>Do Not Dispose in Normal Household Waste Stream</td>
</tr>
<tr>
<td></td>
<td>• Application of this symbol is confirmation that you should not dispose of items, such as Customer Replaceable Units (CRUs), in the normal household waste stream. You must dispose of these items in compliance with agreed national procedures.</td>
</tr>
<tr>
<td></td>
<td>• This symbol often accompanies batteries and indicates that used electrical and electronic products and batteries should not be mixed with general household waste.</td>
</tr>
<tr>
<td></td>
<td>• For more information about collection and recycling, contact your local municipality, your waste disposal service, or the point of sale where you purchased the items.</td>
</tr>
</tbody>
</table>

**Notices and Safety**

Carefully read the following instructions before operating your press. Refer to these instructions to ensure the continued safe operation of your press.
Your Xerox® press and supplies are designed and tested to meet strict safety requirements. Safety requirements include safety agency evaluation and certification, and compliance with electromagnetic regulations and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox® materials only.

Unauthorized alterations, which can include the addition of new functions or connection of external devices, can affect the product certification. For more information, contact your Xerox representative.

**Electrical Safety**

**General Guidelines**

![WARNING:](image)

Read the following warnings.

- Do not push objects into slots or openings on the press. Touching a voltage point or shorting out a part could result in fire or electric shock.
- Do not remove the covers or guards that are fastened with screws unless you are installing optional equipment and are instructed to do so. Switch off the press when performing these installations. Disconnect the power cord when removing covers and guards for installing optional equipment. Except for user-installable options, there are no parts that you can maintain or service behind these covers.

**Emergency Power Off**

The following are hazards to your safety:

- The power cord is damaged or frayed.
- Liquid is spilled into the press.
- The press is exposed to water.
- The press emits smoke, or the surface is unusually hot.
- The press emits unusual noise or odors.
- The press causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

**Power Cable and Electrical Supply**

- Use the power cords that are supplied with your press.
- Do not remove or modify the power cord.
- The electrical outlet must be near the printer and must be easily accessible.
- Plug the power cable directly into a properly grounded electrical outlet. Ensure that each end of the cable is connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet.
WARNING: To avoid risk of fire or electrical shock, do not use extension cords, power strips, or power plugs. Always adhere to national and local building, fire, and electrical codes regarding length of cord, conductor size, grounding, and protection.

- Do not use a ground adapter plug to connect the press to an electrical outlet that does not have a ground connection terminal.
- The electrical supply for the press must meet the requirements stated on the data plate located on the rear of the press. If necessary, consult your local electricity provider or a licensed electrician.
- Do not place the press in an area where people can step on the power cable.
- Do not place objects on the power cable.
- Do not plug or unplug the power cable while the power switch is in the On position.
- If the power cable becomes frayed or worn, replace it.
- To avoid electrical shock and damage to the cable, grasp the plug when unplugging the power cable.

**Disconnect Device**

The power cable is the disconnect device for this equipment. To remove all electrical power from the machine, disconnect the power cable from the electrical outlet.

**Laser Safety**

**North America Laser Safety**

This product complies with safety standards and is certified as a Class 1 Laser product under the Center for Devices and Radiological Health (CDRH) of the United States Food and Drug Administration (FDA) implemented regulations for laser products. This product complies with FDA performance standards for Laser products except for deviations pursuant to Laser Notice No. 50 dated June 24, 2007. These regulations apply to laser products marketed in the United States. The label on the Production Press indicates compliance with CDRH regulations and must be attached to laser products marketed in the United States. This product does not emit hazardous laser radiation.

⚠️ **Laser Warning:** Use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous exposure of laser light.

Since radiation emitted inside this product is completely confined within the protective housing and external covers, the laser beam cannot escape from the Production Press during any phase of the user operation.

This product contains laser warning labels. These labels are intended for use by the Xerox Service Representative and are placed on or near panels or shields that require special tools for removal. Do not remove any of the panels. There are no operator serviceable areas in these covers.

**European Union (EU) Laser Safety**

This product complies with IEC safety standard EN 60825-1: 2014.

The equipment complies with laser product performance standards set by governmental, national, and international agencies as a Class 1 Laser Product. It does not emit hazardous radiation as the beam is totally enclosed during all phases of customer operation and maintenance.
WARNING: Use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous radiation exposure.

If you need additional safety information about the product or Xerox supplied materials, you can email request to EHS-Europe@xerox.com.

Operational Safety

Your Xerox equipment and supplies were designed and tested to meet strict safety requirements. These include safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines will help ensure the continued safe operation of your Press:

- Do not remove any trays when the Press is printing.
- Do not open the doors when the Press is printing.
- Keep hands, hair, neckties, and so on, away from the exit and feed rollers.
- Covers, which require tools for removal, protect the hazard areas within the Press. Do not remove the protective covers.
- Do not attempt to remove paper that is jammed deeply inside the Press. Switch off the Press promptly and contact your local Xerox representative.
- To avoid a tip hazard, do not push or move the device with all of the paper trays extended.
- Do not place the Press in locations susceptible to vibrations.
- For optimum performance, use the Press at the Altitude specified in Environmental Specifications section of the User Documentation.
- Use the materials and supplies specifically designed for your Press. The use of unsuitable materials may result in poor performance of the Press and possibly a hazardous situation.
- Follow all warnings and instructions that are marked on or supplied with the Press.
- Place the Press in a room that provides adequate space for ventilation and servicing.
- Place the Press on a level, solid surface, not on a thick pile carpet, that has adequate strength to support the weight of the Press.
- Do not attempt to move the Press. A leveling device that was lowered when your Press was installed may damage the carpet or floor.
- Do not set up the Press near a heat source.
- Do not set up the Press in direct sunlight.
- Do not store or operate the Press in an extremely hot, cold, or humid environment.
- Do not set up the Press in line with the cold air flow from an air conditioning system.
- Do not place containers of coffee or other liquid on the Press.
- Do not block or cover the slots and openings on the Press.
- Do not attempt to override any electrical or mechanical interlock devices.

Hot Warning: Be careful when working in areas identified with this warning symbol. These areas may be very hot and should not be touched.
If you need any additional safety information concerning the Press or materials, contact your Xerox representative.

**Ozone Information**

This product produces ozone during normal operation. The ozone is heavier than air, and the quantity is dependent on print volume. Install the system in a well-ventilated room.

For more information, refer to *Facts about ozone* and *Fact about ventilation* at [www.xerox.com/EHS](http://www.xerox.com/EHS) or [www.xerox.com/EHS-eu](http://www.xerox.com/EHS-eu).

**Maintenance Information**

Do not carry out any maintenance on this product which is not described in the customer documentation.

⚠️ **WARNING:** Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable when used on electromechanical equipment.

Use supplies and cleaning materials only as directed.

Do not remove the covers or guards that are fastened with screws. Customer service items are not located behind these covers.

⚠️ **WARNING:** Your Xerox Production Press is equipped with a power saving device to conserve power when the Production Press is not in use. The Production Press can be left on continuously.

⚠️ **Hot Warning:** The metallic surfaces in the fuser area are hot. Use caution when you remove paper jams from this area and avoid touching any metallic surfaces.

**Vacuum Cleaner Use for Dry Ink/Toner Spills**

Use a broom or a wet cloth to wipe off spilled dry ink/toner. Sweep slowly to minimize generation of dust during clean up. Avoid using a vacuum. If a vacuum must be used, the unit should be designed for combustible dusts (for example, explosion rated motor and non-conductive hose).

**Consumable Information**

⚠️ **WARNING:** Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this Production Press. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these areas. For more details, contact your Xerox representative.

⚠️ **WARNING:** When handling cartridges such as ink or fuser, avoid skin or eye contact. Eye contact can cause irritation and inflammation. Do not attempt to disassemble the cartridge. This can increase the risk of skin or eye contact.

Store all consumables in accordance with the instructions given on the package or container.

Keep all consumables away from the reach of children.

Never throw dry ink/toner, print cartridges, or dry ink/toner containers into an open flame.

For information on Xerox® supplies recycling programs, go to:
Battery Safety

One or more circuit boards in this printer contain a lithium battery.

Do not attempt to repair or replace the lithium battery. If there is a problem with the battery, contact an authorized service representative to correct the problem.

The lithium battery in this printer contains Perchlorate material. For information about the special handling procedures associated with Perchlorate material, refer to www.dtsc.ca.gov/hazardouswaste/perchlorate.

⚠️ WARNING: If the battery on a circuit board is installed incorrectly, there is a risk of explosion.

Environmental, Health, and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox® product and supplies, contact the following:

- United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)
- Email request to Europe: EHS-Europe@xerox.com.

Press Overview

The press is a full color or black and white, auto-duplex copier and printer that operates at a speed of 80 prints per minute when printing on 8.5 x 11 inch or A4 paper.
Press Components

1. User Interface
2. Document Feeder
3. Document Glass
4. Press Power Switch
5. Dry Ink/Toner Front Cover
6. Press Front Door
7. Trays 1-3
8. Bottom Left Door
9. Casters
10. Tray 5 (Bypass)
11. Tray 5 (Bypass) Top Cover
12. USB Memory Port
13. Offset Catch Tray (OCT)
**Press with Full System Configuration**

This is an example of a full system configuration of the press with optional devices attached.

1. Dual Advanced Oversized High Capacity Feeder (Trays 8 and 9) (Optional)
2. Advanced Oversized High Capacity Feeder (Trays 6 and 7) (Optional)
3. Press
4. Interface Decurler Module (IDM) (Optional)
5. Inserter Module (Optional)
6. High Capacity Stacker (Optional)
7. Two-sided Trimmer (Optional)
8. C/Z Folder (Optional)
9. Production Ready (PR) Finisher (Optional)
10. SquareFold® Trimmer (Optional)

*Note: Full system configurations vary depending on which optional devices are attached to the press. For detailed information about an optional device, refer to the appropriate section in this guide.*

**Locating the Press Serial Number**

The press serial number can be accessed from the User Interface (UI) or from the serial number plate which is located on the inside frame of Tray 1.

1. Press the **Machine Status** button on the UI.
2. From the Machine Status screen, ensure that the **Device Information** tab is displayed.
   
   The press serial number is displayed under Device Serial Number near the bottom of the screen.
3. If there is a loss of power and it is not possible to access the **Machine Status** screen, the press serial number can also be found on the inside frame of the press near the Paper Tray 1 drawer:
   
   a. At the press, fully open Tray 1.
b. At the left of the tray, on the press frame, locate the plate with the serial number (SER#).

User Interface (UI)

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Touch Screen</td>
<td>Directly touch the screen to select and set features. Displays instructional and informational messages, fault clearance procedures and general press information.</td>
</tr>
<tr>
<td>2</td>
<td>Services Home button</td>
<td>Press this button to display the main window. Provides access to features such as Copy, E-Mail, and Network Scanning, just to name a few features. Other features can be available depending on your marketplace.</td>
</tr>
<tr>
<td>3</td>
<td>Services button</td>
<td>This button lights when the main power is on.</td>
</tr>
<tr>
<td>4</td>
<td>Job Status button</td>
<td>Use to check the progress of active jobs and detailed information about completed jobs or pending jobs. This area also allows you to delete a job (cancel printing or copying) and pause jobs.</td>
</tr>
<tr>
<td>Item Number</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>5</td>
<td>Machine Status</td>
<td>Use this button to access the Device Information, Faults, Supplies, Billing Information, and Tools feature which include the press configuration, the software version, the press billing meters and counter information, and print job history or error reports.</td>
</tr>
<tr>
<td>6</td>
<td>Log In / Out</td>
<td>Use to log in and out of Administrator mode or Authentication mode with user ID and password.</td>
</tr>
<tr>
<td>7</td>
<td>Power Saver</td>
<td>Use this button if the press is inactive and the touch screen is dark, or the press is in Power Saver mode. This button manually exits the press from Power Saver mode; it does not place the press in Power Saver mode.</td>
</tr>
<tr>
<td>8</td>
<td>Clear All</td>
<td>Use this button to return all selections to the same state as when the press was powered on. Press once to clear a current entry. Press twice to return to default settings.</td>
</tr>
<tr>
<td>9</td>
<td>Stop</td>
<td>Press to stop and pause the print or copy job in progress.</td>
</tr>
<tr>
<td>10</td>
<td>Start</td>
<td>Use this button to perform certain functions, such as scanning and copying a document or printing a selected report from the print engine. This button is also used by the Customer Service Engineer (CSE) during diagnostic routine procedures.</td>
</tr>
<tr>
<td>11</td>
<td>Interrupt</td>
<td>Use this button to suspend a copy or print job in progress and have the press stop to process another job. During the Interrupt mode, the Interrupt button lights. Pressing the Interrupt button again exits the Interrupt mode and resumes the suspended job.</td>
</tr>
<tr>
<td>12</td>
<td>Numeric Keypad</td>
<td>Use to enter alphanumeric characters. The C (Cancel) Entry cancels the previous entry made on the numeric keypad.</td>
</tr>
<tr>
<td>13</td>
<td>Language</td>
<td>Use to select a different language for the touch screen options.</td>
</tr>
<tr>
<td>14</td>
<td>Help</td>
<td>Displays the Help System, this feature may not be available in all marketplaces.</td>
</tr>
</tbody>
</table>

**Features**

**Login**

There are two login levels:

- **Guest/Operator**: This is the default login user. You are automatically logged on as Guest.
- **Administrator**: This login level is required to customize the system and network defaults for your press and to customize print jobs by setting or changing the parameters for certain features. Press the **Guest** button (or the **Log in** button on the User Interface) to access the Login screen.
Note: Refer to the System Administrator Guide for more information on the Administrator features.

Language

Note: The number of languages available on your system depends on what was installed during the initial installation process.

Selecting a particular language immediately changes the language on the User Interface. No confirmation is required.

Changing the Language

1. Press the Language button on the User Interface.

   The Language window displays on the touch screen.

2. Choose one of the following:
   - Select the desired language from the list, then select Save. The language on the screen changes to the new language and closes the Language window.
   - Select the Cancel button to return to the main screen.

Press Performance Customization

There are three different performance customization configurations available with the press:

- Xerox® Versant® 280 Press with basic print engine configuration performance
- Xerox® Versant® 280 Press with All Stock Rated Speed (ASRS) configuration performance (optional)
- Xerox® Versant® 280 Press with Performance Package (PP) configuration performance (optional)

Press with Basic Print Engine Configuration Performance

The press is a full color or black and white, automatic 2-sided copier and printer that operates at a speed of 80 prints per minute when printing on 8.5 x 11 in. or A4 paper. The press uses CMYK to create full color.
Press with Optional All Stock Rated Speed (ASRS) Configuration Performance

The All Stock Rated Speed (ASRS) performance option is ordered before the initial installation of the system. It is not possible to upgrade an existing press with the All Stock Rated Speed (ASRS) performance after the system is ordered and installed.

The All Stocks Rated Speed (ASRS) feature eliminates the slower speeds created by heavier weight stocks. With ASRS, only the size of the stock, and not its weight, governs the speed of the press. Therefore, all stock weights up to 400 g/m² for a given sheet size run at the rated speed, that is the top speed, for that stock size.

With the Xerox® Versant® 280 Press with All Stock Rated Speed (ASRS) performance option, the user experiences a 25 percent increase in handling heavyweight stock. The press does not require a standalone print server, and comes with the integrated Xerox® EX-i 280 Print Server, Powered by Fiery®.

Note: If you purchase the optional All Stocks Rated Speed (ASRS) package, the Interface Decurler Module for All Stocks Rated Speed (ASRS) is required, regardless of any additional finishing devices.

Press with Optional Performance Package

Important: The Performance Package is ordered prior to initial installation of the system. It is not possible to upgrade an existing press with the Performance Package after the press is ordered and installed.

The optional Performance Package is a suite of technologies and tools that enhances the capabilities of the base press in three areas: operational speed, color management automation, and print shop productivity.

The Performance Package is comprised of the following technologies and tools:

• All Stocks Rated Speed (ASRS) software
• Automated Color Quality System (ACQS) software
• Inline Spectrophotometer (ILS), which is included with the Interface Decurler Module
• Xerox EX 280 Print Server

All Stocks Rated Speed (ASRS)

The All Stocks Rated Speed (ASRS) feature eliminates the slower speeds created by heavier weight stocks. With ASRS, only the size of the stock, and not its weight, governs the speed of the press. Therefore, all stock weights up to 400 g/m² for a given sheet size run at the rated speed, that is the top speed, for that stock size.

Automated Color Quality System (ACQS)

The Automated Color Quality System (ACQS) is an advanced color management technology that transfers the complex decisions about color maintenance from operators to an automated system. ACQS automates the printing and measuring of calibration charts and then calculates and makes precise adjustments to color tables based on the results.
ACQS takes the variability out of the color equation by incorporating standardized color measurements. The standardized color measurements use the Inline Spectrophotometer on the Interface Decurler Module. The Inline Spectrophotometer calibrates color on the press and generates accurate destination profiles for different stocks.

Procedures are automated in that they eliminate the need for an operator to scan target sheets manually using an external spectrophotometer. The operator initiates the procedure at the print server, but all target sheets are generated and scanned automatically, and all measurements, calculations, and corrections are performed automatically.

**Inline Spectrophotometer (ILS)**

The Inline Spectrophotometer (ILS) is housed in the Interface Decurler Module. The ILS enables the Automated Color Quality Suite (ACQS). ACQS automates the process of ensuring stable and accurate color from job to job. This automation eliminates the need for operators to use a hand-held spectrophotometer during print server calibration. It also facilitates the creation of custom destination profiles for each stock on which the press prints.

With the ILS placed strategically within the paper path, automated processes are quick to perform and require less downtime for the press. Automated processes include measurements for calibration and destination profiling. Over time, the ACQS software and the ILS hardware work together to provide accurate and more stable color.

In addition to the Inline Spectrophotometer (ILS), the Interface Decurler Module provides cooling for the press when the press is running at higher speeds. Also, the Interface Decurler Module provides a decurler to ensure flat sheets for finishing.

**Configuration Information Regarding the Performance Package**

1. The Performance Package must be ordered when the press is ordered. Once the press has been configured without the Performance Package option, it cannot be upgraded later to include the package.
2. The Performance Package is not available with the Xerox EX-i 280 Print Server. Customers are required to order the external Xerox EX 280 Print Server.
3. If customers configure the press with the Business Ready (BR) Finisher, the Business Ready Finisher with Booklet Maker, or the Offset Catch Tray, the Performance Package option is not available for the configuration.
4. The Performance Package requires the Interface Decurler Module with ILS.
5. Finishing options that are enabled when the Interface Decurler Module with ILS is installed include these finishers and their options:
   - Inserter device
   - GBC® AdvancedPunch® Pro
   - High Capacity Stacker (HCS)
   - Crease and Two-Sided Trimmer
   - C/Z Folder
• Production Ready (PR) Finisher
• PR Booklet Maker Finisher
• PR Finisher Plus
• SquareFold® Trimmer device. This device requires the PR Booklet Maker Finisher
• Plockmatic® Pro 35 and Plockmatic® Pro 50. This device requires the PR Finisher Plus

Print Server Overview
The print server networked with your press accepts, processes, and manages document files for job submission to the press.

One of the following print servers can be used with your press:
• Xerox® EX 280 Print Server, Powered by Fiery®
• Xerox® EX-i 280 Print Server, Powered by Fiery®

Note: For detailed information on your specific print server, refer to the customer documentation that was delivered with it. Documentation may also be downloaded from www.xerox.com by searching for the press and selecting the Support link.

Specifications

Rated Speed
Full color or black only: 80 pages per minute of Letter (8.5 x 11 in.), A4 paper size

Print Modes
Two print modes are supported and are specified at the print server:
• 4 Color Mode (CMYK)
• Black and White Mode (Grayscale)

Maximum Printable Area
• Default Border: 4 mm on the leading edge and 2 mm on the remaining sides
• For Trays 1–3, 6, 7, and Tray 5 (Bypass):
  – 323 x 482 mm (12.72 x 18.98 in.) before adjustment
  – 326 x 482 mm (12.83 x 18.98 in.) after adjustment
• For Tray 5 (Bypass), Extra Long Sheet:
  – 323 x 654 mm (12.72 x 25.75 in.) before adjustment, when connected to the optional Oversized High Capacity Feeder
  – 326 x 654 mm (12.83 x 25.75 in.) after adjustment, when connected to the optional Oversized High Capacity Feeder
• Image Quality Assurance Area:
  – Print: 317 x 482 mm (12.48 x 18.98 in.)
  – Copy: 293 x 426 mm (11.54 x 16.77 in.)

Paper Size Ranges

• Minimum:
  – Trays 1–3: 140 x 182 mm (5.51 x 7.17 in.)
  – Tray 5 (Bypass): 96 x 146 mm (3.78 x 5.75 in.)
  – Trays 6, 7 (optional Advanced oversized High Capacity Feeder without Envelope Support Kit): 182 x 182 mm (7.17 x 7.17 in.)
  – Trays 6, 7 (optional Advanced oversized High Capacity Feeder with Envelope Support Kit): 98 x 182 mm (3.86 x 7.17 in.)
  – Tray 6 (optional Oversized High Capacity Feeder with Envelope Support Kit): 100 x 182 mm (3.94 x 7.17 in.)

• Maximum:
  – Trays 1–3: 330.2 x 488 mm (13 x 19.2 in.)
  – Tray 5 (Bypass): 330.2 x 488 mm (13 x 19.2 in.)
  – Tray 5 (Bypass) Extra Long Sheet, 1-sided: 330.2 x 660 mm (13.0 x 26.0 in.)
  – Trays 6, 7 (optional Advanced oversized High Capacity Feeder): 330.2 x 488 mm (13.0 x 19.2 in.)

Printing Resolution

• Print Engine Imaging Resolution: 2400 x 2400 dpi
• Print Server RIP Resolution (print server to print engine): 1200 x 1200 dpi

First-Print-Out Time

First Print-Out Time is measured from the time that the printer starts to the time the trailing edge of the sheet exits the Offset Catch Tray.

Note: If the system is equipped with various types of finishing devices, the First-Print-Out Time varies depending on the length of the paper path required to transport that paper.

• From a cold start (power on or power saver), the system takes less than 5 minutes to start printing.
• From standby mode, the system usually takes less than 1 minute to start printing.
• In Ready Mode, on average, the First-Print-Out Time is less than 8 seconds for color and less than 10 seconds for black and white.
• When you copy or print during initial power on, the system requires 30–45 seconds to produce the first print.
• Switching from a color mode job to a black and white job or the reverse requires on average 30–60 seconds.
- 60 seconds is needed after a paper jam to ensure that the system is recovered from possible contamination, and to ensure that the image quality is optimized.

**Press Warm-up Time**

The press warm-up times vary depending on the current state or mode of the press. Warm-up times are listed as follows:

- From a cold start (power on or power saver mode), less than 5 minutes
- From Sleep Mode or Power Saver, less than 5 minutes
- From Standby Mode, less than 1 minute
- When switching print modes (such as from black only to full color), approximately 2 minutes

**Duplex Automatic Document Feeder (DADF) Specifications**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
</table>
| Document Size and Type                    | **Size:**
|                                            | Maximum: A3, 297 x 432 mm (11 x 17 in.)                                       |
|                                            | Minimum: A5, 148 x 210 mm (5.82 x 8.26 in.)                                  |
|                                            | Weight: 38–200 g/m², 10–53 lb., 2-sided: 50–200 g/m²                         |
|                                            | **Type:**
|                                            | A5, A5, A4, A4, 8.5 x 11 in., 8.5 x 14 in. (SEF), 11 x 17 in. (SEF)          |
| Paper Capacity                            | 250 sheets                                                                   |
|                                            | When you use Xerox 75 g/m², 20 lb. paper.                                    |
| Document Productivity (8.5 x 11 in., A4 portrait, 1-sided) | A4 LEF or Letter LEF:
|                                            | • 1-sided to 1-sided, full color: 75 dpm* or more                           |
|                                            | • 1-sided to 1-sided, black and white: 75 dpm or more                       |
|                                            | • 2-sided to 2-sided, full color: 75 dpm or more                           |
|                                            | • 2-sided to 2-sided, black and white: 75 dpm or more                       |
|                                            | * Documents per minute (dpm)                                                 |

**Copy Specifications**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copier Type</td>
<td>Console</td>
</tr>
<tr>
<td>Scanning Resolution</td>
<td>600 x 600 dpi</td>
</tr>
<tr>
<td>Output Resolution</td>
<td>600 x 600 dpi</td>
</tr>
<tr>
<td>Gradation</td>
<td>256 gradation</td>
</tr>
<tr>
<td>Warm-up Time</td>
<td>5 minutes or less, when the room temperature is 20° C (68° F)</td>
</tr>
<tr>
<td>Item</td>
<td>Specification</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Copy Document</td>
<td>The maximum size is 297 x 432 mm (11 x 17 in.), A3 for both sheets and books</td>
</tr>
</tbody>
</table>
| Copy Paper Size                  | Maximum: 320 x 488 mm (12.6 x 19.2 in.), 330 x 483 mm (13 x 19 in.)  
Minimum: A5, 5.75 x 8.25 in. (Postcard for Tray 5 (Bypass))  
Image loss:  
  • Leading edge and trailing edge: 4 mm (0.157 in.) or less  
  • Front and back: 4 mm (0.157 in.) or less.                                                                 |
| Paper Trays 1–3                  | A5, A4 LEF, A4 SEF, A3, B5, B4  
8.5 x 11 in. LEF, 8.5 x 11 in. SEF, 8.5 x 13 in., 8.5 x 14 in., 11 x 17 in., 12.6 x 19.2 in. (320 x 488 mm)  
8K, 16K, tab paper (8.5 x 11 in., A4)  
Non-standard size: X direction from 140–330 mm (5.5–13 in.), Y direction from 182–488 mm (7–19 in.) |
| Tray 5 (Bypass)                  | A6, A5, A4 LEF, A4 SEF, B4  
8.5 x 11 in. LEF, 8.5 x 11 in. SEF, 8.5 x 13 in., 8.5 x 14 in., 11 x 17 in., 12 x 18 in., 12.6 x 19.2 in. (320 x 488 mm), 13 x 19 in. (330 x 483 mm)  
8K, 16K  
Non-standard size: X direction from 148–488 mm (5.8–19 in.), Y direction from 100–330 mm (4–13 in.) |
| Copy Paper                       | Trays 1–3: 52–256 g/m²  
Tray 5 (Bypass): 52–400 g/m²  
Trays 6, 7 (optional Advanced OHCF): 52–400 g/m²  
Use Xerox recommended papers for best results. |
| First Copy Output Time           | Trays 1–3:  
  • Black and white: 5.2 seconds or less  
  • Full color: 9 seconds or less  
These times apply when 100 % Reduction/Enlargement and 8.5 x 11 in. or A4 are used. |
| Copy Reduction and Enlargement Ratio | 100 %: 1:1 ± 0.7%  
Preset %: 1:0.500, 1:0.707, 1:0.816, 1:0.866, 1:1.154, 1:1.225, 1:1.414, 1:1.632, 1:2.000  
Variable %: 1:0.25–1:4.00, in 1 % increments |
| Continuous Copy Speed            | A4 LEF or Letter LEF:  
  • 1-sided to 1-sided, full color: 80 ppm  
  • 1-sided to 1-sided, black and white: 80 ppm  
  • 2-sided to 2-sided, full color: 80 ppm  
The speed may be reduced in order to adjust image quality. |
### Item Specification

- The performance may be reduced depending on the paper type.

#### Paper Feed Method and Capacity

**Standard:**
- Trays 1–3: 550 sheets
- Tray 5 (Bypass): 250 sheets
- Optional Trays 6, 7: 2000 sheets for each tray, total of 4000 sheets
- Maximum paper capacity: 9900 pages, including Trays 8 and 9, optional Advanced Oversized High Capacity Feeder

The maximum paper capacity, 9900, is based on 90 g/m², 24 lb. Xerox Bond Digital Uncoated Paper.

#### Continuous Copy Pages

- 9999 sheets

The press can pause temporarily to perform image stabilization.

### Scan Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Color scanner</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scan Size</strong></td>
<td>Maximum size: 297 x 432 mm (11 x 17 in.), A3 for both sheets and books</td>
</tr>
<tr>
<td><strong>Scan Resolution</strong></td>
<td>600 x 600 dpi, 400 x 400 dpi, 300 x 300 dpi, 200 x 200 dpi</td>
</tr>
<tr>
<td><strong>Scan Graduation</strong></td>
<td>Color: 10-bit input or 8-bit output for each RGB color Monochrome: 1-bit input, 1-bit output (2 tones), or 8-bit Grayscale output (256 tones)</td>
</tr>
<tr>
<td><strong>Document Scan Speed</strong></td>
<td>For 8.5 x 11 in. or A4: 200 dpi Black &amp; White: 100 IPM (Images per minute) 600 dpi Full Color: 80 IPM (Images per minute) Scanning speeds change depending on the original document type.</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>Sharing with print controller</td>
</tr>
</tbody>
</table>
### Environmental Specifications

For the press system to operate, the temperature and relative humidity of the room where the press is located needs to be within the minimum and maximum allowable temperature and relative humidity limits.

**Ambient temperature**

- The operating temperature range is 10–32°C (50–90°F)
- Ambient temperature for optimal image quality and paper handling performance is achieved at 20–24°C (68–76°F)

> **Note:** The press can operate outside of this range, but the performance cannot be guaranteed.

**Relative humidity**

- The required humidity range is 15–85% (relative humidity) - (RH) J zone (Dew condensation is inhibited)
- Relative humidity for optimal image quality and paper handling performance is achieved at 45% RH

> **Note:** The press can operate outside of this range, but the performance cannot be guaranteed.

**Altitude**

The press functions at the elevation of 0–2500 meters (0–8200 feet)
Getting Help

Help on the Xerox Web Site

For technical product support, Xerox supplies, customer documentation, and answers to frequently-asked questions, go to www.xerox.com. You will find the latest documentation and the knowledge base under Support & Drivers. Use the Contact link for specific contact information/telephone numbers in your area.

Note: Be sure to periodically check this website for the latest information on your product.

It may be helpful to know your press serial number before calling for support. The press serial number is shown on the Device Information tab: Machine Status > Device Information.

Print Server Customer Documentation

The EFI Print Server Help menu on the Command WorkStation window is designed to provide information on specific work flows when using the Command WorkStation. Additional user documentation supplied by EFI is available to you from www.xerox.com under the Support and Drivers link.

More Information

Refer to the following sources for more information about your press and its capabilities.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other documentation for your printer</td>
<td>Print Server Documentation: For more information, refer to the documentation, such as USB, that shipped with the print server. After installation is complete, it is recommended that you or your System Administrator print the print server documentation for later reference <a href="http://www.xerox.com/VERSANT_280docs">www.xerox.com/VERSANT_280docs</a>.</td>
</tr>
<tr>
<td>Recommended Media List</td>
<td>United States: <a href="http://www.xerox.com/rmlna">www.xerox.com/rmlna</a></td>
</tr>
<tr>
<td></td>
<td>Europe: <a href="http://www.xerox.com/rmleu">www.xerox.com/rmleu</a></td>
</tr>
<tr>
<td>Technical support information for your printer; including online technical support, Online Support Assistant, and print driver downloads.</td>
<td>Go to <a href="http://www.xerox.com/VERSANT_280support">www.xerox.com/VERSANT_280support</a></td>
</tr>
<tr>
<td>Information Pages</td>
<td>To print from the control panel, press the Machine Status button, then touch Device Information.</td>
</tr>
<tr>
<td></td>
<td>To print from the CentreWare® Internet Services, click Support, then on the Online Support, click Connect.</td>
</tr>
<tr>
<td>Order supplies for your printer</td>
<td>Go to <a href="http://www.xerox.com/VERSANT_280supplies">www.xerox.com/VERSANT_280supplies</a></td>
</tr>
<tr>
<td>Local sales and Technical Customer Support</td>
<td>Go to <a href="http://www.xerox.com/office/worldcontacts">www.xerox.com/office/worldcontacts</a></td>
</tr>
<tr>
<td>Printer registration</td>
<td>Go to <a href="http://www.xerox.com/register">www.xerox.com/register</a></td>
</tr>
</tbody>
</table>
It is recommended that you print all customer documentation and keep it close to the machine.

Note: For the latest documentation updates for your Xerox Digital Press, go to www.xerox.com/VERSANT_280docs or www.xerox.com/VERSANT_280support.

Before you contact Xerox for support, ensure that you have the serial number of your Xerox press. To locate the press serial number, refer to Locating the Press Serial Number.

Regulatory Information

Basic Regulations

Xerox® has tested this printer to electromagnetic emission and immunity standards. These standards are designed to mitigate interference caused or received by this printer in a typical office environment.

Changes or modifications to this device not specifically approved by the Xerox® Corporation may void the user’s authority to operate this equipment.

FCC Regulations in the USA

This product has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the Federal Communications Commission (FCC) Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his or her own expense.

Changes or modifications to this equipment not specifically approved by the Xerox® Corporation may void the user’s authority to operate this equipment.

To maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded cables is likely to result in interference to radio and TV reception.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation.

Responsible Party: Xerox® Corporation
Address: 800 Phillips Road, Webster, NY 14580

Canada

This Class A digital apparatus complies with Canadian ICES-003 and ICES-001.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 et NMB-001 du Canada.

This device complies with Industry Canada’s license-exempt RSSs. Operation is the subject to the following two conditions:
1. This device may not cause interference, and
2. This device must accept any interference, including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de licence. L’exploitation est autorisée aux deux conditions suivantes:
1. l’appareil ne doit pas produire de brouillage, et
2. l’utilisateur de l’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d’en compromettre le fonctionnement.

There are operational restrictions for License-Exempt Local Area Network (LE-LAN) devices: the device for operation in the band 5150-5250 MHz is only for indoor use to reduce the potential for harmful interference to co-channel mobile satellite systems.

Il y a des restrictions opérationnelles pour dispositifs de réseaux locaux exempts de licence (RL-EL): les dispositifs fonctionnant dans la bande 5 150-5 250 MHz sont réservés uniquement pour une utilisation à l’intérieur afin de réduire les risques de brouillage préjudiciable aux systèmes de satellites mobiles utilisant les mêmes canaux.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter. This equipment must be installed and operated with a minimum distance of 20 centimeters between the radiator and your body.

Cet émetteur ne doit pas être Co-placé ou ne fonctionnant en même temps qu’aucune autre antenne ou émetteur. Cet équipement devrait être installé et actionné avec une distance minimum de 20 centimètres entre le radiateur et votre corps.

**European Union and European Economic Area Compliance**

The CE mark applied to this product indicates compliance to applicable EU Directives. You can find the full text of the EU Declaration of Conformity in www.xerox.com/environment_europe.

**European Union Lot 4 Imaging Equipment Agreement**

Xerox® has agreed to design criteria for energy efficiency and environmental performance of our products that are in scope of the European Union (EU) Energy Related Products Directive, specifically the Lot 4 - Imaging Equipment.

In scope products include Household and Office equipment that meet the following criteria:
- Standard monochrome format products with a maximum speed less than 66 A4 images per minute.
- Standard color format products with a maximum speed less than 51 A4 images per minute.
Environmental Benefits of Duplex Printing

Most Xerox® products have duplex printing, also known as 2-sided printing, capability. This enables you to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the duplex function has been auto-enabled, during the setup and driver installation. Some Xerox models below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of install. Use of the duplex function will reduce the environmental impact of your work. However, you must require simplex or 1-sided printing, you can change the print settings in the print driver.

Paper Types

You can use this product to print on both recycled and virgin paper, approved to an environmental stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper (60 g/m²), which contains less raw material and thus saves resources per print, can be used in certain applications. We recommend you to check if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy-efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and models qualified to ENERGY STAR can be found at the following website: www.energystar.gov.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States, European Union, Japanese governments, and the office equipment industry to promote energy-efficient copiers, printers, fax, multifunction printers, personal computers, and monitors. Reducing product energy consumption helps combat smog, acid rain, and long-term changes to the climate by decreasing the emissions that result from generating electricity.

For more information on energy or other related topics, go to:

- www.xerox.com/environment or
- www.xerox.com/environment_europe
Power Consumption and Activation Time

The amount of electricity that a device consumes depends on the way the device is used. This device is designed and configured to enable you to reduce your electricity usage.

Power Saver modes are enabled on your device to reduce energy consumption. After the last print, the device goes to Ready mode. In this mode, the device can print again immediately. If the device is not used for a specified period, the device goes to Low Power mode, then to Sleep mode. In these modes, to enable reduced-power consumption, only essential functions remain active. The device takes longer to produce the first print after it exits the Power Saver modes than it takes to print in Ready mode. This delay is the result of the system waking up and is typical of most imaging devices on the market.

To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is enabled, you can configure the mode as follows:

- **Always Allowed**: The device powers off automatically after the specified time, and the cumulative Low Power mode and Sleep mode time outs have elapsed.
- **Allowed ONLY When the Conditions are Met**: The device automatically powers off only after time outs have elapsed. The device also powers off if USB Drive, and Wired and Non-Wired Network are not activated.

To change the Power Saver settings, refer to the User Documentation at www.xerox.com/VERSANT_280docs. For more details, contact your System Administrator or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System Administrator Guide at www.xerox.com/VERSANT_280docs.

To learn more about Xerox participation in sustainability initiatives, go to:

- www.xerox.com/environment or
- www.xerox.com/environment_europe

Default Power Saver Settings

This device is ENERGY STAR® qualified under the ENERGY STAR Program Requirements for Imaging Equipment. The Low-Power mode time can be configured up to 30 minutes. The default value is 1 minute. The Sleep mode time can be configured up to 30 minutes. The default value is 1 minute. Sleep mode begins after the configured time of inactivity rather than time after Low-Power mode.

To change the Default Power Saver settings, contact your System Administrator, or refer to the System Administrator Guide at www.xerox.com/VERSANT_280docs.

**Note**: Changing the default Power Saver activation times can result in an overall higher energy consumption of the device. Before you turn off Power Saver modes or set a long activation time, consider the increase in device power consumption.

Eurasian Economic Union Compliance

The EAC mark applied to this product indicates certification for use on the markets of the Member States of the Customs Union.
Turkey RoHS Regulation
In compliance with Article 7(d), we hereby certify “it is in compliance with the EEE regulation EEE yönetmeligine uygundur.” (Compliant with EEE Regulations).

Ukraine RoHS Compliance
Обладнання відповідає вимогам Технічного регламенту щодо обмеження використання деяких небезпечних речовин в електричному та електронному обладнанні, затвердженої постановою Кабінету Міністрів України від 3 грудня 2008 № 1057
(The equipment complies with requirements of the Technical Regulation, approved by the Resolution of Cabinet of Ministry of Ukraine as of December 3, 2008, in terms of restrictions for the use of certain dangerous substances in electrical and electronic equipment.)

Copy Regulations

United States
Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties of fine or imprisonment can be imposed on those guilty of making such reproductions.

1. Obligations or Securities of the United States Government, such as:
   - Certificates of Indebtedness
   - National Bank Currency
   - Coupons from Bonds
   - Federal Reserve Bank Notes
   - Silver Certificates
   - Gold Certificates
   - United States Bonds
   - Treasury Notes
   - Federal Reserve Notes
   - Fractional Notes
   - Certificates of Deposit
   - Paper Money
   - Bonds and Obligations of certain agencies of the government, such as FHA and so on
   - Bonds. United States Savings Bonds can be photographed only for publicity purposes for the campaign of the sale of such bonds
   - Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a canceled revenue stamp, this can be done provided the reproduction of the document is performed for lawful purposes
• Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps can be photographed, provided the reproduction is in black and white and is less than 75% or more than 150% of the linear dimensions of the original document

• Postal Money Orders
• Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States
• Stamps and other representatives of value, of whatever denomination, which have been or can be issued under any Act of Congress
• Adjusted Compensation Certificates for Veterans of the World Wars

2. Obligations or Securities of any Foreign Government, Bank, or Corporation

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the reproduction falls within the fair use or library reproduction rights provisions of the copyright law. Further information of these provisions can be obtained from the Copyright Office, Library of Congress, Washington, D.C. 20559. Ask for Circular R21.

4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates can be photographed.

5. Passports. Foreign Passports can be photographed.

6. Immigration papers

7. Draft Registration Cards

8. Selective Service Induction papers that bear any of the following Registrant information:
   • Earnings or Income
   • Court Record
   • Physical or mental condition
   • Dependency status
   • Previous military service
   • Exception: United States military discharge certificates can be photographed

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the various Federal Departments, such as FBI, Treasury, and so on, unless the head of such department or bureau orders a photograph.

Reproducing the following items is prohibited in certain states:
• Automobile Licenses
• Driver Licenses
• Automobile Certificates of Title

The above list is not all-inclusive, and no liability is assumed for its completeness or accuracy. If there is doubt, consult your attorney.

Canada
Parliament, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions:

- Current bank notes or current paper money
- Obligations or securities of a government or bank
- Exchequer bill paper or revenue paper
- The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a court of law
- Proclamations, orders, regulations or appointments, or notices thereof (with intent to falsely cause same to purport to have been printed by the Queen’s Printer for Canada, or the equivalent printer for a province)
- Marks, brands, seals, wrappers or designs used by or on behalf of the Government of Canada or of a province, the government of a state other than Canada or a department, board, Commission or agency established by the Government of Canada or of a province or of a government of a state other than Canada
- Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a province or by the government of a state other than Canada
- Documents, registers or records kept by public officials charged with the duty of making or issuing certified copies thereof, where the reproduction falsely purports to be a certified copy thereof
- Copyrighted material or trademarks of any manner or kind without the consent of the copyright or trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be imposed on those found guilty of making such reproductions.

- Currency notes
- Bank notes and checks
- Bank and government bonds and securities
- Passports and identification cards
- Copyright material or trademarks without the consent of the owner
- Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact your legal counsel.

Safety Certification

This device is compliant with IEC and EN product safety standards certified by a National Regulatory Test Laboratory (NRTL).
Safety Data Sheets
For Material Safety Data information regarding your printer, go to:
- Web address: www.xerox.com/sds or www.xerox.co.uk/sds_eu
- United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)
- For other markets, send email request to: EHS-Europe@xerox.com

Recycling and Disposal

All Countries
If you dispose your Xerox product, note that the printer may contain lead, mercury, perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The presence of these materials is fully consistent with global regulations applicable at the time that the product was placed on the market. For recycling and disposal information, contact your local authorities.

Perchlorate Material: This product may contain one or more perchlorate-containing devices, such as batteries. Special handling may apply. For more information, go to www.dtsc.ca.gov/hazardouswaste/perchlorate.

Battery Removal
Only a manufacturer approved service facility can replace the batteries.

North America
Xerox operates an equipment take-back and reuse or recycle program. Contact your Xerox representative (1-800-ASK-XEROX) to ensure that this Xerox product is part of the program. For more information about Xerox environmental programs, go to www.xerox.com/environment.

For recycling and disposal information, contact your local authorities.
European Union

These symbols indicate that this product is not to be disposed of with your household waste, according to the Waste Electrical and Electronic Equipment (WEEE) Directive (2012/19/EU), the Battery Directive (2006/66/EC) and national legislation implementing those Directives.

If a chemical symbol is printed beneath the symbol shown above, in accordance with the Battery Directive, this indicates that a heavy metal (Hg = Mercury, Cd = Cadmium, Pb = Lead) is present in this battery or accumulator at a concentration above an applicable threshold specified in the Battery Directive.

Some equipment can be used in both a domestic or household and a professional or business application. Private households within European Union can return used electrical and electronic equipment to designated collection facilities free of charge. For more information about collection and recycling of old products and batteries, contact your local municipality, your waste disposal service or the point of sale where you purchased the items. In some member states, when you purchase new equipment, your local retailer may be required to take back your old equipment free of charge. For more information, contact your retailer.

Business Users in the European Union, in accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be managed within agreed procedures. If you discard electrical and electronic equipment, contact your dealer or supplier, local reseller or Xerox representative for end of life take-back information prior to disposal.

Improper handling of this type of waste can have a possible impact on the environment and human health due to potentially hazardous substances that are generally associated with EEE. Your cooperation in the correct disposal of this product will contribute to the effective usage of natural resources.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you want to discard these items, contact your local authorities or dealer and ask for the correct method of disposal.

Other Countries

Contact your local waste management authority to request a disposal guidance.

Working With

Power On or Off the Press

The Power Switches

There are three power switches on the press:

- The Breaker switch located at the rear of the press. Initially check to ensure that this switch is set to **On** when the press is shipped.
• The Main Power switch located inside the Front Door. This switch is used mainly by the Xerox Service Representative when servicing the press. In rare problem-solving cases, you are directed to power off the press with this switch.

• The Power On/Off button located on the top of the press near the Document Feeder. This button is the primary way for you to power on or off the press. It is used by the operator as the workflow requires.

Use the Power On/Off button to power on or power off the press.

⚠️ Important: To power off, always press the power button first. Wait until the lights on the user interface stop blinking, to allow the fuser to finish cooling. Move the main power switch to the off position.
Power On or Off the Press

Power On the Press
1. Check that the Main Power switch behind the Front Door is On.
2. Press the Power button on top of the press to the ON position.
   The Services button glows blue.
   A screen message advises of a short wait while the fuser warms up and the press runs a system check. You can set features for a job during this time and the printing process will start automatically when the press is ready.

Power Off the Press

**Important:** Always power off the power button first, and then power off the main power switch.
1. Press the Power On/Off button on the top of the press to Off.
   Wait until the lights on UI stop blinking, as this allows the fuser to begin cooling.
2. Switch Off the Main Power switch behind the Front Door.
   
   **Note:** Allow the press to remain off for a minimum of 10 seconds before switching on the power again.

Power Saver

The Power Saver feature allows the press to enter a reduced power consumption mode when all print jobs have completed and there are no jobs currently processing. There are two power saving modes: Low Power and Sleep.

By default, the press automatically enters the Low Power mode after 1 minute of inactivity. After 1 minute of inactivity, the press then enters Sleep mode. These time intervals for both modes can be changed by the system administrator.

Refer to the following example:
- Low Power Mode is set to 1 minute.
- Sleep Mode is set to 10 minutes.
- Sleep Mode activates after 10 minutes of total inactivity and not 10 minutes after the Low Power Mode begins.

Low Power Mode

In this mode, the power to the User Interface (UI) and fuser unit is lowered to save power. The display goes out and the Power Saver button on the UI lights. To use the press, press the Power Saver button. The Power Saver button is no longer lit, indicating that the Power Saver feature is canceled.

Sleep Mode

In this mode, the power is lowered more than in the Low Power mode. The display goes out and the Power Saver button on the UI lights. To use the press, press the Power Saver button. The Power Saver button is no longer lit, indicating that the Power Saver feature is canceled.
Exiting Power Saver

The press exits Power Saver mode by doing one of the following:

- Pressing the Power Saver button on the press UI
- Receiving print data for an incoming job to be printed
- Programming and performing a copy or scan job

Press Apps

Print

Print Job Submission

There are several ways in which to submit your job for printing:

- From your computer workstation (PC or Mac), using print drivers such as PostScript and Printer Command Language (PCL), you can submit a document file to the print server queue. From the print server, you would then submit the job to the press.

  Note: Make sure the appropriate print drivers have been installed on your computer. Refer to your print driver documentation or the Xerox web site for more information on how to download or install print drivers.

- At any remote workstation, using a Hot Folders application to submit the document file to the print server.

- At the print server, importing/adding a document file to a print queue. Manage the job settings of the document and then submit to the press for printing.

Printing from a Computer

The system supports Xerox® EX print drivers, Powered by Fiery®. Through print drivers installed on your computer or Mac, you can send a document file from your desktop to the print server, which can then be submitted to the press for printing.

Note: You can also use a drag and drop Hot Folders feature by which to send your files to the print server for printing to the press.

1. From your computer, select the file you want to print and open it in its application.
2. Select File > Print.
3. Select the desired print server queue.
4. Select the Properties button for the queue.
5. Select the desired output options such as quantity or 1–sided/2–sided printing.
6. Select OK to close the Properties window.
7. Select Print to send the job to the print server queue.

Printing a Job from the Print Server

The following is a basic workflow for setting up a job and submitting it from the print server:
1. At the press, load the appropriate paper to be used for the job.

2. From the press UI, ensure that the Paper Tray settings/Tray Properties window matches the stock properties for the paper you will use and that it is assigned to the same feeder tray where the paper is loaded.

3. At the print server main window, customize your job such as inserting special pages and tabs and create your print queue that defines the attributes of those jobs sent to the queue.

4. Submit the job file from the print server to the networked press for printing.

**Printing from the EX Print Server**

From your computer, you can submit your document files (select Print) to a directory on the print server using installed print drivers. You could also copy the document files onto a USB flash drive or CD/DVD and then connect those devices to the print server for importing.

1. From the EX Print Server, select **File > Import Job**.

2. Select **Add**.

3. Locate your storage device or other directory containing the document files.

4. Select and highlight one of the document files. Select **Open**.

5. Select **Import**.

6. Select the desired queue such as **Process and Hold** or **Print and Hold**.

   The job is sent to the selected queue or to the press for immediate printing.

**Printing on Tabs from the Print Server**

**Basic Procedure for Printing on Tabs from a Print Server**

There are many types of tab stock and tab sequences available. Precut tabs are commonly used and have two different orientations: the single straight collated tab stock or the single reverse collated tab stock.

When programming tab jobs and loading tab stock, consider the following:

- Precut tabs can only print 1-sided
- There are specific job settings that you need to define such as tab order or sequence, number of bank sets, stock weight, paper size, and insertion before or after body pages. Refer to your print server documentation for more detailed setting information.
- Always load tab stock LEF into the tray where the straight edge of the stock is the lead edge and the tabs are oriented at the trail edge.
- Always use a complete set or bank or tabs in the paper tray.
- If staple or punch finishing, use tray 5 or, if available, trays 6 or 7.

The following are the basic steps for printing tabs on your press.

1. From the print server, create and define the Tab stock for the paper tray you will be using.

2. Load the Tab stock in Trays 1, 2, 3, 5, 6 or 7.

3. From the print server window, access the Held queue that contains your document. Select the document you want to configure with tabs. Double click to open the file properties.
4. Once all settings are made, select **Print**.

   The press prints the complete set of tabs with the body pages defined. Any extra tabs not used in
   the job are sent to the output tray.

**Tips for Printing on Tabs from the EX Print Server**

Use the following tips for printing on tabs from the EX Print Server:

- The EX Print Server allows for setting up your job to print on tabs. Otherwise, you can set up your
  job to insert preprinted tabs into your document. Use one tray for the body pages, another tray
  for the preprinted tab stock, and another tray for cover or back pages.
- While you can print tab stock from any of the paper trays on the system (Trays 1, 2, 3, 5, 6 or 7),
  Trays 6 and 7 should be used for best results. If you plan to apply staple or punch finishing, use
  Trays 5, 6 or 7 only.
- Loading orientation depends on what tray you are using.

**Copy**

**Document Feeder and Glass**

**Document Feeder Tips**

Tips for using the Duplex Automatic Document Feeder (DADF):

- For best output, ensure that the documents are in good condition.
- A maximum of 250 documents can be scanned at one time by using the document feeder.
- Mixed-size original documents can be used; however, the top left corners of the original
  documents must be aligned in the document handler.
- Remove any staples and paper clips from the documents before loading them in the document
  feeder.

**Document Glass**

Use the Document Glass for scanning and copying various types documents, such as bound originals
(books), odd size documents, or poor-quality originals. Documents should be placed face down on the
glass and aligned with the tip of the registration arrow in the top left corner.

The document glass accommodates document sizes up to a maximum of 11 x 17 in., A3.

**Basic Copying Steps**

**Basic Copying with the Document Feeder (DADF)**

1. Adjust the movable document guides to their widest position.
2. Load the documents face up with the first page on top and with the headings toward the back or left of the press.

The confirmation indicator lights to show that the documents are loaded correctly.

3. Press the **Home** button on the press UI.

4. Select **Copy** on the **Home** window.

5. Select the desired Copy features/options:
   - Paper Supply
   - Reduce/Enlarge
   - Output Color
   - 2-Sided Copying
   - Original Type
   - Lighten/Darken

   The features displayed on the main Copy window vary depending on how it is configured by the administrator.

6. Enter the quantity.

7. Press **Start**.

**Basic Copying with the Document Glass**

1. Open the document feeder.

2. Place the document face down by aligning it as shown in the illustration.
3. Press the **Home** button on the press UI.

4. Select **Copy** on the **Home** window.

5. Select the desired Copy features or options:
   - Paper Supply
   - Reduce or Enlarge
   - Output Color
   - 2-Sided Copying
   - Original Type
   - Lighten/Darken
   The features displayed on the main Copy window vary depending on how it is configured by the administrator.

6. Enter the quantity.

7. Press **Start**.

**Selecting Copy Options for a Third-Party Finishing Device**

Read the following list before performing the procedure:

- If your press has an optional, third-party, Document Finishing Architecture (DFA) device attached, then this profile feature is available and specific copy options may be selected for a job.

- Prior to physically attaching the DFA device to the press, device profiles are created. The profiles represent the characteristics of your finishing device.

- Refer to the third-party customer documentation for information on setting the profile values for the specific DFA device attached to the press.

- A profile for the job can be selected from the print server, the print driver on your computer, or the User Interface (UI). Depending on the DFA device, a maximum of twelve profiles are available.

1. Place your original documents in the document feeder or on the document glass.

2. Press the **Home** button on the UI.

3. Select **Copy** on the **Home** window.

4. Select the **Output Format** tab.
   a. Select the **DFA Finisher**.
      The DFA Finisher Profile screen displays.
   b. From the displayed list, select the profile for the job.
      If the device is an e-binder, select the binding position.
   c. Select **Save**.
   d. Select the desired **Face Up/Down Output** option.

5. Select the desired **Copy features/options**.
   The features displayed on the main Copy window vary depending on how it is configured by the administrator.

6. Enter the quantity.
7. Press **Start**.
   If prompted on the UI, follow the instructions provided to correct any job submission errors. If there is a DFA problem, refer to your DFA documentation.

**Copy Feature**

**Copy Feature Overview**

![Tip: Depending on how the Copy tab is configured by the administrator, this tab may contain different features than the ones listed here.](image)

The **Copy** feature includes the following options:

- Reduce/Enlarge (R/E)
- Paper Supply (Auto Select)
- Output Color
- Copy Output
- 2 Sided Copying
- Original Type
- Darken/Lighten

**Reduce/Enlarge**

**Reduce and Enlarge**

The reduce/enlarge (R/E) feature provides a variety of reduction and enlargement options to adjust the size of the output image. Originals can be enlarged or reduced from 25-400%. Various automatic and preset selections are available to help you choose the most common reductions or enlargements, while a custom setting enables you to select the ratio that suits your requirements. Basic reduction/enlargement options include:

**100% or R/E entry box**

The default setting in the R/E entry box is 100%. This selection produces an image on your copy exactly the same size as the image on your original document.

You can also set the R/E ratio by using the plus or minus buttons. In this case, the ratio is displayed in the R/E entry box.

**Auto%**

This selection proportionally reduces or enlarges the image so that it will fit onto your chosen paper. If this option is selected, you must also select a specific paper tray.

**Preset R/E buttons**

Depending on what the System Administrator has selected, you see several percentage options for reduction or enlargement. These buttons can be customized by the Administrator to display the reduction/enlargement ratios that you frequently use.

**More**

When the Reduce/Enlarge (R/E) **More** button is selected, a new window opens and displays additional R/E options.
More Reduce and Enlarge Options

The Reduce/Enlarge (R/E) More options include:

Proportional %
All of the options will reduce or enlarge the image by the same ratio in both directions so that the image gets bigger or smaller, but the proportion remain the same.

Auto %
Proportionally reduces or enlarges the image so that it will fit onto your chosen paper. If this option is selected, you must also select a specific paper tray.

Independent X-Y%
This option allows you to specify different height and width ratios to scale the height and width independently. **Auto X-Y%** ensures copies are made with the height and width ratios set automatically to match the paper size.

Auto Center
This option allows you to specify individually the height and width values.

Preset percentage buttons
The percentage buttons are preset for specific magnification levels by the administrator to reflect the percentages used most frequently.

Paper Supply
Select the desired tray to be used for your job; options include:

Auto Select
This option automatically detects the size of the original document and selects the proper tray for output.

Tray buttons
Allows you to select a specific tray containing the desired media for your job.

More button
Displays the Paper Supply screen showing all available trays for the machine and their media content.

Output Color
Select the desired Output Color option which best applies to the job. The options include:

Auto Detect
This option allows the press to automatically detect if the original document is in color or black and white.

Color
This option generates copies with full color output, using all four printing colors - cyan, magenta, yellow, and black.
Black and White  
This option copies in black and white only. Colors in the original are converted to shades of gray.

Dual Color  
This option allows you to separate the colors of the original into two groups of colors for copying. The source color is extracted from the original and replaced by the target area color. The rest of the colors are replaced by the non-target area color that you select.

Single Color  
This option allows you to copy in one of the preset or custom colors.

More  
This option allows you to customize the color for the copied output.

Copy Output  

Important: Copy Output options vary depending on the finishing devices attached to your press.

Note: Copy Output may be accessed from the Copy tab or from the Output Format tab.

Use the Copy Output feature to select the desired options for your output; options include:

- Auto  
- Collated  
- Uncollated  
- Uncollated with Separators  
- Original Orientation  
- Optional finishing features, including:  
  - Output Destination/Offset  
  - Stapling  
  - Hole Punching  
  - C/Z Folding

2-Sided Copying  

Note: The 2-Sided Copying option may be accessed either from the main Copy screen or from the Output Format tab.

Make one or two-sided copies from one or two-sided originals using the document feeder or the document glass. The two-sided option enables you to select your output in book or calendar orientation. Options include:

1-1 Sided  
Use this option if your originals are printed on one side and you want single-sided copies.

1-2 Sided  
Use this option if your originals are printed on one side and you want two-sided copies.
2-2 Sided
Use this option if you want to make two sided copies from two-sided originals.

2-1 Sided
This option will make one-sided copies from two-sided originals.

Originals and Copies
Select the orientation of both your original documents and the output copies. Options include Head to Head and Head to Toe.

Head to Head
This option is sometimes called Top-to-Top. For your original documents, select this option when all the pages of your original documents have the same orientation. For copy output, select this option to copy or print the reverse side of a page so that the finished document opens like a book.

Head to Toe
This option is sometimes called Top-to-Bottom. For your original documents, select this option when the pages of your original documents have the opposite orientation such as on a calendar. For copy output, select this option to copy or print the reverse side of a page so that the finished document opens like a calendar.

Original Orientation

Upright Images
Select this option when placing the top edge of the document against the top side of the document glass or document feeder.

Sideways Images
Select this option when placing the top edge of the document against the left side of the document glass or document feeder.

Original Type

Note: The Original Type option may be accessed from the main Copy screen or from the Image Quality tab.

The Original Type feature provides a convenient way to enhance the quality of your output based on the type of original images you are copying. Select the Original Type button on the Image Quality tab, then select the desired option.

Auto
This option sets the output color according to the document type preset in the System Administration mode.

Photo and Text
Use this option if your original is from a magazine or other source that contains high quality photographs with text. This setting produces better pictures, but slightly reduces sharpness for text and line art.
Text
Use this option if your original contains only text or line art. The result is sharper edges for the text and line art.

Photo
This option is specifically designed to copy photographs or magazine pictures without any text or line drawings. This option prevents faint reproduction of colors.

Map
Use this option for making copies of documents that have text on colored backgrounds such as maps.

Darken or Lighten

Note: The Darken/Lighten option may be accessed from the main Copy screen or from the Image Quality tab and then by selecting Image Options.

The Darken/Lighten option provides manual control to adjust the lightness or darkness of the scanned images.
- Select the Left scroll button to darken the scanned image from light originals such as pencil images.
- Select the Right scroll button to lighten the scanned image from dark originals such as half tones or originals with colored backgrounds.

Image Quality Feature

Original Type Option for Image Quality

Note: The Original Type option may be accessed from the main Copy screen or from the Image Quality tab.

The Original Type feature provides a convenient way to enhance the quality of your output based on the type of original images you are copying. Select the Original Type button on the Image Quality tab, then select the desired option.

Auto
This option sets the output color according to the document type preset in the System Administration mode.

Photo and Text
Use this option if your original is from a magazine or other source that contains high quality photographs with text. This setting produces better pictures, but slightly reduces sharpness for text and line art.

Text
Use this option if your original contains only text or line art. The result is sharper edges for the text and line art.

Photo
This option is specifically designed to copy photographs or magazine pictures without any text or line drawings. This option prevents faint reproduction of colors.
Map
Use this option for making copies of documents that have text on colored backgrounds such as maps.

Image Quality Feature Overview
The Image Quality feature includes the following options:
• Original Type
• Image Options
• Image Enhancement
• Color Effects
• Color Balance
• Color Shift

Selecting Image Quality Options
1. Load the document or documents onto the Document Glass or into the Document Feeder.
2. Press the Home button on the press UI.
3. Select Copy on the Home window.
4. Select the Image Quality tab.
5. From the Image Quality window, select the desire options:
   • Original Type
   • Image Options
   • Image Enhancement
   • Color Effects
   • Color Balance
   • Color Shift
6. Select the Copy tab.
7. Select the desired Copy options including:
   • Paper Supply
   • Reduce/Enlarge
   • 2-Sided Copying
8. Select any other desired Copy features/options (such as Layout Adjustment, Output Format).
9. Enter the quantity.
10. Press Start on the UI.

Image Options
Use the Image Options feature to make adjustments to the following options:

Lighten/Darken
This option provides manual control to adjust the lightness or darkness of the scanned images.
• Select the Down scroll button to darken the scanned image from light originals such as pencil images.
• Select the Up scroll button to lighten the scanned image from dark originals such as half tones or originals with colored backgrounds.

Sharpness
This option controls the balance between sharp text and moiré (patterns within the image). Move the slider control down (Soften) to produce an image with a smooth, uniform appearance ideally suited for photographic scanned images. Move the slider control up (Sharpen) to produce an image with better quality text or line art.

Saturation
This option allows colors to become more or less vivid. To make the colors on your output more vivid, move the slide bar up. To create a less vivid output or a pastel effect, move the slide bar down. To keep the output normal, do not adjust the saturation.

Image Enhancement
Use the Image Enhancement settings when your scanned image requires more than the basic image quality. There are two features associated with Image Enhancement:

Suppress Background
This option prevents reproduction of unwanted shading from originals where the opposite side printing shows through.
- Off
- Auto Suppression: This option automatically reduces or eliminates any background on the copies caused by colored paper or newspaper originals.

Contrast
Selections are Auto Contrast or Manual Contrast. The Contrast feature controls the difference between the image densities within the scanned image. Lower contrast settings reproduce more detail in light and dark areas of the original. Higher contrast settings produce vivid blacks and whites for sharper text and lines, but produce less detail in pictures. Auto Correction automatically chooses the best settings for your job.

Color Effects
This feature produces balanced image tones on your output. Options include:

Lively
This option uses the highest color saturation to produce rich, vivid output colors. The option increases the color saturation of the most vivid setting in order to produce fresher images.

Bright
This option produces images that have a brighter appearance and enhanced contrast.

Warm
This option produces a soft image on the output and adding a warm, reddish tint to low density colors. Use this setting to apply a light pink tone to skin colors and to give a soft tone to dark, warm colors.
Cool
This option produces a strong, clear blue tone on the output. This setting makes blue color stronger and makes dark, cold colors clearer.

Shadow Suppression
This option reduces or eliminates any background shadow caused by colored paper or newspaper originals.

Color Balance
This feature allows you to adjust the balance between colors and the overall amount of color on the output copies. You can adjust the levels of all four process colors (Yellow, Magenta, Cyan, and Black) for their low, medium, and high density ranges.

- The default option is **Normal**.
- **Basic Color** adjusts the density.
- **Advanced Color** adjusts the Highlights, Midtones, and Shadows.

Color Shift
This feature allows you to shift all hues in an image simultaneously in order to make the overall character of the output image warmer or cooler. For example, if you select one of the:

**Normal**
This is the default option.

**Plus buttons**
The red colors shift toward the yellow hue, the green colors shift toward the cyan hue, and the blue colors shift toward the magenta hue. All colors between these original colors also shift in the same direction.

**Minus buttons**
The red colors shift toward the magenta hue, the blue colors shift toward the cyan hue, and the green colors shift toward the yellow hue. Again, all colors between these original colors also shift in the same direction.

Layout Adjustment Feature

Layout Adjustment Feature Overview
The **Layout Adjustment** feature includes the following options:

- Book Copying
- 2 Sided Book Copying
- Original Size
- Edge Erase
- Image Shift
- Image Rotation
- Invert Image
Selecting Layout Adjustment Options
1. Load the document or documents onto the Document Glass or into the Document Feeder.
2. Press the Home button on the press UI.
3. Select Copy on the Home window.
4. Select the Layout Adjustment tab.
5. From the Layout Adjustment window, select the desired options:
   - Book Copying
   - 2 Sided Book Copying
   - Original Size
   - Edge Erase
   - Image Shift
   - Image Rotation
   - Invert Image
   - Original Orientation
6. Select the Copy tab.
7. Select the desired Copy options including:
   - Paper Supply
   - Reduce/Enlarge
   - Darken/Lighten
8. Select any other desired Copy features/options (such as Image Quality, Output Format).
9. Enter the quantity.
10. Press Start on the UI.

Book Copying
Bound originals (such as books) can be placed on the document glass to make 1-sided or 2-sided copies. The bound original should be placed face down and registered to the rear left corner of the document glass. Align the top of the bound original against the rear edge of the document glass.
Book Copying options include:

**Both Pages**
Copies both pages in page order.

**Left Page Only**
Copies the left page only.

**Right Page Only**
Copies the right page only.

**Binding Edge Erase**
This option erases or deletes the shadow from your copies that is caused by the center binding of the bound original.

**2-Sided Book Copying**
You can make 2-sided copies from two pages of a bound original. This feature allows you to assign pages when making copies of a bound original so that the copied pages face each other in the same way as the bound original. 2-Sided Book Copying options include:

- Select a starting and ending page
- Select Starting Page (Left Page or Right Page)
- Select Ending Page (Left Page or Right Page)

**Original Size**
The press can detect the size of the document if it is a standard size. If the document is not a standard size, the machine does not know what size it is. This does not matter if you select a specific reduction/enlargement option and also select a specific paper tray. However, you can tell the press the size of the document if you want to use the Auto features. Original Size options include:

**Auto Detect**
This option automatically detects the size of the scanned pages. The document sizes that can be detected automatically include all standard sizes.
Manual Size Input
This option allows you to select a standard paper size from the options shown or to input a non-
standard (custom) size. When you have selected the size of your document, you can use the auto
reduce/enlarge or the auto paper supply features.

Mixed Size Originals
With this option the press automatically detects the size of each document.

Edge Erase
This option allows you to erase images around the border of a document. Edge Erase also deletes
center streaks caused by a gap between the spine of a bound document and the document glass.
Options include:

All Edges
This option causes a preset amount to be erased from the top/bottom and left/right edges and
from the center of the output image.

Print to Edge
This option does not perform any edge deletions.

Individual Edges
This option allows you to independently set the amount to be erased for each of the four edges
and the center of your output. The default is 0.1 in. (2.54 mm) and each edge can be adjusted in
0.1 in. (2.54 mm) increments up to 2.0 in (50.8 mm).

Presets
With this option you choose pre-programmed erase amounts that were previously created and
saved by the system administrator.

Image Shift
Image Shift allows you to move the position of the image on the output page. Options include:

Off
This is the default setting. The image on the copy will be in the same place as the image on the
original.

Auto Center
This option automatically centers the scanned image on the output paper. To work effectively, the
original should be smaller than the selected output stock or the image should be reduced.

Corner Shift
This option enables you to move the image to each of the four corners of the paper or to the
center of each of the four sides of the paper (eight positions total).

Margin Shift
This option creates a margin for binding one edge of a document by shifting the image away from
that edge. The Margin Shift option enables you to center a document image, shift the image to
one edge slightly, or move the image to a specified edge (0-50.8 mm (0-2.0 in.), Left and Right or
Top and Bottom) of the output.
Presets

With this option you choose pre-programmed shift amounts that were previously created and saved by the system administrator.

Image Rotation

If the orientation of the paper loaded in the selected paper tray differs from that of the document that is scanned, the Image Rotation option automatically rotates the document image to match the orientation of the paper loaded in the paper tray. You can also select which edge of the original document to use as a reference for image rotation if documents are of mixed orientations. Options include:

Off

This option causes copies to be made as they are loaded, even if they are oriented differently from the paper in the selected paper tray.

Always On

This option causes copies to be made with the document image automatically rotated so that the orientation of the document matches that of the paper in the selected paper tray.

On during Auto

This option provides automatic rotation of the image on your original to fit correctly on your selected copy paper when Auto Select or Auto % is selected.

Invert Image

The Invert Image feature allows you to make copies with the left and right sides of the document image reversed or the colors reversed. Options include:

Mirror Image

This option reverses the original image creating a mirror of the original. This feature can be used when you want to change the apparent direction of an image or where the original is inked on the reverse of the paper (for example engineering drawings).

Negative Image

This option converts the black image areas in the original to white, the white image areas to black, and any dark gray image areas to light gray. This feature is useful for documents that have a substantial amount of dark background and/or light text and images, saving on dry ink/toner usage.

Original Orientation

This feature is used to inform the system of orientation of your original document when it is placed in the document feeder or on the document glass. The orientation must be specified in order to identify the top of the document set. This information is used by the system to make a decision about how to accurately place images on paper when using features such as Image Shift, Edge Erase, Multiple-Up, Repeat Image, Annotation, and Booklet Creation. Original Orientation options include:

- Upright Images: Select this option when placing the top edge of the document against the top side of the document glass or document feeder.
- Sideways Images: Select this option when placing the top edge of the document against the left side of the document glass or document feeder.
Output Format Feature

Output Format Feature Overview
The **Output Format** feature includes the following options:
- Booklet Creation
- Covers
- Transparency Options
- Page Layout
- Poster
- Annotations
- Watermark
- Tab Margin Shift
- Face Up/Down Output
- ID Card Copying
- Transparency Options
- Folding (optional)

Selecting Output Format Options
1. Load the document or documents onto the Document Glass or into the Document Feeder.
2. Press the **Home** button on the press UI.
3. Select **Copy** on the **Home** window.
4. Select the **Output Format** tab.
5. From the Output Format window, select the desire options:
   - Booklet Creation
   - Covers
   - Transparency Options
   - Page Layout
   - Poster
   - Annotations
   - Watermark
   - Tab Margin Shift
   - Face Up/Down Output
   - ID Card Copying
   - Transparency Options
   - Folding (optional)
6. Select the **Copy** tab.
7. Select the desired Copy options including:
   • Paper Supply
   • Reduce/Enlarge
   • Darken/Lighten

8. Select any other desired Copy features/options (such as **Image Quality**, **Layout Adjustment**, **Output Format**).

9. Enter the quantity.

10. Press **Start** on the UI.

**Booklet Creation**

**Booklet Creation** allows you to create multi-page booklets from an ordered set of 1-Sided or 2-Sided originals.

Refer to the following tips when using the **Booklet Creation** feature:

- When **Auto%** is selected, the press reduces or enlarges the image as required.
- Any other **Reduce/Enlarge** selection could result in image loss.
- When **Booklet Creation** is selected, the output is automatically set to 1-2 Sided.
- Ensure that the **Original Orientation** setting reflects the same orientation as that of the original documents.

**Booklet Creation Options**

When **On** is selected, the following Booklet Creation options are available:

**Original Input**

- 1 Sided Originals
- 2 Sided Originals
- 2 Sided Rotated Originals

**Binding Shift**

Use this option to set the booklet binding-shift value within the range from 0 to 1.9 in. (0 to 50 mm) in 0.1 in. or 1 mm increments.

**Covers**

This option allows you to attach covers to the booklet. The front and back covers can be output before the first page and after the last page of the document and on a different type of paper.

**Divide Output**

Use this option when you have a large number of original documents. The original documents are divided to create subsets in order to reduce the thickness of each booklet. The press folds copies in half and piles them up to form a booklet. The Light Production C Finisher with Booklet Maker allows you to specify the number of sheets within the range of 1-50 sheets in one-sheet increments.
Output/Offset
This option is available only when specific optional finishers are attached, such as the Standard Finisher or Booklet Maker Finisher.

Auto Image Positioning
This option adjusts the image position so that the printing position from the edge of each page remains consistent between the inner and outer pages of the booklet. Auto Image Positioning is available for selection if you have already selected Create Left/Top Bound Booklet or Create Right Bound Booklet.

Fold and Staple (optional)
Folding and stapling are optional features. These features are available only with finishing devices that provide these capabilities. When available, select the desired Fold and Staple option:
- No Fold and Staple: This option produces booklets without folding or stapling.
- Fold Only: This option produces booklets that are folded in half.
- Fold and Staple: This option produces booklets that are folded in half and stapled in the center.

Booklet Trimming and Pressing (optional)
Booklet trimming and pressing are available only if the optional SquareFold Trimmer Module is attached to the Booklet Maker Finisher. Booklet Trimming and Pressing options include the following:
- Booklet Trimming: This option trims (cuts) away the face (edge) of the booklet, resulting in a neat finished edge.
- Book Pressing: Book Pressing, also known as square folding, flattens the booklet spine, thereby reducing the booklet thickness and giving it the appearance of a perfect bound book.

Covers
This feature allows you to automatically add covers to your copied sets using stock from a different tray. For example, you can add colored stock, card or transparencies to your copied sets to add a professional finish to your copy job.

The Covers feature includes the following options:

Front Cover and Back Cover
Select an option for a front cover only, back cover only, or select options for both front and back covers:
- Off
- Blank Cover: Uses blank sheets of paper as the cover.
- Print on Side 1
- Print on Side 2
- Print on Both

Paper Supply
Select the tray or trays from which front and/or back cover media is supplied. If Blank Covers is selected, enter the number of blank sheets that will be used for the covers.
Note: If Blank Cover is used for both the front and back covers, verify that the correct quantity is selected for both the covers.

Page Layout

The Page Layout options are ideal for handouts, storyboards, or for archival purposes.

Pages per Side

The Pages per Side feature is ideal for handouts, storyboards or for archival purposes. It allows the scanning of up to eight independent images to fit onto one sheet of paper. Your press reduces or enlarges the images as needed in order to display them in either portrait (upright) or landscape (sideways) orientation on one page; this is based on the paper supply selected.

Repeat Image

This option allows you to copy a single image up to eight times onto one page.

Variable Repeat: This option specifies the number of times to repeatedly copy the image along each of the long and short sides of the paper. You can specify from 1 to 23 repeats along the short side (Y) and from 1 to 33 repeats along the long side (X). The examples shown are a typical output that can be produced when using the Repeat Image feature.

Poster

This feature allows you to create a large poster by pasting together copies spread over multiple sheets. Copies are provided with a paste margin so that they can be pasted together. Options include:

Output Size

This option allows you to choose from a list of preset output poster sizes.

Enlargement %

This option allows you to enter specific height and width percentage values (from 100% to 400%) for your final poster size.

Annotations

This option allows you to add a stamp to your copied output. Options include:

Comment

This option allows you to add comment stamps that are stored on the press to the output copies. Select one of eight existing stamped messages to be printed on the first page or all pages of your copied sets. Stored comments include Confidential, Urgent, and Draft. You can also create new or edit existing comments. These can also be stored to the press memory. You can also change the position and appearance of the comment using the Position and Font Size buttons.

Date

This option allows you to place the current date in the margins of your output. The date can be printed on only the first page of the output or it can be printed on all pages. You can also change the position and appearance of the date using the Position buttons.

Page Numbers

This option allows you to add an independent page number to one or many copied pages. You can also change the position and appearance of the page numbers using the Position and Font Size buttons.
**Bates Stamp**

This option allows you to place an alphanumeric prefix, followed by a sequential page number in the margins of the output. You can specify an existing Bates Stamp or you can create a new or edit an existing Bates Stamp. You can also change the position and appearance of the stamp using the **Position** and **FontSize** buttons.

**Watermark**

This option to add a lightly printed sequential control-number, stored watermark, date and time, or serial number on the background of each copy set. This feature can be used to help track confidential documents. For example, you can use sequential numbering to associate distribution copies with specific recipients. Options include:

**Control Number**

This option allows you to input a start number that will be printed on each document set. For example, if you select 1 for the start number, the number 1 will be printed on the first set of documents, the number 2 will be printed on the second set, and so on.

**Stored Watermarks**

This option allows you to select an existing watermark to be printed on one page or many pages. Existing watermarks include Copy Prohibited, Copy, and Duplicate.

**Date and Time**

This option prints the current date and time on the output (each page).

**Serial Number**

This option allows you to make copies with the press serial number printed on each page. This feature is useful if you want to track the copies coming from a certain machine.

**Watermark Effect**

This option allows you choose an embossed or outline style for the watermark text you print.

**Tab Margin Shift**

The **Tab Margin Shift** option allows you to copy images from a document onto tabbed stock. You have the option to copy the entire original document onto the tabbed stock or you can choose to copy only the edge of the original document onto the tabbed stock. Options include:

**Shift to Tab**

This option prints the edge of the original document image onto the tab of the tabbed stock. You can change the amount of shift required by using the Shift Value buttons on the touch screen.

**Shift All**

This option copies the whole image of the document onto tab stock. Use the Shift Value button when you want to adjust the position of the image on the tab area.

**Shift Value buttons**

These buttons allow you to specify a shift value in the range of 0-15 mm (0-0.59 in.) in 1 mm (0.039 in.) increments.
Add Tab Stock
Use this option to select a specific number of tab stock sheets to use.

Paper Supply
Use this option to select the tray containing the tab stock.

Face Up or Face Down Output
The Face Up/Down Output option allows you to select whether copies are output facing up or facing down. Options include:

Auto
Selecting the Auto button automatically determines whether the copies should be output face up or face down.

Face Up
Selecting the Face Up button causes all output to be delivered face up, with the first page on top of the output stack.

Face Down
Selecting the Face Down button causes all output to be delivered face down, with the first page on the bottom of the output stack.

Face Up (Reverse Order)
Selecting the Face Up (Reverse Order) button causes all output to be delivered face up, with the last page on the top of the output stack. This setting may not be available, depending on how your system administrator configures the press.

ID Card Copy
Whether needing to copy insurance cards, a driver license, or any other form of identification, the ID Card Copying feature offers a simple and efficient way to save time. Information on both sides of an ID card can be copied onto one side of a sheet of paper into the paper or bypass tray.

1. Open the document feeder and place the ID card on the top, left corner of the document glass.
2. Close the document feeder.
3. Press the Home button on the press UI.
4. Select Copy on the Home window.
5. Select Output Format > ID Card Copying.
7. Select Save.
8. Enter the quantity.
10. Open the document feeder and turn the ID card over to copy side 2.
11. Close the document feeder.
12. Press **Start** to begin scanning side 2.
   Printing begins and copies are delivered to the output area.

**Transparency Options**
When making a set of transparencies you can insert a divider between each transparency in order to make it easier to manage your presentation slides. You can also produce paper copies of the transparencies in order to distribute them to people. Transparency options include:

**Blank Transparency Separators**
This option delivers your transparencies to the output destination with a blank sheet of paper separating each transparency.

**Blank Separators and Handouts**
This option inserts a blank sheet of paper between each printed transparency. In addition, a distribution set of copies is also printed on the stock you specify using the Paper Supply Settings button. Handouts can be 1- or 2-sided and stapled (if available).

**Transparency Set and Handouts**
This option delivers the transparencies without separators. However, a distribution set of copies will be printed on the stock you specify using the Paper Supply button. Handouts can be 1- or 2-sided and stapled (if available).

**Transparency Tray**
Select the tray containing the transparencies.

**Separator Tray / Separator and Handout Tray / Handout Tray**
This option varies depending on the selected transparency option. Select the desired tray that contains the separator and/or handout stock.

**Optional Folding**

![Note: This feature is available only if the appropriate, optional finishing device is attached to your press.]

Review the following information before using the **Folding** option.

- If your press is equipped with an optional Folder, you can make copies or prints using the **Folding** feature.
- Depending on the finishing device, the **Folding** option can fold your output in half (single or bi-fold) or in thirds (C-fold or Z-fold types).
- The **Folding** option can be selected for both your copy and network print jobs.
- Depending on the copy/print job, the **Folding** option can be selected from the press UI or from the print driver on your workstation.
- The **Folding** option can also be selected at the print server for the selected job.
- In order to use the folding option, the orientation of documents must be short-edge feed (SEF). You must select a paper tray that contains SEF stock.

Folding options include:
• **Single Fold** (Bi-Fold): Select this option to fold the output copies in half.
• **C-Fold**: Select this option to fold the output copies in thirds.
• **Z-Fold**: Select this option to fold the output copies with two folds that are folded in opposite directions, resulting in a type of fan fold.
• **Z-Fold Half Sheet**: This option has two folds that are folded in opposite directions, with two unequal folds. The two unequal folds allow one edge of the sheet to have a longer edge which allows for stapling or hole punching.
• **Image Inside Fold**: Folds copies so that the image is printed on the inside.
• **Images Outside Fold**: Folds copies so that the image is printed on the outside.

**Job Assembly Feature**

**Job Assembly Feature Overview**

Janet Webster

**Job Assembly** includes the following features:

• Build Job
• Sample Job
• Combine Original Sets
• Delete Outside / Delete Inside

**Build Job**

This feature allows you to change and save settings individually for each document page or stack. You can then make copies of documents with different settings as one job.

1. Split the hard-copy document into sections for individual programming.
2. On the Home window, select **Copy**.
3. Select the **Job Assembly** tab.
4. Select **Build Job**.
5. Select **On**.
6. Select **Save**.
7. Select **Build Job** again.
8. Program the job requirements for the first segment of the job by selecting and saving the applicable features from the features shown at the bottom of the Build Job window. After making selections for each category, select **Save**. Then on the Build Job window, select **Save**.
   - Copy Output
   - Booklet Creation
   - Covers
   - Annotations
   - Segment Separators
   - Watermark
   - Face Up/Down Orientation

9. Load only the first segment into the document feeder or place the segment on the document glass one page at a time.

10. Press **Start**.
    When the first segment has finished scanning, the Copy Status screen will appear.

11. Remove the originals from the document feeder or document glass.

12. Select **Change Settings**.

13. Program the job requirements for the second segment.

14. Load the second segment into the document feeder or on the document glass.

15. Press **Start**.

16. Repeat the previous steps until all segments of your job have been programmed and scanned.

17. After the last segment has been scanned, select **Last Original**.
    The press will complete the quantity selected.

18. Retrieve the copies from the output area.

**Sample Job**

When making multiple copies, you can continue making copies after making and examining a sample set. You can choose to continue or cancel the job after confirmation.

To print a sample of the job, perform the following:

1. Press the **Home** button on the User Interface (UI).

2. Select **Copy** on the **Home** window.

3. Select **Job Assembly > Sample Job**.

4. Select **On**.

5. Select **Save**.

6. Load the documents in the document feeder or on the document glass.

7. Program the job with the Copy desired features/options.

8. Enter the quantity.
9. Press **Start**.
   
   One copy set of the job (the sample set) is printed and the remainder of the job is placed on hold and the press is paused.

10. If desired, change any applicable setting and copy quantity.

11. Select **Start** to finish the job or **Cancel** to stop the job.

   Selecting **Start** continues the copy process and the programmed number of sets will be printed. Retrieve the copies from the output area.

12. Upon completion, press the **Clear All** button on the UI to return the settings to their default state.

**Combine Original Sets**

This feature allows you to copy sets of documents that cannot be loaded into the document feeder. This is useful when copying documents that may be damaged, ripped or torn, or too wrinkled to go through the document feeder. Combine Original Sets allows you to copy each original by placing it on the document glass and creating one copy job for the entire set.

1. Press the **Home** button on the press UI.

2. Select **Copy** on the **Home** window.

3. Select the **Job Assembly** tab.

4. From the Job Assembly tab, select **Combine Original Sets**.

5. Select **On** or **Off**.
   
   - **On**: Select this option to have the Next Original option highlighted on the copy screen when scanning is in process.
   
   - **Off**: Select this option to have the Last Original option highlighted on the copy screen the scanning process is in process.

6. Select **Save** to save your choice.
   
   This feature is available only when **Collated** is selected in the Copy Output window.

7. Load your documents into the document feeder or individually place them on the document glass.

8. Program the job with the desired Copy features or options.

9. Enter the quantity.

10. Press **Start**.

11. When you are finished scanning all the documents, select **Last Original** to complete the job.

12. Retrieve the copies from the output area.

**Delete Outside/Delete Inside**

This feature allows you to specify the area for omission or deletion and then to copy that area. Keep the following in mind when you use this feature:

- When specifying multiple areas to delete, it is also possible to overlap and specify an area.

- When selecting Reduce or Enlarge, the areas are reduced or enlarged by interlocking magnification.
1. Press the Home button on the User Interface (UI).

2. Select Copy on the Home window.

3. Select the Job Assembly tab.

4. Select Delete Outside/Delete Inside.

   The Delete Outside/Delete Inside screen appears. By default, Off is selected.

5. Select Delete Outside or Delete Inside.

6. If the originals are 2-sided, select the applicable option:
   - Both Sides
   - Side 1 Only
   - Side 2 Only

7. Select the Area 1 button.

   The Delete Outside/Delete Inside Area 1 screen appears. Use this screen to define the first area for deletion (omission) from the copy output.

8. To define a specific area, enter the two X and Y coordinates within a range 0.0-17.0 inches (0.0-431.8 mm). Navigate from coordinate to coordinate by selecting each X or Y button:
   a. Select the Y1 box and use the numeric keypad on the UI to enter the value for Y1.
   b. Select the Y2 box and use the numeric keypad on the UI to enter the value for Y2.
   c. Select the X1 box and use the numeric keypad on the UI to enter the value for X1.
   d. Select the X2 box and use the numeric keypad on the UI to enter the value for X2.

   Clear a deletion area by selecting the Clear Area X (1, 2, or 3) button.

9. Select Save.

10. Select Save again.

11. Select any other desired copy features or options.

12. Enter the quantity.

13. Press Start.

14. Retrieve the copies from the output area.

### Scan

#### Scan Overview

The Scan feature supports several methods for scanning and storing an original document. You can use the scanning functions while printing is in progress. This press supports the following scan capabilities:

- **Email**: Scans a document and sends the scanned data as an email attachment after converting the data to TIFF, JPEG, PDF, DocuWorks®, or XPS (XML Paper Specification).

- **Network Scanning**: Scans a document using a job template that was created using CentreWare® Internet Services (CWIS). When Scan to Home is enabled and the Remote Access feature is
available, the scanned data can be transferred to a different destination according to an authenticated user.

- **Scan to PC**: Scans a document and sends the scanned data to a network computer using the FTP or SMB protocol.
- **Store to Folder**: Scans a document and saves the scanned data in a folder on the press.
- **Store to USB**: Scans a document and saves the scanned data to a USB memory device. (This is an optional feature.)
- **Store & Send Link** (Send to Folder): Scans a document and sends an e-mail notifying the user of two URLs: one is for the location where the scanned data can be retrieved and second is for the location from which the data can be deleted.
- **Store to WSD** (Web Services on Device): Scan a job at the press or by sending a command from a network computer to the press. The scanned data is sent to a specified network computer.

**Basic Scanning**

**Basic Scanning Procedure**
1. From the press UI, press the **Clear All** button.
2. Press the **Home** button.
3. Select the desired scan method.
   - E-mail
   - Network Scanning
   - Scan to PC
   - Store to Folder
   - Send from Folder
   - Store to USB
   - Store & Send Link (Send to Folder)
   - Store to WSD
4. Load your original documents in the document feeder or on the document glass.
5. Select the desired scan options.
   - Color Scanning
   - 2 Sided Scanning
   - Original Type
   - Scan Presets
   - Advanced Settings
   - Layout Adjustments
   - E-mail Options or Filing Options
6. Press **Start**.
   If using the document glass and multiple documents or multiple pages of a bound original/book need to be scanned, the perform the following substeps:
a. Select **Next Original**, place the original to be scanned and select the **Start** button.
b. Continue until you are scanning the last original, select **Last Original** then select the **Start** button.

7. Select **Job Status** on the UI to view the status of the scanned job.
8. Retrieve the original documents from the Document Feeder or Document Glass.

**Previewing Scanned Images**

1. Scan the images and select job features.
2. While scanning, select **Preview** to preview the last page that was scanned.
3. From the drop-down menu, specify the view size by selecting **Whole Page** or **Enlarge View** and set **Current Page**.
4. After the confirmation, select **Close** to close the preview screen.

**Changing Scan Settings and Options**

While your job is scanning, perform the following steps to change the settings to that job.

1. Select **Next Original**.
2. Select **Change Settings**.
3. Select the appropriate section and make select features. The following features can be adjusted:
   - Color Scanning
   - 2 Sided Scanning
   - Original Type
   - Image Options (Lighten/Darken)
   - Image Enhancement
   - Resolution
   - Quality/File Size
   - Shadow Suppression
   - Original Orientation
   - Original Size
   - Edge Erase
   - Book Scanning
   - Reduce or Enlarge
4. After your changes are complete, select **Start**.

**Canceling a Scan Job**

1. From the User Interface (UI), touch **Stop** on the touch screen or press the **Stop** button.
2. On the UI, press **Cancel** to end scanning or **Start** to restart the scan.
3. Press the **Job Status** button on the UI.
4. Select the job to cancel, then press **Stop**.

   *Note:* When a scan is canceled, scan data already stored to the mailbox is deleted.

**Stopping a Scan Job**

1. To stop a scan job while the job is in process, press the **Stop** button on the User Interface (UI) or touch **Delete** on the UI.
2. Select **Delete**.
3. If Delete does not appear on the screen, press the **Job Status** button on the UI.
4. Select the job to cancel and select **Delete**.

**Scan Options**

**Scan Options Overview**

The following settings can be set for scan jobs.

- Basic Scan Options (shown on the first tab of the selected scan method window)
- Advanced Settings
- Layout Adjustment
- Email Options or Filing Options (depends upon the selected scan method)

**Basic Scan Options**

The basic scan options are shown on the first tab of the selected scan method. These options include the following:

**Color Scanning**

Color Scanning options include:

- **Auto Detect**: The color of the document is determined automatically; the press scans in full color when the document is colored, otherwise, scans in monochrome.
- **Color**: Select this option to scan a color document.
- **Black & White**: Scans a document in monochrome two tones. You can select the document type in Original Type.
- **Grayscale**: Scans a document in grayscale. Adds shades to monochrome, creating intermediate tones that change gradually. Suited to documents containing gradations that cannot be reproduced with monochrome (2-color tone).

**2 Sided Scanning**

2 Sided Scanning options include:

- **1 Sided**: Select this option to scan only one side of the document.
- **2 Sided**: Select this option when both sides of the 2-sided document are in the same orientation.
- **2 Sided, Rotate Side 2**: Select this option when both sides of the 2-sided document are in opposite orientations.
Original Type

Original Type options include:

- **Photo & Text**: Select this option when scanning a document that contains both text and photos. The press automatically identifies the text and photo areas and scans each area with optimum quality.
- **Text**: Select this option when scanning text clearly.
- **Photo**: Select this option when scanning photos.

Scan Presets

Scan Presets options include:

- **Sharing and Printing**: This setting is best used for sharing files to be viewed on screen and for printing most of the standard business documents. This setting results in small file sizes and higher image quality.
- **Archival Record**: This setting is best used for standard business documents that are stored for record keeping purposes. This setting results in the smallest file size and normal image quality.
- **Optical Character Recognition**: This setting is best used for documents that are processed by OCR software. This setting results in large file sizes and the highest image quality.
- **High Quality Printing**: This setting is best used for documents that contain detailed graphics and photos. This setting results in large file sizes and the maximum image quality.
- **Simple Scan**: This setting is best used for faster processing but may result in excessively large file sizes. Use this setting to apply the minimal amount of image processing and compression.

Advanced Settings

The options for **Advanced Settings** are shown on the second tab of the selected scan method; these options include the following:

Image Options

The **Image Options** include:

- **Lighten/Darken**: This option provides manual control to adjust the lightness or darkness of the scanned images. Scroll down to darken the scanned image of light originals such as pencil images. Scroll up to lighten the scanned image of dark originals such as half tones or originals with colored backgrounds.
- **Sharpness**: This option controls the balance between sharp text and moiré (patterns within the image). Move the slider control down (Soften) to produce an image with a smooth, uniform appearance (ideally suited for photographic scanned images). Move the slider control up (Sharpen) to produce an image with better quality text or line art.

Image Enhancement

The **Image Enhancement** options include:

- **Background Suppression**: This option prevents reproduction of unwanted shading from originals where the opposite side printing shows through (translucent).
  - **Off**: This is the default setting. With background suppression off, originals are scanned without filtering the document backgrounds.
  - **Auto Suppression**: This option automatically reduces or eliminates any background on the output which may be caused by colored paper or newspaper originals. For example, when **Color**
Scanning is set to Black & White, the background of a document printed on colored paper, such as newspaper, is suppressed. When Color Scanning is set to Color, the background of a document printed on white-color paper is suppressed.

- **Contrast**: This option controls the difference between the image densities within the scanned image. Lower contrast settings reproduce more detail in light and dark areas of the original. Higher contrast settings produce vivid blacks and whites for sharper text and lines, but produce less detail in pictures.

**Resolution**

Choose one of four resolution settings:

- **200 dpi** (dots per inch): This setting produces normal output quality and a small file size. Use this setting for office documents and photos.

- **300 dpi**: This setting produces a higher output quality and larger file size. Use this setting for sharper scanning of office documents and photos.

- **400 dpi**: This setting produces medium output quality and the largest file size. Use this setting for high quality printing; this setting is suitable for fine lines and small fonts that have been enlarged and for documents with low image definition.

- **600 dpi**: This setting produces maximum output quality and the largest file size. Use this setting for high quality printing; this setting is suitable for fine lines and small fonts that have been enlarged and for documents with low image definition.

**Quality/File Size**

This feature allows you to select the ratio of data compression for color and grayscale scanned images. Use the slider to choose from good image quality with small file size, higher image quality with larger file size, or highest image quality with largest file size.

⚠️ **Note**: This feature is unavailable whenever Black and White (Color Scanning) is selected.

**Photographs**

This feature enhances the image for files that are scanned using photographic originals. Select Off (default setting) or Enhance Photographs.

⚠️ **Note**: In order to use this feature, Color Scanning must be set for Color. Furthermore, when Enhance Photographs is selected, Shadow Suppression and Background Suppression are not available.

**Shadow Suppression**

Select Auto Suppression to hide background color and image bleed through for color scanning. This feature is not available when Black and White is selected for Color Scanning.

**Layout Adjustment**

The options for Layout Adjustment are shown on the third tab of the selected scan method; these options include the following:

- **Original Orientation**
  Select the direction that your original lays in the document feeder or on the document glass. Select Upright Images or Sideways Images.
Original Size
Select one of three options that indicate the size of your originals.

- **Auto Detect**: This option automatically detects the size of the scanned pages. All standard sizes are automatically detected.
- **Manual Size Input**: This option allows you to select a standard paper size from the options shown or to input a non-standard (custom) size.
- **Mixed Size Originals**: With this option the press automatically detects the size of each document.

Edge Erase
This option erases images around the border (margins) of a document.

- **All Edges**: This option erases a preset, equal amount from the top, bottom, left and right margins.
- **Print to Edge**: This option does not erase any of the margins of the document.
- **Individual Edges**: This option independently erases differing amounts from each of the four margins.
- **Presets**: This option erases preprogrammed amounts as set up by the System Administrator. This includes preset options for **Header/Footer Erase** and **Hole Punch Erase**.

Book Scanning
Use this option to scan pages from bound originals. Options include:

- **Left Page then Right**: Scans the left page first and the right page of the facing pages for the bound original.
- **Right Page then Left**: Scans the right page first and the left page of the facing pages for the bound original.
- **Top Page then Bottom**: Scans the top page first and then the bottom page of the facing pages for the bound original.

The following sub-options are also available:

- **Both Pages**: Scans both pages in page order.
- **Left Page Only**: Scans the left page only.
- **Right Page Only**: Scans the right page only.
- **Top Page Only**: Scans the top page only.
- **Bottom Page Only**: Scan the bottom page only.
- **Binding Edge Erase**: This option erases or deletes the shadow that is caused by the center binding of the bound original.

Reduce/Enlarge
Use this option to select a reduction or enlargement value for the scanned document.

E-Mail Options
E-mail Options is the fourth tab of the E-mail scan method and options include the following:
File Name
Use this option to enter a file name. If no name is entered, the system automatically generates a file name.

Reply To
Use this option to enter a reply recipient email address.

Read Receipts
This option requests an email with the delivery status from the recipient to the sender.

File Format
Select the desired file format for scanned data; options include:

- **PDF**: Saves scanned data in PDF format.
- **PDF/A**: Saves scanned data in the PDF/A format. PDF/A is used primarily for archiving and long-term preservation.
- **TIFF**: Saves scanned data in TIFF format.
- **JPEG**: Saves scanned data in JPEG format. This option is selectable when Color or Grayscale is selected for Color Scanning.
- **TIFF/JPEG Auto Select**: Automatically selects JPEG or TIFF. The file format is determined for each page: JPEG for full-color and grayscale pages and TIFF for monochrome pages.
- **XPS (XML Paper Specification)**: Saves multiple pages into a single file.

Note: Options may vary and some options may not be available for your press.

Additional File Format options
Depending on the selected file format, the following sub-options also are available:

- **Compression Method**: Allows you to select a compression method for the scanned data.
- **MRC High Compression**: Allows you to save PDF and XPS files with high compression.
- **Searchable Text**: Allows you to select whether to perform character recognition in PDF files.
- **PDF Security**: Allows you to configure security for the PDF output in order to prevent unauthorized access.
- **Optimize For Quick Web View**: Optimizes the PDF file so that it is displayed faster on a web browser.
- **Add Thumbnail**: Allows you to attach thumbnails to XPS files when XPS is selected. A thumbnail is a reduced, small file size image that helps you check the file contents.
- **Single File for Each Page**: Saves each page as a single file in the specified format.

Compression Method options
When **Manual Select** is chosen for the **Compression Method**, some or all of the following options are available.

For black and white images and pages only, select one of the following options:
• **Modified Modified Read (MMR):** This setting is automatically selected when **Photo and Text** or **Text** is chosen for **Original Type**.

• **Modified Huffman (MH):** This setting is automatically selected when **Photo** is chosen for **Original Type**.

• **JBIG2 Arithmetic Encoded:** This process has better compression performance than the Huffman encoded process. However, the compression rate is slower than Huffman encoded and it uses more memory but yields better compression results.

  
  
  **Note:** JBIG stands for Joint Bi-level Image experts Group. JBIG compresses only black and white images.

• **JBIG2 Huffman Encoded:** Huffman coding takes less page memory and has faster compression and decompression than the arithmetic coding. Use this option if high-quality compression results do not matter and you want to use less page memory.

For grayscale or color images and pages, select one of the following options:

• **JPEG:** This is the default setting for grayscale and color pages.

• **Flate:** This option saves the image data at a higher compression rate than JPEG. Flate is lossless and does not remove data during the compression process.

**PDF Security options**

The following PDF Security options are available when selecting **E-mail Options > File Format > PDF > PDF Security > Password:**

• **Encryption Algorithm:** Choose one of three encryption methods:
  – **128-bit RC4:** Encrypts the file by using the 128-bit RC4 method. Files encrypted with this method can be opened with Adobe® Acrobat® 5.0 or later.
  – **128-bit AES:** Encrypts the file by using the 128-bit AES method. Files encrypted with this method can be opened with Adobe® Acrobat® 7.0 or later.
  – **256-bit AES:** Encrypts the file by using the 256-bit AES method. Files encrypted with this method can be opened with Adobe® Acrobat® 9.0 or later.

• **File Open Password:** This option sets a password for opening the PDF. The recipient of the PDF file must know the password before it can be opened.

• **Permissions:** This option adds restrictions to the PDF file which prevents unauthorized printing or editing of the file. The recipient of the PDF must know the permissions password in order to remove these restrictions.

**Filing Options**

**Note:** **Filing Options** is not available with the **E-mail** scan method.

**Filing Options** is the fourth tab of the selected scan method. Options include the following:

**File Name**

Use this option to enter a file name. If no name is entered, the system automatically generates a file name.

**File Name Conflict**

Use this option to resolve file name conflicts. Choices include:
• **Do Not Save:** Cancels the scan operation so that you can enter another file name.

• **Rename New File:** Attaches a 4-digit number (0000-9999) to the end of the duplicate file name and saves the file in the same directory.

• **Overwrite Existing File:** Deletes the existing file with the duplicate file name and saves the new file with the specified file name in the same directory.

• **Add to Existing Folder:** Adds the scanned file to the existing folder and overwrites any other file that has the same file name.

• **Add Date Stamp to File Name:** Adds the current date to the name of the new file.

**File Format**

Select the desired file format for scanned data; options include:

• **PDF:** Saves scanned data in PDF format.

• **PDF/A:** Saves scanned data in the PDF/A format. PDF/A is used primarily for archiving and long-term preservation.

• **TIFF:** Saves scanned data in TIFF format.

• **JPEG:** Saves scanned data in JPEG format. This option is selectable when Color or Grayscale is selected for Color Scanning.

• **TIFF/JPEG Auto Select:** Automatically selects JPEG or TIFF. The file format is determined for each page: JPEG for full-color and grayscale pages and TIFF for monochrome pages.

• **XPS (XML Paper Specification):** Saves multiple pages into a single file.

© Note: Options may vary and some options may not be available for your press.

**Additional File Format options**

Depending on the selected file format, the following sub-options also are available:

• **Compression Method:** Allows you to select a compression method for the scanned data.

• **MRC High Compression:** Allows you to save PDF and XPS files with high compression.

• **Searchable Text:** Allows you to select whether to perform character recognition in PDF files.

• **Optimize For Quick Web View:** Optimizes the PDF file so that it is displayed faster on a web browser.

• **Add Thumbnail:** Allows you to attach thumbnails to XPS files when XPS is selected. A thumbnail is a reduced, small file size image that helps you check the file contents.

• **Single File for Each Page:** Saves each page as a single file in the specified format.

**Compression Method options**

When **Manual Select** is chosen for the **Compression Method**, some or all of the following options are available.

For black and white images/pages only, select one of the following options:

• **Modified Modified Read** (MMR): This setting is automatically selected when **Photo and Text** or **Text** is chosen for **Original Type**.

• **Modified Huffman** (MH): This setting is automatically selected when **Photo** is chosen for **Original Type**.
• **JBIG2 Arithmetic Encoded**: This process has better compression performance than the Huffman encoded process. However, the compression rate is slower than Huffman encoded and it uses more memory but yields better compression results.

   ![Note] JBIG stands for Joint Bi-level Image experts Group. JBIG compresses only black and white images.

• **JBIG2 Huffman Encoded**: Huffman coding takes less page memory and has faster compression and decompression than the arithmetic coding. Use this option if high-quality compression results do not matter and you want to use less page memory.

   For grayscale or color images/pages, select one of the following options:

• **JPEG**: This is the default setting for grayscale/color pages.

• **Flate**: This option saves the image data at a higher compression rate than JPEG. Flate is lossless and does not remove data during the compression process.

**Resolving a File Name Conflict**

   ![Note] This option is not available with some of the scan methods.

1. Select the **Filing Options** tab.
2. Select the **FileNameConflict** option.
3. Select the appropriate option:
   - **Do Not Save**: Cancels the scan operation so that you may enter another file name.
   - **Rename New File**: Attaches a 4-digit number (0000-9999) to the end of the duplicate file name and saves the file in the same directory.
   - **Overwrite Existing File**: Deletes the existing file with the duplicate file name and saves the new file with the specified file name in the same directory.

4. Select **Save**.

**E-mail**

**E-Mail Overview**

The E-mail feature scans a document and sends the scanned data as an e-mail attachment to one or more recipients.

**E-Mail Components**

**New Recipient**

If the recipient of the e-mail cannot be found in the address book, select **New Recipient** option to add the address in the **To**, **Cc**, or **Bcc** field of the e-mail. A maximum of 128 characters may be entered for a single e-mail address.

**Address Book**

Use the address book to find and add recipients in the **To**, **Cc**, or **Bcc** fields of the e-mail.

- List all public entries: This option displays the local address list which resides on the press.
- Retrieve entries using index: This option displays a keyboard allowing you to enter characters and narrow the search to specific recipients.
Search Public: This option searches for entries in the local address list.

Note: The address book displays only entries that were previously added by the system administrator. A maximum of 2,000 addresses may be stored in the address book.

Add Me and From fields
By default, these fields are not available for use. The system administrator must change the settings for these fields before they can be used.
When these fields are available for use, enter the email address for the sender in the From field and send a copy of the e-mail to the sender by selecting Add Me. A maximum of 128 characters may be entered for the address for the sender in the From field.

Recipient(s) field
From this field, an e-mail address can be edited or removed by selecting a specific recipient.

Subject
Use this field to enter the subject of the e-mail. A maximum of 128 characters may be entered for the subject line.

Message
Use this field to enter a message to the recipient. A maximum of 512 characters may be entered for the e-mail body text.

Preview
Select this check box in order to preview the scanned images or data.

Note: Scanned images or data cannot be previewed with E-mail Options > File Format > MRC High Compression > On.

Scanning to an E-Mail Address
1. From the UI, press the Clear All button.
   This clears all previous settings from the press.
2. Press the Home button.
3. Select E-mail.
4. Specify one or more recipients by choosing one of the following options:
   - **New Recipient**
     1. Use the keyboard to enter the entire address.
     2. Select Add.
     3. If sending to multiple recipients, repeat the previous sub-steps until finished.
     4. Select Close.
   - **Address Book**
     1. Select Address Book.
     2. Select one of the choices from the pull-down menu (such as List all public entries).
     3. Select the desired recipient.
     4. Select one of the fields To, Cc, or Bcc.
     5. If sending to multiple recipients, repeat the previous sub-steps until finished.

5. If applicable, perform the following:
   - Select From and add the sender e-mail address.
   - To send a copy of the email to the sender, select Add Me.
   - Edit or remove recipients from the Recipient(s) field.
   - Select Subject to enter and save an e-mail subject.
   - Select Message to enter and save the e-mail message.

6. Load your original documents in the document feeder or on the document glass.
7. Select the desired scan options.
8. Press Start to begin scanning.
9. Retrieve the original documents from the Document Feeder or the Document Glass.

**Network Scanning**

**Network Scanning Overview**

This feature scans documents after selecting a specific job template and choosing other scan options such as the forwarding destination server. Job templates are created by using CentreWare Internet Services. Scanned data is converted to the format specified in a job template and is automatically sent to a server. The press allows you to automatically retrieve the job templates that are stored in a server.

When Scan to Home is enabled and the Remote Access feature is available, the scanned document can be transferred to a different destination according to an authenticated user.

*Note:* In order to use Network Scanning, job templates must be created and set up by the system administrator. The system administrator uses CentreWare Internet Services to create and set up Job templates. Refer to the System Administrator Guide for detailed information.
Network Scanning Components

Job templates

On the Network Scanning tab, this is a list of available job templates. Select the desired template to use for your network scanning job. If a template is not listed, contact your system administrator. DEFAULT: This is the default job template. When a new template is created from CentreWare Internet Services, it is based on the default template. This template cannot be deleted. It can be edited and returned to the factory-default template only by the system administrator.

Go To

Use the numeric keypad to enter a 3-digit job template number. The job template then appears at the top of the list.

Template Description

This button displays the Template Description screen. This button is available for selection only when a description has been added to a job template.

Update Templates

Select this button to refresh the information. If a created job template is not displayed, select Update Templates to display all the job templates.

Network Scanning Procedure

On the Network Scanning window, you can scan documents after specifying a file (job template) saving scanning conditions, information on the forwarding destination server, and others. This feature creates job templates on a computer using CentreWare Internet Services. Scanned data is converted to the format specified in a job template and is automatically sent to a server. The press allows you to automatically retrieve job templates stored in a server. When Scan to Home is enabled and the Remote Access feature is available, the scanned document can be transferred to a different destination according to an authenticated user.

1. From the UI, press the Clear All button.
2. Press the Home button.
4. Select a template.
5. Load your original documents in the document feeder or on the document glass.
   a. From the drop-down menu, specify the view size by selecting Whole Page or Enlarge View and set Current Page.
   b. After the confirmation, select Close to close the preview screen.
7. Select the desired scan options.
8. Press Start to begin scanning.
9. Retrieve the original documents from the Document Feeder or the Document Glass.
Scan to PC

Scan to PC Overview

The Scan to PC service allows you to scan documents and send the scanned data to a network computer using the FTP or SMB protocol.

Scan to PC Components

Transfer Protocol

The Scan to PC service allows you to scan documents and send the scanned data to a network computer using the FTP or SMB protocol. Specify the protocol to use when selecting Transfer Protocol. Choices include:

- FTP
- SMB
- SMB (UNC Format): UNC stands for Universal Naming Convention and its format is as follows: \\
  \hostname\sharedname\directory name

Address Book

Specify the recipient from the Address Book.

Browse Network for PC

Specify a destination PC by browsing your network. Selecting browse displays a hierarchy consisting of available server names and folders.

Specify Destination

Use this option to specify a destination PC using the screen keyboard. Enter information in the fields provided for the selected protocol, to specify a forwarding destination.

How to Use the Scan to PC Feature

Using the Scan to PC Feature

Before performing the following procedure, ensure that a shared folder is created on your computer; this folder is where the scanned data will be stored.

The Scan to PC service allows you to scan documents and send the scanned data to a network computer using the FTP or SMB protocol.

1. From the UI, press the Clear All button.
2. Press the Home button.
3. Select Scan to PC.
4. Select the desired Transfer Protocol.
5. Select Save.
6. Choose the Save in destination where the data will be stored:
   - **Address Book**: for instructions, refer to *Using the Address Book to Specify a Scan to PC Destination*.
   - **Browse**: the network for a destination PC; for instructions, refer to *Browsing the Network for a Scan to PC Destination*.
   - **Use the UI screen keyboard**: for instructions, refer to *Specifying a Scan to PC Destination Using the UI Keyboard*.

7. Load your original documents in the document feeder or on the document glass.
8. If desired, select **Preview**.
9. Select the desired scan options.
10. Press **Start** to begin scanning.
11. Retrieve the original documents from the Document Feeder or the Document Glass.

**Using the Address Book to Specify a Scan to PC Destination**
1. From the main **Scan to PC tab** window, select **Address Book**.
2. The Address Book was previously set up (contains address information)?
   - **Yes**: Continue to the next step.
   - **No**: See your System Administrator. Only the administrator can set up entries in the Address Book.
3. Select a recipient from the **Name/Protocol** list.
4. Select **Add**.
   
   This adds the recipient to the Save in box.
5. Select **Close** to save and close the window.

Complete the steps in the procedure **Using the Scan to PC Feature**.

**Browsing the Network for a Scan to PC Destination**
1. From the main **Scan to PC tab** window, select **Browse**.
2. Select the destination for saving the data by locating a file:
   - Select **Previous** to move to an upper directory.
   - Select **Next** to move to a lower directory.
3. To add the selected destination to the address book, perform the following substeps:
   a. Select **Add to Address Book**.
   b. Select **Save**.
      
      The Browse window is displayed.
4. Select **Save** to save and close the Browse window.

Complete the steps in the procedure **Using the Scan to PC Feature**.
Specifying a Scan to PC Destination Using the UI Keyboard

1. From the main Scan to PC tab window, select inside the Server field. The UI screen keyboard is displayed.

2. Enter information to identify the server using the keyboard. For the Server name, enter a server name or IP address. When the save location is in the DFS namespace on Windows, enter a domain name or server name. Up to 64 characters are allowed.

3. Select Save.

4. Select inside the Shared Name field and enter a shared name. When the save location is in the DFS namespace on Windows, enter a root name. Up to 64 characters. This option is only available when you select SMB in Transfer Protocol.

5. Select Save.

6. Select inside the Save In field and enter a directory path. When the save location is in the DFS namespace on Windows, enter a folder name. Up to 128 characters. This option is only available when you select FTP or SMB in Transfer Protocol.

7. Select Save to save and return to the main Scan to PC tab window.

8. Select inside the User Name field then enter the user name of the computer to which you are forwarding the data. When a user name is not required for the destination, this field can be skipped.

9. Select Save.

10. Select inside the Password field and enter the password for the user name. Up to 32 characters are allowed.

11. Select Save.

Complete the steps in the procedure Using the Scan to PC Feature.

Store to Folder

Store to Folder Overview

Use the Store to Folder option to scan documents and save the scanned data in a folder of the press.

Note: Folders must be created before using the Store to Folder feature. Refer to the System Administrator Guide for detailed information and instruction on creating folders.

Store to Folder Components

Use the Scan to Folder option to scan documents and save the scanned data in a folder of the press.

Folder

Select a folder to save the scanned data in. Select the up arrow to return to the previous screen or select the down arrow to move to the next screen.

Go to

Use the numeric keypad to enter a 3-digit folder number. The folder then appears at the top of the list.
File List
Select a folder and then select this button to display the File List screen. You can confirm or delete files stored in the folder.

Using the Store to Folder Feature

Note: Folders must be created before using the win feature. Refer to the System Administrator Guide for detailed information and instruction on creating folders.

1. From the User Interface, press the Clear All button.
2. Press the Home button.
3. Select Store to Folder.
4. Select the desired destination folder.
5. Load your original documents in the document feeder or on the document glass.
6. Select the desired scan options.
7. Press Start to begin scanning.
8. Retrieve the original documents from the Document Feeder or the Document Glass.

Store to USB

Store to USB Overview
The Store to USB feature allows you to scan documents and save the scanned data to a USB memory device.

Use the following USB memory devices:
- A formatted USB memory device
- A USB 2.0 compliant memory device (USB 1.1 is not supported.)
- A USB memory device with a storage capacity of up to 128 GB

Before using the Store to USB feature, review the following information:
- A USB memory device encrypted with software is not supported.
- A commercially available Memory Card Reader with a single slot can be used for this feature, but the safe performance of this reader is not guaranteed. When a Memory Card Reader with multiple slots is used, only one particular slot is available.
- When a USB memory device is inserted into the USB memory slot during the Power Saver mode, the UI touch screen does not light. After exiting the Power Saver mode by pressing the Power Saver button, insert the USB memory device again or select Store to USB on the Home window.
- Before removing the USB memory device, make sure that a window indicating that data is being transferred is not displayed. If you remove the USB memory device while the data is being stored, the data in the device may be damaged. You can also view Job Status to confirm if the data has been stored to the USB memory device.

Using the Store to USB Feature
1. Load your original documents in the document feeder or on the document glass.
2. Insert the USB memory device into the USB memory slot on the front of the press (near the User Interface).

One of the following happens:
- The USB Device Detected window displays.
- The Store to USB window displays.
- The UI touch screen does not change.

3. Choose one of the following options:
- If the USB Device Detected window displays, perform the following:
  1. On the press UI, select Store to USB.
  2. Go to Step 4.
- If the Store to USB window displays, go to Step 4.

4. From the main Store to USB window, select Save in.

5. Select a folder in which to save the scanned data. This will be a folder location on the USB memory device.

6. Select Save.

    The main Store to USB window displays.

7. Select the desired scan options.

8. If desired, select Preview.

9. Press Start to begin the scanning process.

10. Retrieve the original documents from the Document Feeder or the Document Glass.

Store and Send Link Feature (Send to Folder)

Store and Send Link (Send to Folder) Overview

Tip: This feature may not be available in all marketplaces.

Note: The Store & Send Link feature is also referred to as the Send to Folder feature.

If an authenticated user scans a document, the press temporarily saves the scanned data and automatically obtains the e-mail address for the user that was registered in advance. The press then sends an e-mail notifying the user of two URLs:

- One URL is for the location where the scanned data can be retrieved.
- The second URL is for the location from which the data can be deleted.

Tip: Only the authenticated user who logs into the press can be the recipient of an e-mail transmission. The press cannot send e-mail to multiple recipients.

After receiving the e-mail on a computer, the user can retrieve the scanned data using a web browser.

Review the following information before using the Store & Send Link (Send to Folder) feature:
• Scan files stored in the press will be automatically deleted when the retention period expires.
• This retention period can be specified in URL File Expiration option by the System Administrator in the range of 1 to 168 hours. The default value is 3 hours.
• The files will always be deleted automatically.
• To strengthen security, after retrieving the scanned data, access the second URL to delete the scanned data stored in the press.
• The Store & Send Link feature does not provide the following document management features:
  – Backing up and/or restoring files
  – Deleting all the data at one time
  – Listing files
  – Displaying available storage space
• The Store & Send Link feature allows you to retrieve scanned data without specifying an e-mail address from the Address Book or from a folder for each scan job. However, the size of the data and its retention period are restricted on the press. If you want to avoid these restrictions, use the Scan to PC or E-mail service.
• For more information, refer to the System Administrator Guide.
• You can customize the layout of the features displayed on the Store and Send Link feature. For more information, refer to System Administrator Guide.

Storing and Sending a Link (Sending to Folder)
1. Press the Log In/Out button on the UI or select the login information field on the UI touch screen.
2. Enter the user ID.
3. Select Store & Send Link on the UI Home window.
   The system automatically obtains the preregistered e-mail addresses of the authenticated users and displays them in the Scan To and From fields.
4. Select inside the Subject and Message fields to enter the desired information.
   A maximum of 128 characters may be used for the Subject field and a maximum of 512 characters may be used for the Message field.
5. Load your original documents in the document feeder or on the document glass.
6. If desired, select Preview.
7. Select the desired scan options.
8. Press Start to begin scanning.
9. Retrieve the original documents from the Document Feeder or the Document Glass.

Store to Web Services for Devices (WSD)

Store to WSD Overview

Note: WSD stands for Web Services for Devices.
Use the **Store to WSD** feature to scan a job at the press or by sending a command from a network computer to the press. The scanned data is then sent to a specified network computer.

The following options are available with **Store to WSD**:

- **Computer**: Select this option to start a scan job by sending a request from a network computer, then forward the scanned data to a network computer. The scan job will be operated from the network computer.
  - To operate the scan job from a network computer, use an application which supports image loading feature such as **Windows Fax and Scan**.
  - **Windows Fax and Scan** is not available for computers with Windows Vista Home Basic or Windows Vista Home Premium. To perform a scan from such a computer, use a different method, for example, using the **Paint** application and selecting the option **From Scanner** or **Camera**.

- **This Device**: Select this option to start a scan job from the press UI, and then forward the scanned data to a network computer. When this option is selected, a list of available computers is displayed; from this list select the computer that will receive the scanned data.
  - When **This Device** is selected, a List of Components is displayed.
  - This list shows computer names and four processing methods including **Scan to User PC** (this is a specified network computer), **Scan for Print to User PC**, **Scan for E-mail to User PC**, and **Scan for OCR to User PC**.

**How to Use the Store to Web Services for Devices (WSD) Feature**

**Using the Store to WSD Feature**

1. From the press UI, press the **Clear All** button.
2. Load your original documents in the document feeder or on the document glass.
3. Press the **Home** button.
4. Select **Store to WSD**.
5. From the Start Scan Job From window, choose one of the following options:
   - **Computer**: go to Starting a Scan Job from a Network Computer.
   - **This Device**: go to Starting a Scan Job from This Device.

**Starting a Scan Job from a Network Computer**

Ensure that the original documents are loaded and that **Computer** is selected on the Start Scan Job From window.

**Note**: The following procedure describes the scan method using **Windows Fax and Scan** with **Windows 7**.

1. Select **Operate from Computer**.
   - The UI displays a standby message stating that a scan job is waiting.
2. To exit the standby mode, select **Delete**.
   - The UI displays a Remove Your Original message.
3. Remove your originals and select **OK**.
4. Reload your originals.
5. From the network computer, select **Start > All Programs > Windows Fax and Scan**.
6. At the bottom of the left pane, select **Scan**, then select **New Scan** from the toolbar.
7. In the New Scan dialog box, select **Change**, then select the press.
   Ensure that the press model name is displayed; it will be shown to the right of **Scanner**.
   If the press model name is not displayed, select **Change**, then select the press.
8. Select the **Profile** list, then select **Document**.
9. Select the desired scan options.
10. Select **Scan**.
    After the documents are scanned, the scanned data is forwarded to the specified computer.
11. The press UI displays a Remove Your Original message.
    a. Remove your original documents from the press Document Feeder or Document Glass.
    b. Select **OK** on the press UI.
12. The UI displays a standby message stating that a scan job is waiting.
    - **Yes**: The press cannot start another scan job even though the network computer recognizes
      the press. Clear the press; go to the next step.
    - **No**: The scan job is completed and the press is ready for other copy/print jobs.
13. From the UI, select **Delete**.
    The scan operation is stopped. The UI displays a Remove Your Original message.
14. Remove your originals and select **OK**.
    The scan job is completed and the press is ready for other copy/print jobs.

**Starting a Scan Job from This Device**

Ensure that the original documents are loaded and that **This Device** is selected on the Start Scan Job From window.

- **Note**: This procedure is done from the press UI.
1. From the List of Components, select a destination.
2. Press the **Start** button.
   The scanned date will be forwarded to the specified destination.
3. Retrieve the original documents from the Document Feeder or the Document Glass.
4. Check the forwarded data on the destination computer.

**Send from Folder (Folder/File Management)**

**Send from Folder: Folder and File Management Overview**

The **Send from Folder** feature allows you to access and manage folders and files that were saved on
the press. Folder/file management includes the following functions:
• Access the saved files
• Review the details of the files
• Print the files
• Rescan the files
• Send the files in an email
• Retrieve the email (with the file attachment) from a network computer
• Delete the files
• Create automatic routine tasks
• Register/create private folders and/or shared folders

File Options
The following options are available:
• **Refresh**: Displays the updated information.
• **List**: Lists the files stored in the folder, with their stored dates and pages.
• **Thumbnail**: Displays the images and names of the files stored in the folder.
• **Number of Files**: Displays the number of files stored in the selected folder.
• **Select All**: Allows you to select all the files in the folder. If you select **Select All** again, all the files are deselected.
• **Delete**: Allows you to delete the selected files in the folder.
• **File Details**: Previews the selected file to allow you to check its details and to copy or move it to another folder.
• **Job Flow Settings**: Allows you to create, link, and execute job flows.
• **Print**: Allows you to print selected files separately.
• **Batch Print**: Allows you to print multiple files as one file.

File Details Option
For the **File Details** option, these additional selections are available:
• **Whole Page**: Allows you to select whether to display the whole page or to enlarge the image by 200%. You can select the view size from **Whole Page** and **Enlarged View**. A small-sized document cannot be enlarged even if you select **Enlarged View**. You can rotate or enlarge the image of the file in a folder in preview, but cannot save the file with the image rotated or enlarged.
• **No Rotation**: Allows you to select an angle to preview the image from **Right 90 degrees**, **Left 90 degrees**, and **180 degrees**. You can rotate or enlarge the image of the file in a folder in preview, but cannot save the file with the image rotated or enlarged.
• **Change File Name**: Allows you to change the file name. Use the displayed keyboard to enter a new name.
• **Current Page**: Allows you to specify a page to preview on the screen using + and - or the numeric keypad.
Print Option

For the Print option, these additional selections are available:

- **Paper Supply**: Select the desired paper tray.
- **2 Sided Printing**: Select 2-sided printing.
- **Output**: Select the desired output options including stapling, hole punching, and which finishing tray to deliver the printed output.
- **File Details**: Displays a preview image of the selected file.
- **Print Quantity**: Select the number of print sets.
- **Print**: Prints the selected file.

Batch Print Option

The Batch Print option allows you to select batch printing. You can print multiple files as one file. A maximum of 100 files can be bound in the selected order.

Note: For 2-sided printing, the last page becomes blank when the total number of printed pages is odd. For printing of multiple files, a blank page is inserted after the final page of each file. If a different size document is included in multiple files, it may be printed in improper orientation.

These additional options are available with Batch Print:

- **Paper Supply**: Select the desired paper tray.
- **2 Sided Printing**: Select 2-sided printing.
- **Output**: Select the desired output options including stapling, hole punching, and which finishing tray to deliver the printed output.
- **File Details**: Displays a preview image of the selected file.
- **Print Quantity**: Select the number of print sets.
- **Print**: Prints the selected file.

Managing Folders and Scanned Files

1. From the UI, press the Clear All button.
2. Press the Home button.
3. Select Send from Folder.
4. Select a folder.
5. Select a file from the folder list.
6. From the drop-down menu, select how to display the file:
   - **List**
   - **Thumbnail**
7. Select one or more other options.

- Refresh
- Select All
- Delete
- Review
- File Details
- Job Flow Settings
- Print
- Batch Print

**How to Configure/Start a Job Flow**

**Configuring/Starting a Job Flow**

The Send from Folder feature allows you to configure and/or start a job flow. Refer to the following information for the various job flow settings and options that are available in the Send from Folder feature.

**Job Flow Settings**

The options available with **Job Flow Settings** include the following:

- **Auto Start**: This sets auto start of the job flow for files stored in the folder. The job flow automatically starts when a file is stored.
- **Start Current Job Flow**: Select files in the folder, then select this button to start the job flow linked to this folder. After executing the job flow, confirm from **Job Status** or print a **Job History Report** to check the result.
- **Cut Link**: Cancels the link between a folder and the linked job flow sheet.
- **Create/Change Link**: Displays the **Link Job Flow Sheet to Folder** window.
- **Select Job Flow Sheet**: Select this button while files are selected to display the **Select Job Flow Sheet** screen.

**Create/Change Link**

The settings available with the **Create/Change Link** option include the following:

- **Refresh**: Displays the updated file information.
- **Create**: Displays the Create New Job Flow Sheet window.
- **Edit/Delete**: Displays the Details window.
- **Search by Name**: Searches for job flows that partially match the entry. The press searches through job flow names that were registered upon each job flow creation. The entry can be up to 128 characters.
- **Search by Keyword**: Searches for job flows that fully match the entry. The press searches through keywords that were registered upon each job flow creation. The entry can be up to 12 characters.
You can select from preset keywords if they have been registered in the System Administration mode.

- **Select by Keyword**: Displays the Select Keyword window. Select a keyword registered in the System Administration mode to search for job flows. Job flows that fully match the entry are searched. The press searches through keywords that were registered upon each job flow creation.

- **Sheet Filtering**: Displays the Sheet Filtering window. Sheet Filtering allows you to filter the job flow sheets that are displayed. Displayed job flow sheets may vary depending on the Authentication feature.

**Select Job Flow Sheet**

The settings available with the **Select Job Flow Sheet** option include the following:

- **Start**: Executes the selected job flow sheet.
- **Refresh**: Displays updated information.
- **Details**: Displays the Details window.
- **Change Settings**: If the selected job flow sheet setting is editable, the Change Settings window appears. You can temporarily change the settings.
- **Search by Name**: Searches for job flows that partially match the entry. The press searches through job flow names that were registered upon each job flow creation. The entry can be up to 128 characters.
- **Search by Keyword**: Searches for job flows that fully match the entry. The press searches through keywords that were registered upon each job flow creation. The entry can be up to 12 characters. You can select from preset keywords if they have been registered in the System Administration mode.

**Sheet Filtering Options**

Sheet Filter options include the following:

- **Owner**:
  - System Administrator - If this box is checked, the only Job Flow Sheets available to the System Administrator are displayed.
  - Non-System Administrator - If this box is checked, Job Flow Sheets displayed do not include those available to the System Administrator.
  - No Filtering - When both the System Administrator and Non-System Administrator boxes are checked, all the Job Flow Sheets are displayed.

- **Target**: Place a check in each job type you want displayed.
Using Send from Folder to Link a Job Flow Sheet to a Folder
1. From the UI, press the Clear All button.
2. Press the Home button.
3. Select Send from Folder.
4. Select a folder, if required.
5. Select the files from the folder list.
6. Select the desired Job Flow option.
   - Auto Start
   - Start Current Job Flow
   - Cut Link
   - Create/Change Link
   - Select Job Flow Sheet
7. To link a specific job flow sheet, choose Select Job Flow Sheet.
   a. Select a desired job flow sheet.
   b. Select Job Flow Settings.
   c. Select Create/Change Link.
   d. Select any option.
      If Sheet Filtering is selected, select the desired filtering conditions, then select Save.
   e. From the Link Job Flow Sheet to Folder window, select Save.
8. Select Start to run the job flow.

Job Flow

Job Flow Introduction
Job Flow is a feature that allows you to register transfer settings of scanned data, such as a transfer method and destination; this simplifies data-transfer tasks. Job flow sheets are categorized into two types according to the target:
- Files stored in folders
- Scan files

Automatic/Manual Starting a Job Flow
A Job Flow is started in the following ways:
- Automatically when a document or file is linked to a folder
- Manually selecting a Job Flow to act on the documents or files stored in the folder

To automatically start a job flow, you must create a link with a folder and a job flow sheet in advance. Files are automatically processed with the job flow sheet when they are stored in the linked folder.
Acceptable Features to Register

You can register the following features:

- **Forward**: Multiple forwarding recipients can be configured for each forwarding method.
  - **FTP**: Forwards via FTP. A maximum of two recipients can be specified.
  - **SMB**: Forwards via SMB. A maximum of two recipients can be specified.
  - **Mail**: Forwards via email. A maximum of 100 recipients can be specified.
- **Email Notification**: Job results may be sent by email.
- **Print**: Files in a folder may be printed.

Job Flow Restrictions

A job flow sheet can be used by only one user, can be shared by multiple users, or can be used only for certain folders.

Only the Job Flow Sheets that you have permission to execute are displayed.

Job Flow Settings and Options

Overview of Job Flow Options

📝 **Note:** Created Job Flow Sheets can be executed, modified, duplicated, or deleted only from the folder in which it was created.

Job Flow options include the following:

- **Refresh**: Displays updated information.
- **Details**: Displays the Details window. You can confirm the details of a job flow such as the name, last updated date, target, owner, and save location. When you select the information (i) button, the entire description of the job flow sheet is displayed.
- **Change Settings**: If available, this option allows you to change the job flow settings.
- **Search by Name**: Searches for job flows that partially match the entry. The press searches through job flow names that were registered upon each job flow creation. The entry can be up to 128 characters.
- **Search by Keyword**: Searches for job flows that fully match the entry. The press searches through keywords that were registered upon each job flow creation. The entry can be up to 12 characters. You can select from preset keywords if they have been registered in the System Administration mode.
- **Select by Keyword**: Displays the Select Keyword window. Select a keyword registered in the System Administration mode to search for job flows. Job flows that fully match the entry are searched. The press searches through keywords that were registered upon each job flow creation.
- **Sheet Filtering**: Displays the Sheet Filtering window. Sheet Filtering allows you to filter the job flow sheets that are displayed. Displayed job flow sheets may vary depending on the Authentication feature.

Additional Job Flow Options

Additional job flow options include the following:
• **Name**: Set the name for the job flow using a maximum of 128 characters.

• **Description**: Set the description of the job flow using a maximum of 256 characters.

• **Keyword**: Used to search for a Job Flow Sheet using a maximum of 12 characters. For example, enter Accounting as a keyword to access any Job Flow Sheets that contain Accounting in the Job Flow name.

• **Send as E-mail**: Specify the recipients for the e-mail. You can specify a total of up to 100 addresses. Select from the address book numbers or by direct input by using the keypad.

• **Transfer via FTP (1), Transfer via FTP (2)**: Specify the server where documents are sent using SMB protocols. When the server address is registered in the address book, you can specify the address from the address book. The specified address appears in the SMB Transfer window.

• **Transfer via SMB (1), Transfer via SMB (2)**: Specify where SMB forwarding is to be stored.

• **Print**: Configure the print settings. When *On* is selected, you can configure the settings for the Print feature.

• **E-mail Notification**: You can receive an e-mail notification when a file is saved in a folder or a job flow ends.

• **Edit/Delete**: Review the content of the job flow sheet and edit, copy, or delete it. Additional options include: Edit, Delete, and Copy.

**Sheet Filtering Options**

Sheet Filter options include the following:

• **Owner**:
  – System Administrator: If this box is checked, only the Job Flow Sheets available to the System Administrator are displayed.
  – Non-System Administrator: If this box is checked, Job Flow Sheets displayed do not include those available to the System Administrator.
  – No Filtering: When both the System Administrator and Non-System Administrator boxes are checked, all the Job Flow Sheets are displayed.

• **Target**: Place a check in each job type you want displayed.

**Send as E-mail Options**

The settings available with the **Send as E-mail** option include the following:

• **Address Book**: The recipients can be specified from address book. The specified recipient appears in Recipient Name/E-mail Address in the Send E-mail screen.

• **New Recipient**: Specify a new recipient. The specified recipient appears in Recipient Name/E-mail Address in the **Send as E-mail** screen.

• **Name/E-mail Address**: Displays the recipient name or e-mail address specified.

• **Subject**: If desired, set a specific subject.

• **Delete Recipient**: Deletes all the information for the selected recipient.

• **Edit**: Allows you to check or change the information for the selected recipient.

• **File Format**: Specify the output file format.
• **Resend Attempts**: Set the amount of times you want to resend an E-mail or to switch off the feature. If you select **On**, set the number of resend attempts and time interval:
  – Resend Attempts: Set the number of times to resend an email between 1-5.
  – Resend Interval: Set the transmission retry interval from 30-300 seconds.

**Transfer via FTP (1)/Transfer via FTP (2) Options**

The additional settings available with the **Transfer via FTP (1) / Transfer via FTP (2)** option include the following:

- Address Book
- File Format
- Resend Attempts
- Name, Server, Save, User Name, and Password: The maximum number of characters for each item is:
  – Name: Maximum 18 single-byte characters
  – Server: Maximum 64 single-byte characters
  – Save in: Maximum 128 single-byte characters
  – User Name: Maximum 97 single-byte characters
  – Password: Maximum 32 single-byte characters

**Transfer via SMB (1)/Transfer via SMB (2) Options**

The additional settings available with the **Transfer via SMB (1) / Transfer via SMB (2)** option include the following:

- Address Book
- File Format
- Resend Attempts
- Name, Server, Save, User Name, and Password: The maximum number of characters for each item is:
  – Name: Maximum 18 single-byte characters
  – Server: Maximum 64 single-byte characters
  – Save in: Maximum 128 single-byte characters
  – User Name: Maximum 97 single-byte characters
  – Password: Maximum 32 single-byte characters

**Print Options**

The additional settings available for **Print** option include the following:

- Print Quantity
- Paper Supply
- 2-Sided Printing
- Output
E-mail Notification Options
The additional settings available for E-mail Notification option include the following:
- Name/E-mail Address
- Message
- When to Notify
- Delete Recipient
- Edit
- Close Menu

Job Flow Procedures

Creating a Job Flow Sheet
1. Press the Machine Status button.
2. Select the Tools tab on the UI.
4. Select Create.
5. Select one of the line items from the list (Name).
   a. Select Edit.
   b. Enter the name information using the UI screen keypad.
   c. Select Save.
6. Repeat the previous step for other line items (such as Description) until all desired information is entered and saved.
7. If Send as E-mail is used, ensure all the required information is entered, including the recipient name and e-mail address.
8. If desired, select Print to set options to print the linked Job Flow Sheet. Select Off to disable this feature.
9. Select Save to keep your settings.
10. Review the newly created Job Flow Sheets and select Exit.
11. Press Clear All to return the press to its default values and settings.

Linking a Job Flow Sheet with a Folder
1. Log in as Administrator.
2. Press the Machine Status button.
3. Select the Tools tab on the press User Interface (UI).
4. Select Setup & Adjustment > Setup > Create Folder.
5. Select a folder that is not being used (Available).
   The New Folder window displays.
6. On the New folder - Passcode window, choose one of the following:
   - **Off**: If you do not assign a passcode, all users will be allowed access to the folder.
   - **On**:
     1. Enter a passcode with a maximum of 20 digits.
     2. Select a Target Operation option: **Always (All Operations)**, **Save (Write)**, or **Print/Delete (Read)**.

7. Select **Save**.

8. Enter the following information by selecting each line item and selecting **Edit**:
   - **Folder Name** (maximum of 20 characters)
   - **Check Folder Passcode**
   - **Delete Documents After Retrieval**
   - **Delete Expired Files**
   - **Link Job Flow Sheet to Folder**: Select and go to the next step.

9. At the Link Job Flow to Folder window, select **Create/Change Link**.

10. Select the Job Flow Sheet that you want to link and then select **Save**.

11. At the Link Job Flow to Folder window, choose one of the following:
   - **Auto Start**: Select this option if you want the Job Flow Sheet to be automatically executed when a new document is saved to the folder. If you do not select **Auto Start**, you will need to press the **Start** button on the UI to execute the linked Job Flow Sheet.
   - Select **Close**.

      ✍️ **Note**: Selecting Cut Link at any time will remove the link to the specified Job Flow Sheet.

      The Job Flow Sheet is linked to the folder.

12. Select **Close** to exit to the Tools tab.

**Starting a Job Flow Manually**

1. Load the original document(s).
2. From the UI, press the **Clear All** button.
3. Press the **Home** button.
4. If enabled by the System Administrator, select **Job Flow Sheets**, then select **OK**.
5. Select a listed Job Flow Sheet.
6. Press the **Start** button. The job runs and is placed in a folder or on the appropriate server.

**Confirming and Changing a Job Flow**

You can confirm a Job Flow and temporarily change its parameters. However, only fields that have change permission, assigned when the Job Flow was created, can be edited.

1. From the UI, press the **Clear All** button.
2. Press the **Home** button.
3. If enabled by the System Administrator, select Job Flow Sheets, then select OK.
4. Select a listed Job Flow.
5. Select Change Settings.
6. Select the group to change from the Group of Items.
7. Select an item in the group that will be changed.
8. Select the options you want to change and make changes as instructed.
9. Close any open windows to keep your changes.

Job Status

Job Status Overview
The Job Status feature allows the user to check active, pending, and completed jobs. The ability to cancel printing or pause jobs is also available from Job Status.

Job Status Area
The Job Status button on the press UI displays the progress and status of any currently printing jobs and lists all completed jobs.

1. Select the Active Jobs tab to view the status of currently pending or in-progress print jobs on the system.
2. Select the Completed Jobs tab to view a list of all jobs that have completed successfully.
3. Select the Group Parent Jobs check box to list and display the jobs according to a parent and child relationship hierarchy.

Active Jobs Tab
1. Press the Job Status button on the UI.
2. Select the Active Jobs tab.
3. From the displayed list, select the applicable job to view.
   Use the up or down buttons to navigate the list.
4. If required, select Display Time to show the time required to process the job.
5. To delete a job or change the execution order, select a job from the list.
6. Select Delete or Promote from the pop-up menu.
   - Delete: This option cancels the current or pending job.
   - Promote: This option moves a job to the top of list and runs it after the job that is currently printing or copying.
   - Job Progress: This option shows the details of the selected document.
   - Close Menu: This option closes the pop-up menu.

Completed Jobs Tab
1. Press the Job Status button on the UI.
2. Select the **Completed Jobs** tab.
   A list of the completed or deleted jobs display. Use the scroll bar to navigate the list.
3. To check the details of a job, select the job from the displayed list.
4. From this Status window, select one of the following to print a history of this job.
   a. To print the job details, select **Print this Job Report** button.
   b. To print the history of parent and child jobs, select the **Print this Job History Report** button.
5. After checking the job details, select **Close**.

**Machine Status**

**Machine Status Overview**
Press the **Machine Status** button on the UI to access the Machine Status information, including maintenance and reporting features.

- Device Information
- Faults
- Supplies
- Billing Information
- Tools

**Device Information Tab**
This tab provides general information about the press such as the currently installed software version and the press (device) serial number. This area also allows you to print reports and view details that apply to billing impressions.

**Device Serial Number**
The Device Serial Number is displayed under the General Information area on the **Device Information** tab. Use this number when calling Xerox for technical information or assistance.

**Current System Software**
The version of the system software that is currently installed on the press is displayed under the Current System Software title.

**IP Address and Host Name**
The unique Internet Protocol Address and name identifies the press to the specific network to which it is connected.

**Paper Tray Status**
Select the **Paper Tray Status** button to display tray status information including percentage amount of media installed in each tray.

**Device Configuration**
Select the **Device Configuration** button to display a list of the various hardware components and options that are available on the press and their status. Hardware components and options include any optional feeding and finishing devices attached to the press.
Software Version

Select the Software Version button to display a list of the software versions for the various system components, including any optional feeding and finishing devices.

Print Reports

This Print Reports button is enabled by the system administrator. From the various reports available, select a report on the touch screen and then select the Start button to print. Some reports are only available in the system administrator mode.

From the Print Reports screen, select:

- Job Status
- Copy Reports
- Scan Reports
- Network Controller Job Report
- Job Counter Report (available in System Administrator mode only)
- Auditron Report / Meter Report (available in System Administrator mode only)

Maintenance Assistant

Select the Maintenance Assistant button to send the Xerox Remote Print Services diagnostic information on the press to Xerox Support.

Others

From the Others window, select the Overwrite Hard Disk button. This feature is a standard data security function on the system. It prevents the document image and registered data that is recorded on the press hard disk from being illegally retrieved or removed.

Job image data stored on the hard disk within the press can be deleted and overwritten after a number of overwrites or a period of time specified by the system administrator. The Standby status indicates the completion of the overwriting process.

Faults Tab

The Faults tab provides access to a list of current faults affecting the press and some detailed information about the fault such as when it occurred. Access this tab by pressing the Machine Status button on the UI and selecting the Faults tab on the screen.

Fault History

This column identifies the fault code number assigned to the fault message.

Date/Time

This column indicates the day and time the fault occurred.

Image Count

This column indicates the total number of printed impressions.

From the Faults screen, select a fault to view instructions on how to fix the error.

Supplies Tab

The Supplies tab provides status information about the customer replaceable units (CRUs) that are used in the press.
To access supplies information, press the Machine Status button on the UI and then select the Supplies tab. Each Customer Replaceable Unit and status is displayed.

**Billing Information Tab**

**Accessing Billing Information**
1. Press the Machine Status button on the UI.
2. Select the Billing Information tab.

   The Billing Information screen displays.

**Billing Impressions Information**

The Billing Information screen allows you to view the total number of impressions (prints) recorded by the press, including a category of the number of color prints only, black prints only and large media prints. The screen displays specific usage counter information. The counters display the impression amount for all printed jobs.

All meters that can be used for billing purposes are displayed on the Billing Information screen:

- **Color Impressions**: This value represents the total number of color impressions that have been printed.
- **Black Impressions**: This value represents the total number of black-only impressions that have been printed.
- **Total Impressions**: This value represents the total number of all impressions. The value is the sum of the Color Impressions and the Black Impressions.
- **Color Large Impressions**: This value represents the total number of large color impressions. These impressions are one side of one sheet of large media, for example A3, 11 x17 in. Large impressions are any prints that are larger than 145 sq. in., 935 sq. cm.

  **Note**: This meter is NOT added to the Total Impressions meter since it is already added to the Color Impressions meter.

- **Extra Long Impressions**: For this impression type, the meter increases for any media with a length between 491 mm (19.33 in.) and 661 mm (26 in.).

**Usage Counters**

Select the Usage Counters button (from Machine Status > Billing Information) to view even more detail on billing and counts being tracked on the press such as the number of 1-sided vs 2-sided print jobs.

From the Counters drop-down list you can select the desired counter to view:

- Impression Counters
- Sheet Counters
- Images Sent Counters
- All Usage Counters
Impression Counters
This view displays the total impression amount. In other words, impression is the image on one side of one sheet of media. This counter shows the total impression amount for color and black-only impressions.

- Total Impressions: This number represents the total number of impressions for all color and black-only print jobs.
- Black Impressions: This number represents the total number of impressions for all black/white print jobs; includes Black Copied Impressions and Black Printed Impressions.
- Black Large Impressions: These impressions are one side of one sheet of a large black-only document (such as 11 x17 in./A3). Large Impressions are any prints that are larger than 8.5 x14 in./B4.
- Color Impressions: This number represents the total number of impressions for all color print jobs; includes Color Copied Impressions and Color Printed Impressions.
- Color Large Impressions: These impressions are one side of one sheet of a large color document (such as 11 x17 in./A3). Large Impressions are any prints that are larger than 8.5 x14 in./B4.

Sheet Counters
This counter provides information on the total number of sheets the press feeds to the output area. Each sheet counts as one click on the counter (regardless of size or whether it is a one-sided or two-sided print job).

Images Sent Counters
This counter provides information on the total amounts for email images and network scanned images.

All Usage Counters
This view provides a complete total of all the counters, including the totals from the Impression Counters and Sheet Counters.

Update Button
Select this button to refresh and update the counts.

Tools Tab (Operator Mode)
Regular users have limited access to some of the features on the Tools tab.

Create Folder
Use this feature to create folders on the press for storing copied and scanned documents.

Stored Programming
When available to the user, this feature enhances productivity by saving a series of programming steps and assigning them to a specified Stored Programming option. Stored programs save frequently used features and job settings which can be accessed using a shortcut button. Stored Programming not only remembers feature settings, but it can record a series of operations. This enables the user to record the hierarchy of displayed screens for each step. For example, Stored Programming can record the following actions for printing reports: Press the Machine Status button and display the Print Reports screen.
Create Job Flow Sheet

Use this feature to create job flow sheets which contain transfer settings of scanned data, such as a transfer method and destination. These sheets simplify data-transfer tasks.

Add Address Book Entry

Select this feature to add Address and Recipient Information. To add, select an available entry and enter the information. To view an entry, select the entry and the information will automatically display.

Paper Tray Attributes

The Paper Tray Attributes feature allows the user to change the attributes of a paper tray, including size, type, and weight.

Note: The Paper Tray Attributes feature appears on the Tools tab only if the system administrator has made it available to users.

Billing Impression Mode

The Billing Impression Mode defines how the press tracks and records impressions made on large-size paper such as A3 or tabloid. The type of Billing Impression Modes used by your press is set during system installation. A Xerox Sales Representative can confirm the Billing Impression Modes applicable for your press. There are two types of Impression Mode:

- **A3 Impression Mode**: For all media sizes (including oversized), counts all impressions equally.
- **A4 Impression Mode**: Counts large impressions on media such as A3 and 11 x 17 inches (media that is larger than 8.5 x 14 inches), as their A4 equivalent.

To view the current Billing Impression Mode, press the Machine Status button on the UI, then select Tools > Billing Impression Mode.

Changing the Paper Tray Attributes

1. Press the Machine Status button on the UI.
2. Select the Tools tab.
4. Select a tray.
5. If the settings are correct, select Confirm. Otherwise, select Change Settings.
6. If necessary, make the required changes to the tray settings (such as weight, type, and size).
7. Select Save.
8. Select Confirm.
   - The main Tools screen is displayed.
10. Press the Home button on the UI to return to the main home screen.
Paper and Media

Before loading paper, consider the following:

- The press supports the ability to pull different stock sizes and paper types from various trays and assemble them as part of a single job. To select multiple paper trays and insert different papers within one job, program this custom job at the print server using features such as special pages.

- The press supports Automatic Tray Switching, which allows a job to switch automatically from an empty tray to a full tray containing the same size paper, orientation, and stock type. Refer to the Paper and Media chapter for how to enable this feature and prioritize the order of trays to search on and use.

Supported Paper

Paper Specifications

Note: Always refer to the Tested Substrate List (TSL) for a comprehensive list of supported media. The Tested Substrate List can be accessed from www.xerox.com.
<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Paper Size</th>
<th>Trays</th>
<th>Weight (g/m²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper (coated and uncoated)</td>
<td>B5 SEF and LEF</td>
<td>Trays 1–3</td>
<td>52–256</td>
</tr>
<tr>
<td></td>
<td>A4 SEF and LEF</td>
<td>Trays 5, 6 and 7</td>
<td>52–400</td>
</tr>
<tr>
<td></td>
<td>A4-Cover SEF and LEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DT Special A4 SEF and LEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B4 SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A3 SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SRA3 SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DT Special A3 SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 6 in. SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>7.25 x 10.5 in. SEF and LEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 x 10 in. SEF and LEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.46 x 12.4 in. SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 11 in. SEF and LEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 13 in. SEF and LEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 14 in. SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>9 x 11 in. SEF and LEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 x 15 in. SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 x 17 in. SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>12 x 18 in. SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>12.6 x 19.2 in. SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>13 x 18 in. SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>16-kai (TFX) SEF and LEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>16-kai (GCO) SEF and LEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pa-kai (TFX) SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>pa-kai (GCO) SEF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drilled paper (coated and uncoated)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 11 in. (A4) LEF</td>
<td>All Trays</td>
<td>64–105</td>
</tr>
<tr>
<td></td>
<td>Embossed (coated and uncoated)</td>
<td>Trays 1–3</td>
<td>106–256</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Trays 5, 6 and 7</td>
<td>106–400</td>
</tr>
<tr>
<td></td>
<td>Transparency</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Postcard (coated and uncoated)</td>
<td>Trays 5, 6 and 7</td>
<td>106–400</td>
</tr>
<tr>
<td></td>
<td>Government-Legal SEF/LEF</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>DT Special A4 SEF/LEF</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>Recycled paper (coated and uncoated)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 11 in. (A4) LER</td>
<td>All Trays</td>
<td>52–400</td>
</tr>
<tr>
<td></td>
<td>106–256</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>106–400</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 13 in.</td>
<td>215.9 x 330.2</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>DT Special A4 SEF/LEF</td>
<td>226.0 x 310.0</td>
<td>—</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Paper Size</td>
<td>Trays</td>
<td>Weight (g/m²)</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------</td>
<td>------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>DT Special A3 SEF</td>
<td>12.20 x 17.00 in.</td>
<td>310.0 x 432.0</td>
<td>—</td>
</tr>
<tr>
<td>Envelopes</td>
<td>For supported envelope sizes, refer to Customer Expectation and Installation Guide.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Labels (coated and uncoated)</td>
<td>8.5 x 11 in., A4 LEF</td>
<td>Trays 1–3</td>
<td>106–256</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Trays 5, 6 and 7</td>
<td>106–400</td>
</tr>
<tr>
<td>Tabbed Inserts</td>
<td>9 x 11 in. LEF</td>
<td>All Trays</td>
<td>163</td>
</tr>
</tbody>
</table>

Paper Tray Information

Print Engine Trays 1, 2, and 3

When the press is installed, the tray size setting for Trays 1 and 3 are set to 8.5 x 11 in. or A4 (LEF). The tray size setting for Tray 2 is set to 11 x 17 in. or A3 (SEF). The specifications for each tray are:

- Maximum of 550 sheets of 90 g/m² (24 lb.) uncoated paper
- Paper weight range of 64–256 g/m² (18 lb. Bond–95 lb. Cover)
- Paper sizes from 182 x 182–330 x 488 mm (7.2 x 7.2–13 x 19.2 in.)
- Stock types include transparencies, heavyweight, coated and uncoated, predrilled, and tabs
- Loading paper Long Edge Feed (LEF) or portrait or Short Edge Feed (SEF) or landscape (dependent on the actual paper size)
- Auto size detection capability
- Automatically adjusts the tray position in the front and back based on the paper size. The adjustment happens after the tray is closed.

Bypass Tray 5

- Maximum of 250 sheets of 90 g/m² (24 lb.) uncoated paper
- Paper weight range of 52–400 g/m²
- Stock types include transparencies, heavyweight, coated and uncoated, predrilled, and tabs.

Throughput and Productivity Information

Process and print speed are based on simplex or duplex mode, paper type, paper weight, paper size, and feeding tray. Trays 1, 2, and 3 support 52–256 g/m² paper only.
### Table 1 Trays 1, 2, and 3 in LEF Feed Direction

<table>
<thead>
<tr>
<th>Paper Size and Paper Type</th>
<th>Paper Weight</th>
<th>Prints Per Minute: Basic Print Engine Configuration</th>
<th>Prints Per Minute: All Stocks Rated Speed (ASRS) Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>1-Sided</td>
<td>2-Sided</td>
</tr>
<tr>
<td>8.5 x 11 in., A4 Uncoated, Coated, and Matte Coated</td>
<td>52–220 g/m²</td>
<td>80 ppm</td>
<td>40 ppm</td>
</tr>
<tr>
<td></td>
<td>221–256 g/m²</td>
<td>60 ppm</td>
<td>30 ppm</td>
</tr>
<tr>
<td>8.5 x 11 in., A4 Labels, Cast Coated, Embossed or Textured Film</td>
<td>52–256 g/m²</td>
<td>40 ppm</td>
<td>—</td>
</tr>
<tr>
<td>9 x 11 in., A4 Tab Stock Uncoated, Coated, and Matte Coated</td>
<td>52–220 g/m²</td>
<td>64 ppm</td>
<td>32 ppm</td>
</tr>
<tr>
<td></td>
<td>221–256 g/m²</td>
<td>48 ppm</td>
<td>24 ppm</td>
</tr>
</tbody>
</table>

### Table 2 Trays 1, 2, and 3 in SEF Feed Direction

<table>
<thead>
<tr>
<th>Paper Size and Paper Type</th>
<th>Paper Weight</th>
<th>Prints Per Minute: Basic Print Engine Configuration</th>
<th>Prints Per Minute: All Stocks Rated Speed (ASRS) Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>1-Sided</td>
<td>2-Sided</td>
</tr>
<tr>
<td>Postcard Uncoated, Coated, and Matte Coated</td>
<td>52–220 g/m²</td>
<td>80 ppm</td>
<td>40 ppm</td>
</tr>
<tr>
<td></td>
<td>221–256 g/m²</td>
<td>60 ppm</td>
<td>30 ppm</td>
</tr>
<tr>
<td>8.5 x 11 in. Uncoated, Coated, and Matte Coated</td>
<td>52–220 g/m²</td>
<td>64 ppm</td>
<td>32 ppm</td>
</tr>
<tr>
<td></td>
<td>221–256 g/m²</td>
<td>48 ppm</td>
<td>24 ppm</td>
</tr>
<tr>
<td>A4 Uncoated, Coated, and Matte Coated</td>
<td>52–220 g/m²</td>
<td>51 ppm</td>
<td>25.5 ppm</td>
</tr>
<tr>
<td></td>
<td>221–256 g/m²</td>
<td>38 ppm</td>
<td>19 ppm</td>
</tr>
<tr>
<td>8.5 x 14 in., B4 Uncoated, Coated, and Matte Coated</td>
<td>52–220 g/m²</td>
<td>51 ppm</td>
<td>25.5 ppm</td>
</tr>
<tr>
<td></td>
<td>221–256 g/m²</td>
<td>38 ppm</td>
<td>19 ppm</td>
</tr>
<tr>
<td>11 x 17 in., A3 Uncoated, Coated, and Matte Coated</td>
<td>52–220 g/m²</td>
<td>44 ppm</td>
<td>22 ppm</td>
</tr>
<tr>
<td></td>
<td>221–256 g/m²</td>
<td>32 ppm</td>
<td>16 ppm</td>
</tr>
<tr>
<td>12 x 18 in., SRA3 Uncoated, Coated, and Matte Coated</td>
<td>52–220 g/m²</td>
<td>37 ppm</td>
<td>18.5 ppm</td>
</tr>
<tr>
<td></td>
<td>221–256 g/m²</td>
<td>29 ppm</td>
<td>14.5 ppm</td>
</tr>
<tr>
<td>Paper Size and Paper Type</td>
<td>Paper Weight</td>
<td>Prints Per Minute: Basic Print Engine Configuration</td>
<td>Prints Per Minute: All Stocks Rated Speed (ASRS) Configuration</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>13 x 19 in., 330.2 x 488 mm Uncoated, Coated, and Matte Coated</td>
<td>52–220 g/m² 221–256 g/m²</td>
<td>37 ppm 29 ppm</td>
<td>18.5 ppm 14.5 ppm</td>
</tr>
<tr>
<td>8.5 x 11 in. Labels, Cast Coated, Embossed or Textured Film</td>
<td>52–256 g/m²</td>
<td>32 ppm —</td>
<td>32 ppm —</td>
</tr>
<tr>
<td>8.5 x 14 in., B4, A4 Labels, Cast Coated, Embossed or Textured Film</td>
<td>52–256 g/m²</td>
<td>25 ppm —</td>
<td>25 ppm —</td>
</tr>
<tr>
<td>11 x 17 in., A3 Labels, Cast Coated, Embossed or Textured Film</td>
<td>52–256 g/m²</td>
<td>22 ppm —</td>
<td>22 ppm —</td>
</tr>
<tr>
<td>12 x 18 in., SRA3 Labels, Cast Coated, Embossed or Textured Film</td>
<td>52–256 g/m²</td>
<td>20 ppm —</td>
<td>20 ppm —</td>
</tr>
<tr>
<td>13 x 19 in., 330.2 x 488 mm Labels, Cast Coated, Embossed or Textured Film</td>
<td>52–256 g/m²</td>
<td>19 ppm —</td>
<td>19 ppm —</td>
</tr>
<tr>
<td>Paper Size and Paper Type</td>
<td>Paper Feed Direction</td>
<td>Paper Weight</td>
<td>Prints Per Minute: Basic Print Engine Configuration</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------</td>
<td>--------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1–Sided</td>
</tr>
<tr>
<td>Postcard</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>53 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>221–350 g/m²</td>
<td>48 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>351–400 g/m²</td>
<td>48 ppm</td>
</tr>
<tr>
<td>8.5 x 11 in., A4</td>
<td>LER</td>
<td>52–220 g/m²</td>
<td>53 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>221–350 g/m²</td>
<td>48 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>351–400 g/m²</td>
<td>48 ppm</td>
</tr>
<tr>
<td>8.5 x 11 in.</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>46 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>221–350 g/m²</td>
<td>40 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>351–400 g/m²</td>
<td>40 ppm</td>
</tr>
<tr>
<td>A4</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>39 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>221–350 g/m²</td>
<td>33 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>351–400 g/m²</td>
<td>33 ppm</td>
</tr>
<tr>
<td>8.5 x 14 in., B4</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>39 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>221–350 g/m²</td>
<td>33 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>351–400 g/m²</td>
<td>33 ppm</td>
</tr>
<tr>
<td>11 x 17 in., A3</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>34 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>221–350 g/m²</td>
<td>28 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>351–400 g/m²</td>
<td>28 ppm</td>
</tr>
<tr>
<td>12 x 18 in., SRA3</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>32 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>221–350 g/m²</td>
<td>26 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>351–400 g/m²</td>
<td>26 ppm</td>
</tr>
<tr>
<td>13 x 19 in.,</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>32 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>221–350 g/m²</td>
<td>26 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>351–400 g/m²</td>
<td>26 ppm</td>
</tr>
<tr>
<td>330.2 x 488 mm</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>31 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>221–350 g/m²</td>
<td>26 ppm</td>
</tr>
<tr>
<td>Uncoated, Coated, and Matte Coated</td>
<td></td>
<td>351–400 g/m²</td>
<td>26 ppm</td>
</tr>
<tr>
<td>8.5 x 11 in., A4</td>
<td>LEF</td>
<td>52–300 g/m²</td>
<td>39 ppm</td>
</tr>
<tr>
<td>Paper Size and Paper Type</td>
<td>Paper Feed Direction</td>
<td>Paper Weight</td>
<td>Prints Per Minute: Basic Print Engine Configuration</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------</td>
<td>-------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1–Sided</td>
</tr>
<tr>
<td>8.5 x 11 in. Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>32 ppm</td>
</tr>
<tr>
<td>8.5 x 14 in., B4, A4 Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>25 ppm</td>
</tr>
<tr>
<td>11 x 17 in., A3 Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>21 ppm</td>
</tr>
<tr>
<td>12 x 18 in., SRA3 Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>19 ppm</td>
</tr>
<tr>
<td>13 x 19 in., 330.2 x 488 mm Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>19 ppm</td>
</tr>
<tr>
<td>13 x 19 in., 330.2 x 488 mm Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>19 ppm</td>
</tr>
<tr>
<td>13 x 19 in., 330.2 x 488 mm Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>19 ppm</td>
</tr>
<tr>
<td>13 x 19 in., 330.2 x 488 mm Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>19 ppm</td>
</tr>
<tr>
<td>Paper Size and Paper Type</td>
<td>Paper Feed Direction</td>
<td>Paper Weight</td>
<td>Prints Per Minute: Basic Print Engine Configuration</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------</td>
<td>--------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1–Sided</td>
<td>2–Sided</td>
</tr>
<tr>
<td>Extra Long Sheets (XLS) 488–660 mm Uncoated, Coated, and Matte Coated</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>19 ppm</td>
</tr>
<tr>
<td>Extra Long Sheets (XLS) 488–660 mm Label Tacking paper, Cast paper, Film Embossed paper, OHP Transfer Paper</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>9 ppm</td>
</tr>
<tr>
<td>9 x 11 in., A4 Tab Stock Uncoated, Coated, and Matte Coated</td>
<td>LEF</td>
<td>52–220 g/m²</td>
<td>46 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>221–350 g/m²</td>
<td>40 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>351–400 g/m²</td>
<td>40 ppm</td>
</tr>
</tbody>
</table>

Table 4 Optional Trays 6, 7, 8, and 9

<table>
<thead>
<tr>
<th>Paper Size and Paper Type</th>
<th>Paper Feed Direction</th>
<th>Paper Weight</th>
<th>Prints Per Minute: Basic Print Engine Configuration</th>
<th>Prints Per Minute: All Stocks Rated Speed (ASRS) Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>1–Sided</td>
<td>2–Sided</td>
<td>1–Sided</td>
</tr>
<tr>
<td>Postcard Uncoated, Coated, and Matte Coated</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>80 ppm</td>
<td>40 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>221–350 g/m²</td>
<td>60 ppm</td>
<td>30 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>351–400 g/m²</td>
<td>60 ppm</td>
<td>30 ppm</td>
</tr>
<tr>
<td>8.5 x 11 in., A4 Uncoated, Coated, and Matte Coated</td>
<td>LEF</td>
<td>52–220 g/m²</td>
<td>80 ppm</td>
<td>40 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>221–350 g/m²</td>
<td>60 ppm</td>
<td>30 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>351–400 g/m²</td>
<td>60 ppm</td>
<td>30 ppm</td>
</tr>
<tr>
<td>8.5 x 11 in. Uncoated, Coated, and Matte Coated</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>64 ppm</td>
<td>32 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>221–350 g/m²</td>
<td>48 ppm</td>
<td>24 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>351–400 g/m²</td>
<td>48 ppm</td>
<td>—</td>
</tr>
<tr>
<td>A4 Uncoated, Coated, and Matte Coated</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>51 ppm</td>
<td>25.5 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>221–350 g/m²</td>
<td>38 ppm</td>
<td>19 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>351–400 g/m²</td>
<td>38 ppm</td>
<td>—</td>
</tr>
<tr>
<td>Paper Size and Paper Type</td>
<td>Paper Feed Direction</td>
<td>Paper Weight</td>
<td>Prints Per Minute: Basic Print Engine Configuration</td>
<td>Prints Per Minute: All Stocks Rated Speed (ASRS) Configuration</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------</td>
<td>--------------</td>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1–Sided</td>
<td>2–Sided</td>
</tr>
<tr>
<td>8.5 x 14 in., B4 Uncoated, Coated, and Matte Coated</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>51 ppm</td>
<td>25.5 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>221–350 g/m²</td>
<td>38 ppm</td>
<td>19 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>351–400 g/m²</td>
<td>38 ppm</td>
<td>—</td>
</tr>
<tr>
<td>11 x 17 in., A3 Uncoated, Coated, and Matte Coated</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>44 ppm</td>
<td>22 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>221–350 g/m²</td>
<td>32 ppm</td>
<td>16 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>351–400 g/m²</td>
<td>32 ppm</td>
<td>—</td>
</tr>
<tr>
<td>12 x 18 in., SRA3 Uncoated, Coated, and Matte Coated</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>37 ppm</td>
<td>18.5 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>221–350 g/m²</td>
<td>29 ppm</td>
<td>14.5 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>351–400 g/m²</td>
<td>29 ppm</td>
<td>—</td>
</tr>
<tr>
<td>13 x 19 in., 330.2 x 488 mm Uncoated, Coated, and Matte Coated</td>
<td>SEF</td>
<td>52–220 g/m²</td>
<td>37 ppm</td>
<td>18.5 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>221–350 g/m²</td>
<td>29 ppm</td>
<td>14.5 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>351–400 g/m²</td>
<td>29 ppm</td>
<td>—</td>
</tr>
<tr>
<td>8.5 x 11 in., A4 Labels, Cast Coated, Embossed or Textured Film</td>
<td>LEF</td>
<td>52–300 g/m²</td>
<td>40 ppm</td>
<td>—</td>
</tr>
<tr>
<td>8.5 x 11 in. Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>32 ppm</td>
<td>—</td>
</tr>
<tr>
<td>8.5 x 14 in., B4, A4 Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>25 ppm</td>
<td>—</td>
</tr>
<tr>
<td>11 x 17 in., A3 Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>22 ppm</td>
<td>—</td>
</tr>
<tr>
<td>12 x 18 in., SRA3 Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>20 ppm</td>
<td>—</td>
</tr>
</tbody>
</table>
### Loading Media in Trays 1, 2, and 3

#### Information About Loading Media in Trays 1, 2, and 3

Trays 1, 2, and 3 are identical. Each tray has a capacity of 550 sheets of 20 lb./75 g/m² paper. Stock can be Long Edge Feed (LEF) or Short Edge Feed (SEF), landscape or portrait.

*Note:* Each feeder tray has a stock loading label. When loading media into the tray, refer to the labels on the inside panel of the feeder tray for the correct orientation of that stock type.

#### Loading Paper in Trays 1, 2, and 3

*Note:* A paper jam may occur if a tray is opened while it is being used to feed stock.

1. Select the appropriate paper stock for your print or copy job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Load and align the edge of the paper against the left edge of the tray.

<table>
<thead>
<tr>
<th>Paper Size and Paper Type</th>
<th>Paper Feed Direction</th>
<th>Paper Weight</th>
<th>Prints Per Minute: Basic Print Engine Configuration</th>
<th>Prints Per Minute: All Stocks Rated Speed (ASRS) Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>1–Sided</td>
<td>2–Sided</td>
</tr>
<tr>
<td>13 x 19 in., 330.2 x 488 mm Labels, Cast Coated, Embossed or Textured Film</td>
<td>SEF</td>
<td>52–300 g/m²</td>
<td>19 ppm</td>
<td>—</td>
</tr>
<tr>
<td>9 x 11 in., A4 Tab Stock Uncoated, Coated, and Matte Coated</td>
<td>LEF</td>
<td>52–220 g/m²</td>
<td>64 ppm</td>
<td>32 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>221–350 g/m²</td>
<td>48 ppm</td>
<td>24 ppm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>351–400 g/m²</td>
<td>48 ppm</td>
<td>24 ppm</td>
</tr>
</tbody>
</table>

Paper can be loaded in either the LEF/portrait or SEF/landscape direction.
6. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly touches the edge of the material in the tray.

Do not load materials above the MAX line located on the rear Edge Guide.

7. Gently push in the tray until it comes to a stop.

If enabled by your System Administrator, the Paper Tray settings/Tray Properties window may be displayed on the UI. You can view and set stock attributes and verify trays are assigned with the correct stock.

8. From the Paper Tray settings/Tray Properties window, choose one of the following:
   - No changes were made to the paper tray; select **Confirm** to close the window.
   - Changes were made to the paper tray; go to the next step.

9. Select the **Change Settings** button.
   a. Make the desired selections for **Paper Type/Paper Weight**, **Paper Size**, and **Paper Color**.
   b. If necessary, make the desired changes to paper curl and alignment adjustment.
   c. Select **Save** until you are returned to the Paper Tray settings/Tray Properties window.
   d. Select **Confirm** or **OK** to save the information and close the Paper Tray settings/Tray Properties window.

Loading Tab Stock in Trays 1, 2, and 3

Refer to the following tips before loading tab stock in the tray:

- You can load either single straight collated or single reverse collated tab stock.
- For network print jobs, refer to your print server customer documentation for instructions on loading tab stock into a tray.
- If a jam occurs while running tabbed sets, cancel the job and start again.

1. Pull out the tray slowly until it stops.
2. Fan the tab stock before loading into the tray.
3. Load the tab stock LEF (portrait) and align the straight edge of the tab stock against the left edge of the tray (tabs to the right or trailing edge). For single straight collated tabs, the first blank tab cutout in the stack will be toward the rear of the tray. For single reverse collated tabs, the first blank tab cutout in the stack will be toward the front of the tray.

Note: Tab stock is loaded so the straight edge of the stock is in the feed direction. Also, you can only load the tab stock LEF.

4. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly touches the edge of the stock in the tray. Do not load materials above the MAX line located on the rear Edge Guide.

5. Gently push in the tray until it comes to a stop.

6. If the Paper Tray settings/Tray Properties window displays on the UI, confirm the correct tray to which it is printing and other information, including size, type (precut tab), and, if necessary, paper curl and/or alignment option.

7. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Transparencies in Trays 1, 2, and 3

Read these tips before using transparencies:

- Do not use transparencies with the white side strip (permanent or removable).
- Do not mix paper and transparencies in a tray. Jams may occur.
- Do not load more than 100 transparencies in a paper tray at one time.
- Load 8.5 x 11 in (A4) transparencies long edge feed only (landscape).

1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Fan the transparencies to stop them from sticking together before loading into the tray.
4. Load a small stack of paper into the tray first. The paper must be the same size as the transparencies.
5. Load the transparencies LEF on top of this paper stack. Align the edge of the transparencies against the left edge of the tray, with the side to be printed on facing down.

6. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly touches the edge of the material in the tray. Do not load materials above the MAX line located on the rear Edge Guide.

7. Gently push in the tray until it comes to a stop.

   If enabled by your System Administrator, the Paper Tray settings/Tray Properties window displays on the UI.

8. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, weight and, if necessary, paper curl and/or alignment option.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

**Loading Hole Punch Paper in Trays 1, 2, and 3**

Pre-drilled paper is defined as having two or more holes along one edge for use in ring binders and notebooks. To prevent jams or damage, make sure that any plugs (pieces cut out of the paper to create the holes) do not remain in the stack.

1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Load and align the edge of the pre-drilled paper with the holes against the left edge of the tray.

6. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly touches the edge of the material in the tray. Do not load materials above the MAX line located on the rear Edge Guide.

7. Gently push in the tray until it comes to a stop.

If enabled by your System Administrator, the Paper Tray settings/Tray Properties window appears on the UI.

8. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, weight and, if necessary, paper curl and alignment option.

9. Select **Confirm** or **OK** to save the information and close the Paper Tray settings/Tray Properties window.

### Loading Media in the Bypass (Tray 5)

*Note: If any optional feeding devices are attached, the Bypass (Tray 5) is installed above or on top of that feeding device.*

This tray is used primarily when using a small quantity and special media (such as envelopes). Review the following tips when using the Bypass (Tray 5):

- Verify the stock loaded in the tray with the Paper Tray settings/Tray Properties window on the UI
- Load a maximum of 250 sheets of 24 lb./90 g/m² paper
- Do not load mixed-size paper into the Bypass Tray
- Do not load materials above the MAX line as indicated on the tray

### Loading Paper in the Bypass (Tray 5)

*Note: The following procedure shows the Bypass (Tray 5) located on top of the 2-Tray OHCF.*
1. Gently extend the Bypass tray (Tray 5) as necessary to accommodate the paper.

2. Hold the center of the paper guides and slide them to the desired paper size.

3. Select the appropriate paper stock for your print/copy job.
4. Open the ream of paper with the seam side facing up.
5. Fan the sheets before loading them into the tray.
6. Insert the paper or media into the tray until it stops.
7. Adjust the paper guides so that they touch the edges of the stack.
   If enabled by your System Administrator, the Paper Tray settings/Tray Properties window may be displayed on the UI.
8. If the Paper Tray settings/Tray Properties window displays on the UI, confirm the correct tray to which it is printing and other information, including size, type (precut tab), and, if necessary, paper curl and/or alignment option.
9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.
Loading Tab Stock in the Bypass (Tray 5)

Refer to the following tips before loading tab stock in the tray:

- You can load either single straight collated or single reverse collated tab stock.
- For network print jobs, refer to your print server customer documentation for instructions on loading tab stock into a tray.
- If a jam occurs while running tabbed sets, cancel the job and start again.

1. Gently extend the Bypass tray (Tray 5) as necessary to accommodate the tab stock.
2. Hold the center of the paper guides and slide them to the desired stock size.
3. Fan the tab paper before inserting into the tray.
4. Insert the tab stock into the tray so the straight edge of the stock is in the feed direction (lead edge) and the tabs are to the left (trail edge).
5. Continue to insert the tab stock into the tray until it stops.
6. Adjust the paper guides so that they touch the edges of the stack.
7. If the Paper Tray settings/Tray Properties window displays on the UI, confirm the correct tray to which it is printing and other information, including size, type (precut tab), and, if necessary, paper curl and/or alignment option.
8. Select **Confirm** or **OK** to save the information and close the Paper Tray settings/Tray Properties window.

Loading Transparencies in the Bypass (Tray 5)

☞ **Note:** Do not use transparencies with a white side strip (permanent or removable).

1. Gently extend the Bypass tray (Tray 5) as necessary to accommodate the paper.
2. Hold the center of the paper guides and slide them to the desired paper size.
3. Select the appropriate paper stock for your print/copy job.
4. Fan the transparencies to stop them from sticking together before loading into the tray.
5. Insert the transparencies LEF into the tray with the side to be printed on face up and with the removable stripe to the right.
6. Continue to insert the paper or media into the tray until it stops.
7. Adjust the paper guides so that they touch the edges of the stack.
8. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, weight and, if necessary, paper curl and/or alignment option.
9. Select **Confirm** or **OK** to save the information and close the Paper Tray settings/Tray Properties window.

Loading Hole Punch Paper in the Tray 5 (Bypass)

1. Gently extend the Bypass tray (Tray 5) as necessary to accommodate the paper.
2. Hold the center of the paper guides and slide them to the desired paper size.
3. Select the appropriate paper stock for your print or copy job.
4. Fan the sheets before loading them into the tray.
5. Insert the pre-drilled stock into the tray in the LEF direction with the holes to the right.

6. Continue to insert the paper or media into the tray until it stops.

7. Adjust the paper guides so that they touch the edges of the stack.

8. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, weight and, if necessary, paper curl and alignment option.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Envelopes in Tray 5 (Bypass)

It is recommended that you print envelopes from the Bypass (Tray 5). If you are required to print envelopes from the optional Trays 6 and 7, use the Postcard Bracket.

☞ Note: For information on supported envelope types and sizes, refer to the Customer Expectation and Installation Guide.

When setting up your print job, select from the following options:

- **Envelope Feeder**: used for standard-sized envelopes
- **Change Settings**: used for custom-sized envelopes

☞ Note: Store unused envelopes in their original packaging to avoid the excess moisture or dryness that can affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing.

Some wrinkling or embossing can occur when printing on envelopes. Successful envelope printing depends on the quality and construction of the envelopes. Try another envelope brand if problems occur.

When defining custom paper settings at the Paper Tray settings/Tray Properties window, assign the custom stock to the Bypass Tray (Tray 5) or an Advanced Oversized High Capacity Feeder (Tray 6 or 7). Select **Auto Detect** for automatic size-detection or measure the height and width of the envelope with the flap closed, then enter the dimensions. For more detailed information, refer to the following steps.

1. Always load envelopes with the flaps closed.
   Do not use padded envelopes.

2. When loading in the SEF direction, place the flaps facing the back of the press. When loading in the LEF direction, place the flaps facing the lead edge.

3. When submitting your network print file, select **Custom Paper** as the Paper Type. Enter the dimensions of the envelope.
   Measure the width from the lead edge to the trail edge of the envelope. For example, if you load SEF, enter the long dimension of the envelope as the width. If you load the envelope LEF, enter the short dimension of the envelope as the width.

4. Enter a heavy paper weight value, such as 220 g/m² in the **Paper Weight** field.
   A paper weight of 220 is a good starting point. If the printing is blurred or smeared, enter a higher value.

5. Select the **Bypass Tray** (Tray 5) as the Paper Source.
Feeding Devices

High Capacity Feeder, Tray 6

The 1-tray High Capacity Feeder (HCF), otherwise known as Tray 6, provides a 2,000-sheet, letter-size (8.5 x 11 in., A4) paper source.

Note: This tray uses only letter-size, 8.5 x 11 in. or A4 (210 x 297 mm) paper, long-edge feed (LEF).

Loading Paper in Tray 6

Tips for the 1-tray HCF (Tray 6):

- This tray accommodates A4 (8.5 x 11 in.) long-edge feed (LEF) stock.
- Additionally, the tray can accommodate B5 and Executive (7.25 x 10.5 in.), but requires an NVM change for the default size settings. For changes to the NVM settings, contact Xerox Technical Customer Support.
- This tray supports stock weights 64–22 g/m² (18 lb. Bond–80 lb. Cover).
- This tray holds a maximum of 2000 sheets of 75 g/m² (20lb.) paper.
- Load stock in the LEF direction only.
- Do not load materials above the MAX line.
1. Select the appropriate paper for your job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side face up.
4. Before you load the paper into the tray, fan the sheets.
5. Load the paper in the tray.
a. Align the edge of the paper against the right edge of the tray.
b. Move the paper guides so that they just touch the edges of the paper stack.
Do not load materials above the MAX line.

6. Gently push in the tray until it stops.
   If enabled by your system administrator, the Paper Tray settings screen is displayed on the user
   interface.

7. If changes are made to the paper tray, select Change Settings, otherwise, proceed to the next
   step.
   a. Select the required settings for Paper Type/Paper Weight, Paper Size, and Paper Color.
   b. If necessary, make the required changes to the paper curl and alignment adjustment
      settings.
      
      Note: Refer to the System Administrator Guide for detailed information on the paper
      curl and alignment adjustment options.
   c. Select Save repeatedly, until you return to the tray settings window.

8. To close the window, select Confirm.

Tray 6 Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Capacity</td>
<td>2,000 sheets</td>
</tr>
<tr>
<td>Sheet Size</td>
<td>8.5 x 11 in. or A4</td>
</tr>
<tr>
<td></td>
<td>B5 and Executive (7.25 x 10.5 in.), but requires NVM change for default size settings.</td>
</tr>
<tr>
<td></td>
<td>Contact your customer support representative.</td>
</tr>
<tr>
<td>Paper Weight</td>
<td>64–220 g/m² uncoated or coated paper</td>
</tr>
</tbody>
</table>

Advanced Oversized High Capacity Feeder, Trays 6 and 7

Trays 6 and 7 Overview

The Oversized High Capacity Feeder (OHCF) is available in a 1-tray or 2-tray option. The OHCF feeds a
variety of stock sizes, including standard and oversized stock up to 13 x 19.2 in./330.2 x 488 mm.
Each tray holds 2,000 sheets.
1. 2-tray Advanced OHCF with Bypass (Trays 6 and 7)
2. 1-tray OHCF with Bypass and storage cabinet above the tray (Tray 6)

Paper and Media in Trays 6 and 7

*Note:* Each feeder tray has a stock loading label. When loading media into the tray, refer to the labels on the inside panel of the feeder tray for the correct orientation of that stock type.

It is recommended that you use the Bypass Tray (Tray 5) to feed envelopes. However, if you use Trays 6 and 7, feed C5 and No. 10 envelopes SEF with the Postcard Bracket or Envelope Support Kit installed. Without the Envelope Support Kit, the maximum recommended stack height is 200 envelopes. The Envelope Support Kit increases the maximum recommended envelope capacity.

*Note:* The Envelope Support Kit is an additional kit to print envelopes, that can be ordered separately.

If you are using the optional Postcard Bracket, minimum size is 101.6 x 152.4 mm (4 x 6 in.).

*Note:* For more information on the optional Postcard Bracket, refer to Paper and Media.

Loading Paper in Trays 6 and 7

1. Select the appropriate paper stock for your print/copy job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Load paper into the tray.
6. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly touches the edge of the material in the tray.
   
   Do not load materials above the MAX line located on the rear Edge Guide.
7. Gently push in the tray until it comes to a stop.
   
   The Paper Tray settings/Tray Properties window displays on the UI. You can view and set stock attributes and verify trays are assigned with the correct stock.
8. From the Paper Tray settings/Tray Properties window, enter or verify the correct paper information, including size, type, weight and, if necessary, paper curl and/or alignment option. Select the stock and assign the stock to the tray to be used.
9. Select **Confirm** or **OK** to save the information and close the Paper Tray settings/Tray Properties window.

**Loading Tabs in Trays 6 and 7**

Refer to the following tips before loading tab stock in the tray:

- You can load either single straight collated or single reverse collated tab stock.
- For network print jobs, refer to your print server customer documentation for instructions on loading tab stock into a tray.
- If a jam occurs while running tabbed sets, cancel the job and start again.

1. After programming your tab job at the print server, select the appropriate and matching tab stock for your print job.
2. Pull out the tray slowly until it stops.
3. Fan the tab paper before loading into the tray.
4. Load the tab stock LEF (portrait) and align the straight edge of the tab stock against the right edge of the tray (tabs to the left or trailing edge). For single straight collated tabs, the first blank tab cutout in the stack will be toward the front of the tray. For single reverse collated tabs, the first blank tab cutout in the stack will be toward the rear of the tray.

![Tab stock orientation](image)

Tab stock is loaded so the straight edge of the stock is in the feed direction. Also, you can only load the tab stock LEF.

5. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly touches the edge of the stock in the tray.

Do not load materials above the MAX line located on the rear Edge Guide.

6. Gently push in the tray until it comes to a stop.

The Paper Tray settings/Tray Properties window displays on the press UI.

7. From the Paper Tray settings/Tray Properties window, confirm the correct tray to which it is printing and other information, including size (9 x 11 inches), type (precut tab), and, if necessary, paper curl and/or alignment option.

8. Select **Confirm** or **OK** to save the information and close the Paper Tray settings/Tray Properties window.
Loading Transparencies in Trays 6 and 7

Read these tips before using transparencies:

- Do not use transparencies with the white side strip (permanent or removable).
- Do not mix paper and transparencies in a tray. Jams may occur.
- Do not load more than 100 transparencies in a paper tray at one time.
- Load 8.5 x 11 in (A4) transparencies long edge feed only (landscape).

1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Fan the transparencies to stop them from sticking together before loading into the tray.
4. Load transparencies LEF on top of a small stack of same-size paper and align the strip edge of the transparency against the right edge of the paper tray, with the side to be printed on facing down.
5. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly touches the edge of the material in the tray.
   - Do not load materials above the MAX line located on the rear Edge Guide.
6. Gently push in the tray until it comes to a stop.
   - If enabled by your System Administrator, the Paper Tray settings/Tray Properties window displays on the UI.
7. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, weight and, if necessary, paper curl and/or alignment option.
8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Hole Punch Paper in Trays 6 and 7

1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Load and register the paper against the right side of the tray for LEF direction.

6. Load and register the paper against the right side of the tray as depicted below for SEF direction.

7. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly touches the edge of the stock in the tray.
   Do not load materials above the MAX line located on the rear Edge Guide.

8. Gently push in the tray until it comes to a stop.
   If enabled by your System Administrator, the Paper Tray settings/Tray Properties window displays on the UI.

9. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, weight and, if necessary, paper curl and/or alignment option.

10. Select **Confirm** or **OK** to save the information and close the Paper Tray settings/Tray Properties window.

**Postcard Bracket**

The Postcard bracket is delivered with the OHCF from manufacturing. The Postcard bracket allows you to print on smaller size media without requiring post-processing cutting or sorting. The Postcard bracket specifically accommodates 4 x 6 in. (101.6 x 152.4 mm) SEF media.
Using the Postcard Bracket

Use the following procedure for installing and using the Postcard bracket when printing on smaller media (101.6 x 152.4 mm (4 x 6 in.)).

With the Postcard Bracket installed, you can print envelopes from Trays 6 and 7.

1. Slowly open one of the paper trays until it stops, then remove the paper.

2. Move the paper guides out to their largest position.

3. To remove the postcard bracket, loosen the screw on the left side of the tray (1), then remove the bracket (2).
4. Install the Postcard bracket so that it sits on the locating pins on the upper frame and in the grooves on the bottom of the tray.

5. Tighten the thumb screw so that it locks the Postcard bracket in place.
6. Load the postcard stock and adjust the paper guides against the stock.

7. Close the paper tray, then confirm the new settings on the press user interface and if necessary at the print server.

8. Run your print job.

9. Upon completion of your print job, remove the postcard stock and the Postcard bracket from the tray.

10. Store the postcard bracket by inserting it into the storage area on the left side of the tray (1) and tightening the screw (2).
Skew Adjustment Levers for Trays 6-9

The skew adjustment levers are found in all paper trays. These levers are used to improve paper feed accuracy and to reduce paper skew problems.

1. Rear Skew Adjustment Lever
2. Right Side Skew Adjustment Lever

Note: These levers should remain in their default position. The position of these levers should be changed only if there is a skew problem when running a specific print job and/or media type. Changing the levers may cause more skew problems when running certain media types such as coated, label, transparency and film.

Use the following procedure to set the skew adjustment levers:

1. Pull out the tray slowly until it stops.
   - The Tray Properties / Settings automatically display at the press User Interface (UI).
2. From the Tray Properties window, verify that the correct paper information is being used including size, type, weight and paper curl or alignment option for the tray. Select **OK** and close the Tray Properties window.
3. At the tray, slide the rear skew adjustment lever to the right.
4. Gently push in the tray until it comes to a stop.
5. Run your print job:
   - If the paper is fed accurately without skew and the printed output is satisfactory; your task is complete.
   - If the paper is skewed and the printed output is unsatisfactory; proceed to the next step.
6. Pull out the tray slowly until it stops.
7. Verify the tray and paper settings at the print server.
8. Return the rear skew adjustment lever to its left, default position.
9. Slide the right-side skew adjustment lever toward the front of the paper tray.
10. Gently push in the tray until it comes to a stop.
11. Run your print job:
   • If the paper is fed accurately without skew and the printed output is satisfactory; your task is complete.
   • If the paper is skewed and the printed output is unsatisfactory; proceed to the next step.

12. Pull out the tray slowly until it stops.

13. Return the right-side skew adjustment lever toward the rear of the paper tray; this is its default position.

14. Gently push in the tray until it comes to a stop.

### Trays 6 and 7 Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Capacity</td>
<td>1 Tray: 2,000 sheets plus top Storage Cabinet</td>
</tr>
<tr>
<td></td>
<td>2 Tray: 2,000 sheets per tray (total of 4000 sheets)</td>
</tr>
<tr>
<td></td>
<td><strong>Important:</strong> When using up to Xerox 24 lb., 90 g/m² bond paper.</td>
</tr>
<tr>
<td>Sheet Sizes</td>
<td>1 Tray: 182 x 250 mm (7.2 x 10 in.), B5 to 330 x 488 mm (13 x 19.2 in.), SRA3</td>
</tr>
<tr>
<td></td>
<td>1 Tray, with Postcard Bracket: 100 x 148 mm minimum</td>
</tr>
<tr>
<td></td>
<td>2 Tray: 102 x 152 mm (4 x 6 in.) to 330 x 488 mm (13 x 19.2 in.), SRA3</td>
</tr>
<tr>
<td></td>
<td>2 Tray, with Postcard Bracket: 98 x 148 mm minimum</td>
</tr>
<tr>
<td>Paper Weight</td>
<td>52–400 g/m²</td>
</tr>
</tbody>
</table>

### Dual Advanced Oversized High Capacity Feeder, Trays 8 and 9

#### Trays 8 and 9 Overview

**Important:** The Dual Advanced Oversized High Capacity Feeder (OHCF), Trays 8 and 9, can be added only to a system which includes Trays 6 and 7.

Trays 8 and 9 can be added to the system to extend the paper capacities by providing two additional trays. Trays 8 and 9 feed a variety of stock sizes, including standard, heavyweight, and oversized stocks up to 330 x 488 mm (13 x 19.2 in.) in size and weighing between 52 g/m² and 400 g/m². Each tray holds 2000 sheets of coated and uncoated stock.
Note: The OHCF comes equipped from manufacturing with the Postcard bracket tray inserter. If using the optional Postcard bracket, minimum size is 101.6 x 152.4 mm (4 x 6 in.)

Note: For more information on the optional Postcard Bracket, refer to Paper and Media.

Paper and Media for Trays 8 and 9

Loading Paper in Trays 8 and 9
1. Select the appropriate paper stock for your print/copy job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Load paper into the tray.
6. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly touches the edge of the material in the tray.
   Do not load materials above the MAX line located on the rear Edge Guide.
7. Gently push in the tray until it comes to a stop.
   The Paper Tray settings/Tray Properties window displays on the UI. You can view and set stock attributes and verify trays are assigned with the correct stock.
8. From the Paper Tray settings/Tray Properties window, enter or verify the correct paper information, including size, type, weight and, if necessary, paper curl and/or alignment option. Select the stock and assign the stock to the tray to be used.
9. Select **Confirm** or **OK** to save the information and close the Paper Tray settings/Tray Properties window.
Loading Tabs in Trays 8 and 9

Refer to the following tips before loading tab stock in the tray:

- You can load either single straight collated or single reverse collated tab stock.
- For network print jobs, refer to your print server customer documentation for instructions on loading tab stock into a tray.
- If a jam occurs while running tabbed sets, cancel the job and start again.

1. After programming your tab job at the print server, select the appropriate and matching tab stock for your print job.
2. Pull out the tray slowly until it stops.
3. Fan the tab paper before loading into the tray.
4. Load the tab stock LEF (portrait) and align the straight edge of the tab stock against the right edge of the tray (tabs to the left or trailing edge). For single straight collated tabs, the first blank tab cutout in the stack will be toward the front of the tray. For single reverse collated tabs, the first blank tab cutout in the stack will be toward the rear of the tray.

5. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly touches the edge of the stock in the tray.

   Do not load materials above the MAX line located on the rear Edge Guide.

6. Gently push in the tray until it comes to a stop.

   The Paper Tray settings/Tray Properties window displays on the press UI.

7. From the Paper Tray settings/Tray Properties window, confirm the correct tray to which it is printing and other information, including size (9 x 11 inches), type (precut tab), and, if necessary, paper curl and/or alignment option.

8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.
Loading Transparencies in Trays 8 and 9

Read these tips before using transparencies:

- Do not use transparencies with the white side strip (permanent or removable).
- Do not mix paper and transparencies in a tray. Jams may occur.
- Do not load more than 100 transparencies in a paper tray at one time.
- Load 8.5 x 11 in (A4) transparencies long edge feed only (landscape).

1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Fan the transparencies to stop them from sticking together before loading into the tray.
4. Load transparencies LEF on top of a small stack of same-size paper and align the strip edge of the transparency against the right edge of the paper tray, with the side to be printed on facing down.
5. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly touches the edge of the material in the tray.
   Do not load materials above the MAX line located on the rear Edge Guide.
6. Gently push in the tray until it comes to a stop.
   If enabled by your System Administrator, the Paper Tray settings/Tray Properties window displays on the UI.
7. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, weight and, if necessary, paper curl and/or alignment option.
8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Hole Punch Paper in Trays 8 and 9

1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Load and register the paper against the right side of the tray for LEF direction.

6. Load and register the paper against the right side of the tray as depicted below for SEF direction.

7. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly touches the edge of the stock in the tray.

   Do not load materials above the MAX line located on the rear Edge Guide.

8. Gently push in the tray until it comes to a stop.

   If enabled by your System Administrator, the Paper Tray settings/Tray Properties window displays on the UI.

9. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, weight and, if necessary, paper curl and alignment option.

10. Select **Confirm** or **OK** to save the information and close the Paper Tray settings/Tray Properties window.

**Skew Adjustment Levers for Trays 8 and 9**

For information and instructions on using the skew adjustment levers for trays 8 and 9, refer to **Skew Adjustment Levers for Trays 6-9**.
## Trays 8 and 9 Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sheet size</td>
<td><strong>Short Edge Feed (SEF):</strong>&lt;br&gt;• 8.5 x 11 in., A4&lt;br&gt;• 8.5 x 13 in.&lt;br&gt;• 8.5 x 14 in.&lt;br&gt;• 10 x 14 in., B4&lt;br&gt;• 11 x 17 in., A3&lt;br&gt;• 12 x 18 in.&lt;br&gt;• 12.6 x 17.7 in., SRA3&lt;br&gt;• 13 x 18 in.&lt;br&gt;• 13 x 19 in.&lt;br&gt;• 12.6 x 19.2 in.&lt;br&gt;• B5  &lt;br&gt;<strong>Long Edge Feed (LEF):</strong>&lt;br&gt;• B5&lt;br&gt;• 7.25 x 10.5 in. (executive)&lt;br&gt;• A4&lt;br&gt;• 8.5 x 11 in.&lt;br&gt;• 8.0 x 10 in.  &lt;br&gt;<strong>Custom sizes:</strong> 182–330 mm (7.2–13 in.) Width and 182–488 mm (7.2–19.2 in.) Length</td>
</tr>
<tr>
<td>Paper weight</td>
<td>52–400 g/m²</td>
</tr>
</tbody>
</table>
| Paper capacity | 2,000 sheets per tray  

⚠️ **Important:** When using up to Xerox 24 lb., 90 g/m² bond paper.
High Capacity XLS Vacuum Feeder and Dual High Capacity XLS Vacuum Feeder

High Capacity XLS Vacuum Feeder (HCVF) Components

1. Error Indicator
2. Paper Level and Tray in Use Indicator
3. Tray 5, Bypass Tray
4. Extra Long Sheet (XLS) Feeder
5. Circuit Breaker Switch
6. Tray 6 of High Capacity XLS Vacuum Feeder
7. Tray 7 of High Capacity XLS Vacuum Feeder
8. Right Side Cover

The following information applies to the High Capacity XLS Vacuum Feeder:

- When a paper jam occurs, the error indicator illuminates.
- For the paper level indicator, when the corresponding tray is active, the top active indicator illuminates. The four center indicators, 1=25%, indicate the amount of remaining paper. When all four indicators are off, the tray is empty and the Empty Paper Indicator illuminates.
- In the event of fault current or a short circuit, the circuit breaker disconnects the electrical supply to the device automatically.
- To clear paper jams, open the right side cover.
Dual High Capacity XLS Vacuum Feeder Components

1. Paper Level and Tray in Use Indicator for Trays 6 and 7
2. Error Indicator for Trays 8 and 9
3. Paper Level and Tray in Use Indicator for Trays 8 and 9
4. Tray 5, Bypass Tray
5. Extra Long Sheet (XLS) Feeder
6. Circuit Breaker Switch
7. Tray 8 of High Capacity XLS Vacuum Feeder
8. Tray 9 of High Capacity XLS Vacuum Feeder
9. Right Side Cover for Trays 8 and 9
10. Tray 6 of High Capacity XLS Vacuum Feeder
11. Tray 7 of High Capacity XLS Vacuum Feeder
12. Right Side Cover for Trays 6 and 7
13. Error Indicator for Trays 6 and 7
Circuit Breaker Switch

During normal operating conditions, the circuit breaker switch is in the up position. Before you move the HCVF, or if the HCVF is idle for an extended period of time, switch off the circuit breaker. To switch off the circuit breaker, move the switch to the down position.

1. Circuit Breaker Switch
2. Test Button

Note: When a fault is detected, the power to the circuit breaker is disconnected automatically. Do not touch the breakers under normal operating conditions.

High Capacity XLS Vacuum Feeder Specifications

Supported Paper Types and Weights

<table>
<thead>
<tr>
<th>Trays</th>
<th>Paper Sizes</th>
<th>Weights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 5, Bypass Tray*</td>
<td>Standard:</td>
<td>52–400 g/m²</td>
</tr>
<tr>
<td></td>
<td>• Maximum: SRA3 (320 x 450 mm),</td>
<td></td>
</tr>
<tr>
<td></td>
<td>320 x 488 mm (12.6 x 19.2 in.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Minimum: Postcard, 100 x 148 mm (3.9 x 5.8 in.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Width: 98–330.2 mm (3.8–13 in.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Length: 146–660 mm (5.7–26 in.)</td>
<td></td>
</tr>
<tr>
<td>HCVF Tray 7 or Dual HCVF</td>
<td>Standard:</td>
<td>52–400 g/m²</td>
</tr>
<tr>
<td>Trays 6, 7, and 9</td>
<td>• Maximum: SRA3 (320 x 450 mm),</td>
<td></td>
</tr>
<tr>
<td></td>
<td>320 x 488 mm (12.6 x 19.2 in.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Minimum: Postcard, 100 x 148 mm (3.9 x 5.8 in.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom:</td>
<td></td>
</tr>
</tbody>
</table>
Trays | Paper Sizes | Weights
--- | --- | ---

- **Width**: 98–330.2 mm (3.8–13 in.)
- **Length**: 148–488 mm (5.8–19.2 in.)

Extra Long Sheet (XLS) Feeder

**Standard:**
- **Maximum**: SRA3 (320 x 450 mm), 320 x 488 mm (12.6 x 19.2 in.)
- **Minimum**: A4 (210 x 297 mm), 8.3 x 11.7 in.

**Custom:**
- **Width**: 210–330.2 mm (8.2–13 in.)
- **Length**: 210–1200 mm (8.2–47.2 in.)

52–400 g/m²

* If the press is equipped with a Dual High Capacity XLS Vacuum Feeder, the Tray 5, bypass tray, is installed on the second HCVF.

**High Capacity XLS Vacuum Feeder Tray Capacity**

- **Tray 5, Bypass Tray**: 250 sheets
- **HCVF Tray 7 or Dual HCVF Trays 6, 7, and 9**: 2100 sheets for each tray
- **Extra Long Sheet (XLS) Feeder**: 700 sheets

*Note: The values are based on 90 g/m² paper.*

**Paper and Media for High Capacity XLS Vacuum Feeder**

**Important:**

- Loading paper above the maximum fill line can cause paper jams or device malfunctions.
- Position the guides correctly to match the paper size. Incorrectly positioned guides can cause misfeeds and paper jams.
- When the power is reconnected while the bottom plate of the tray is rising, it is possible that the plate does not continue to move up. In this case, pull out the tray, ensure that the plate lowers fully, then push the tray into the machine slowly and firmly.

*Note: When paper sheets are loaded or fed, the tray makes a sound of supplying air. This sound is caused by the Air Assist function and not an abnormal noise.*

**Loading Paper in the High Capacity XLS Vacuum Feeder (HCVF) Trays**

**Important:** If fewer than 100 sheets of paper are loaded, the tray guides apply too much pressure to the paper, which causes the paper to be skewed. Skewed paper leads to paper jams.
1. Pull out the tray toward you until it stops.

2. Remove any paper remaining in the tray.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of paper jams.

4. Load 100–500 sheets of paper. For preprinted media, load the paper with the printed side facing up.

   a. Align the edges of the paper against the right edge of the tray (1). Paper can be loaded in the long-edge-feed (LEF) or portrait direction, or in the short-edge-feed (SEF) or landscape direction.

   b. To adjust the paper guides, press in the guide release lever and move the guides carefully until they touch lightly the edges of the paper in the tray (2).
5. Load the remaining sheets into the tray, then align the paper edges in the direction shown (1). To adjust the paper guides, press in the guide release lever and move the guides carefully until they touch lightly the edges of the paper (2).

6. Gently push the tray into the press until it stops.

Special Media

Hole-Punched Paper

For hole-punched paper, place the paper with the holes to the right when you face the front side of the High Capacity Vacuum Feeder (HCVF).

Precut Tabs

For precut tabs, place the paper with the tabs to the left when you face the front side of the HCVF. After you load the paper, install the appropriate tab guide on the end guide, at the short edge of the paper.

Note: Ensure that the tabs of the precut tab fit the notch of the tab guides.
Postcard Setting

To load paper size 98–181.9 mm portrait or smaller, attach the Postcard Kit to the High Capacity Vacuum Feeder (HCVF) tray. The Postcard Kit can be used in the HCVF trays only. You cannot use the Postcard Kit with Extra Long Sheet (XLS) Trays.

The following procedure defines how to load paper using postcard guides.

1. Pull out the tray toward you until it stops.

2. Remove any paper that remains in the tray.

3. To install the Postcard Kit, remove the postcard guides from their storage area.

4. Remove the shutters.
   a. Fold the shutters (1).
   b. Lift the stack of shutters and remove them (2).
5. Insert guide B into the slits on the side (1) and bottom (2) of the tray. Tighten the screw to secure the guide (3).

⚠️ **Caution:** If the screw is not tightened fully, it can come off and hit the transport device, which can result in breakage of the transport device.

6. Insert the guide A into the slit on the interior (1) and the bottom (2) of the tray. Tighten the screw to secure the guide (3).
7. Load 100–500 sheets of paper, then align the paper edges in the direction shown (1). For preprinted media, load the paper with the printed side facing up. Hold the side guides by its grip, then move them to touch the long edges of the paper lightly (2).

Note: Ensure that you load the paper in the short-edge-feed (SEF) direction. The right side of the short edge of the postcard is the leading edge (1).

8. Load the remaining sheets in the tray.
   a. Align the paper edges in the direction shown (1).
   b. Move the end guide to touch the short-edges of the paper lightly (2).
      Adjust the paper guides by pressing in the guide release lever and carefully moving the guides until they touch the edges of the paper lightly.

9. Gently push the tray into the press until it comes to a stop.

10. To remove and store the postcard guides, perform the following:
    a. Remove any paper from the tray.
    b. Unfasten the screw from the postcard guide.
11. After removing the postcard guides, place the shutters in their original positions, then expand them.

**Note:** Hang the edges of the shutters on the beveled shutter retainers on both ends of the adjustable side guide. Confirm that they are fixed firmly.

12. Store the postcard guides in their storage area.

**Note:** Align the triangular marks so that the shutters can be mounted in the correct orientation. In the following image, the mark on the guide at the top edge of the paper is not visible, and the mark on the guide at the bottom edge of the paper is shown in the correct state.

---

**Envelope Setting**

Before you load envelopes in the paper tray, read and adhere to the following envelope guidelines:

- **Curled or waving edges:** If there are envelopes with curled or waving edges, replace the envelopes or straighten the edges.

- **Adhered or glued to each other:** If applicable, remove the glue and ensure bonding surfaces of the envelopes do not touch.

- **Glue protruded:** If applicable, wipe off the glue.

- **Folded or non-flat surfaces:** To flatten the top surface of the pile of envelopes, do the following:
  1. Place 100 envelopes on a level tabletop.
  2. Press down the higher side of the top surface of the stack of envelopes.
  3. When the higher side are not flattened, reduce the number of loaded envelopes until it becomes flat.
  4. Repeat the process for another 100 envelopes. For example, if you are required to prepare 300 envelopes, then perform the process three times.
- Ensure that the top surface of the loaded envelopes is flattened. The height difference between the front and back edge of the envelope can be no more than 1 cm., with the front edge of the envelope on the lower side. This guideline applies only when the Large Envelope Kit is not used.

Within 1 cm.

Loading and Orientation Information

- Loading side: Load envelopes with the printable side face up.
- Load direction with the flap open: Place the envelope with the flap facing to the left, when you are at the front of the device.

- Load direction with the flap closed: Place the envelope with the flap facing to the right, when you are at the front of the device.

- When loading self-seal envelopes, fold the flaps.
- If the weight of each envelope is different, a multifeed is detected.
- If the printed output is not as expected, due to the image orientation or the flaps being open or closed, change the image orientation at the print server. While changing the image orientation at the print server, do not change the direction of loading paper.

  ! Caution: If envelopes are loaded above the maximum fill line or the top of the envelope stack is not level, a device malfunction can occur.

If any of the following fault codes appear, reduce the number of envelopes loaded:

- Tray 6: 078-250
- Tray 7: 078-260
- Tray 8: 178-250
- Tray 9: 178-260
Envelope Specification

- Type: Uncoated
- Weight: Specify the weight as twice that of the actual. For example, if 70 g/m² is indicated, specify the weight as 140 g/m².
- Size:
  - Standard size: If the envelope flaps are closed, use this size.
  - Custom size: If the envelope flaps are open, use this size.

If the output is curled, decurling is required. If the cutting surfaces of envelopes have burrs, before you load the envelopes in the tray, flex the envelopes back and forth and fan them.

Optional Large Envelope Kit Components

When you load the envelope size C4 (324 x 229 mm), C5 (229 x 162 mm), or DLX (235 x 120 mm), use the Large Envelope Kit. The Large Envelope Kit is an optional kit. Refer to the following Large Envelope Kit components for loading the envelopes with open flaps:

Based on the size of the envelope, ensure the correct combination of the Large Envelope Kit components. Refer to the following table to identify the correct components to be used.
<table>
<thead>
<tr>
<th>Envelope Size</th>
<th>Postcard Kit*</th>
<th>Large Envelope Kit</th>
</tr>
</thead>
<tbody>
<tr>
<td>C4</td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>C5</td>
<td>A B</td>
<td>D</td>
</tr>
<tr>
<td>DLX</td>
<td>A B</td>
<td>E</td>
</tr>
<tr>
<td>Any other sizes, 181.9 mm (7.16 in.) or less on the long edge in the portrait orientation</td>
<td>A B</td>
<td>F1</td>
</tr>
<tr>
<td>Any other sizes, 182.0 mm (7.16 in.) or more on the long edge in the portrait orientation</td>
<td></td>
<td>F2</td>
</tr>
</tbody>
</table>

* When you attach the Postcard Kit (A and B), remove the shutters.
Optional Large Envelope Kit Installation Instructions

1. To install the parts A and B, refer to Postcard Setting.
2. Fasten the screws to the side guide on the rear side to fix part C.
   Fasten the screws to the side guide on the front side to fix part D.

⚠️ Caution: If the screw is not tightened fully, it can come off and hit the transport device, which can result in breakage of the transport device.

3. Attach part E to the end guide, at the short edge of the paper. Place part F1 or F2 along the wall on the leading edge of the paper. Verify that the parts are firmly fixed.

Loading Envelopes Using the Optional Large Envelope Kit

1. Pull out the tray toward you until it stops.
2. Remove any paper remaining in the tray.
3. Attach or remove the shutter from the Postcard Kit or Large Envelope Kit, depending on the size of the envelopes.
4. Load one envelope with the paper edges aligned in the direction shown (1), to place it on parts E and F. For preprinted media, load the paper with the printed side facing up. Hold the end guide by its grip, then move it so that it touches the edges of the envelope lightly (2). Adjust the paper guides as needed.

![Image 1](image1)

*Note:* Do not press the paper guide forcefully or leave a gap between the end guide and the envelope. These actions can cause a paper feeding error.

5. To fill the tray easily, load the stack of envelopes in small bundles. Bend the envelope stacks to provide additional clearance while loading.

![Image 2](image2)

6. Load each stack of envelopes and align the envelopes edges in the direction shown (1). Hold the side guide by its grip, then move it to touch the edges of the envelopes lightly (2).

![Image 3](image3)

7. When you load envelopes repeatedly, widen the side guide, then repeat the loading process for every bundle of about 100 envelopes. When you are using the Postcard Kit, align the envelopes by putting your hand between the side guide and the envelopes.

*Note:* If the envelopes do not align, misalignment on prints or a paper feed error can occur.


Loading Envelopes Without the Large Envelope Kit

1. Pull out the tray toward you until it stops.
2. Remove any paper remaining in the tray.
3. Load a bundle of about 100 envelopes and align the envelope edges in the direction shown (1). For preprinted media, load the paper with the printed side facing up. Hold the side guide by its grip, then move it to touch the edges of the envelopes lightly (2). Adjust the paper guides as needed.

4. When you load envelopes repeatedly, widen the side guide, then repeat the loading process for every bundle of about 100 envelopes. When using Postcard Kit, align the envelopes by putting your hand between the side guide and the envelopes.

   ![Note: If the envelopes do not align, misalignment on prints or a paper feeding error can occur.]

5. Move the end guide to touch the edges of the envelopes lightly. To adjust the paper guides, press in the guide release lever and move the guides carefully until they touch the edges of the envelopes lightly.

Loading Paper in the Automatic Extra Long Sheet (XLS) Feeder

Caution: If fewer than 100 sheets are loaded in the Extra Long Sheet (XLS) Feeder tray, the paper guides apply more pressure to the paper. This pressure can distort the paper, which causes paper jams. For example, loading 10–20 sheets of 864 mm (34 in.) or longer paper can cause paper jams.

Note: The Postcard Kit for High Capacity XLS Vacuum Feeder (HCVF) cannot be used with the Extra Long Sheet (XLS) Feeder tray.

Loading 488 mm (19.21 in.) or Smaller Paper

1. Remove the paper from the bypass tray, then open the two covers.
2. On the left of the side guides at the long edge of the paper, lower the lever. Remove any paper remaining in the tray.

3. If the end guide is stored, open the end guide shutter, then rotate the end guide to latch in the vertical position.
   a. Pinch the lever and open the shutter (1).
   b. Hold the paper guide and pull it up (2). Pull the paper guide toward you until it clicks in place.
   c. Pinch the lever (3) and close the shutter.
   
   !Caution: Do not hold the paper guide clip to pull up the paper guide. The guide clip can break.

4. Load 100–500 sheets of paper with the paper edges aligned in the direction shown (1). For preprinted media, load the paper with the printed side facing up. Hold the side guides by its grip, then move it to touch the edges of the paper lightly (2).
5. Load the remaining sheets into the tray, then align the paper edges in the direction shown (1). Move the end guide to touch the edges of the paper lightly (2). Adjust the paper guides by pressing in the guide release lever and carefully moving the guides until they touch the edges of the paper lightly.

6. Close the two covers.

**Loading 488.1–864 mm (19.21–34.0 in.) Paper**

1. Remove the paper from the bypass tray, then open the two covers.

2. Lift the lever on the left of the side guide. Remove any paper that remains in the tray.

3. If the end guide is standing, store it:
a. Pinch the lever and open the shutter (1).

b. Hold the release lever and lay down the paper guide (2).

c. Pinch the lever (3) and close the shutter.

4. Load about 100 sheets of paper with the paper edges aligned in the direction shown (1). For preprinted media, load the paper with the printed side facing up. Hold the side guide by its grip, then move it to touch the edges of the paper lightly (2).

5. Hold the XLS rear-side guide by its grip, then move it to touch the edges of the paper lightly (1). Place the XLS front side guide to fit the loaded paper (2). The XLS front side guide is removable. Install the front side guide in the direction that ensures that the metal surface touches the paper.
6. Load the remaining sheets in the tray, then align the paper edges in the direction shown.

![Image of paper being loaded]

7. Place the rear XLS end guide to fit the loaded paper. The rear end guide is removable. Install the rear end guide in the direction that ensures that the metal surface touches the paper.

![Image of rear end guide being installed]

8. Close the two covers.

**Loading 864.1 mm (34.02 in.) or Larger Paper**

You can load a maximum of 100 sheets of 864.1 mm (34.02 in.) or larger, 90 g/m² paper.

1. Unfasten and remove the screws on the top of the left side cover. Remove the cover.

![Image of screws being removed]

---

153
2. Remove the paper from the bypass tray, then open the two covers.

![Image of paper removal and cover opening]

3. Attach the XLS extension tray and the extension plate.
   a. Insert the XLS extension tray, then tighten the screws to secure it, as shown.

![Image of XLS extension tray insertion]

b. Insert the XLS extension plate.

![Image of XLS extension plate insertion]

c. When not in use, hang the parts on the holder of the lower part.

![Image of parts hanging on the holder]
4. Lift the lever on the left of the front side guide. Remove any paper that remains in the tray.

5. If the end guide is standing, store it:
   a. Pinch the lever and open the shutter (1).
   b. Hold the release lever and lay down the paper guide (2).
   c. Pinch the lever (3) and close the shutter.

6. Load 100 or less sheets of paper with the paper edges aligned in the direction shown (1). For preprinted media, load the paper with the printed side facing up. Hold the rear-side guide by its grip, then move it to touch the edges of the paper lightly (2).
7. Hold the XLS rear-side guide by its grip, then move it to touch the edges of the paper lightly (1). Place the XLS front side guide to fit the loaded paper (2). The XLS front side guide is removable. Install the front side guide in the direction that ensures that the metal surface touches the paper.

8. Close the two covers (1), then wait until the bottom plate rises. Place the XLS end guide to fit the loaded paper (2). The XLS end guide is removable. Install the end guide in the direction that ensures that the metal surface touches the paper.

Finishing Devices

Related Topics:
Business Ready (BR) Finisher and Optional Booklet Maker
Interface Decurler Module and Interface Decurler Module with Inline Spectrophotometer (ILS)
Inserter Device
GBC® AdvancedPunch® Pro
High Capacity Stacker (HCS)
Crease and Two-Sided Trimmer
C/Z Folder
Production Ready (PR) Finishers
SquareFold® Trimmer Device
Business Ready (BR) Finisher and Optional Booklet Maker

Tip: The BR Finisher, with or without the Booklet Maker, attaches directly to the press and does not require an Interface Decurler Module or an Interface Decurler Module with Inline Spectrophotometer.

The Business Ready (BR) Finisher adds several professional-level finishing options to the press while requiring minimal additional space for the finisher. The finisher is available with or without an optional booklet maker.

Business Ready (BR) Finisher without Booklet Maker

The BR Finisher supports hole punching and stapling. The Right Top Tray is used for stacked output and can receive up to 500 sheets of paper. The Stacker is used for offset and stapled output and can hold up to 3,000 sheets.

Business Ready (BR) Finisher with the optional Booklet Maker

The BR Finisher with the optional Booklet Maker supports hole punching, stapling, and booklet making. The Right Top Tray is used for stacked output and can receive up to 500 sheets of paper. The Right Center Tray is used for offset and stapled output and can hold up to 1,500 sheets. Both trays can be used for hole punched output (optional). The Bottom Finisher Tray is used for receiving saddle-stapled booklets.
Identifying the BR Finisher Components

1. Finisher Front Cover
2. Right Top Tray
3. Right Middle Tray
4. Staple Cartridge
5. Booklet Maker Tray (optional)
6. Booklet Staple Unit (optional)
7. Booklet Maker Unit (optional)

BR Finisher Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray Capacity</td>
<td></td>
</tr>
<tr>
<td>• Offset (Top) Tray: 500 sheets</td>
<td></td>
</tr>
<tr>
<td>• Stacking or Stapling Tray:</td>
<td></td>
</tr>
<tr>
<td>• 3,000 sheets unstapled</td>
<td></td>
</tr>
<tr>
<td>• 100 sets (dual or 4-position staple), 11 x 17 in., 8.5 x 14 in., A4</td>
<td></td>
</tr>
<tr>
<td>• 200 sets (single-position staple), A4, 8.5 x 11 in.</td>
<td></td>
</tr>
<tr>
<td>Sizes</td>
<td></td>
</tr>
<tr>
<td>• Stacking: A6–SRA3, 4 x 6–12 x 19 in.</td>
<td></td>
</tr>
<tr>
<td>• Stapling: B5–A3, 7.25 x 10.5–11 x 17 in.</td>
<td></td>
</tr>
<tr>
<td>Paper Weight</td>
<td>Top Tray and Stacker Tray: 52–400 g/m² uncoated and coated paper</td>
</tr>
<tr>
<td>Stapling</td>
<td>Single and multi-position stapling</td>
</tr>
<tr>
<td>• Auto stapling, 50 sheets maximum, 90 g/m², 24 lb.</td>
<td></td>
</tr>
<tr>
<td>• Letter, Legal, Tabloid, A3, A4, B4, and B5 sizes supported</td>
<td></td>
</tr>
<tr>
<td>Hole Punch</td>
<td>North America: 2–3 Hole Punch</td>
</tr>
<tr>
<td></td>
<td>Europe: 2–4 Hole Punch; 4 Hole Swedish Punch (Optional)</td>
</tr>
</tbody>
</table>
### BR Finisher with Booklet Maker

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tray Capacity</strong></td>
<td>• <strong>Offset (Top) Tray:</strong> 500 sheets of 8.5 x 11 in., A4 unstapled</td>
</tr>
<tr>
<td></td>
<td>• <strong>Stacking or Stapling Tray:</strong></td>
</tr>
<tr>
<td></td>
<td>– 1500 sheets of 8.5 x 11 in., A4, 11 x 17 in., A3, SRA3 unstapled</td>
</tr>
<tr>
<td></td>
<td>– 200 stapled sets of 8.5 x 11 in., A4 (single-position stapling, or dual</td>
</tr>
<tr>
<td></td>
<td>or 4-position stapling)</td>
</tr>
<tr>
<td></td>
<td>– 100 stapled sets of 11 x 17 in., A3, SRA3</td>
</tr>
<tr>
<td><strong>Sizes</strong></td>
<td>• Stacking: A6–SRA3, 4 x 6–12 x 19 in.</td>
</tr>
<tr>
<td></td>
<td>• Stapling: B5–A3, 7.25 x 10.5–11 x 17 in.</td>
</tr>
<tr>
<td><strong>Paper Weight</strong></td>
<td>52–400 g/m² uncoated and coated paper, for Top Tray and Stack Tray</td>
</tr>
<tr>
<td><strong>Stapling</strong></td>
<td>Single and multi-position stapling</td>
</tr>
<tr>
<td></td>
<td>• Auto stapling, 50 sheets maximum, 90 g/m², 24 lb.</td>
</tr>
<tr>
<td></td>
<td>• Letter, Legal, Tabloid, A3, A4, B4, and B5 sizes supported</td>
</tr>
<tr>
<td><strong>Hole Punch</strong></td>
<td><strong>North America:</strong> 2–3 Hole Punch</td>
</tr>
<tr>
<td></td>
<td><strong>Europe:</strong> 2–4 Hole Punch; 4 Hole Swedish Punch (Optional)</td>
</tr>
<tr>
<td><strong>Booklet Maker</strong></td>
<td>• Saddle stitch 2–16 sheets (7 sheets at 106–176 g/m² uncoated, or 5 sheets</td>
</tr>
<tr>
<td></td>
<td>at 177–220 g/m² coated)</td>
</tr>
<tr>
<td></td>
<td>• Bi-fold up to 5 sheets</td>
</tr>
<tr>
<td></td>
<td>• Letter, Legal, Tabloid, A3, A4, 12 x 18 in., SRA3 supported</td>
</tr>
</tbody>
</table>

### Interface Decurler Module and Interface Decurler Module with Inline Spectrophotometer (ILS)

The Interface Decurler Modules (IDM) are optional finishing devices that are used in conjunction with other optional finishing devices.

Two Interface Decurler Modules are available with the Xerox® Versant® 280 Press:

- Interface Decurler Module (IDM)
- Interface Decurler Module (IDM) with Inline Spectrophotometer (ILS)
The Interface Decurler Modules provide the following functions:

- Communication between the press and the attached finishing device
- An aligned paper path between the press and the attached finishing device
- Cooling and decurling of the paper as it exits the press

**Optional Performance Customization and the Interface Decurler Module with Inline Spectrophotometer**

There are three different performance customization configurations available with the press:

- **Xerox® Versant® 280 Press with basic print engine configuration performance**
- **Xerox® Versant® 280 Press with All Stock Rated Speed (ASRS) configuration performance** (optional)
  
  **Note:** If you purchase the optional All Stocks Rated Speed (ASRS) package, the Interface Decurler Module for All Stocks Rated Speed (ASRS) is required, regardless of any additional finishing devices.

- **Xerox® Versant® 280 Press with Performance Package (PP) configuration performance** (optional)
  
  **Note:** If the optional Performance Package is purchased, the Interface Decurler Module (IDM) with Inline Spectrophotometer (ILS) is required, regardless of any additional finishing devices.

**Important:** The All Stock Rated Speed (ASRS) configuration or the Performance Package can be ordered prior to initial installation of the system. It is not possible to upgrade an existing press with the ASRS or Performance Package after the press is ordered and installed.

With the Xerox® Versant® 280 Press with the All Stock Rated Speed (ASRS) performance option, the user experiences a 25 percent increase in handling heavyweight stock. The press does not require a standalone print server, and comes with the integrated Xerox® EX-i 280 Print Server, Powered by Fiery®.

The optional Performance Package is a suite of technologies and tools that enhances the capabilities of the base press in three areas: operational speed, color management automation, and print shop productivity.

The Performance Package is comprised of the following technologies and tools:

- **Xerox EX 280 Print Server:** The Performance Package is not available with other print servers.
- **All Stocks Rated Speed (ASRS) software:** The All Stocks Rated Speed (ASRS) feature eliminates the slower speeds created by heavier weight stocks. With ASRS, the speed of the press is governed by the size of the stock only and not by its weight. This means that all stock weights up to 400 g/m² for a given sheet size runs at the rated speed or the top speed for that stock size.
- **Automated Color Quality System (ACQS) software:** The Automated Color Quality System (ACQS) is an advanced color management technology that transfers the complex decisions about color maintenance from operators to an automated system. ACQS automates the printing and measuring of calibration charts and then calculates and makes precise adjustments to color tables based on the results.
  
  **Note:** The ACQS suite is available only with the external Xerox® EX 280 Print Server, Powered by Fiery®, it is not available with the Xerox® EX-i 280 Print Server, Powered by Fiery®.
ACQS takes the variability out of the color equation by incorporating standardized color measurements using the Inline Spectrophotometer to calibrate color on the press as well as generating accurate destination profiles for different stocks.

Procedures are automated in that they eliminate the need for an operator to manually scan target sheets using an external spectrophotometer. The operator must initiate the procedure at the print server, but all target sheets are then generated and scanned automatically and all measurements, calculations, and corrections are performed automatically.

- **Inline Spectrophotometer (ILS)** - included with the IDM with ILS:
  - The Inline Spectrophotometer (ILS) is housed in the Interface Decurler Module. The ILS enables the Automated Color Quality Suite, which automates the process of ensuring stable and accurate color from job to job, by eliminating the need for operators to use a hand-held spectrophotometer during print server calibration. It also facilitates the creation of custom destination profiles for each stock on which the press prints.
  - With the ILS is strategically placed within the paper path, automated processes like measurements for calibration and destination profiling are quick to perform and require less down-time for the press. Working together, the ACQS software and the ILS hardware gives accurate color faster and provides more stable color over time.
  - Besides the Inline Spectrophotometer (ILS), the Interface Decurler Module contains additional cooling to support the higher speeds of the press when running at higher speeds and a decurler component to ensure flat sheets for finishing.

**Configuration Information Regarding the Performance Package**

1. The Performance Package must be ordered when the press is ordered. Once the press has been configured without the Performance Package option, it cannot be upgraded at a later time to include the package.

2. The Performance Package is not available with the Xerox EX-i 280 Print Server. Customers must order the external Xerox EX 280 Print Server.

3. If customers configure the press with the Business Ready (BR) Finisher, the Business Ready Finisher with Booklet Maker, or the Offset Catch Tray, then the Performance Package option is not available for the configuration.

4. When the Performance Package is ordered, the Interface Decurler Module with ILS must be used. The package cannot be used with other Interface Decurler Modules.

5. Various finishing options are enabled when the Interface Decurler Module or the Interface Decurler Module with Inline Spectrophotometer (ILS) is installed.

**Finishing Devices that Require an Interface Decurler Module**

The following finishing devices require the Interface Decurler Module or the Interface Decurler Module with Inline Spectrophotometer (ILS):

- Inserter device
- GBC® AdvancedPunch® Pro
- High Capacity Stacker (HCS)
- Two-Sided Trimmer
- C/Z Folder
• Production Ready (PR) Finisher
• PR Booklet Maker Finisher
• PR Finisher Plus
• Xerox® SquareFold® Trimmer device, this device requires the PR Booklet Maker Finisher
• Plockmatic® Pro 35 and Plockmatic® Pro 50, this device requires the PR Finisher Plus

**Interface Decurler Module Components**

1. Paper Jam and Error Indicator Panel
2. Interface Decurler Module Front Cover

**Control Panel on the Interface Decurler Module**

1. Paper Jam and Error Indicator
2. Curl Up and Down Indicators
5. Auto Curl Button and Indicator

Curl Correction on the Interface Decurler Module

**Tip:** The purpose of this curl correction is to fix paper curl as it leaves the press but before it reaches the next inline-finishing device. Use the Interface Decurler Module (IDM) curl correction feature while the press is printing.

1. Printed Media from the Press
2. Interface Decurler Module paper path
3. Printed media from the Interface Decurler Module to inline finishing device

As media enters the module, it feeds into the IDM decurler for paper curl correction. The IDM decurler has both upper and lower decurler rolls that apply pressure to the media based on the following:

- System default, **Auto** on
- Manual selections made from the IDM control panel

If you want to adjust the paper curl on the printed output quickly, use the manual curl up or down buttons. After you use these buttons, if the printed output contains too much curl, refer to the *System Administrator Guide*, the section entitled *Custom Paper Settings, Adjust Paper Curl*.

From the decurler, the printed media is cooled and routed from the Interface Decurler Module to the next inline finishing device that is connected to the press.

Curl Correction Modes and Functions on the Interface Decurler Module

**Note:** When an Interface Decurler Module (IDM) curl correction mode is selected, the new mode is applied to the next sheet that is delivered to the IDM.
### Indicator Mode Function

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Mode</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="VP3100_036" alt="Auto Indicator" /></td>
<td>Auto</td>
<td>This is the default mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Automatically corrects the paper curl by selecting the curl direction and amount. This is based on the paper size and orientation and on the finishing device that is receiving the output. Automatic decurl mode flattens output sheet-by-sheet based on environment, paper weight, area coverage, and 1-sided or 2-sided printing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- When <strong>Auto</strong> is selected, the indicator to the right of the button is illuminated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- This mode has seven automated settings for controlling paper curl: three upcurl settings, three downcurl settings, and mid-range.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- When <strong>Auto</strong> mode is in use, an indicator flashes momentarily on the control panel. The control panel shows the preselected curl direction and amount of decurl applied to the paper.</td>
</tr>
<tr>
<td><img src="VP3100_037" alt="Mid-range Indicator" /></td>
<td>Mid-range</td>
<td>When this indicator is illuminated for either Auto mode or Manual mode, no curl correction is applied to the printed output.</td>
</tr>
<tr>
<td>Indicator</td>
<td>Mode</td>
<td>Function</td>
</tr>
<tr>
<td>-----------</td>
<td>------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| ![Indicator](image1.png) | Manual Upward Curling | - When the printed output is curled upwards, select the curl-up button.  
- There are three upward curl correction values.  
- The top three indicators show which level of upward curl correction is selected.  
- The top indicator is the highest amount of upward curl correction that can be applied to a printed output. |
Indicator Mode Function

- When the printed output is curled downwards, select the curl-down button.
- There are three downward curl correction values.
- The bottom three indicators show which level of downward curl correction is selected.
- The bottom indicator is the lowest amount of downward curl correction that can be applied to a printed output.

Pressing the curl-up button changes the curl correction levels as shown:

Pressing the curl-down button changes the curl correction levels as shown:
Inserter Device

Note: This optional finishing device requires an Interface Decurler Module.

Use the Inserter device to load stock, such as blank, preprinted, or special stock, which is inserted into the finished output. This stock serves as separators and covers for the finished output. Paper fed from the Inserter device is not printed on; however, the paper is placed into the printed output at selected locations.

Note: The Inserter device sometimes is referred to as the post-process inserter or the interposer.

Inserter Components

1. Tray T1 or Inserter Tray
2. Inserter Control Panel
3. Inserter Front Cover
## Inserter Control Panel

<table>
<thead>
<tr>
<th>Number</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Paper Jam Error Indicator</td>
<td>This indicator lights when a paper jam occurs in the Inserter.</td>
</tr>
</tbody>
</table>
| 2      | Curl Up/Down Indicators        | Similar to the Interface Decurler Module (IDM), these indicators show the direction of the curl correction. However, there are only three curl correction options for the Inserter:
|        |                                | • One upward curl correction; this is the top indicator.                   |
|        |                                | • One downward curl correction; this is the bottom indicator.              |
|        |                                | • Off (no curl correction); this is the middle indicator.                 |
| 3      | Manual Curl Up Button          | When the printed output is curled upwards, select the curl-up button.      |
| 4      | Manual Curl Down Button        | When the printed output is curled downwards, select the curl-down button.  |
| 5      | Auto Curl Button               | Automatically corrects the paper curl by selecting the curl direction and amount. |

**Important:** Use one of the following buttons only if paper curl continues after setting the curl correction level to the highest or lowest setting on the Interface Decurler Module (IDM).

### Paper and Media for Inserter Tray T1

**Tip:** Paper fed from the Inserter device is not printed on; however, the paper is placed into the printed output at selected locations.
Supported Paper for the Inserter Tray T1

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Paper Weight</th>
<th>Tray Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>182 x 148– 30 x 488 mm (7.2 x 5.8–13 x 19.2 in.), A3</td>
<td>52–400 g/m² coated and uncoated</td>
<td>250 sheets, based on Colotech+90</td>
</tr>
</tbody>
</table>

Note: When the Inserter Tray is filled with 8.5 in. wide (SEF) media, its default size is 8.5 x 14 in. If you insert 8.5 x 11 in. media, it is necessary to use Admin Mode Tools to adjust the default value of NVM 769-503. For more information, refer to the System Administrator Guide.

When you combine the following paper types with saddle stitch or bi-fold, use Tray 5 (Bypass):
- Coated paper that weighs 127 g/m² or less
- Blank sheets or unprinted paper that weighs 80 g/m² or less

Note: If a tray other than Tray 5 is used, the combination can cause misalignment of folding positions and wrinkle.

Loading Paper in Inserter Tray T1

Before using tray T1, review the following guidelines:
- Remove any remaining paper from the tray.
- Load all the paper required for the job into the tray.
- To use saddle stitch / bi-fold options, ensure that the paper loaded in the main feeding tray (for example, tray 1) is the same size as the paper loaded in tray T1.
- For supported paper information, refer to Supported Paper for the Inserter Tray T1.

To insert separator sheets or cover sheets, such as blank or preprinted sheets, use the Inserter Tray T1. Paper loaded in tray T1 is inserted into the finished / printed output. A maximum of 250 sheets (Colotech+90) may be loaded in tray T1.

Tip: Paper fed from the Inserter device is not printed on; however, the paper is placed into the printed output at selected locations.

1. Load the paper, aligning all edges.

If the paper is preprinted, load the paper with the printed side facing up.

Note: Do not load paper above the maximum fill line. It may cause paper jams or press malfunctions.
2. Hold the center of the paper guides and gently slide them to the desired paper size so that they are touching the edges of the paper.

If the distance between the guides is too long or short relative to the paper, paper jams may occur.

If set by the system administrator, the Tray Properties window displays on press UI.

3. From the Tray Properties window, enter or verify the correct paper information.

4. Select **OK** to save the information and close the Tray Properties window.

**Printing on Special Media**

**Hole-punched Paper**

Load hole-punched paper into tray T1 long-edge feed (LEF) with the holes on the right side as you face the front of the Inserter device.

**Tab Stock**

Load tab stock paper in tray T1 long-edge feed (LEF) with the tabs on the left side as you face the front of the Inserter device.
Purge Function for Tray T1

If tray T1 runs out of paper, the press stops printing. When this happens, any printed output leaving
the press is delivered to the inline finishing device output tray.

Tip: Do not reuse the output that is ejected by the purge function as this may cause paper
jams.

To prevent the purge function from occurring when tray T1 runs out of paper, the function may be
disabled or switched off from the press Tools mode.

Important: Only a system administrator for the press can change the setting for the purge
function for tray T1.

Tray T1 Purge Function Settings

The purge function allows you to specify how the press behaves when tray T1 is used. The purge
function has two settings:

Standard

For each printed set that requires the inclusion of paper into the finished set, the press checks that
paper is loaded in tray T1 before it starts printing.
This setting increases the wait time between sets, which causes decreased productivity. However,
paper purging does not occur even if tray T1 runs out of paper.

Speed First

The printer starts printing regardless of the paper status of tray T1.
This setting maintains productivity based on press productivity. However, paper is purged from the
press and the press stops printing when tray T1 runs out of paper.

Note: Speed First is the default setting for the tray T1 purge function.

Changing the Purge Function Setting for Tray T1

Important: The following procedure must be performed by a system administrator with press
administrator login authority.

1. Log in as the administrator.
2. On the control panel, press the Machine Status button.
3. Touch the Tools tab.
4. Select System Settings > Common Service Settings.
5. Select **Maintenance**.
   The Maintenance screen displays.

6. Use the up/down arrows to scroll through the Maintenance screens until you see **Print Action When Using Tray T1 (Inserter)**

7. Select **Print Action When Using Tray T1 (Inserter)**.
   The Tray T1 purge function screen displays.

8. Select the desired purge function option:
   - **Standard**: Select this option to switch off the purge function. It decreases productivity, but the press continues to run even when tray T1 runs out of paper. This may cause some printed output sets to be delivered to the designated finishing tray without inserts.
   - **Speed First**: This setting maintains productivity. Select this option to have the press stop printing and purge paper when tray T1 runs out of paper.

      ![Note: Speed First is the default setting.](image)

9. Select **Save** or **OK**.
   The Maintenance screen displays.

10. Select **Close**.
    The main Tools tab screen displays.

11. Exit the administrator mode.

**GBC® AdvancedPunch® Pro**

The GBC® AdvancedPunch® Pro is an automatic hole punch module that integrates with the press to streamline the production of reports, directories, pricing guides and other bound books. It equals or betters traditional quality while saving time and increasing productivity by eliminating the labor-intensive steps of manual punching. The compact AdvancedPunch® Pro takes minimal space and accepts a variety of optional multiple hole punch die sets.

The AdvancedPunch® Pro can be connected to a variety of optional finishing devices and sits inline with these devices.

![Note: This optional finishing device requires an Interface Decurler Module.](image)
The AdvancedPunch® Pro provides the following capabilities:

- A bigger range of media sizes and types
- Trail edge, LEF and SEF punching
- Die set detection control panel shows die type and cycle count
- User Die set options include comb, wire, coil, and 3-7 hole varieties to enable most popular binding formats
- Operates at rated print engine speed for most paper sizes
- Quick-change die sets that can be interchanged without any tools
- All die sets include an Identification Label providing the user with the hole pattern and name
- Convenient storage area for two extra Die Sets which is located above the sheet bypass on the device

For detailed information and instructions to use the AdvancedPunch® Pro, refer to the press User Documentation or go to www.xerox.com/gbc-advancedpunch-pro.

**High Capacity Stacker (HCS)**

*Note:* This optional finishing device requires the Interface Decurler Module.

The High Capacity Stacker (HCS) is an optional finishing device that provides large-capacity stacking and offsetting capabilities for production output to a stacker tray and cart. The HCS also provides a top tray convenient for short stack runs.
## High Capacity Stacker (HCS) Components

<table>
<thead>
<tr>
<th>Number</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Paper jam and error indicators</td>
<td>These indicators light when a paper jam occurs in HCS areas E1-E8.</td>
</tr>
<tr>
<td>2</td>
<td><strong>Sample</strong> button</td>
<td>Press this button to have the HCS deliver a sample sheet to the top tray. The indicator to the left of the button blinks until a sample sheet is delivered to the top tray.</td>
</tr>
<tr>
<td>3</td>
<td><strong>Unload</strong> button</td>
<td>Press this button to stop printing and remove paper.</td>
</tr>
<tr>
<td>4</td>
<td>Top tray</td>
<td>Receives the printed output. Sample sheets also are delivered here. Holds a maximum of 500 sheets (13 x 19.2 in., 330 x 488 mm).</td>
</tr>
<tr>
<td>5</td>
<td>Circuit breaker switch</td>
<td>The circuit breaker switch is located on the rear of the HCS. This switch automatically shuts off electricity in the event of electrical failure or a short circuit.</td>
</tr>
<tr>
<td>6</td>
<td>Top cover</td>
<td>Open this cover to clear paper jams.</td>
</tr>
<tr>
<td>Number</td>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>7</td>
<td>Stacker tray/cart</td>
<td>Collated sets (up to a total of 5000 sheets) are transported to the stacker tray, which is located on a movable stacker cart.</td>
</tr>
<tr>
<td>8</td>
<td>Front door</td>
<td>Open this door to remove paper/printed output.</td>
</tr>
</tbody>
</table>

**HCS Circuit Breaker**

The HCS circuit breaker is located on the rear of the HCS unit.

1. **On or Off Switch**
2. **Test Button**

The circuit breaker switch is normally in the **ON** position.

> **Note:** When an electrical interruption is detected, the circuit breaker automatically switches off to discontinue the electrical flow to the HCS. For electrical information, refer to Safety.

**Output Trays**

The High Capacity Stacker (HCS) has two output trays.
1. Top Tray
2. Stacker Tray or Cart

The Top Tray offers the following:

- Convenience for short stack runs (up to 500 sheets) without offsetting
- Delivery of purged sheets

**Control Buttons**

1. Sample button: Press this button to output a sample sheet to the top tray.
2. Unload button: Press this button to stop printing and remove paper.

**Unloading the Stacker Tray or Cart**

>Note: The HCS may be unloaded while it is running.

1. Press the **Unload** button on the HCS control panel.
2. After the Unload Indicator lights, open the HCS front door.
3. Position the securing bar on top of the stacked paper.
4. Pull the **Stacker Cart** straight out of the HCS.
5. Remove the securing bar.
6. Remove the paper from the stacker tray.
7. Push the empty **Stacker Cart** straight into the HCS.
8. Position the securing bar on the fixed area inside the HCS.
9. Close the front door; the tray will rise to the operate position.
## HCS Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tray capacity</strong></td>
<td></td>
</tr>
<tr>
<td>Top tray</td>
<td>500 sheets</td>
</tr>
<tr>
<td>Stacker tray or cart</td>
<td>5,000 sheets</td>
</tr>
<tr>
<td><strong>Note:</strong> The values are based on paper less than 80 g/m²</td>
<td></td>
</tr>
</tbody>
</table>

### Paper size

<table>
<thead>
<tr>
<th>Paper size</th>
<th>Top tray</th>
<th>Standard size</th>
<th>Minimum</th>
<th>Postcard</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4 x 6 in.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>100 x 148 mm</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Maximum</td>
<td>13 x 19 in.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>A3</td>
</tr>
<tr>
<td>Custom size</td>
<td></td>
<td>Height</td>
<td>3.9–13 in.</td>
<td>98.0–330.2 mm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Width</td>
<td>6-26 in.</td>
<td>148.0–660.4 mm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Stacker tray or cart</th>
<th>Standard size</th>
<th>Minimum</th>
<th>JIS BS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Maximum</td>
<td>13 x 19 in.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A3</td>
</tr>
<tr>
<td>Custom size</td>
<td>Height</td>
<td>8–13 in.</td>
<td>203.0–330.2 mm</td>
</tr>
<tr>
<td></td>
<td>Width</td>
<td>7.2–19.2 in.</td>
<td>182.0–488.0 mm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper weight</th>
<th>Top Tray</th>
<th>52–400 g/m², coated and uncoated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stacker tray or cart</td>
<td>52–400 g/m², coated and uncoated</td>
<td></td>
</tr>
</tbody>
</table>

### HCS Media Guidelines

- Stacker tray/cart accepts 52–400 g/m² coated or uncoated stock with the possibility of degraded stack quality and increased jam rate for stocks that are heavier than 300 g/m².
- Transparencies can be run to the top tray or to the stacker tray/cart. Stack height should be limited to 100 transparencies.
- Coated paper lighter than 100 g/m² cannot run as reliably as coated paper heavier than 100 g/m².
- Non-standard papers longer than 305 mm (12 in.) in the feed direction require 210 mm (8.3 in.) minimum measurement across the feed direction.
- Non-standard papers shorter than 254 mm (10 in.) in the cross-feed direction require 330 mm (13 in.) minimum measurement in the feed direction.
Crease and Two-Sided Trimmer

Note: This optional finishing device requires the Interface Decurler Module.

The Crease and Two-Sided Trimmer is an optional finishing device that provides trimming on two sides of the output.

- Trims 6–25 mm (0.24–0.99 in.) from the top and bottom of prints or booklets to produce an even edge.
- When paired with the SquareFold® Trimmer, all sides of booklets are trimmed except the binding, which enables full-bleed booklets. For more information, refer to SquareFold Trimmer Device.
- Trims paper sizes 182 x 257–330 x 488 mm (7.2 x 10.1–3 x 19.2 in.). If the trimmed output is for booklet making, the minimum paper size is 194 x 257 mm (7.6 x 10.1 in.).
- Handles uncoated and coated paper 52–350 g/m².

Crease and Two-Sided Trimmer Components
<table>
<thead>
<tr>
<th>Number</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Paper jam and error indicator</td>
<td>This indicator lights when a paper jam occurs. If the indicator blinks, you must clear the paper jam before printing can resume.</td>
</tr>
<tr>
<td>2</td>
<td>Trimmer Waste Container Full indicator</td>
<td>This indicator lights when it is time to empty the Trimmer Waste Container and blinks when the container is full.</td>
</tr>
<tr>
<td>3</td>
<td>Upper cover</td>
<td>Open this cover to clear paper jams.</td>
</tr>
<tr>
<td>4</td>
<td>Lower cover</td>
<td>Open this cover to empty the Trimmer Waste Container.</td>
</tr>
</tbody>
</table>

### Crease and Two-Sided Trimmer Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two-sided Trim</td>
<td></td>
</tr>
<tr>
<td>Paper size</td>
<td>Standard size</td>
</tr>
<tr>
<td></td>
<td>Minimum</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 in.)</td>
</tr>
<tr>
<td></td>
<td>A4</td>
</tr>
<tr>
<td></td>
<td>Maximum</td>
</tr>
<tr>
<td></td>
<td>13 x 19 in.</td>
</tr>
<tr>
<td></td>
<td>A3</td>
</tr>
<tr>
<td></td>
<td>Custom size</td>
</tr>
<tr>
<td></td>
<td>Height</td>
</tr>
<tr>
<td></td>
<td>7.7–13 in.</td>
</tr>
<tr>
<td></td>
<td>194.0–330.2 mm</td>
</tr>
<tr>
<td></td>
<td>Width</td>
</tr>
<tr>
<td></td>
<td>8.26–19.2 in.</td>
</tr>
<tr>
<td></td>
<td>10.0–488.0 mm</td>
</tr>
<tr>
<td>Paper weight</td>
<td>Uncoated</td>
</tr>
<tr>
<td></td>
<td>52–350 g/m²</td>
</tr>
<tr>
<td></td>
<td>Coated</td>
</tr>
<tr>
<td></td>
<td>52–350 g/m²</td>
</tr>
<tr>
<td>Trimming size</td>
<td>0.24–0.99 in.</td>
</tr>
<tr>
<td></td>
<td>6–25 mm</td>
</tr>
</tbody>
</table>

**Note:** Setting a head-to-toe trimming area size of 7 mm (0.275 in.) or less can cause damage of the trimmed edges.

### C/Z Folder

The C/Z Folder is available only with one of the optional Production Ready (PR) Finishers. For more information, refer to Production Ready (PR) Finishers.

**Note:** This optional finishing device requires the Interface Decurler Module.

The C/Z Folder is an optional finishing device that provides Envelope Folding (C-Fold and Z-Fold) for 8.5 x 11 in. and A4 media and large sheet folding (Half-Sheet Z-Fold) for 11 x 17 in. and A3 media.

Folded output is produced by selecting the **Fold** feature.
- For network print jobs, select the Fold feature from the print drive.
- For copy and scan jobs, select the Fold feature from the scanner.
  
  **Note:** Copy and scan jobs are applicable only if the press includes a scanner.
- To use the Fold feature, the orientation of documents must be short-edge feed (SEF).
- Select a tray that contains SEF media.
- There are three types of folds available: C-Fold, Z-Fold, and Z-Fold Half-Sheet.

### C/Z Fold Types

**C-Fold**

A C-Fold has two folds, which create a three-panel output.

![C-Fold Diagram]

**Z-Fold**

A Z-Fold has two folds that are folded in opposite directions, resulting in a type of fan fold.

![Z-Fold Diagram]

**Z-Fold Half Sheet (shown here with 3-hole punch)**

As with a regular Z-Fold, the Z-Fold Half-Sheet has two folds that are folded in the opposite directions. The difference between a regular Z-Fold and a Z-Fold Half Sheet is that the Z-Fold Half Sheet is not folded in two equal folds. The two folds are unequal which allows one edge of the Z-Fold Half Sheet to have a longer edge. The longer edge allows for stapling or hole punching.
C/Z Folder Components

Note: For detailed information about the folding feature, refer to the System Administrator Guide.

<table>
<thead>
<tr>
<th>Number</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>C/Z fold output tray</td>
<td>Receives output sheets.</td>
</tr>
<tr>
<td>2</td>
<td>C/Z fold output tray button</td>
<td>Press this button to open the output tray.</td>
</tr>
</tbody>
</table>
C/Z Fold Output

<table>
<thead>
<tr>
<th>Number</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>C/Z fold output tray button</td>
<td>When you press the button, the indicator flashes. When the output tray is unlocked and the indicator shows a steady light on (no blinking), pull out the output tray.</td>
</tr>
<tr>
<td>2</td>
<td>C/Z fold output tray</td>
<td>C-Fold or Z-Fold jobs are delivered to this tray only. Note: C/Z Fold jobs cannot be delivered to any other tray.</td>
</tr>
</tbody>
</table>

C/Z Folder Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z-Fold Half Sheet</td>
<td>Paper size</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Paper weight</td>
</tr>
<tr>
<td>Trifold (C or Z)</td>
<td>Paper size</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Item Specification

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper weight</td>
<td>60–105 g/m², uncoated</td>
</tr>
<tr>
<td>Tray capacity</td>
<td>30 sheets</td>
</tr>
</tbody>
</table>

*Note: Values are based on Colotech+90.*

---

**Production Ready (PR) Finishers**

*Note: These optional finishing devices require the Interface Decurler Module.*

Three Production Ready (PR) Finishers are available with your press.

- Product Ready (PR) Finisher
- Product Ready (PR) Booklet Maker Finisher
- Product Ready (PR) Finisher Plus

*Note: Throughout this section, the three PR Finishers are referred to simply as the Finisher. Any differences between the finishers are distinguished by using the specific finisher name.*

The Production Ready (PR) Finishers provide the following capabilities:

- Handling media that is smaller than 5.83 x 8.27 in., A5.
- Stapling up to 100 sheets with one or two staples.
- Handling large-sized paper, maximum size of 13 x 19.2 in., 330.2 x 488 mm.
- For coated stocks, stapling a maximum of 35 pages.
- For the PR Finisher Plus only: Feeding the output media from the press and any inline finishing devices to a third-party DFA device.

*Note: The optional C/Z Folder is available with all three Production Ready (PR) Finishers.*

**Production Ready (PR) Finisher**

The PR Finisher consists of:
- Two output trays: Top Tray and Stacker Tray
- Stapler
- Optional Basic Punch

**Production Ready (PR) Booklet Maker Finisher**

The Production Ready (PR) Booklet Maker Finisher provides all the same features as the PR Finisher plus it automatically creates saddle-stitched booklets of up to 30 sheets and bi-folding, also called single-folding.

The Production Ready (PR) Booklet Maker Finisher consists of:
- Three output trays: Top Tray, Stacker Tray, Booklet Output Tray
- Booklet Maker Unit
- Stapler
- Optional Basic Punch

**Production Ready (PR) Finisher Plus**

The Production Ready (PR) Finisher Plus consist of:
- Two output trays: Top Tray and Stacker Tray
- Stapler
- Optional Basic Punch
The Production Ready (PR) Finisher Plus serves as an interface to transfer paper between the press and any third-party, Document Finishing Architecture (DFA) device attached to the press.

**Finisher Components**

1. Paper Jam and Error Indicator
2. Top Tray
3. Stacker Tray
4. Booklet Tray*
5. Booklet Output Button*
6. Front Cover
7. Staple Waste Container
8. Basic Staple Cartridge for Side Stitch
9. Two Booklet Staple Cartridges for Saddle Stitch*
10. Hole Punch Waste Container

* Note: * Available only with the PR Booklet Maker Finisher.
Finisher Output Trays

1. Top tray
2. Stacker tray
3. Booklet tray*

*Available only with the PR Booklet Maker Finisher.

Top Tray

If output sheets are not fully ejected, this causes the press to detect a Paper Full condition. If this condition is detected frequently, change the angle of the top tray.

Refer to the following guidelines for changing the top tray angle:

- For normal usage, keep the tray in its lower, default position.

  **Important:** Continual usage of the tray in the upper position, may cause paper jams or output sheets to fall from the tray upon delivery.

- When using the following paper types, change the angle of the tray to its upper position. These paper types may cause frequent Paper Full conditions:
  - Light-weight (106 g/m² or lighter) coated paper
  - Coated paper whose edges are 364 mm or longer
  - Long paper

  **Note:** If sheets are curled, changing the tray angle has no effect.
To change the angle of the tray:
1. Pull the top tray from the lower seating (A) by pulling it toward the right.
2. Insert the clutches at the lead edge of the tray into upper seating (B).

Stacker Tray
Side stitch jobs are delivered to this tray only.

Note: Delivering 2,000 or more sheets to this tray with excessive downward curl may cause the output stack to fall out of the tray. If this happens, set the curl correction level on the Interface Decurler Module to its lowest level and set curl correction on the Inserter setting to downward. For information, refer to Paper Curl Correction with the PR Finishers.

Booklet Tray

Note: The booklet tray is attached to PR Booklet Maker Finisher. However, if the SquareFold Trimmer is installed, the booklet tray is attached to SquareFold Trimmer.

Bi-Fold and Bi-Fold with Saddle Stitch jobs are delivered to this tray only.
Top Tray Aligner Accessory

The Xerox Top Tray Aligner Accessory is an additional component for the top tray of the Production Ready Finishers. This accessory improves the stack quality of the Production Ready Finishers. The Top Tray Aligner Accessory aligns any small-size stock that goes on the top tray, such as small sheets, postcards, and envelopes.

To install the Top Tray Aligner Accessory on a Production Ready Finisher, do the following:

1. Empty the top tray of the Production Ready Finisher.

2. Place the Top Tray Aligner Accessory on the top tray of the PR Finisher. Adjust the alignment between the top tray and the Tray Aligner Accessory.
3. To achieve better stacking of the media, adjust the movable document guides on the Top Tray Aligner Accessory. To align the document guides with the media, put the media on the Top Tray Aligner Accessory, then adjust the guides.

4. To align the document guides for envelopes or small stocks, put an envelope on the Top Tray Aligner Accessory, then adjust the document guides.

**Paper Curl Correction with the PR Finishers**

If sheets are curled when delivered any of the finisher trays, refer to the following information:

- Printing on 5.83 × 8.27 in., A5, LEF paper with upward curl may cause paper jams. If this occurs, set the curl correction level on the Interface Decurler Module to its **highest** setting and on the Inserter, set it to **upward**.

- Printing on heavyweight paper with downward curl may cause paper jams. If this occurs, set the curl correction level on the Interface Decurler Module to its **lowest** setting and on the Inserter, set it to **downward**.

- Printing on paper weighing 157 g/m² or heavier with up curl may cause paper jams. If this occurs, set the curl correction level on the Interface Decurler Module to its **highest** setting and on the Inserter, set it to **upward**.

For more information about the paper curl correction features, refer to **Curl Correction Modes and Functions on the Interface Decurler Module and Inserter Control Panel**.

**Bi-Fold Feature for the Production Ready Booklet Maker Finisher**

- **Note:** The Bi-Fold feature is available only with the Production Ready (PR) Booklet Maker Finisher.

- To use the Bi-Fold feature, the orientation of documents must be short-edge feed (SEF). You must select a tray that contains SEF stock.

- The Bi-Fold feature is selected from the print driver (for network print jobs) or from the scanner (for copy and scan jobs; applicable only if the press is a combination copier and printer).

- Bi-Fold is sometimes referred to as Single Fold.

- **Important:** The C-Fold and Z-Fold options are available only with the C/Z Folder; for more information, refer to **C/Z Folder**.

A Bi-Fold (Single Fold) has one fold which creates two panels to the output.
There are three Bi-Fold options available:

- Bi-Fold Single Sheet
- Bi-Fold Multiple Sheets
- Bi-Fold Multiple Sheets Stapled

*Note:* For detailed information about fold types, refer to the *Adjust Fold Positions in System Administrator Guide.*

**Booklet Output Button on the Production Ready Booklet Maker Finisher**

Press this button to remove finished booklets from the finisher.

*Note:* If the SquareFold Trimmer is installed, pressing this button moves the booklets to the booklet tray installed on SquareFold Trimmer.

**PR Finisher Specifications**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray</td>
<td>Top tray</td>
</tr>
<tr>
<td></td>
<td>Collate and stack</td>
</tr>
<tr>
<td>Item</td>
<td>Specification</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Stacker tray</strong></td>
</tr>
<tr>
<td></td>
<td>Collate (offsetting supported) and stack (offsetting supported)</td>
</tr>
<tr>
<td></td>
<td><strong>Booklet tray</strong></td>
</tr>
<tr>
<td></td>
<td>Collate and stack</td>
</tr>
<tr>
<td>Paper size</td>
<td><strong>Top tray</strong></td>
</tr>
<tr>
<td></td>
<td>Standard size</td>
</tr>
<tr>
<td></td>
<td>Minimum Postcard (100 x 148 mm)</td>
</tr>
<tr>
<td></td>
<td>Maximum 13 x 19 in., A3</td>
</tr>
<tr>
<td></td>
<td>Custom size</td>
</tr>
<tr>
<td></td>
<td>Height 98–330.2 mm</td>
</tr>
<tr>
<td></td>
<td>Width 148–660.4 mm</td>
</tr>
<tr>
<td></td>
<td><strong>Stacker tray</strong></td>
</tr>
<tr>
<td></td>
<td>Standard size</td>
</tr>
<tr>
<td></td>
<td>Minimum 5.83 x 8.27 in., A5</td>
</tr>
<tr>
<td></td>
<td>Maximum 13 x 19 in., A3</td>
</tr>
<tr>
<td></td>
<td>Custom size</td>
</tr>
<tr>
<td></td>
<td>Height 148.0–330.2 mm</td>
</tr>
<tr>
<td></td>
<td>Width 148.0–488.0 mm</td>
</tr>
<tr>
<td></td>
<td><strong>Booklet tray</strong></td>
</tr>
<tr>
<td></td>
<td>Standard size</td>
</tr>
<tr>
<td></td>
<td>Minimum JIS B5</td>
</tr>
<tr>
<td></td>
<td>Maximum 13 x 19 in., A3</td>
</tr>
<tr>
<td></td>
<td>Custom size</td>
</tr>
<tr>
<td></td>
<td>Height 182–330.2 mm</td>
</tr>
<tr>
<td></td>
<td>Width 257–488 mm</td>
</tr>
<tr>
<td>Paper weight</td>
<td><strong>Top tray</strong></td>
</tr>
<tr>
<td></td>
<td>52–400 g/m²</td>
</tr>
<tr>
<td></td>
<td><strong>Stacker tray</strong></td>
</tr>
<tr>
<td></td>
<td>52–400 g/m²</td>
</tr>
<tr>
<td></td>
<td><strong>Booklet tray</strong></td>
</tr>
<tr>
<td></td>
<td>60–350 g/m²</td>
</tr>
<tr>
<td>Tray capacity</td>
<td><strong>Top tray</strong></td>
</tr>
<tr>
<td></td>
<td>500 sheets</td>
</tr>
<tr>
<td></td>
<td><strong>Stacker tray</strong> (without staples)</td>
</tr>
<tr>
<td></td>
<td>8.5 x 11 in., A4</td>
</tr>
<tr>
<td></td>
<td>PR Finisher: 3,000 sheets</td>
</tr>
<tr>
<td></td>
<td>PR Booklet Maker Finisher: 2000 sheets</td>
</tr>
<tr>
<td></td>
<td>JIS B4 or larger</td>
</tr>
<tr>
<td></td>
<td>1500 sheets</td>
</tr>
<tr>
<td></td>
<td>Mix stack</td>
</tr>
<tr>
<td></td>
<td>350 sheets</td>
</tr>
<tr>
<td></td>
<td><strong>Stacker tray</strong> (with staples)</td>
</tr>
<tr>
<td></td>
<td>8.5 x 11 in., A4</td>
</tr>
<tr>
<td></td>
<td>PR Finisher: 200 sets or 3000 sheets</td>
</tr>
<tr>
<td></td>
<td>PR Booklet Maker Finisher: 2000 sheets</td>
</tr>
<tr>
<td></td>
<td>JIS B4 or larger</td>
</tr>
<tr>
<td></td>
<td>100 sets or 1500 sheets</td>
</tr>
<tr>
<td></td>
<td><strong>Booklet tray</strong></td>
</tr>
<tr>
<td></td>
<td>20 sets</td>
</tr>
</tbody>
</table>

**Note:** The values are based on Colotech+90. Mix stack means a set of paper sheets where larger sheets are placed over smaller ones. For example, A4 over JIS B5 or JIS B4 over A4. The booklet tray capacity is 16 sets if one set consists of 17 or more sheets.

<p>| Staple   | Capacity | 100 sheets |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> The values are based on Colotech+90. Five sheets larger than A4 Letter (8.5 x 11 in.)</td>
<td></td>
</tr>
<tr>
<td>Paper size</td>
<td><strong>Standard size</strong> Minimum 5.83 x 8.27 in., A5 Maximum Tabloid (11 x 17 in.), A3 Custom size Height 182–297 mm Width 148–432 mm</td>
</tr>
<tr>
<td>Paper weight</td>
<td>Uncoated 52–350 g/m² Coated 52–350 g/m²</td>
</tr>
<tr>
<td>Stapling position</td>
<td>1 place, 2 places or 4 places</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> The number of punch holes you can choose depends on the paper size.</td>
<td></td>
</tr>
<tr>
<td>Punch (with Punch Unit)</td>
<td><strong>Paper size</strong> Standard size Maximum A3, Tabloid (11 x 17 in.) Minimum 2-hole or 3-hole 4-hole A4, 16K Custom size Height 203–297 mm Width 182–431.8 mm</td>
</tr>
<tr>
<td>Paper weight</td>
<td>Uncoated 52–220 g/m² Coated 72–200 g/m²</td>
</tr>
<tr>
<td>Number of Holes</td>
<td>2, 4-hole or US 2, 3-hole</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> The values are based on Colotech+90.</td>
<td></td>
</tr>
<tr>
<td>Saddle Stitch / Bi-Fold</td>
<td><strong>Capacity</strong> Saddle Stitch 30 sheets Bi-Fold 5 sheets</td>
</tr>
<tr>
<td>PR Booklet Maker Finisher</td>
<td><strong>Paper size</strong> Standard size Maximum 13 x 19 in., A3 Minimum JIS B5 Custom size Height 182–330.2 mm Width 257–488 mm</td>
</tr>
<tr>
<td>Paper weight</td>
<td>Uncoated 52–300 g/m²</td>
</tr>
<tr>
<td>Item</td>
<td>Specification</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------</td>
</tr>
<tr>
<td></td>
<td>Coated</td>
</tr>
<tr>
<td></td>
<td>52–300 g/m²</td>
</tr>
</tbody>
</table>

**Staple Output Capacity**

<table>
<thead>
<tr>
<th>Paper weight (g/m²)</th>
<th>Side Stitch</th>
<th></th>
<th></th>
<th>Saddle Stitch</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A4 or smaller</td>
<td>Larger than A4</td>
<td></td>
<td>Uncoated</td>
</tr>
<tr>
<td></td>
<td>Uncoated</td>
<td>Coated</td>
<td>Uncoated</td>
<td>Coated</td>
</tr>
<tr>
<td>52–59</td>
<td>100</td>
<td>35*</td>
<td>65</td>
<td>35*</td>
</tr>
<tr>
<td>60–71</td>
<td></td>
<td>30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>72–80</td>
<td>35</td>
<td>35</td>
<td>35</td>
<td>25</td>
</tr>
<tr>
<td>81–90</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>91–105</td>
<td>50</td>
<td>30</td>
<td>50</td>
<td>30</td>
</tr>
<tr>
<td>106–128</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>129–150</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>151–176</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>177–220</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>221–256</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>257–300</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>301–350</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Can be stapled; however, binding accuracy or paper feed performance cannot be guaranteed.

Values in the table indicating the maximum number of sheets that can be stapled have been evaluated using the following paper types: 82 g/m², Colotech+ (200 g/m², 250 g/m², 350 g/m²).

Even for a print job whose number of pages is within the limit, staple faults can occur depending on the following conditions:

- Type of paper, such as Gloss Coated Paper
- Environment where the press is installed, such as room temperature, humidity, and others
- Print data, even if you use recommended paper types
- The job is made of a mixture of paper type or paper weight

**Important:** In an environment at a low temperature and low humidity, stapling of 40 sheets or more can cause paper jams.

**Note:** The press determines paper type and paper weight based on paper information set for the job, not based on paper actually loaded in the tray. The press determines the number of sheets per job based on job information. Therefore, when multifeeds occur, stapling can be performed even if the number of sheets being fed exceeds the limit. However, this can cause staple faults.
The SquareFold® Trimmer device:

- Receives the booklet from the booklet maker area of the finisher
- Flattens the booklet spine which reduces the booklet thickness and gives it the appearance of a perfect-bound book
- Trims and cuts away the face edge of the booklet, resulting in a neat finished edge

The booklet area of the finisher assembly and staples booklet. The booklet enters the SquareFold® Trimmer device already assembled. Any adjustments to the image of the original and its placement on the booklet page must be set at the print server.
# SquareFold® Trimmer Components

<table>
<thead>
<tr>
<th>Number</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Left Cover *</td>
<td>Open this cover to remove paper jams.</td>
</tr>
<tr>
<td>2</td>
<td>Right Cover *</td>
<td>Open this cover to remove paper jams.</td>
</tr>
<tr>
<td>3</td>
<td>Circuit Breaker Switch on the rear of device</td>
<td>Automatically shuts off electricity in the event of an electrical fault or a short circuit.</td>
</tr>
<tr>
<td>4</td>
<td>Booklet Tray</td>
<td>This tray receives square-fold booklet output from the finisher.</td>
</tr>
<tr>
<td>5</td>
<td>Square-fold Adjustment Button</td>
<td>Press this button to adjust the thickness of printed booklets.</td>
</tr>
<tr>
<td>6</td>
<td>Paper Jam and Error Indicator</td>
<td>Lights when a paper jam occurs.</td>
</tr>
<tr>
<td>7</td>
<td>Trimmer Waste Container</td>
<td>Collects waste from the trimmer area of the device.</td>
</tr>
</tbody>
</table>

* The covers cannot be opened during normal operation or when the press is idle. The covers can be opened only when an indicator is lit and a jam or fault occurs within the SquareFold® Trimmer device.
SquareFold® Trimmer Circuit Breaker

The circuit breaker is located on the rear of the device. The circuit breaker is normally in the ON position.

Note: When an electrical interruption is detected, the circuit breaker automatically switches off to discontinue the electrical flow to the device. For electrical information, refer to Safety.

Under normal operating conditions, this switch should not be touched. If the press is moved, press this button to switch off power to the device.

Output Trays

1. Finisher Output Tray: Unused sheets that are purged by the press are ejected to this output tray.
2. Booklet Tray: Saddle Stitch/Bi-fold and Trim/Square-fold jobs are delivered only to this tray.
Control Panel

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1      | Fault indicators: These indicators light when a fault or jam occurs in a particular area of the SquareFold® Trimmer device. The lower indicator (with the lock icon) lights when the trimmer waste container is pulled out or when it is full.  
  Note: If E1, E2, or E3 is lit, the left and right covers can be opened and the jam or fault cleared. Otherwise, during normal operation or when the press is idle, the covers cannot be opened. |
| 2      | Select the desired square-fold setting; for more information refer to the Square Fold Adjustment Settings. |
| 3      | Press this button to adjust the square-fold, book thickness setting. |

SquareFold® Trimmer Paper Path

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The booklet leaves the booklet area of the finisher and enters the SquareFold® Trimmer device. The booklet exit sensor, in the SquareFold® Trimmer device, detects the lead-edge spine of the booklet and moves the booklet to the square-fold area.</td>
</tr>
<tr>
<td>2</td>
<td>Once the booklet spine reaches the square-fold area, the booklet is clamped and the square-folding operation begins.</td>
</tr>
<tr>
<td>Number</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>3</td>
<td>The booklet is flattened and the spine squared according to the square-fold setting indicated on the control panel.</td>
</tr>
</tbody>
</table>
| 4      | After the booklet is flattened and the spine squared, it is moved to the trimmer area.  
- Based on the finished booklet size, the booklet is moved until the trail edge reaches the trimmer cutter.  
- The trail edge is trimmed (cut); this is based on the finished booklet size entered for the trimmer mode setting. |
| 5      | The booklet is then moved to the exit area where it is transported to the booklet tray. |

**Note:** Booklets exiting the SquareFold® Trimmer device may contain trim remnants or scraps from the previously trimmed booklet. This is due to static electricity build-up and is normal. If booklets contain trim remnants or scraps, simply remove and discard them.

**Square Fold and Trim Features**

**Square Fold Feature**

The Square Fold feature is available only when the press is connected to both a finisher with a booklet maker and the SquareFold Trimmer Module.

The Square Fold feature can be selected or accessed from your computer print driver, the press User Interface (UI), or the print server.

**Note:** The term Book Pressing is used synonymously with the terms Square Fold or Square Folding.

**Square Fold Adjustment Settings**

The square fold feature can be switched on or off based on user preference. When the feature is switched on, you can select one of five options depending on your requirements for the finished booklet job.

**Note:** Run one or more test prints before running large jobs.
<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select this setting (&lt;-2 / Lower / Low 2) when your finished booklet is five pages or less and on lightweight paper (100 g/m² or lower). The least amount of pressure that can be applied to the booklet is -2.</td>
</tr>
<tr>
<td>2</td>
<td>Select this setting (&lt;-1 / Low / Low 1) when you want less pressure applied to the spine of the booklet. The less pressure applied to the booklet, the more rounded the booklet spine will be.</td>
</tr>
<tr>
<td>3</td>
<td><strong>Auto / Normal</strong> is the default setting and is used for most jobs.</td>
</tr>
<tr>
<td>4</td>
<td>Select this setting (&lt;+1 / High / High 1) when you want a greater amount of pressure applied to the spine of the booklet, but not as much as the +2 setting uses.</td>
</tr>
<tr>
<td>5</td>
<td>Select this setting (&lt;+2 / Higher / High 2) when you want the most amount of pressure applied to the spine of the booklet. The more pressure applied, the more square the booklet spine will be. The greatest amount of pressure that can be applied to the booklet is +2.</td>
</tr>
</tbody>
</table>

**Booklet Example**

The following illustration shows two different booklet types:

1. This booklet is not square-folded; it has a rounded, thicker appearance to the spine.
2. This booklet is square-folded; the booklet spine is flattened and squared, giving a perfect-bound book appearance.

**Trim Feature**

Access the trim feature from your computer print driver, the press UI, or the print server.

**Trim Options**

When using the trim options, always consider the following:
• Booklets exiting the SquareFold® Trimmer device can contain trim remnants or scraps from the previously trimmed booklet. Static electricity causes this build-up and it is normal. If booklets contain trim remnants, simply remove and discard them.

• The trim feature can be switched on or off. When the feature is on, you can adjust the trim setting in 0.1 mm (0.0039 in.) increments depending on your requirements for the finished booklet job.

The trim options include the following:

- **Trimming On/Off**: Switch On/Off the Trimming feature. The default setting is Off.

- **Cut to Size**: Use the Left/Right Arrow buttons to decrease or increase the trimmer setting. Adjustments are made in 0.1 mm (0.0039 in.) increments.

The trim setting is based on:

- The number of sheets in the finished booklet
- The finished booklet width size
- The media type (coated or uncoated)
- The media weight

Note: Experiment with various settings to determine the best selections for your job. You may want to run one or more test prints before running larger jobs for best booklet output.

Note: Trim settings cannot be adjusted to remove less than 2 mm (0.078 in.) or more than 20 mm (0.787 in.) of edge material from the booklet. Adjustments less than 2 mm may produce poor trim quality. Adjustments greater than 20 mm result in no trimming to the booklet edge.

**Trim Guidelines**

The following table shows various scenarios using different paper weights, media types, and trim setting selections. Use this table as a guideline when selecting a trim setting for your specific job.

Note: The settings shown in the following table are provided as examples and are not meant to represent every possible job scenario; again, use this table as a guideline only.

<table>
<thead>
<tr>
<th>Scenario number</th>
<th>Paper Size</th>
<th>Finished booklet size</th>
<th>Paper weight (lbs./g/m²)</th>
<th>Approximate trim setting (mm)</th>
<th>Number of pages in finished booklet</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>210 x 298 mm (8.5 x 11 in.), A4</td>
<td>149 x 210 mm (5.5 x 8.5 in.)</td>
<td>20 lbs./ 75 g/m²</td>
<td>130</td>
<td>20</td>
</tr>
<tr>
<td>2</td>
<td>210 x 298 mm (8.5 x 11 in.), A4</td>
<td>149 x 210 mm (5.5 x 8.5 in.)</td>
<td>24 lbs./ 90 g/m²</td>
<td>125</td>
<td>14</td>
</tr>
<tr>
<td>3</td>
<td>210 x 298 mm (8.5 x 11 in.), A4</td>
<td>149 x 210 mm (5.5 x 8.5 in.)</td>
<td>32 lbs./ 120 g/m²</td>
<td>135</td>
<td>10</td>
</tr>
<tr>
<td>4</td>
<td>210 x 298 mm (8.5 x 11 in.), A4</td>
<td>149 x 210 mm (5.5 x 8.5 in.)</td>
<td>20 lbs./ 75 g/m²</td>
<td>125</td>
<td>10</td>
</tr>
<tr>
<td>5</td>
<td>210 x 298 mm (8.5 x 11 in.), A4</td>
<td>149 x 210 mm (5.5 x 8.5 in.)</td>
<td>80 lbs./ 120 g/m²</td>
<td>135</td>
<td>12</td>
</tr>
<tr>
<td>6</td>
<td>250 x 353 mm (8.5 x 14 in.), B4</td>
<td>250 x 176.5 mm (8.5 x 7 in.)</td>
<td>20 lbs./ 75 g/m²</td>
<td>172</td>
<td>6</td>
</tr>
<tr>
<td>ScENARIO NUMBER</td>
<td>PAPER SIZE</td>
<td>FINISHED BOOKLET SIZE</td>
<td>PAPER WEIGHT (LBS./G/M²)</td>
<td>APPROXIMATE TRIM SETTING (MM)</td>
<td>NUMBER OF PAGES IN FINISHED BOOKLET</td>
</tr>
<tr>
<td>----------------</td>
<td>------------</td>
<td>-----------------------</td>
<td>--------------------------</td>
<td>-------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>7</td>
<td>250 x 353 mm (8.5 x 14 in.), B4</td>
<td>250 x 176.5 mm (8.5 x 7 in.)</td>
<td>24 lbs./90 g/m²</td>
<td>170</td>
<td>6</td>
</tr>
<tr>
<td>8</td>
<td>297 x 420 mm (11 x 17 in.), A3</td>
<td>210 x 297 mm (8.5 x 11 in.), A4</td>
<td>24 lbs./90 g/m²</td>
<td>200</td>
<td>14</td>
</tr>
<tr>
<td>9</td>
<td>297 x 420 mm (11 x 17 in.), A3</td>
<td>210 x 297 mm (8.5 x 11 in.), A4</td>
<td>80 lbs./216 g/m²</td>
<td>205</td>
<td>5</td>
</tr>
<tr>
<td>10</td>
<td>297 x 420 mm (11 x 17 in.), A3</td>
<td>210 x 297 mm (8.5 x 11 in.), A4</td>
<td>20 lbs./80 g/m²</td>
<td>210</td>
<td>22</td>
</tr>
<tr>
<td>11</td>
<td>297 x 420 mm (11 x 17 in.), A3</td>
<td>210 x 297 mm (8.5 x 11 in.), A4</td>
<td>24 lbs./90 g/m²</td>
<td>210</td>
<td>8</td>
</tr>
<tr>
<td>12</td>
<td>297 x 420 mm (11 x 17 in.), A3</td>
<td>210 x 297 mm (8.5 x 11 in.), A4</td>
<td>80 lbs./120 g/m²</td>
<td>205</td>
<td>10</td>
</tr>
<tr>
<td>13</td>
<td>305 x 458 mm (12 x 18 in.)</td>
<td>152 x 229 mm (6 x 9 in.)</td>
<td>80 lbs./120 g/m²</td>
<td>220</td>
<td>6</td>
</tr>
<tr>
<td>14</td>
<td>305 x 458 mm (12 x 18 in.)</td>
<td>152 x 229 mm (6 x 9 in.)</td>
<td>80 lbs./120 g/m²</td>
<td>215</td>
<td>5</td>
</tr>
<tr>
<td>15</td>
<td>305 x 458 mm (12 x 18 in.)</td>
<td>152 x 229 mm (6 x 9 in.)</td>
<td>80 lbs./120 g/m²</td>
<td>210</td>
<td>4</td>
</tr>
<tr>
<td>16</td>
<td>305 x 458 mm (12 x 18 in.)</td>
<td>152 x 229 mm (6 x 9 in.)</td>
<td>28 lbs./105 g/m²</td>
<td>220</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>305 x 458 mm (12 x 18 in.)</td>
<td>152 x 229 mm (6 x 9 in.)</td>
<td>80 lbs./120 g/m²</td>
<td>210</td>
<td>14</td>
</tr>
</tbody>
</table>

**SquareFold® Trimmer Specifications**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper size</td>
<td>• Maximum: 330 x 457 mm (13 x 18 in.)</td>
</tr>
<tr>
<td></td>
<td>• Minimum: 216 x 270 mm (8.5 x 11 in.), A4 SEF</td>
</tr>
<tr>
<td>Trim capacity</td>
<td>• 5–20 sheet booklet (up to 80 imaged sides) at 90 g/m², 26 lb.</td>
</tr>
<tr>
<td></td>
<td>• 5–25 sheet booklet (up to 100 imaged sides) at 80 g/m², 200 lb.</td>
</tr>
<tr>
<td>Trim size</td>
<td>2–20 mm, adjustable in 0.1 mm increments</td>
</tr>
<tr>
<td>Paper weights</td>
<td>16 lb. bond to 90 lb. cover</td>
</tr>
<tr>
<td></td>
<td>60–350 g/m² uncoated and coated</td>
</tr>
</tbody>
</table>
Job Workflows

Printing Extra-Long Sheets

Printing Extra-Long Sheets (XLS) with the EX Print Servers

You can print on long sheets of paper up to 330 x 660 mm (26 in.) using the standard XLS feature. This process allows you to create banners, advertisements, A4 landscape book covers, calendars, and long sheet prints. XLS specifications include:

- Print Speed: Up to 9 ppm, 1-sided mode only
- Paper Weights: For uncoated, 52–220 g/m² and coated, 72–220 g/m²
- Maximum Paper Size: 330 x 660 mm
- Maximum Printable Area: 323 x 654 mm

To use this feature, feed sheets from Tray 5, then for output destination, specify an option:

- Offset Catch Tray
- Top Tray of the desired finishing device

Note: A GBC® AdvancedPunch™ Pro cannot be configured with the system.

To print extra-long sheets:
1. To support the long paper, use the Top Tray Extension Rolls. If the rails are inserted in the Finisher Tray, pull them out to their full extension. If the rails are stored in the back of the finisher, retrieve them and insert them into the holes at the end of the Tray.

2. Load the paper into the Bypass Tray 5, on top of the 2-Tray Advanced Oversized High Capacity Feeder, or directly on the side of the press when no optional feeders are configured with the system.
   a. To insert the paper easily, spread the Tray 5 paper guides wider than the paper.
   b. Hold the center of the paper guides, then squeeze them until they touch the edges of the stack of paper.

3. Specify the paper size and type at the press touchscreen.
   a. After you load the paper, the Paper Tray Settings window opens on the User Interface. On this window, touch Change Settings.
   b. Touch Papersize.
   c. Touch Custom size.
   d. Enter the length (x) and height (y) of the paper that you loaded.
      For example: 26 in. x 13 in.
   e. Touch Save.
   f. Change other parameters as needed.
   g. Touch Save.

4. Touch Confirm.

5. Submit the job file to the Hold Queue for the print server. To send the job, use File > Print from a PC on the network or use the Import function at the server. To use Import, follow these steps:
   a. On the Fiery® print server, click the Import shortcut.
   b. Click Add.
   c. Navigate to the file, then select it.
   d. Click Hold.
      The job is sent to the Hold queue.

6. At the print server, set the Job Properties.
   a. To open the job properties, double-click the job in the Hold area.
   b. On the Quick Access tab, set Copies to the number of prints that you want to make.
   c. On the Quick Access tab, under Paper size, click Custom.
   d. Set the Width and Height of the paper, as you did at the press User Interface.

   **Note:** The terms for the paper dimensions are different on the server. Width corresponds to the measurement in the cross-process direction. Height corresponds to the length of the paper in the process direction. Process direction means the direction that the paper moves in the press.

   e. Click OK.
f. On the Media tab, set Paper source to Tray 5 (bypass).

g. On the Finishing tab, for Delivery options, select the Offset Catch Tray or specific Top Tray that you want to use to collect the prints. Specify delivery of the output to the Offset Catch Tray or a Top Tray.

7. Click Print, then monitor the printing.

Printing Saddle-stitched Booklets with Full Bleed, Trimmed Edges, and Inserting Preprinted Covers

**Important:** The following print job workflows require you to have an Inserter device, a Production Ready Booklet Maker Finisher, a Crease and 2-Sided Trimmer, and a SquareFold Trimmer.

This workflow produces an appealing look on the printed output because:

- The booklet maker creates saddle-stitched booklets
- The two trimmers cut off the edges on three sides of the booklets so that the images extend to the edge of the pages
- Preprinted cover pages are inserted into the workflow with the Inserter device

There is one workflow scenario for the Xerox® EX 280 and EX-i 280 Print Servers, Powered by Fiery®.

**Creating Booklets with Full Bleed with the EX Print Servers**

This procedure requires the following finishing devices:

- A Production Ready Booklet Maker Finisher
- A Crease and Two-Sided Trimmer device
- Inserter device
- SquareFold® Trimmer device

The booklet maker creates saddle-stitched booklets, while the two trimmers cut the edges off three sides of the booklets so that the images extend to the edge of the pages. With the Inserter device, you can insert preprinted cover pages in this workflow. This full-bleed output produces an appealing look for some documents.

The setup for this type of workflow includes:

- Loading the paper and programming it at the press UI
- Submitting the job and opening Job Properties
- Setting Properties for the media, layout, folding and trimming
- Selecting the settings to insert preprinted covers
- Releasing the job for a Proof copy
- Checking the output and making any adjustments to the trim settings or imposition
- Printing the job

Print the file first with no trim to see how much trim is needed to achieve a full bleed of page images.
1. If needed, load the paper into a press tray. If you want the finished size to be 8.5 x 11 in., A4, you can load 12 x 18 in., A3 paper and impose two 8.5 x 11 in. images onto each side of the sheets. This provides an edge around the images for trimming. If you load 11 x 17 in. paper, you can still impose two 8.5 x 11 in. images onto each side of sheets, but after the edges are trimmed the resulting size will be less than 8.5 x 11 in.

2. If you loaded paper in a tray, the Tray window opens on the press UI. If you loaded the same size paper, touch Confirm on this window. If you loaded a different size paper, touch Change Settings and enter the new stock properties - Size, Type, and Weight.

3. Submit the job file to the print server Hold queue.

4. At the print server, double-click the job to open its Properties.

5. On the Quick Access tab, enter the Paper size and Paper source (where you loaded the paper) and enter the number of Copies.

6. On the Media tab, for 2-sided, select Top-top if printing on 2 sides of the paper. For 1-sided printing, leave the setting Off.

7. On the Finishing tab, under Fold, set Fold style to Booklet-fold.

8. On the Finishing tab, under Stapler, set Stapler mode to Center.

9. On the Finishing tab, under Trim, select the box for Head and foot trim.

10. Use the up and down arrows to set the Finish Size of pages. This is the distance from the top of the page to the bottom.

11. For Spine printing, select Normal.

12. Select the box for Engage fore (face trim).

13. Use the up and down arrows to set the face trim. You can set the Finish Size, which is the distance from the spine to the right side of the page for a right-bound booklet, or the amount of the face to be trimmed.

14. If your file is pre-imposed, the settings are now complete and you can release the job to print. However, if the file is not preimposed, access the Layout tab and select Booklet to set the imposition you want for the job.

15. If you are not inserting pre-printed covers, proof the job, check the output, then release the job to print.

16. For optionally inserting covers when the job is pre-imposed:
   a. Load the pre-printed cover stock into the Inserter Tray T1.
   b. Program the stock at the Control Panel.
   c. Select the Media tab, then scroll down to select Define Cover.
   d. Click the check box for Front Cover, then select Insert from the drop-down menu.
   e. For Paper source, select T1.
   f. Set any other unique paper properties for the cover stock, if they are different from the body stock. For example, the g/m² weight may be heavier.
   g. Click OK on the Cover Media window.
   h. Click Print on the Media tab to release the job.
Note: If you have an Inserter configured with your press, you can optionally insert pre-printed cover sheets for the booklets. The size of the cover sheets should be the same as the body sheets. The Booklet Maker will wrap the pre-printed cover sheet around the body pages to form a front and a back cover.

17. For optionally inserting covers when the job is not pre-imposed:
   a. Load the pre-printed cover stock into the Inserter Tray T1.
   b. Program the stock at the Control Panel.
   c. Select the Layout tab.
   d. Select the **Booklet** radio button.
   e. Scroll down to the Cover area.
   f. For Content input, select **Pre-Printed**.
   g. Click **Define Cover**.
   h. For Cover source select T1.
   i. For Media Weight, select the g/m² for the cover stock and set any other unique cover stock properties.
   j. Click **OK**.
   k. Click **Print** on the Layout tab to release the job.

Note: If you have an Inserter device with your press, you can optionally insert preprinted cover sheets for the booklets. The size of the cover sheets should be the same as the body sheets. The Booklet Maker will wrap the preprinted cover sheet around the body pages to form a front and a back cover.

### Adjusting Booklet Fold and Staple Positions

Use this procedure:

- To adjust the staple position horizontally on the paper
- To ensure that the booklet staples lay precisely on the fold, not off the fold

Note: This procedure does not enable you to move the staples up or down on the fold. A Customer Service Engineer must make vertical adjustments for staple positions on the fold.

To adjust the fold and staple positions for booklets, log in as Administrator and use the **Tools** menu. Create a profile for a specific size booklet in terms of the number of sheets or create a profile for booklets that vary in length.

If printing booklets that use the same number of sheets, enter that number. If printing booklets that differ in the number of sheets used, perform adjustments separately for a small set of sheets (Set 1) and again for a large set of sheets (Set 2). The system calculates and automatically uses the required adjustments for booklets that vary in size between Set 1 and Set 2.

The paper weight for the booklet media is important when creating the profile. The number of sheets used in the sets vary based on the selected weight. The system automatically determines the size of the sets based on the selected paper weight.
Creating a Profile for Adjusting the Fold and Staple Positions

1. For the booklet job, load the paper, short-edge feed (SEF) in the tray.
2. From the press UI, confirm or change the media settings.
3. Log in as Administrator.
4. Press the Machine Status button.
6. Perform one of the following:
   • To edit an existing profile, select the profile name and touch Change Settings. Go to .
   • To create a new profile, continue to the next step.
7. To create a new profile:
   a. From the Adjust Fold Position window, select one of the <Available> rows.
   b. Touch Change Settings.
   c. To enter a unique name, touch Change Settings again.
   d. For the profile you are creating, enter a unique name .
   e. Touch Save.
8. Select the Booklet fold type.
   The Booklet window opens.
10. Touch the Paper Type button.
11. Select the Paper Type and Paper Weight you are using to print the booklets.
12. Touch Save.
13. For Adjustment Method, select Standard or Variable Sheet.
   • Standard provides a profile with the most flexibility for booklets with a range of pages. When you select Standard, you must print and check two sample prints. One sample print is for a small page set. The other sample print is for a large page set. The system interpolates the settings from these two adjustments to match a range of pages between them.
   • Variable Sheet provides the best accuracy if you always print booklets with the same number of pages. When you select Variable Sheet, you enter a fixed number of pages in your booklets, then make just one set of adjustments.
14. If you selected Variable Sheet, in the field, enter the number of sheets.
15. Touch the Sample Printout button.
17. Select the tray that contains the paper for the booklets.
The booklet paper must be loaded short-edge feed (SEF) in the tray.
18. Touch Save.
20. When the printing completes, touch Close.
21. Touch Close again.

22. From the press output area, collect the print sample.

23. Touch Next.

The Booklet Fold State window opens.

24. Hold the sample booklet in front of the Booklet Fold State window with the fold on top as shown on the window.

25. Place the line on the back cover of the booklet, to the left of the fold.

26. On the Booklet Fold State window, review the four staple and fold position buttons for the following information:
   a. Identify the staple offset position: left or right of the fold.
      The staple offset position indicates eliminates two of the four buttons and indicates one of the two buttons on the left or one of the two buttons on the right.
   b. Of the two buttons remaining, record one of the two buttons to use.
      If the staple is not offset, but is correctly positioned, skip this step.

27. Fold the booklet closed to determine if one side, left or right, is longer than the other side.

28. Touch the button that best describes the position of both the staple and the fold.

The Booklet Fold State window displays an illustration showing how to measure the offsets.

29. Record the following measurements:
   a. The distance the fold is off (A).
   b. How far the staple position is off (B).
      Measure the B value from the current position of the fold.

30. Use the arrows to enter the A distance and the B distance.

31. Touch Sample Printout.

32. Select Paper Supply, then select the tray that contains the paper for the booklets.

33. Touch Save.

34. Press the green Print button on the Control Panel.

35. When printing completes, touch Close.

36. Collect the sample print and check the staple and fold positions. If the fold and staple positions are not correct, repeat to . Go to the next step when you are satisfied with the results.

37. If you selected Variable Sheet, you are done and the profile is now complete. Touch Save and Close the windows.

38. If you selected Standard in , touch Next to make adjustments for Set 2. Repeat to .

39. When the second set of adjustments are complete, touch Save.

40. Touch Close.

41. Touch Close again.

42. Log out as Administrator.
Applying the Fold and Staple Position Profile to a Tray

1. Open and close the paper tray that you want to associate with the custom fold profile.
2. On the Tray Properties window that opens on the Touch Screen, select **Change Settings**.
3. Touch **Adjust Fold Position**.
4. Select the specific profile that you want to use. You need to use the up or down arrows to locate it.
5. Touch **Save**.
6. Touch **Save** again.
7. Touch **Confirm**.

The custom fold profile is now associated with the tray and is used for any paper in the tray.

**Note:** You can assign the profile to a Custom Paper, then assign the Custom Paper to the tray. It is useful if there are other adjustments, such as paper curl, alignment, or print engine adjustments that you want to apply to the paper you are using for the booklets, in addition to the fold adjustment settings.

Producing Simple Folded Sheets and Inserting Folded Sheets into a Document

Use the Production Ready (PR) Finisher, Basic Punch, and C/Z Folder to produce simple folded sheets or insert folded sheets into a document.

With the optional C/Z Folder, you can produce C and Z folds on 8.5 x 11 in. or A4 sheets. You also can create engineering Z-folds on 11 x 17 in. or A3/B4 media. These Z-folds are called Half Z-folds. The engineering Z-fold or Half Z-fold folds the 11 x 17 in. or A3/B4 paper and reduces the sheet to 8.5 x 11 in. or A4 paper, respectively. This process allows you to insert the folded sheet into an 8.5 x 11 in. or A4 document so that the reader can pull out the folded portion to see an extra-large image.

| C-Fold or Trifold | Z-fold | Half Z-fold or Engineering Z-fold |

**Important:** When you load or select media for folding, position the paper Short Edge Feed (SEF).

Producing Simple Folded Sheets with the EX Print Servers

1. For the job, load the paper short-edge feed (SEF) into a tray and program the media at the press **User Interface** (UI).
2. Submit the job to the print server **Hold** queue.
3. From the print server, to open the job, double-click the **Properties**.
4. Set all required properties for the job such as quantity, paper size, source tray, and 1-sided or 2-sided.

5. Select one of the following:
   • For C and Z-folds, use 8.5 x 11 in. or A4 sheets.
   • For Engineering Z-fold or Half Z-fold, use 11 x 17 in. or A3/B4 paper.

6. Select the Finishing tab, then scroll down to the Fold area.

7. For Fold, set the style to the fold you want:
   • Trifold
   • Z-fold
   • Half Z-fold
   • Half fold

8. Set the fold to Inside or Outside.
   When you select Inside, Page 1 is within the fold. For Outside, Page 1 is on the back of the fold.

9. If a message opens stating that the Output delivery is Face down – normal order and should be Face down – reverse order, select OK to correct the setting.

10. If you want the sheets hole-punched, under Punch:
    a. Set Punch edge to Left, Right, or Top.
    b. Set Punch to 2 hole punch or 3 hole punch.

11. Select Print.

12. Collect the folded output from the Top Tray of the finisher or the bottom drawer of the C/Z-folder.

13. To open the bottom drawer of the C/Z Folder, push the button on the top left-front of the folder unit.

Inserting Folded Sheets into a Document with the EX Print Servers

You can insert printed and folded sheets into documents as long as they are not booklets created by imposing and folding large sheets. For example, if they are stapled, or hole-punched, but not booklets, document sets can receive folded sheets. Engineering Z-folds or Half Z-folds can create a useful and attractive fold-out sheet for large images in technical manuals or advertising pieces. The folded sheet is printed as a regular sheet in the document, but is programmed as an exception page for folding.

1. If needed, load the paper for the job and program it at the press User Interface (UI).

2. Submit the job to the Hold queue for the print server.

3. From the print server, double-click the job to open its Properties.

4. Set all required properties for the job such as Copies, Paper size, Source tray, and 1-sided or 2-sided.
   Usually, you print the document on 8.5 x 11 in. or A4 paper and print 2-sided, Top-to-top.

5. Select the Finishing tab, then scroll down to the Fold area.

   Even though you do not apply the fold to all pages in the document, make this setting here so that it displays as a selection in the Mixed Media definition that you set.
7. If you want the document stapled, under Stapler, set **Stapler mode** to the location of the staples.
8. If you want the document hole-punched, under Punch, set the **Punch style** to your preference.
9. Scroll down to the Mixed Media area and select the **New Page Range** button.
10. If you are printing 2-sided, select **2 pages**, which are the front and back of the folded page.
11. For Paper size, select **11 x 17 in. (A3)**.
12. For Fold style, select **Half Z-fold**.
13. Select **Add Definition**.
14. Select **Close**.
15. Select **Print**.

**Using the Inserter Device to Include Sheets or Tabs in the Printed Output**

When you insert covers, sheets, or tabs into printed documents using the Inserter device, the insertion occurs after documents exit the press and before they are finished. For the inserted media, use preprinted media or blank media.

**Note:** If you want to print on the inserted sheets, use Tray 5 (Bypass) or another tray.

You can use the Exception Pages feature to specify the tray to use for the inserts. For this workflow, select the Inserter device, Tray T1.

**Inserting Sheets and Tabs into the Printed Output with the EX Print Servers**

With the EX Print Servers, you can use the Inserter device, Tray T1, or Tray 5 to insert covers and sheets into documents.

**Note:** To insert tabs, use Tray 5.

1. If needed, load the main media for the document into a feeder tray with a long-edge feed orientation.

2. Load the sheets into the **Inserter Tray T1** with a long-edge feed (LEF) orientation. If you load tabs in Tray 5, place the tabs face up and out, at the trailing edge of the media. When you insert preprinted or blank tabs, the system does not know how many tabs are in a set. It simply inserts the tabs, one at a time, in the same order they are placed in the tray. Check the tab sets and make sure that there are no partial sets. Also, if you have a jam and lose some tabs, you have to restart the job on a full tab set in Tray 5.

3. Program the media to insert at the press UI:

   **Note:** For Special Paper, ensure that you select the specific paper source where the media is loaded. It is recommended that you run tabs from Tray 5.

   a. From the press UI, configure the Tray settings.

      - A Size of 8.5 x 11 in. (A4), long-edge feed
      - The Weight of the tab media. This weight is usually about 164 g/m², but it depends on your media.
- For Type, select the type of media to be inserted, for example, **Precut tab - Plain**.

4. To close the Tray Properties window, select **Confirm**.
5. Submit the job file to the **Hold** queue on the print server.
6. To open its Properties, double-click on the job.
7. Set all the Properties for the job such as Paper size, 1-sided or 2-sided, and number of Copies.
8. Select the **Media** tab, then scroll down to the Mixed Media section.
9. Select **New Insert**.
10. With **Page Number** selected, enter the page numbers after which you want to insert preprinted or blank sheets or tabs. Use a comma to separate the numbers.
11. For Paper Size, select the size of your tabs, **8.5 x 11 in. Tab LEF** or **A4 Tab LEF**.
12. For Media Type, select **Tabstock (uncoated)** or **Tabstock (emboss)**.
13. Select **Insert**.
14. Select **Close**.
15. Select **Print**.

**Using the GBC® AdvancedPunch® Pro**

**Using the AdvancedPunch® Pro with the EX Print Servers**

1. Load the paper for the job.
2. Confirm or change the media settings at the press UI.
3. Submit the job to the print server **Hold** queue.
4. At the print server, open the job **Properties** by double-clicking the held job.
   a. Set all required properties for the job such as Copies, Paper size, Source tray, and 1-sided or 2-sided.
   b. Select the **Finishing** tab.
   c. Scroll down to the Punch area.
   d. For Punch edge, select the location of the punch on the paper: **Left**, **Right**, or **Top**.
   e. For Punch, select **Advanced Pro-ANSI** or **Advanced Pro-ISO**.
      The name of the unit depends on your geographic region.
   f. To release the job, on the finishing tab, select **Print**.
Maintenance

Cleaning the Press Overview

• Before you start to clean the press, be sure to switch off the power using the rear breaker switch and unplug the press. Cleaning the press without switching off the power may cause an electric shock.

• Always use a dry lint-free cloth for all cleaning actions unless otherwise directed.

• Do not use benzene, paint thinner, other volatile liquids, or spray insect repellent on the press as doing so may discolor, deform, or crack covers.

• If a moistened cloth is used, wipe afterwards with a dry lint-free cloth. Cleaning the press with an excessive amount of water may cause the press to malfunction and/or damage documents during printing.

Cleaning the Exterior

1. Wipe the exterior with a soft cloth moistened with water. If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a small amount of neutral detergent.

2. Wipe off any excess water from the exterior with a soft cloth.

Cleaning the Document Cover and Glass

1. Cleaning the document cover
   a. Raise the document feeder.
b. To remove dirt, wipe the document cover with a soft cloth moistened with water and then wipe it dry with a soft cloth. If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a small amount of neutral detergent.

2. Cleaning the document (platen) glass
   a. To remove dirt, wipe the document glass with a soft cloth moistened with water and then wipe it dry with a soft cloth. If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a small amount of neutral detergent.

Caution: Do not press heavily on the document glass to avoid damaging the glass surface.

3. Cleaning the second-side scanning lens assembly
   a. The second-side scanning lens assembly is located along the left side of the document cover. The assembly consists of the mirrored-glass strip, a metal strip, a white-plastic strip, and rollers. All parts of the assembly must be cleaned to ensure the best image quality when making copies.
b. With the document feeder open, pull the lever that is located at the top of the document cover.

Part of the document cover pulls away from the assembly, which allows better access to the second-side scanning lens assembly.

c. To remove dirt, wipe the mirrored glass, metal strip, both sides of the white-plastic strip, and the rollers with a soft cloth moistened with water, then wipe it dry with a soft cloth.

⚠️ **Caution:** Do not press heavily on the mirrored glass as this will result in damage to the film around the glass surface.

📝 **Note:** If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a small amount of neutral detergent.

4. Once the second-side scanning assembly is clean, return the document cover to its original position and ensure that the lever is locked in place.

If you touch the document cover with your bare hands, wipe it clean before closing the document feeder.

5. Gently close the document feeder.
Cleaning the Document Feeder Rollers

1. Gently lift the latch of the document feeder top cover until it is open completely in a fixed position.

   ![Image of document feeder top cover being opened.]

2. While turning the rollers, gently clean them with a soft cloth moistened with water.

   **Caution:** Use a cloth that has been thoroughly wrung to prevent drops of water falling into the press. Drops of water on internal components may cause a malfunction.

   If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a small amount of neutral detergent.

   ![Image of a hand cleaning roller.]

3. Close the top cover of the document feeder until you hear it click into place.

4. Close the left cover of the document feeder until you hear it click into place.

Cleaning the Drum Drawer Area

When you are replacing a drum cartridge, before inserting the new cartridge, perform these steps to clean under the drum cartridge area:

1. With the Drum Cartridge Drawer open, look for dry ink/toner waste on the bottom of the catch pan under the drum cartridges.

2. Use a clean cloth to wipe down the catch pan.

3. Continue following the instructions on how to insert the new cartridge.

Cleaning the ROS Windows

Unfused dry ink/toner collects on the 4 color ROS window areas located just above the Drum Cartridge Drawer within the press. Contaminated ROS windows can cause a white streak defect on your printed output.

Perform this procedure to clean the ROS window of the affected color whenever:

- You replace the drum cartridge
- A white streak (no image captured) shows in the same position on every print
Use only the wand and cloth pad provided when performing this cleaning procedure. Do not use any other cleaning device, liquid solutions, or cloths.

1. Open the Left Front Door of the press.

2. Locate the Cleaning Wand tool stored on the side panel of the open front door and remove.
   Make sure the pad at the tip of the wand is clean. Replace the pad after 4 uses. Several pads are provided in the Nationalization Kit. To acquire additional pads, contact your Service representative.

3. With the pad facing upward, insert the wand fully into the ROS color window opening and then bring the wand fully out towards you. Complete this in/out action 3 or 4 times in each ROS window.

4. Replace the Cleaning Wand tool into the storage area on the side panel of the open front door.

5. Close the Front Door of the press.

**Cleaning the Fuser Assembly Routine**

When you have an image quality issue caused by contaminants in the fuser, run the **Clean Fuser Assembly** routine from the Tools menu. For example, use this feature when you see dry ink/toner debris on the back side of prints.

The press automatically runs this routine periodically. However, if you see image quality problems with dry ink/toner on the back of prints, you can initiate this procedure manually.

*Note: If you still notice contaminants on the back of the prints after running this procedure, contact Xerox Service. Dry ink/toner debris can originate from either of two areas in the press: the Transfer Roll or the Fuser Assembly Roll.*

**Cleaning the Fuser Assembly with Paper**

1. Press the **Machine Status** button on the press User Interface.

2. Select the **Tools** tab.

3. Select **Clean Fuser Assembly**.

4. For **Paper Supply**, select the paper tray to use.

*Note: Although you can use any type and size of paper, the smooth surface of coated paper has more contact area to the pressure roll.*

5. From **Number of Sheets**, select the number of blank sheets to run (1 — 5).

*Note: For best results, run fewer sheets for more times. It is more effective to run one or two sheets for multiple times than to run five sheets for one time only. This is especially important when running larger sheets, in the short-edge-feed (SEF) direction, such as 11 x 17 in. or A4 paper.*

6. Select **Save**.

7. Press the **Start** button.

*Note: When running five sheets of paper, the process takes approximately one minute.*

The system begins the cleaning process. When the cleaning process finishes, a **Completed Successfully** message displays.

8. Select **OK**.
Reprinted from the XEROX® 3300 Series Operation, Maintenance, and Parts Manual

Reproduced by Xerox Corporation

Reprinted by permission of Xerox Corporation

Copyright © 2000 Xerox Corporation
All rights reserved.

CRUs (Supply Item) | Reorder Quantity | Approximate Print Yield (Full Color 8.5x11/A4 Prints)
--- | --- | ---
Black Dry Ink/Toner Cartridge | 1 per box, 2 per press | 50,000
Cyan Dry Ink/Toner Cartridge | 1 per box | 55,000
Magenta Dry Ink/Toner Cartridge | 1 per box | 51,000
Yellow Dry Ink/Toner Cartridge | 1 per box | 51,000
Waste Dry Ink/Toner Bottle | 1 | 45,000
Suction Filter | 1 | 200,000
Drum Cartridge (R1) | 1 per box | 348,000
Drum Cartridge (R2) | 1 per box | 348,000
Drum Cartridge (R3) | 1 per box | 348,000
Drum Cartridge (R4) | 1 per box | 348,000
OHCF Feed Roll Kit | 1 kit | 500,000
Standard Finisher Staple Cartridge and Staple Waste Container | 4 Staple Cartridges (5,000 staples per cartridge) and 1 Staple Waste Container per carton | 5,000 staples each cartridge

Note: The Fuser Module may be replaced by the customer only if directed to do so by Service.

Note: Store supply items and Xerox parts in their original packages in a convenient location. Always recycle/dispose the used CRU according to the disposal instructions supplied with the new CRU.

Note: The cleaning pads used with the ROS Window cleaning wand are not orderable. Contact your Xerox representative for any additional cleaning pads.

Ordering Supplies

Xerox supplies, paper, and throughput material can be ordered from the web site www.xerox.com and clicking on the Supplies link. For any item that is not orderable from the web site, contact your Xerox Service Representative.

Note: The cleaning pads used with the ROS Window cleaning wand are not orderable. Contact your Xerox representative for any additional cleaning pads.
<table>
<thead>
<tr>
<th>CRUs (Supply Item)</th>
<th>Reorder Quantity</th>
<th>Approximate Print Yield (Full Color 8.5x11/A4 Prints)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Booklet Maker Finisher Staple Cartridge</td>
<td>4 pack: 5,000 staple refills each</td>
<td>5,000 staples each cartridge</td>
</tr>
<tr>
<td>Business Ready (BR) Finisher Staple Cartridge</td>
<td>1 Staple Cartridge</td>
<td>5,000 staples per cartridge</td>
</tr>
<tr>
<td>Business Ready (BR) Finisher with Booklet Maker Staple Cartridge</td>
<td>4 pack: 5,000 staple refills each</td>
<td>5,000 staples per cartridge</td>
</tr>
<tr>
<td>Staple Refills for the Business Ready Finisher and Business Ready Finisher with Booklet Maker</td>
<td>3 refills per carton</td>
<td>5,000 each refill for a total of 15,000</td>
</tr>
</tbody>
</table>

Checking the Status of Consumables

When a consumable is reaching the time it should be replaced, a message is displayed on the press UI. This indicates when it is time to order and/or install a new consumable item. With some CRUs, the screen indicates that the press may continue to run print jobs without immediately replacing the item. Otherwise, when it is time to replace it, a message appears and the press stops running.

1. Press the **Home** button on the UI.
2. Press **Machine Status** and select the **Supplies** tab.
   - The Supplies area shows a 1 to 100% indicator bar of the remaining amount of dry ink/toner. Remaining dry ink/toner is updated in 10% increments.
3. From the Supplies pull-down menu, select **Other Consumables** to view the status of other consumables, such as the drum cartridges the Dry Ink/Toner Waste Bottle, and any applicable optional devices (such as the OHCF feed rolls).

![Supplies Menu](image)

**Note:** The status of the Fuser and Suction Filter are not shown, but a message displays when these items require replacing.
Replacing a Dry Ink/Toner Cartridge

Note: Refer to the following information:

- The dry ink/toner cartridge can be replaced while a job is printing.
- If the press is installed with Xerox® Adaptive CMYK+ Kit, ensure to install the correct color configuration.
- After you replace a dry ink/toner cartridge, the system automatically resets the usage counter to zero (0) for this CRU. Check the Consumables Supplies screen to verify the reset and new status.

1. Open the Dry Ink/Toner cover, located just above the press front door.

2. Lay paper on the floor before removing the cartridge. This will allow any excess dry ink/toner to fall on the paper.

3. Grasp the handle of the dry ink/toner cartridge matching the color indicated in the message.

4. Remove the dry ink/toner cartridge by slowly and gently pulling it straight out. While pulling out, hold the bottom of the cartridge with your other hand to give it support.

5. Dispose of or recycle the cartridge per your local authorities and regulations.
   In the United States, also refer to the Electronic Industries Alliance website: www.eiae.org. For more information about Xerox environmental programs, go to www.xerox.com/environment.

6. Remove the new dry ink/toner cartridge from its packaging.

7. With one hand on either side of the cartridge, vigorously shake and rotate the new cartridge up and down and left and right for 30 seconds to redistribute the dry ink/toner.

8. Install the new dry ink/toner cartridge by gently and evenly sliding the cartridge into the press until it stops.

9. Close the dry ink/toner cover. If the cover does not close completely, make sure the cartridge is in the lock position and is installed into the appropriate dry ink / toner location.
Replacing the Dry Ink/Toner Waste Bottle

The Dry Ink/Toner Waste Bottle collects dry ink/toner that accumulates during the printing process. When the bottle is full, a message displays on the press UI informing you to exchange the full bottle with an empty one.

The press contains one waste bottle located at the front of the press behind the Dry Ink/Toner Waste Bottle Door. When removing a full Dry Ink/Toner Waste bottle, SLOWLY pull it out of the press. This will prevent any dry ink/toner from spilling out of the bottle.

Note: After you replace the Dry Ink/Toner Waste Bottle, the system automatically resets the usage counter to zero (0) for this CRU component. Check the Consumables Supply screen to verify the reset.

1. Ensure that the press is stopped (not running any jobs).
2. Open the front door of the press.
3. Open the Dry Ink/Toner Waste Bottle Door.
5. Support the underside of the bottle with your other hand and continue pulling it out from the press.

Caution: Never use a vacuum cleaner when cleaning up spilled dry ink/toner. Use a broom or a cloth moistened with a neutral detergent.

6. Use both hands to place the old used Dry Ink/Toner Waste Bottle into the provided plastic bag.
7. Remove a new, empty waste bottle from the packaging.
8. Hold the center part on the top of a new bottle and insert it evenly and gently into the press until it comes to a stop.
9. Close the waste bottle door.
Replacing a Drum Cartridge

You need to replace a drum cartridge if it has reached the end of its component life, if it is damaged by light, or if you are experiencing spots and streaks on your output.

*Note:* All four Drum cartridges are interchangeable.

*Note:* After replacing the drum cartridge, the system automatically resets the usage counter of this CRU component to zero (0). Check the Consumables screen for the reset and new status.

*Caution:* Drums are light sensitive. Do not leave the Drum Cartridge Drawer open for more than one minute. Exposing the drum cartridges to direct sunlight or strong light from indoor fluorescent lighting for more than one minute can cause image quality defects.

*Caution:* Replace drum cartridges while the press is powered ON.

1. Ensure that the press is stopped and is not currently printing jobs.
2. Open the press Front Door.
3. Rotate and turn the **R1-R4** Drum Drawer Handle to the unlock position.

4. Open the bag containing the new drum cartridge. Place the new drum cartridge near the press.  
   
   ![image]
   
   **Caution:** Do not touch or scratch the surface of the drum when you take it out from the bag.

5. Unwrap the sheet covering the new drum cartridge and place it under the cartridge. Some drum cartridges may include a protective film. Remove the film on the drum cartridge, if the film is present.
6. Grab the **Release Handle** and pull the Drum Drawer straight out.

![Image of releasing the handle](image1.png)

7. Remove the old drum cartridge by holding the finger rings provided at both ends of the drum cartridge and gently lifting up.

![Image of removing the drum cartridge](image2.png)

**Caution:** Drums are light sensitive. Do not leave the Drum Cartridge Drawer open for more than one minute when replacing cartridges. Exposing the drum cartridges to direct sunlight or strong light from indoor fluorescent lighting for more than one minute can cause image quality defects.

8. Install the new drum cartridge into the press following the guides with the side marked front facing the front.

![Image of installing the new drum cartridge](image3.png)
9. Press both ends of the drum cartridge to place it in a horizontal position.

10. Immediately close the drum cartridge drawer to protect the other drums from light.
11. Return the **Release Handle** to its original position.
12. Return the **R1-R4** handle to the original position and close the front door.
13. Insert the used drum cartridge into an empty container for recycling.

**Replacing the Suction Filter**
You will need the T10 Torx driver tool for this procedure.

After you replace the filter, you will need to contact the system administrator who will log into administrator mode and reset the counter to zero (0) for this CRU.

⚠️ **Caution:** Make sure the press is powered off before performing this procedure.

1. At the back of the press, locate the Suction filter cover on the lower panel.
2. Use the Torx driver to remove the screw on the right side of the cover by turning the screw counterclockwise.
3. Pull out and remove the Suction Filter Cover.
4. Grasp the handle of the filter box and pull straight out.

5. Remove the Suction filter out of the box.

6. Place the new Suction filter into the box and push the tray back in until it stops and is flush with the press.

7. Place the cover back onto the filter box area. Make sure to first insert the left two tabs of the cover into the left side of the box area. Then push the entire cover flush to the press.

8. Insert the Torx driver with the screw attached into the cover and turn clockwise to tighten.

9. Log in as the Administrator or ask the Administrator to perform the following steps to reset the counter to zero (0):
   a. At the UI, press the **Machine Status** button.
   b. From the screen that displays, select the **Tools** tab.
   c. Select **System Settings > Common Service Settings > Maintenance**.
   d. Use the arrow buttons to access the next Maintenance screens.

      **Note:** After selecting the icon in following step, there is a 4 second delay before the Technical Key Operator feature displays.

   e. Select the **Technical Key Operator** (TKO) icon.

   The Technical Key Operator feature displays.

   f. Log in to the Technical Key Operator mode.

   **Attention**

   If you cannot log in as TKO, or do not have the TKO password, call your Customer Service Engineer.

   g. In the Part Number list, select **Suction Filter**.
   h. Select **Reset Current Value**. The system resets the HFSI to 0.

10. Exit administrator mode.
    a. To return to Tools tab, select **Close** twice.

    The main Tools screen displays.
b. Select the **Log In / Out** button on the User Interface.

c. When prompted, select **Logout**.

**Trays 6 and 7 Maintenance**

**Consumable Supplies for Tray 5-9**

<table>
<thead>
<tr>
<th>CRUs (Supply Item)</th>
<th>Reorder Quantity</th>
<th>Approximate Print Yield (Full Color 8.5x11/A4 Prints)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feed Roll Kit (Trays 5–9)</td>
<td>1 kit</td>
<td>300,000</td>
</tr>
</tbody>
</table>

**Important**: Each tray requires its own feed roll kit. Each kit contains all the required items for replacing the feed rolls.

- Reorder number: **008R13196** for Tray 5
- Reorder number: **008R13195** for Tray 6, 1-Tray Oversized High Capacity Feeder
- Reorder number: **008R13169** for Trays 6-9, 2-Tray Advanced Oversized High Capacity Feeder or Dual Advanced Oversized High Capacity Feeder; 1 roll kit is required for each tray.

For more information, contact the Customer Support Center.

**Replacing Tray 5 Feed Rolls**

Use this procedure by Tray 5 is installed on top of Trays 6 and 7.

**Tip**: Replace the bypass tray feed rolls when experiencing frequent multifeeds, single feeds, or blank prints in the stack of the output prints.

Use this procedure to replace the Bypass tray feed rolls, which includes:

- Feed Roll
- Nudger Roll
- Separator Roll

**Note**: After you replace all of the feed rolls, contact your system administrator who will reset the HFSI counter for these CRU components to zero (0).

1. Locate and access the Bypass Tray on top of Trays 6 and 7.
2. Lift up and open the Bypass Tray cover to access the feed roll components.

3. Remove and replace the feed roll by squeezing the metal shaft and lifting out.

4. Remove and replace the nudger roll using the same technique.
5. Remove and replace the separator roll using the same technique.

6. Close the bypass tray cover.

7. Verify that the tray is operating correctly by feeding paper from the bypass tray.

8. Log in as the administrator or ask the administrator to perform the following steps to reset the HFSI count to zero (0):
   a. At the UI press the Machine Status button.
   b. Select the Tools tab.
   c. Select System Settings > Common Service Settings > Maintenance.
   d. Use the arrow buttons to access the next Maintenance screens.
   e. Select the Technical Key Operator (TKO) icon.
      The Technical Key Operator feature displays.
   f. Log in to the Technical Key Operator mode.
      Attention
      If you cannot log in as TKO, or do not have the TKO password, call your Customer Service Engineer.
   g. Select the bypass rolls item that corresponds with the newly-replaced components.
   h. Select Reset Current Value. The system resets the HFSI to 0.

9. Exit the administrator mode by pressing the Log In/Out button on the UI.
   When prompted, select Logout.

Replacing Trays 6 and 7 Feed Rolls
Replace the feed rolls every 300,000 prints or when experiencing frequent multifeeds, single feeds, or blank prints in the stack of the output prints.

Use this procedure to replace the feed rolls, which includes:
- Feed Roll
- Nudger Roll
- Separator Roll

Note: After you replace all of the feed rolls, contact your system administrator who will reset the HFSI counter for these CRU components to zero (0).
1. Pull open the top tray to access the feed components.

2. On the right-side panel of the tray is the feed roll compartment.

3. Remove the nudger roll by pushing down on the black tab with one hand (which raises the roll upward) and then squeezing the metal shaft on both ends with your other hand. Lift out the nudger roll.

4. Replace the new roll by squeezing both ends of the metal shaft, and pushing down on the black tab, insert and release the roll ends into the notches.
5. Next, remove the separator roll assembly at the side of the feeder tray to access the separator roll. Unscrew the 3 thumbscrews.

6. Slide the separator assembly all the way to the left so it is out of the slots. Pull the assembly out towards you until completely removed from the tray. Set aside.

7. With the separator assembly out, access and remove the feed roll. To remove, squeeze both ends of the metal shaft and lift out. To replace, squeeze both ends of the new roll shaft, then insert and release the roll ends into the notches.
8. Finally, replace the separator roll. Squeeze the orange shafts of the separator roll and lift out of the assembly.

9. Replace a new separator roll into the black notches of the assembly using the same technique.

10. Reinstall the separator assembly into the tray. Align the cutout holes of the assembly with the frame of the tray so the pin holes match up. Insert the assembly into the frame. Slide the assembly all the way to the right using the pin as a guideline. Ensure the device is all the way into the slots and the 3 screw areas align.

11. Screw in the 3 thumbscrews to attach the assembly. Do not overtighten.

12. Close the tray and verify that the tray is operating successfully by feeding paper using that tray.

13. Log in as the administrator or ask the administrator to perform the following steps to reset the HFSI count to zero (0).
a. At the UI press the **Machine Status** button.
b. Select the **Tools** tab.
c. Select **System Settings > Common Service Settings > Maintenance**.
d. Use the arrow buttons to access the next Maintenance screens.
e. Select the **Technical Key Operator** icon.
   The Technical Key Operator feature displays.
   
f. Log in to the Technical Key Operator mode.
   
   **Attention**
   
   If you cannot log in as TKO, or do not have the TKO password, call your Customer Service Engineer.

g. Select the item (HCF) that corresponds with the newly-replaced components.
h. Select **Reset Current Value**. The system resets the HFSI to 0.

14. Exit administrator mode by pressing the **Log In/Out** button on the UI.
   When prompted, select **Logout**.

**Trays 8 and 9 Maintenance**

**Replacing Tray 5 Feed Rolls**

Use this procedure by Tray 5 is installed on top of Trays 8 and 9.

![Tip](image)

**Tip:** The feed rolls for Tray 5 (Bypass) should be replaced when experiencing frequent multifeeds, single feeds, or blank prints in the stack of the output prints.

Use this procedure to replace the following feed rolls for Tray 5:

- Feed Roll
- Nudger Roll
- Separator Roll

![Note](image)

**Note:** After you replace all of the feed rolls, contact your system administrator who will reset the High Frequency Service Item (HFSI) usage counter for these CRU components to zero (0).

1. Locate and access Tray 5 (Bypass) on top of Trays 8 and 9.
2. Lift up and open the Bypass Tray cover to access the feed roll components.

3. Remove and replace the feed roll by squeezing the metal shaft and lifting out.

4. Remove and replace the nudger roll using the same technique.
5. Remove and replace the separator roll using the same technique.

6. Close the bypass tray cover.

7. Verify that the tray is operating correctly by feeding paper from the bypass tray.

8. Log in as the administrator or ask the administrator to perform the following steps to reset the High Frequency Service Item (HFSI) count to zero (0):
   a. At the Control Panel, press the **Machine Status** button.
   b. Select the **Tools** tab.
   c. Select **System Settings > Common Service Settings > Maintenance**.
   d. Use the arrow buttons to access the next Maintenance screens.
   e. Select the **Technical Key Operator** (TKO) icon.
      The Technical Key Operator feature displays.
   f. Log in to the Technical Key Operator mode.
      **Attention**
      If you cannot log in as TKO, or do not have the TKO password, call your Customer Service Engineer.
   g. Select the bypass roll items that corresponds with the newly-replaced components.
   h. Select **Reset Current Value**. The system resets the High Frequency Service Item (HFSI) to 0.

9. Exit the administrator mode by pressing the **Log In / Out** button on the UI.
   When prompted, select **Logout**.

**Replacing Trays 8 and 9 Feed Rolls**

Replace the feed rolls every 300,000 prints or when experiencing frequent multifeeds, single feeds, or blank prints in the stack of the output prints.

Use this procedure to replace the feed rolls, which includes:

- Feed Roll
- Nudger Roll
- Separator Roll

**Note:** After you replace all of the feed rolls, contact your system administrator who will reset the High Frequency Service Item (HFSI) usage counter for these CRU components to zero (0).
1. Pull open the top tray to access the feed components.

2. Notice the feed roll compartment on the right-side panel of the drawer.

3. Remove the nudger roll by pushing down on the black tab with one hand (which raises the roll upward) and then squeezing the metal shaft on both ends with your other hand. Lift out the nudger roll.

4. Replace the new roll by squeezing both ends of the metal shaft, and pushing down on the black tab, insert and release the roll ends into the notches.
5. Next, remove the separator roll assembly at the side of the feeder tray to access the separator roll. Unscrew the 3 thumbscrews.

6. Slide the separator assembly all the way to the left so it is out of the slots. Pull the assembly out towards you until completely removed from the tray. Set aside.

7. With the separator assembly out, access and remove the feed roll. To remove, squeeze both ends of the metal shaft and lift out. To replace, squeeze both ends of the new roll shaft, and insert and release the roll ends into the notches.
8. Finally, replace the separator roll. Squeeze the orange shafts of the separator roll and lift out of the assembly.

9. Replace a new separator roll into the black notches of the assembly using the same technique.

10. Reinstall the separator assembly into the tray. Align the cutout holes of the assembly with the frame of the tray so the pin holes match up. Insert the assembly into the frame. Slide the assembly all the way to the right using the pin as a guideline. Ensure the device is all the way into the slots and the 3 screw areas align.

11. Screw in the 3 thumbscrews to attach the assembly. Do not over tighten.

12. Close the tray and verify that the tray is operating successfully by feeding paper using that tray.
13. Log in as the administrator or ask the administrator to perform the following steps to reset the High Frequency Service Item (HFSI) count to zero (0).
   a. At the Control Panel, press the Machine Status button.
   b. Select the Tools tab.
   c. Select System Settings > Common Service Settings > Maintenance.
   d. Use the arrow buttons to access the next Maintenance screens.
   e. Select the Technical Key Operator (TKO) icon.
      The Technical Key Operator feature displays.
   f. Log in to the Technical Key Operator mode.
      **Attention**
      If you cannot log in as T
   g. Select the item that corresponds with the newly-replaced components.
   h. Select Reset Current Value. The system resets the High Frequency Service Item (HFSI) to 0.

14. Exit administrator mode by pressing the Log In / Out button on the Control Panel.
    When prompted, select Logout.

---

**Finishing Devices Maintenance**

**Business Ready (BR) Finisher and Optional Booklet Maker Maintenance**

**Consumable Supplies for the BR Finisher**

<table>
<thead>
<tr>
<th>CRUs (Supply Item)</th>
<th>Reorder Quantity</th>
<th>Approximate Print Yield (Full Color 8.5x11/A4 Prints)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Ready (BR) Finisher Staple Cartridge</td>
<td>1 Staple Cartridge</td>
<td>5,000 staples per cartridge</td>
</tr>
<tr>
<td>Business Ready (BR) Finisher with Booklet Maker Staple Cartridge</td>
<td>4 pack: 5,000 staple refills each</td>
<td>5,000 staples per cartridge</td>
</tr>
<tr>
<td>Staple Refills for the Business Ready Finisher and Business Ready Finisher with Booklet Maker</td>
<td>3 refills per carton</td>
<td>5,000 each refill for a total of 15,000</td>
</tr>
</tbody>
</table>

**Replacing Staples in the Main Stapler Unit**

1. Open the front door of the Business Ready Finisher.
2. Hold the stapler assembly by the orange lever R1 and push it to the right.

3. Grip the staple cartridge by the orange handle and pull it firmly toward you to remove it.

4. Pinch both sides of the staple refill (1) and remove it from the cartridge (2).

5. Insert the front side of the new staple refill into the staple cartridge (1), then push the rear side into the cartridge (2).

6. Close the front door of the Business Ready Finisher.

Replacing Staples in the Booklet Maker

1. Open the front door of the Business Ready Finisher.

2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges appear on the top edge of the device.
3. To remove the staple cartridge from the booklet maker, push down on the staple cartridge handle as shown, then pull the cartridge out and up.

4. Turn the staple cartridge over.

5. To permit the staple cartridge handle to open out and away from the staple refill, press in the green tabs, then pull back the handle.

6. To remove the staple refill, press the rear of the refill container as shown.

7. Replace the staple refill, then return the staple cartridge to the booklet maker.

8. Close the front door of the Business Ready Finisher.

**Emptying the Hole Punch Waste Container**

A message appears on the press User Interface (UI) when the hole punch waste container is full.

⚠️ **WARNING:** Do not perform this procedure while the printer is copying or printing.

1. Open the front door of the Business Ready Finisher.
2. Remove the hole punch waste container from its slot near the top left of the finisher.

- Wait 10 seconds before reinserting the container into the printer. The hole punch counter resets after 10 seconds.
- If you remove the hole punch waste container before the device instructs you to, empty the container before you reinsert it into the finisher.

3. Empty the container.

4. Insert the container all the way into the finisher.

5. Close the front door of the Business Ready Finisher.
Crease and Two-Sided Trimmer Maintenance

Emptying the Crease and Two-Sided Trimmer Waste Container

When the trimmer waste container is nearing the full condition, an indicator lights on the top of the Crease and Two-Sided Trimmer.

Note: The waste container can be emptied before it is full and also while the printer is running.

When the waste container reaches the full condition, the following changes occurs:

- The indicator changes from a steady lighted condition to blinking.
- A message appears on the press indicating that the waste container is full.

Perform the following steps to empty the trimmer waste container.

1. Open the lower cover of the Crease and Two-Sided Trimmer.
2. Pull out and remove the waste container.

3. Discard all waste.
   
   **Important:** Ensure that the waste container is empty. If waste or debris remains in the container, the trimmer may malfunction.

4. To ensure that you remove all waste and debris, especially beneath the frame that is located behind the container, use the cleaning rod to remove any remaining waste from inside the trimmer.

5. Return the cleaning rod to its original position on the inside of the lower cover.

6. Reinsert the waste container and push it in fully.

7. Close the lower cover.
Production Ready Finishers Maintenance

Finisher Consumable Supplies

Xerox supplies, including staples, staple cartridges, and staple waste containers can be ordered from Xerox by going to www.xerox.com and clicking on the Contact Us link for specific contact information and telephone numbers in your area or by clicking on the Supplies and entering/selecting your specific machine information (product family and model type).

Note: Always refer to www.xerox.com for the latest Customer Replaceable Units (CRUs) part numbers.

Store supply items and Xerox parts in their original packages in a convenient location.

<table>
<thead>
<tr>
<th>Supply Item</th>
<th>Supply Unit Shipped with finisher/Reorder Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staple Cartridge and Staple Waste Container (for the PR Finisher, the PR Booklet Maker Finisher, and the PR Finisher Plus)</td>
<td>4 staple cartridges (5,000 staples per cartridge) and 1 staple waste container per carton</td>
</tr>
<tr>
<td>PR Booklet Maker Finisher Staple Cartridge</td>
<td>4 pack: 5,000 staple refills each</td>
</tr>
</tbody>
</table>

Checking the Status of Finisher Consumables

When a consumable is nearing the time for replacement, a message is displayed on the control panel touch screen. This indicates when it is time to order and install a new consumable item. With some Customer Replaceable Units (CRUs), the screen indicates that the press may continue to run print jobs without immediately replacing the item. Otherwise, when it is time to replace it, a message appears and the press stops running.

To check the status of your consumables:

1. Press the **Home** button on the press control panel.

2. Press **Machine Status** and select the **Supplies** tab.

   The Supplies area shows a 1 to 100% indicator bar of the remaining amount of dry ink/toner. Remaining dry ink/toner is updated in 10% increments.
3. From the menu, select **Other Consumables** to view the status of other consumables, such as the drum cartridges, the Dry Ink/Toner Waste Bottle, and any applicable optional devices, such as the OHCF feed rolls.

The Other Consumables window appears and provides information about the percentage of remaining life for each consumable.

4. Use the up and down arrows to see additional consumables, such as the finisher staples, the staple waste container, and other consumables for any additional optional devices that are configured with the press.

**Replacing the Basic Staple Cartridge for Side Stitching**

*Note:* Ensure that the press is not running before performing this procedure.
1. Open the finisher front cover.

2. Pull out R1.

3. Holding the staple cartridge at the position indicated by the arrow, remove it from the unit.
4. Insert a new staple cartridge into the unit.

![Image of staple cartridge](image1.png)

5. Insert the unit to its original position.

![Image of unit in place](image2.png)

6. Close the finisher front cover.

Replacing the Booklet Staple Cartridge for Saddle Stitching

>Note: Ensure that the press is not running before performing this procedure.

>Note: This procedure is applicable only or the PR Booklet Maker Finisher.

1. Open the finisher front cover.

![Image of front cover open](image3.png)
2. Pull out the **Saddle Stitch Unit 3** toward you until it stops.

3. While holding the tabs on the staple cartridge, pull out the cartridge to remove it.

   ![Image](image1)

   **Note:** There are two booklet staple cartridges provided. Check the message to see which cartridge needs replacing.

4. While holding the tabs on the new staple cartridge, push in the cartridge until it seats.

   ![Image](image2)

   **Note:** Make sure that the marks are aligned.
5. Push the Saddle Stitch Unit 3 gently into the finisher until it stops.

6. Close the finisher front cover.

Replacing the Finisher Staple Waste Container

**WARNING:** To avoid personal injury, use care when removing staple waste container.

The press displays a message when staple waste container is full. When the message appears, replace the container with a new one.

**Important:**
- Before you perform this procedure, ensure that the press is not running.
- When you replace the staple waste container, keep the press powered on. If the press is powered off, it does not recognize that the waste container was replaced, and the full message remains displayed.
- To ensure that the press continues running after you replace the waste container, close the finisher front cover.

**Note:** A staple waste container comes with the basic staple cartridge.

1. Open the finisher front cover.
2. Move the lock lever under R5 toward the left to the opened-lock mark.

3. Pull out R5.

4. Place the used staple waste container into the supplied plastic bag.

   Note: Do not disassemble the used waste containers. Return the used staple waste containers to the Customer Support Center.
5. Insert the new staple waste container by lowering it into position and gently pushing it into place.

**WARNING:** To prevent injury, do not put your fingers on top of the container.

6. Move the lock lever under R5 toward the right to the closed-lock mark.

7. Close the finisher front cover.

**Emptying the Hole Punch Waste Container**

The press displays a message when hole punch waste container is full. When the message appears, empty the container of all paper scraps.

⚠️ **Important:**

- Before you perform this procedure, ensure that the press is not running.
- When you empty the container, keep the press powered on. If the press is powered off, it does not recognize that the container was emptied, and the full message remains displayed.
- To ensure that the press continues running after you empty the container, close the finisher front cover.
1. Open the finisher front cover.

2. Pull out the R4.

3. Discard all waste from the container.

   **Important:** Be sure to completely empty the container. If any waste or scraps remain, the container becomes full before a full message displays causing a fault to occur.

4. Return R4 to its original position.

5. Close the finisher front cover.
PR Finisher Plus Maintenance

For information on consumable supplies and maintenance procedures for the PR Finisher Plus, refer to the following:

- Finisher Consumable Supplies
- Checking the Status of Finisher Consumables
- Replacing the Basic Staple Cartridge (for Side Stitching)
- Replacing the Finisher Staple Waste Container
- Emptying the Hole Punch Waste Container

SquareFold® Trimmer Device Maintenance

Emptying the SquareFold® Trimmer Waste Container

When the waste container reaches the full condition, an indicator lights on the top of the SquareFold® Trimmer device. A message also appears on the press indicating that it is full. When the message appears, dispose of the paper scraps.

Note: Keep the press powered on when disposing of the waste. If powered off, the press does not recognize that the container was emptied.

Perform the following steps to empty the trimmer waste container.

1. Ensure that the press is not running, then slowly pull out the Trimmer Waste Container.
2. Hold the belt on the waste container, then remove the container with both hands.

3. Discard all waste and scraps.

   Note: Ensure that the container is completely emptied. If any waste or scraps remain, the container will become full before a message appears causing the press to malfunction.

4. Reinsert the empty waste container and slowly push it in completely.
Troubleshooting

General Troubleshooting

Check the press status for system troubleshooting.

⚠️ **WARNING:** Precision components and high-voltage power supplies are used on the press. Never open or remove covers that are screwed shut unless specifically instructed in this guide. A high-voltage component can cause electric shocks. When opening the panels and covers that are screwed shut to install or detach optional accessories, be sure to follow instructions in this guide. Do not try to alter the press configuration or modify any parts. Doing so might cause press malfunction or fire.

The information in this section helps you resolve some basic problems you can encounter with the press. If the problem persists after following the instructions, contact your Xerox Representative or the Xerox Technical Customer Support.

🔍 **Note:** If your print server indicates that the press has a fault and the User Interface (UI) does not readily display a message, refer to the Print Reports > Job Status > Error History Report.

Press Does Not Power On

**Problem**

The press does not power on.

**Solutions**

1. Ensure the power cord from the press is plugged into the power outlet or receptacle. If the problem persists, perform the following steps:
   a. From inside the front door, press off the main power switch.
   b. Firmly plug in the power cord.
   c. Press the power switch on.
2. From inside the front door, ensure the power switch is set to the **ON** position, the press the power button **ON**.
   🔄 **Note:** The power button is located on top of the press near the user interface (UI).
3. Ensure the power supply is 200–240V (volts) and 30A (amperes).
4. Ensure that the supplied power capacity is compatible with the specified maximum power consumption of the press which is 2.8–3.1 kVA (kilo-volt-ampere).
5. Check the ground fault interrupter (GFI) circuit breakers.
6. If the power in your location is working properly and you have tried the suggested solutions, but the press does not power on, contact the Customer Support Center for assistance.
Cannot Obtain the Press Serial Number from the Machine Status Screen

Problem
There is no power to the press, and you cannot access the Machine Status screen to get the press serial number.

Solutions
Open paper tray 1. On the left frame, near tray 1, locate the serial number. Refer to Locating the Press Serial Number.

User Interface Is Not Working

Problem
The user interface (UI) is not working. It is locked up or completely dark.

Solutions
- If the UI buttons or keyboard do not work, press the power button Off. Wait 30 seconds, then reboot the system by pressing the power button On.
- If the Power Saver button light is on, the press is in the Power Saver Mode. To cancel the Power Saver mode, press the Power Saver button.

Press Does Not Complete a Print Job

Problem
The press does not successfully complete a print job.

Solutions
- To verify that your press connected to the network, from the print server, print a test page.
- Verify that the power cable is connected to the press and to a suitable power outlet.
- Verify that the network cables are attached securely to the press and seated properly.
- Clear out the print job from the print queue, and resend the print job.
- To restart the press, power off the press, then power it on.
- Your press may not be configured on the network. To connect the press to the network, contact the system administrator.
Time Interval Between Print Jobs Is Longer Than 1 Minute

Problem

The press is taking longer than one minute before printing the next job.

Solutions

The system requires approximately 2 minutes when switching print modes in order to make any necessary adjustments for the next print job, including color-to-color registration, density, charge levels, bias levels, or other adjustments.

- The system has two print modes selectable at the print server:
  - 4 Color Mode (CMYK: Cyan, Magenta, Yellow, Black)
  - Black and White Mode Only
- If the next print job is switching print modes, for example from black-only to 4-color, the system requires approximately 2 minutes to make any necessary adjustments.
- During this time, the touch screen displays the Adjusting Image Quality message.
- The next job begins printing once the system completes its adjustments.

Other information to remember includes:

- From a cold start (power on or power saver), system takes less than 5 minutes to start printing.
- From standby mode, system usually takes less than 1 minute to start printing.

Print Output Contains Corrupted Text

Problem

The printed output contains corrupted text, or the text prints incorrectly.

Solutions

Check the application or print driver settings on whether non-standard fonts are used for printing.

Trays Do Not Recognize the Media

Problem

Trays do not recognize the media.
Solutions

- At the user interface (UI), check the paper settings for the tray. To check the paper settings for a tray, select Machine Status > Device Information > Paper Tray Status.
- Check the print server settings.
- Check that the paper is loaded correctly in either the short-edge-feed (SEF) or long-edge-feed (LEF) direction, and at the print server, ensure that the settings match the programmed paper settings.

Prints Are Not on the Desired Paper Size

Problem
Prints are not on desired paper size.

Solutions

- Ensure that the correct paper size and type is loaded in the paper trays.
- Set the paper guides to the correct positions.
- At the print server, select the paper size, tray and weight, and from the Tray Properties window, ensure the paper attributes match.
- From the print driver, ensure the Fit to Paper or an equivalent selection is not selected.

Repeated Paper Misfeeds, Jams, or Wrinkles

Problem
Paper repeatedly misfeeds, jams often, or wrinkles.

Solutions

- If a message appears on the press touch screen, follow the instructions displayed.
- Ensure that the paper and paper tray selected match the paper size settings. Refer to the Tested Substrate List from www.xerox.com/rmlna or www.xerox.com/rmleu.
- Ensure that the trays are loaded properly with acceptable media, and do not exceed the MAX fill line.
- Ensure that the paper tray edge guides are in the correct position. To ensure tray closure, firmly push it in as far as possible.
- In the selected tray, flip the paper stack around or over.
- Remove a few sheets from the top and the bottom of the stack in the paper tray.
- Fan all four edges of the paper in the selected paper tray.
- Replace the paper in the selected paper tray with paper from a new package.
• Remove any partially fed paper from the trays. Make sure to remove any torn pieces of paper still
remaining inside the press.
• Ensure that the paper you are using had been stored properly.
• If the problem is from trays 6-9 only, refer to Multifeeds, Misfeeds and Paper Jams in Trays 6-9.

Multiple Sheets Fed From the Paper Trays

Problem
Multiple sheets feed from the paper trays.

Solutions
• Do not fill the paper trays above the MAX fill line indicator.
• Remove the paper from the tray and fan the sheets to separate the joined sheets.
• If hole–punch paper sticks together at the holes, remove the paper from the tray, and fan the
sheets to separate the joined sheets.
• If environmental conditions are too dry and cause excessive static, paper and transparencies may
stick together. Increase the humidity level in the room to minimize static.
• Before you load transparencies, gently fan them to separate the sheets.
• If the problem is from trays 6-9 only, refer to Multifeeds, Misfeeds and Paper Jams in Trays 6-9.

Paper Jams in Optional Trays 6–9

Problem
Paper jams occur in the optional Trays 6, 7, 8, or 9.

Solutions
• Visually check to see if the feed, separator, or nudger rolls are worn or damaged.
• For the tray rolls, check the high frequency service item (HFSI) interval status. If required, replace
the rolls.

For information, refer to Trays 6 and 7 Maintenance or Trays 8 and 9 Maintenance.

Paper Jams When Exiting the Paper Trays

Problem
When exiting the trays, paper jams occur.
Solutions

- Ensure that the edge guides of the paper tray fit snugly against the paper stack.
- Do not fill the paper trays above the MAX fill line indicator.
- Close the tray slowly to avoid shifting the paper stack.

Printed Output Jams When Exiting Press to Offset Catch Tray (OCT)

Problem
- When exiting the press to the offset catch tray (OCT), the printed output jams.

Solution
- When using the OCT for printed output, to ensure continuous production, empty the tray before it approaches the maximum capacity. The OCT maximum capacity is 500 sheets for 24 lb. or 90 g/m² paper.
- For 11 x 17 in. or A3 output, ensure the first output sheet is not blocking the paper exit.

Excessive Paper Curl

Problem
- The printed output contains excessive paper curl.

Solutions

Potential impacts:
- Ensure that the correct paper weight and paper type are selected.
- The printed output contains a mass of dry ink/toner coverage. On the printed output, the amount of paper curl depends on the size of the dry ink/toner mass.
- The paper weight and whether or not it is coated or uncoated.
- The humidity conditions at the press.
- You can sometimes minimize curl problems by flipping the paper over in the tray. If excessive curl is still present, use a heavier paper.
- To ensure continuous production, empty the output device when the output approaches the maximum amount that the device can hold; refer to the specifications for that output device for output limit amount.
- An attempt to print on thicker paper or on paper stock that is less sensitive to moisture.

Paper curl can be adjusted in the following ways:
- If the Interface Decurler Module or Interface Decurler Module with Inline Spectrophotometer (ILS) is attached, use the manual decurl buttons on the control panel for the module. For
information, refer to Interface Decurler Module and Interface Decurler Module with Inline Spectrophotometer (ILS).

- Refer to Paper Curl.
- Use the Adjust Paper Curl feature. For information, refer to the System Administrator Guide.

**Cannot Print Because Output Paper Width Does Not Match Installed Fuser Assembly**

**Problem**

Unable to print with current fuser assembly because the output paper width does not match the installed fuser.

**Solutions**

- Replace the fuser assembly with one that supports the specific paper width for the current print job. For more information, refer to Fuser Hints and Tips.
- Cancel the current print job and continue with the print job by resubmitting from the print server.

**WARNING:** When resubmitting the job from the print server, do not override the current fuser maximum width. Overriding the fuser width causes a mismatch, and can damage the fuser.

**Message on the User Interface Does Not Clear**

**Problem**

The message on user interface does not clear.

**Solutions**

- If the fault is a paper jam, ensure that any paper is removed from the area and that there are no hidden or small pieces of paper left behind.
- Reboot the press by pressing off the power, and then pressing it on again. The power button is located on top of the press near the user interface (UI).

**Transparency Output Is Damaged**

**Problem**

After you exit from the press, the transparency output is damaged.
Solutions

For copy or print job, for the paper type, ensure that Transparencies is selected. The press temperature adjusts for different types of media, and paper tolerates more heat than transparencies.

Printed Output Is Not Stacked Correctly

Problem
The output is not stacked correctly.

Solution
Check paper curl, and ensure that the paper tray guides are locked into position against the paper.

Note: Mixed media sizes may not stack well.

Pages in the Printed Output Are Not Stapled or Punched

The following information is applicable when one of the following finishing devices is attached to your press:
• Business Ready (BR) Finisher without or with the optional Booklet Maker
• Production Ready (PR) Finisher
• Production Read (PR) Booklet Maker Finisher

For information on these finishing devices, refer to:
• Business Ready (BR) Finisher and Optional Booklet Maker
• Production Ready (PR) Finishers

Problem
Pages in the output set are not stapled or punched.

Solutions
• Select the option on the press touch screen.
• Check that there are staples in the staple cartridge.
• Check that the punch scrap container is not full.

Hole-punch Output Has Holes on the Wrong Side

Problem
The hole-punch output has the paper holes are on the wrong side.
Solutions

Ensure that the hole-punch paper is loaded correctly in the paper tray, and that the holes are positioned as shown on the tray label.

Printing Takes Too Long for First Print or First Copy Out

Copy or Print Jobs With a Combination of Color and Black-and-White Output

Problem
For jobs that are a combination of color and black and white, the first copy or print output takes longer than the expected 10 seconds.

Job Workflows and First Copy or Print Output Time Factors
The following workflow scenarios affect the extended wait-time for the first copy or print output:
- Copy or print jobs that are 1–2 pages only versus copy or print jobs that are more than 2 pages
- The number of users in the print queue
- Copy or print jobs that use the same type of media versus copy or print jobs that contain mixed media types
- Copy or print jobs that use a mixture of color and black-and-white output

If you do not use one of these workflows, the implementation of this solution can result in color stability issues.

Solution
To decrease the wait-time for first copy or print out, perform the following:

1. Increase the Power Saver time to 30 minutes.
   If the wait time remains too long, continue to the next step.

2. For this user requirement, to change the NVM values for 752–175 and 740–437, contact Xerox Technical Customer Support. For more information, refer to the Xerox® Versant® 280 Press System Administrator Guide.

3. For Copy mode, on the press UI, set Output Color to Auto Detect.
   The default setting is Auto Detect.

Color Copy or Color Print Jobs

Problem
For copy or print jobs that are color only, for the first copy or print output, the printing takes longer than the expected 10 seconds.

Color Job Workflows and First Copy or Print Output Time Factors
The following workflow scenarios affect the extended wait-time for the first color copy or print output:
• Copy or print jobs that are 1–2 pages only versus copy or print jobs that are more than 2 pages
• The number of users in the print queue
• Color copy or print jobs that use the same type of media versus copy or print jobs that contain mixed media types
• Copy or print jobs that use only a color output

If you do not use one of these workflows, the implementation of this solution can result in color stability issues.

Solution
To decrease the wait-time for first copy or print out, perform the following:

1. Increase the Power Saver time to 30 minutes.
   If the wait time remains too long, continue to the next step.

2. For this user requirement, to change the NVM values for 752–175 and 740–437, contact your Xerox Technical Customer Support. For more information, refer to the Xerox® Versant® 280 Press System Administrator Guide.

3. For Copy mode, on the press UI, set Output Color to Auto Detect.
   The default setting is Auto Detect.

Reducing Dry Ink/Toner Consumption

Problem
In order to maintain image quality (IQ), the press enters Adjust Image Quality mode. In this mode, dry ink/toner is consumed in the form of dry ink/toner bands and process control patches being laid down. Frequency of image quality adjustment is dependent on many factors including area coverage. While printing jobs of low area coverage or low image density, the frequency of image quality adjustment can be greater.

Solution
Three NVM values can be adjusted to reduce dry ink/toner consumption based on user requirements. Refer to the following table. From the first column of the table, select the solution which best fits user requirements. To implement the appropriate outcome for your environment, contact Xerox Technical Customer Support.

Important: NVM values must be set or changed only by the customer support representative.
### User Requirement

<table>
<thead>
<tr>
<th>User Requirement</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Image Quality (IQ) Priority</td>
<td>For this user requirement, to change the NVM values for 762–075, 752–175 and 762–098, contact Xerox Technical Customer Support.</td>
</tr>
<tr>
<td>These are the press default settings which provide optimum IQ output, but increase dry ink/toner consumption and can reduce productivity.</td>
<td></td>
</tr>
<tr>
<td>2. Middle Setting</td>
<td>For this user requirement, to change the NVM values for 762-075, 752–175 and 762–098, contact Xerox Technical Customer Support.</td>
</tr>
<tr>
<td>This is the recommended setting.</td>
<td></td>
</tr>
<tr>
<td>These settings configure the press for less dry ink/toner usage if image quality is not the highest priority. IQ can be reduced slightly.</td>
<td></td>
</tr>
<tr>
<td>3. Lower Toner Consumption Priority</td>
<td>For this user requirement, to change the NVM values for 762–075, contact Xerox Technical Customer Support. For the NVM values 752–175 and 762–098, no change is required.</td>
</tr>
<tr>
<td>These settings decrease dry ink/toner usage and increase productivity, but can result in degraded IQ.</td>
<td></td>
</tr>
</tbody>
</table>

### Image Quality Troubleshooting

Perform these actions first to improve image quality:

- Manage the stock in use. Ensure that the media used is approved, within press specifications and is clean.
- Ensure the correct media is properly loaded in the paper tray.
- Run print samples and evaluate the defect. From the following table, determine which problem description matches the IQ defect and perform the appropriate corrective actions.

### Contamination on the Back Side of Prints

**Problem**

The back side of the printed output contains contamination. The contamination is a specific toner defect of 10–15 mm wide running from long-edge (LE) or trail-edge (TE), and is near the outboard (OB) side of the print.
Solutions

- Contamination can be media related.
  - Look for paper damage, paper dust, or environmental conditions that may contribute.
  - Ensure the media is fresh and properly loaded in the trays.
- Defects occur on heavyweight stock with lightweight stock settings. Ensure the proper Custom Paper Settings are configured for the media in use. For information and procedures, refer to the System Administrator Guide, Paper Tray Settings.
- If the defect is the specific streak on the back of prints, there may be a secondary-bias transfer roll (2nd BTR) failure. Perform the Cleaning the Fuser Assembly with Paper procedure. If the problem continues, contact the customer support center.

Banding on Prints

Problem

The print shows lines or bands running from the inboard-to-outboard (IB/OB) direction (side-to-side direction).
For defects running Lead Edge to Trail Edge (LE/TE), refer to Streaks or Lines on Prints.

**Solutions**

Acquire the measuring tool from either [www.xerox.com/VERSANT_280docs](http://www.xerox.com/VERSANT_280docs) or the *Nationalization Kit*. Check the frequency of the defect at interval.

- If the defect is at the interval of 37.5 mm or 147 mm, replace the appropriate drum cartridge. Refer to *Replacing a Drum Cartridge*.
- If the defect is defect at the interval of 154 mm, the problem may be with the Pressure Roll Assembly (fuser assembly). For more details, contact the customer support center.
- If the defect is 375 mm, the problem may be Fuser Belt failures. For more details, contact the customer support center.

**Color Nonuniformity on Prints**

**Problem**

The print has variations in color uniformity, such as:

- Uneven density
- Light or dark areas running from the side-to-side direction (inboard-to-outboard)
- Color shift or inconsistent color throughout the page
Solutions

- Perform the Cleaning the ROS Windows procedure.
- Perform the Density Uniformity Adjustment procedure. For refer to the System Administrator Guide, Simple Image Quality (SIQA).
- For other suggested solutions, refer to Custom Paper Settings Troubleshooting.

Random White or Dark Spots on Prints

Problem

The prints show random spots, but they do not repeat at regular intervals.
Solutions

- Ensure that the media used is approved, within press specifications and is clean.
- Check that the press is within environmental specifications and humidity levels.
- Load a new ream of paper or different type of media.
- Run the Clean Toner procedure. For instructions, refer to the System Administrator Guide, Maintenance > Common Service Settings.
- Check for Drum failure or damage. Acquire your measuring tool from either www.xerox.com/VERSANT_280docs or the Nationalization Kit.
  - Check the frequency of the spot intervals. If spots occur every 147 mm on the prints, determine which color drum is affected.
  - To determine which color drum is affected, go to www.xerox.com/VERSANT_280docs, to download, and then print the Halftone Test Pattern PDF.
- To replace or swap the drum; refer to Drum Cartridge.

Repeating Defects at Regular Intervals on Prints

Problem

The prints show any defect type that repeats at intervals that can be measured.
Solutions

Acquire the measuring tool either from [www.xerox.com/VERSANT_280docs](http://www.xerox.com/VERSANT_280docs) or the Nationalization Kit. Check the frequency of the defect interval.

- If the defect occurs every 44 mm on the prints, do not replace the drum. This interval is caused by a damaged or defective developer housing. For more details, contact the Customer Support Center.
- If spots or bands occur every 147 mm on the prints, a drum is damaged or light shocked. Replace or swap the appropriate drum cartridge; refer to Replacing a Drum Cartridge.
- If the defect occurs every 374 mm on the prints, replace the fuser belt assembly. For details, contact the Customer Support Center.

Streaks or Lines on Prints

Problem

The prints show solid color streaks or lines running from Lead Edge to Trail Edge (LE or TE) of prints.
For IQ defects that run Inboard to Outboard (IB or OB); refer to Banding on Prints.
Solutions

- Perform the Cleaning the ROS Windows procedure.
- Measure and check the frequency of the defect intervals:
  - Acquire the measuring tool either from www.xerox.com/VERSANT_280docs or the Nationalization Kit.
  - If spots or bands occur every 147 mm on the prints, a drum is damaged or light shocked.
  - Replace or swap the appropriate drum cartridge. Refer to Replacing a Drum Cartridge.

Edgewear on Prints

Problem

The IB and OB edges of the output prints shows dry ink/toner deletions, density inconsistency, or is lacking in color depth; occurs mainly when using heavier or lighter weight stock.

Solutions

If you run multiple width papers, for more information, refer to Fuser Hints and Tips and Extended Fuser Life.
Halo or Smudges on Prints

Problem
The printed output contains halo or smudges on them.

Solution
Perform the Density Uniformity Adjustment procedure. For instructions, refer to the System Administrator Guide, Simple Image Quality (SIQA).
For other suggested solutions, refer to Custom Paper Settings Troubleshooting.

Image Density

Problem
Print output is too light, faint, or washed out; solid areas not black or inconsistent shading; part of image missing.
Solution

• On the User Interface, press the **Home** button, and check the status of the CRUs/Supplies. Shake or replace the affected dry ink/toner cartridge. Refer to Replacing a Dry Ink/Toner Cartridge.

• For suggested solutions, refer to Custom Paper Settings Troubleshooting.

• Determine if a drum cartridge is contaminated or light-shocked by running a set of halftone test patterns to identify which color is affected:
  - Go to [www.xerox.com/VERSANT_280docs](http://www.xerox.com/VERSANT_280docs) and download the *Halftone Test Pattern* PDF.
  - Print several sets of the *Halftone Test Pattern* PDF.
  - Identify which color is affected.
  - Replace or swap the appropriate drum. Refer to Drum Cartridge.

• For other suggested solutions, refer to Custom Paper Settings Troubleshooting.

**Image-on-Paper Registration**

**Problem**

The entire image on the printed output is misregistered, shifted, skewed or crooked.
Solution

- Ensure the paper tray guides are against the edges of the loaded paper.
- Create or use an existing Alignment Profile.
- Perform the Auto Alignment Adjustment procedure. For instructions, refer to the System Administrator Guide, Simple Image Quality (SIQA).
- Refer to the Image Registration, Perpendicularity, Skew, and Magnification.

Unfused Prints or Fuser Offset

Problem
The image is not properly fused. Dry ink/toner on print is not permanent, smears, flakes, or rubs off.
Solution

- Check that the paper weight settings at the print server match the actual paper loaded in the tray.
- Ensure that the paper loaded is within press specifications. For information on paper and storage, refer to Paper and Media.
- Load a new ream of paper into the selected paper tray.
- For other suggested solutions, refer to Custom Paper Settings Troubleshooting.
- Perform the Cleaning the Fuser Assembly routine. If the problem continues, contact the Customer Support Center for service.

Trail-Edge Deletions

Problem

Trail edge of output contains dry ink/toner deletions, density inconsistency, or is lacking in color depth; this occurs mainly when using heavier or lighter weight stock.
For inboard or outboard (IB or OB) edge deletions, refer to Edgewear.

Solutions

- Create a custom stock and use it.
- Refer to Trail Edge Deletions

Custom Paper Settings Troubleshooting

This section helps you locate and resolve specific problems through the use of the Custom Paper Settings. For more information, refer to the System Administrator Guide.

To improve print quality, ensure that the used page is:

- Compatible with the press
- Within supported specifications
- In good condition
- Assigned to the correct Press Tray

If problem continues, contact the customer support center.
Multifeeds, Misfeeds, and Paper Jams in Trays 6–9

Problem
Multifeed or misfeed paper jams occur in Tray 6, 7, 8, or 9.

Solutions
1. Change the Adjust Air Assist Values setting:
   - Use this feature to adjust the amount of air volume generated by the tray blowers which assist in separating sheets when feeding paper. When using light-weight or heavy-weight paper, which stick together easily, select a stronger air flow setting in order to better separate sheets and prevent paper jams or multifeeds.
   - This feature can be found in Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the desired Custom Paper > Change Settings > Adjust Air Assist Values > Change Settings.
   - The settings available for this feature are:
     - **System Default**: The air volume is set to the appropriate amount based on the Stock and environmental conditions.
     - **Multifeed Support Table**: Select this option if you use paper that tends to trigger multifeeds. This setting increases the air volume to a level higher than System Default.
     - **Mis-Feed Support Table**: Select this option if you use paper that tends to trigger paper jams. This setting increases the air volume to a level higher than Multifeed Support Table.
     - **Forced Off**: Select this option when working with special media that tends to jam as a result of the air flow that is introduced by Adjust Air Assist Values. This setting turns off Adjust Air Assist Values.

2. Change the Tray Heater setting.
   - Use this feature to Enable (checked) or Disable (unchecked) the tray heater. The tray heater warms the air that is blown into the tray by Adjust Air Assist Values to help prevent paper jams and multifeeds by loosening contact between sheets.
   - The tray heater may partially dry paper and affect print quality. If print quality is affected by dry paper, Disable the tray heater.
   - **Note**: Disabling the tray heater may result in an increase of multifeeds.
   - This feature can be found in Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the desired Custom Paper > Change Settings > Tray Heater > Change Settings.
• To **Disable** (unchecked) the tray heater:
  a. Remove any paper loaded in the tray.
  b. In **Adjust Air Assist Values** select any option except **Forced Off**.
  c. **Disable** (unchecked) the tray heater and register the stock.

    The printer performs a forced exhaust action for approximately one minute. During the forced exhaust action, do not change any settings or open a tray.

    ![Important: A forced exhaust with paper loaded in tray can lead to image quality problems.]

  d. After the forced exhaust is complete, load paper in tray.

3. Change the **Multifeed Detection** setting.
   
   • Use this feature to **Enable** (checked) or **Disable** (unchecked) multifeed notifications; this feature does not make any other adjustments.
   
   • The **Multifeed Detection** feature is accessed from **Machine Status > Tools > Setup & Adjustment > Custom Paper Settings**. Select the desired **Custom Paper > Change Settings > Multifeed Detection > Change Settings**.
   
   • The settings available for the **Multifeed Detection** option include:
     
     – **Enabled** (checked): Multifeed notifications are switched **On**.
     – **Disabled** (unchecked): Multifeed notifications are switched **Off**.

   **Note:** To prevent the system from reporting faults due to multifeeds, **temporarily** disable notifications. This allows the user to continue their workflow until the cause of the problem is resolved. Be aware that disabling this feature has no impact on the occurrence rate of actual multifeeds and, if disabled, multifeed sheets may cause jams elsewhere in the system and/or result in additional blank sheets in the final output.

### Paper Curl

**Problem**

The output contains paper curl.
Solutions

1. If your press configuration includes the Interface Decurler Module (IDM)s, confirm that the IDM Curl Correction option on the IDM control panel is set to Auto.

   Note: For more information, refer to Interface Decurler Module and Interface Decurler Module with Inline Spectrophotometer (ILS)

2. Change the Adjust Paper Curl setting.

   Tip: Changing the default setting is considered a temporary solution because environmental conditions vary from day to day. It is recommended that upon completion of the print job you return the option to its default setting.

   • Use the Adjust Paper Curl feature to correct paper curl caused by heat and pressure and to apply fine adjustments based on the characteristics of each paper type. Paper curl may cause paper jams and wrinkled output.

   • This feature can be found in Machine Status > Tools > Setup & Adjustment > Adjust Paper Curl. It can also be found in Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the desired Custom Paper > Change Settings > Adjust Paper Curl > Change Settings.

   • From the Adjust Paper Curl screen, make the change by moving up or down the selections available one at a time.

   • Use the following sequential order when making changes to the paper curl. This ensures that the desired output is achieved:

     Tip: Paper jams and wrinkled output may occur if the change is not performed in the recommended sequential order; for example, using Default and then skipping to Type C.

     Note: Always run test prints every time a setting is changed / selected; this allows you to evaluate the output and determine if additional changes are necessary.

    a. Default
    b. Type A
    c. Type B
    d. Type C
    e. Custom Curl Correction: Slight (Very Small) Upward or Slight (Very Small) Downward
    f. Custom Curl Correction: Moderate (Small) Upward or Moderate (Small) Downward
    g. Custom Curl Correction: Medium Upward or Medium Downward
    h. Custom Curl Correction: Severe (Large) Upward or Severe (Large) Downward

   • If paper curl continues to persist after trying several or all of these settings, try decreasing the image density on the print job or use a different type of paper.

   • If paper curl is still a problem after you decrease the image density and after you use a different type of paper, for more information, contact the customer support center.
Uneven Density or Mottle

Problem

Uneven Density or Mottle

Solutions

1. Perform **Adjust Image Transfer**.
   - Use this feature to adjust the voltage ratio on the secondary bias transfer roll (2nd BTR). For heavy-weight paper, such as 220 g/m² or greater, the 2nd BTR is where the image is transferred from the belt to the paper. However, there are times when it is also used with lightweight paper.
   - This feature is accessed from Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the desired Custom Paper > Change Settings > Adjust Image Transfer > Change Settings.
   - The Adjust Image Transfer procedure can be performed by selecting **Auto** or **Manual**.
     - **Note:** An automatic adjustment fixes most image quality issues. Always perform the Auto procedure before performing the Manual adjustment.
       - **Auto:** The adjustment is done automatically by the press. It eliminates the need for you to interpret printed targets and manually enter adjustment values. This saves time and avoids errors.
       - **Manual:** The user must manually perform the adjustment, including printing test patterns, interpreting the printed targets on those patterns, then manually entering the adjustment values.
         - **Tip:** Use the Manual adjustment option only when the Auto adjustment does not provide the desired output.
   - For detailed information and instructions on how to use the Auto and Manual adjustment options, refer to the System Administrator Guide.

2. If the issue is observed on the tail edge of the printed output and is not corrected by performing a Adjust Image Transfer, change the Adjust Image Transfer for Trail Edge setting.
   - Use this feature to adjust the voltage ratio on the secondary bias transfer roll (2nd BTR); this is where the image is transferred from the belt to the paper.
   - This feature is accessed from Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the desired Custom Paper > Change Settings > Adjust Image Transfer for Trail Edge > Change Settings.
• Decrease the Adjust Image Transfer for Trail Edge in increments of 10%. After every incremental adjustment, run test prints and evaluate the output to determine if additional adjustment is necessary.

3. Perform an Automatic Density Uniformity Adjustment.

   Note: This is a press feature and is not a Custom Paper Settings feature.

• Use this feature to correct image quality issues on the output when that image quality is not consistent throughout the entire output. For example, the image quality is lighter (faded) or heavier (thicker) on the left or right sides of the output (inboard / outboard).

• For information and instructions on how to use this feature, refer to the System Administrator Guide.

Image Registration, Perpendicularity, Skew, and Magnification

Problem

The image on the printed output is misregistered, or is perpendicular, skewed, or magnified.

Solutions

1. If you use trays 1, 2, or 3, switch the optional trays 6, 7, 8, or 9 (if available).

   Note: Trays 6-9 have better registration and skew performance.

2. Create and/or use an existing Alignment Profile.

   Note: Before creating a new and/or using an existing manual alignment, read all the information in the Alignment Adjustment of System Administrator Guide.

• Use Center Line Stock for Alignment Profiles. If the problem occurs when using this stock, call the Customer Support Center.

• The following steps are required for each procedure; for complete instructions, refer to the Alignment Adjustment section in the System Administrator Guide.

• To create a New Alignment Profile, perform the following:

   Note: This option can be found in Machine Status > Tools > Setup & Adjustment > Alignment Adjustment Setup.

   a. From the Alignment tab, select the New button.

      A New Profile Properties window displays.

   b. Enter the Name you want to assign to the profile.

   c. Perform the Auto Alignment procedure.

   d. Run a set of test prints to evaluate the output and evaluate the results.

   e. If necessary, depending on the results, perform a Manual Adjustment.

   f. When making manual adjustments to multiple items, use the following guidelines:
• Adjust the image in the following order: **Registration**, **Perpendicularity**, **Skew**, and **Magnification**.

• Choose only one option at a time (such as **Registration**), then run a set of test prints to evaluate the output. Determine if the printed output for the selected option is acceptable and if it is acceptable, then select and adjust the next alignment option.

• After each option is selected, always run a set of test prints and evaluate the output. Determine if the output for the selected feature is acceptable. If it is, continue to adjust another alignment option as required.

• To use an existing Alignment Profile, perform the following:

  Note: The option may be found by selecting **Machine Status > Tools > Setup & Adjustment > Alignment Adjustment Setup**. Select the desired **Custom Paper > Change Settings > Alignment Adjustment Setup > Change Settings**.

  a. Select the **Alignment Adjustment** button.

  b. Select **Use Default** or **Select from List**.

  If using **Select from List**, make a selection from the list of saved **Alignment Profiles**.

3. Change the **Adjust Regi-Loop** setting.

  Note: Use **Adjust Regi-Loop** only if **Alignment Adjustment** did not correct registration and/or skew problems.

  • Use this feature to adjust Regi-Loop.

  • When paper feeds through the press, it stops once and pressure is applied in order to correct registration and skew. The loop is created when paper is stopped and pressured is Regi-Loop.

    – To correct for registration and skew when the degree of skew varies from sheet to sheet, increase the **Regi-Loop** value to increase pressure on the Lead Edge (LE) of the paper. Increasing the value too much may cause unintended folds or scratches on the Lead Edge paper.

    – In hot and humid environments, decrease the **Regi-Loop** value to lower the pressure on the Lead Edge of light weight paper to avoid ripping the paper.

  • This feature is accessed from **Machine Status > Tools > Setup & Adjustment > Custom Paper Settings**. Select the desired **Custom Paper > Change Settings > Adjust Regi-Loop > Change Settings**.

  • Based on the output, increase or decrease the **Regi-Loop** in increments of 0.3 mm. After each incremental adjustment, run test prints and evaluate the output to determine if additional adjustments are required.

  • If feeding paper from tray 1, 2 or 3 and repeated **Adjust Regi-Loop** adjustments do not make any improvements in a registration problem, return the **Adjust Regi-Loop** value to its default setting.

4. Change the **Adjust Fuser Speed** setting.

  • This feature is used to adjust the fusing speed to improve print quality when the image is distorted (stretched or shrunk).
– If the image is shrunk, increase the fuser speed. If the fuser speed is set too high, it may cause paper jams.
– If the image is stretched, decrease the fuser speed.

• This feature is accessed from Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the desired Custom Paper > Change Settings > Adjust Fuser Speed > Change Settings.
• Increase or decrease the fuser speed in increments of 0.1%.
• After each incremental adjustment, run test prints and evaluate the output to determine if additional adjustments are required.

Unfused Dry Ink or Toner on Output

Problem
The output contains unfused dry ink or toner.

Solutions
1. Change the Adjust Fuser Temperature setting.

   Tip: Changing the default setting of 0 (zero) is a temporary solution because environmental conditions vary from day to day. Upon completion of the print job, the recommendation is to return the option to its default setting.

• Use this feature to adjust the fuser temperature.
• If dry ink/toner comes off the paper, especially with special media, resolve the problem by increasing the fusing temperature.
• If the fuser temperature is too high when printing on lightweight paper, it may cause blocking, media damage, or paper jams at the peeling unit in the fusing module.
• If the fuser temperature is too low, it may cause poor fusing on higher-density image areas and dry ink/toner may peel off the printed output.

• This feature is accessed from Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the desired Custom Paper > Change Settings > Adjust Fuser Temperature > Change Settings.
• Based on the printed output, increase or decrease the Adjust Fuser Temperature in increments of 1° or 2°.
• After each incremental adjustment, run test prints and evaluate the output to determine if additional adjustments are required.

2. If feeding paper from trays 6-9 and if the paper is damp, confirm that the Tray Heater feature is Enabled (checked).

   Note: Tray Heater is available only for trays 6-9.

• Use this feature to Enable (checked) or Disable (unchecked) the tray heater.

• The tray heater warms the air that is blown into the tray by Adjust Air Assist Values and helps prevent paper jams and multifeeds by loosening contact between sheets.

• The tray heater may partially dry paper and affect print quality. If print quality is affected by dry paper, disable the tray heater.

   Note: Disabling the tray heater may result in an increase of multifeeds.

• This feature is accessed from Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the desired Custom Paper > Change Settings > Tray Heater > Change Settings to Enable (check) the box for Tray Heater.

Fold Adjustment

Problem

The fold on the output is not correct or as desired.

Solutions

• The Finisher - Fold Adjust Position is available only when the system configuration includes one of the following:
  – Production Ready (PR) Booklet Maker Finisher (for Bi-Fold or Single-Fold)
  – Optional C/Z Folder with one of the following optional finishers:
    – PR Finisher
    – PR Booklet Maker Finisher
    – PR Finisher Plus

• For detailed information about these finishing devices, refer to the C/Z Folder.

• Create or use an existing Finisher - Fold Adjust Position

  Note: Before you create a new or use an existing profile or performing any alignment adjustments, read or review the Fold Adjustment Profile section in the System Administrator Guide.

• Depending on your system configuration, the following fold adjustments are available:
  – Bi-Fold Single Sheet (available only with the PR Booklet Maker Finisher)
  – Bi-Fold Multiple Sheets (available only with the PR Booklet Maker Finisher)
  – Bi-Fold Multiple Sheets Stapled (available only with the PR Booklet Maker Finisher)
- C-Fold (available with the optional C/Z Folder)
- Z-Fold (available with the optional C/Z Folder)
- Z-Fold Half-Sheet (available with the optional C/Z Folder)

- Create a new or use an existing Finisher - Fold Adjust Position. The following steps are required for creating a new or using an existing procedure.

  **Note:** This option is accessed from Machine Status > Tools > Setup & Adjustment > Finisher - Fold Adjust Position.

1. From the Fold Adjustment tab, select the New or Edit button.
   - If you edit an existing fold adjustment, select Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the desired Custom Paper > Change Settings > Adjust Fold Position > Change Settings.

2. Type in a new name or, if desired, edit the existing name.

3. To complete the procedure, refer to the Fold Adjustment Profile section in the System Administrator Guide.

### Smear at 208 mm from the Lead Edge

**Problem**

On the printed output, a smear occurs at 208 mm from the lead edge of the paper.

**Solutions**

1. Confirm that the media being used is compatible with the press, is within supported specifications, and is in good condition.

2. Change the Adjust Paper Speed at Transfer Module setting.
   - Use this feature to adjust the paper speed in the transfer unit.
   - The option can be found in Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the desired Custom Paper > Change Settings > Adjust Paper Speed at Transfer Module > Change Settings.
   - Based on the output, decrease Adjust Paper Speed at Transfer Module in increments of 0.05%. After every increment adjustment run test prints and evaluate the output to determine if additional adjustment is necessary.
Transfer defects may occur when paper speed is too fast or too slow.

3. Change the Adjust Fusing Speed setting.

- This feature can be used to correct the issue of a smear at 208 mm from the Lead Edge (LE). Increase the fuser speed to correct the issue.
- This feature also impacts print quality.
  - Increasing fuser speed extends the image. If fuser speed is set too high, paper jams can occur.
  - Decreasing fuser speed shrinks the image.
- The option can be found in Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the desired Custom Paper > Change Settings > Adjust Fusing Speed > Change Settings.
- Increase fuser speed in increments of 0.5%. After every increment adjustment run test prints and evaluate the output to determine if additional adjustment is necessary.

**Trail Edge Deletions**

**Problem**

The printed output contains trail edge deletions.

**Solutions**

Change the Adjust Image Transfer for Trail Edge setting.

- This feature is used to adjust the voltage ratio on the Secondary Bias Transfer Roll (BTR), where the image is transferred from the belt to the paper.
- This feature can be found in Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the desired Custom Paper > Change Settings > Adjust Image Transfer for Trail Edge > Change Settings.
- Decrease the Adjust Image Transfer for Trail Edge in increments of 5% – 10%. After every increment adjustment run test prints and evaluate the output to determine if additional adjustment is necessary.

**Custom Paper Settings - Default Settings**

The information provides the default values, ranges, and recommended incremental adjustments for the various Custom Paper Settings features, options, and settings.
### Alignment Profile

#### Table 5 Registration

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side 1, Side</td>
<td>0.0</td>
<td>0.1</td>
<td>-2.0 to 2.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Side 1, Lead</td>
<td>0.0</td>
<td>0.1</td>
<td>-2.0 to 2.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Side 2, Side</td>
<td>0.0</td>
<td>0.1</td>
<td>-2.0 to 2.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Side 2, Lead</td>
<td>0.0</td>
<td>0.1</td>
<td>-2.0 to 2.0 mm</td>
<td>Determined by test print output</td>
</tr>
</tbody>
</table>

#### Table 6 Perpendicularity

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side 1</td>
<td>0.0</td>
<td>0.1</td>
<td>-1.0 to 1.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Side 2</td>
<td>0.0</td>
<td>0.1</td>
<td>-1.0 to 1.0 mm</td>
<td>Determined by test print output</td>
</tr>
</tbody>
</table>

#### Table 7 Skew

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side 1</td>
<td>0.0</td>
<td>0.1</td>
<td>-1.0 to 1.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Side 2</td>
<td>0.0</td>
<td>0.1</td>
<td>-1.0 to 1.0 mm</td>
<td>Determined by test print output</td>
</tr>
</tbody>
</table>
### Table 8 Magnification

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side 1, Height</td>
<td>0.000</td>
<td>0.025</td>
<td>-0.200 to 0.200%</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Side 1, Width</td>
<td>0.000</td>
<td>0.025</td>
<td>-0.200 to 0.200%</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Side 2, Height</td>
<td>0.000</td>
<td>0.025</td>
<td>-0.200 to 0.200%</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Side 2, Width</td>
<td>0.000</td>
<td>0.025</td>
<td>-0.200 to 0.200%</td>
<td>Determined by test print output</td>
</tr>
</tbody>
</table>

### Fold Adjustment Profile

#### Table 9 Bi-Fold - Single Sheet

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left and Right Sides Equal</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Left Side of Fold is Longer</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Right Side of Fold is Longer</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
</tbody>
</table>

#### Table 10 Bi-Fold – Multiple Sheets Stapled

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left and Right Sides Equal</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Left Side of Fold is Longer</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Right Side of Fold is Longer</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
</tbody>
</table>
### Table 11 Bi-Fold – Multiple Sheets Stapled

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sheets in Set 1</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Left and Right Sides Equal</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Left Side of Fold is Longer</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Right Side of Fold is Longer</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>On the Fold</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Left of Fold</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Right of Fold</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td><strong>Sheets in Set 2</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Left and Right Sides Equal</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Left Side of Fold is Longer</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Right Side of Fold is Longer</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>On the Fold</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Left of Fold</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Right of Fold</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
</tbody>
</table>

### Table 12 C-Fold

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>“A” Length</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>“B” Length</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
</tbody>
</table>
Table 13 Z-Fold

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>“A” Length</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>“B” Length</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
</tbody>
</table>

Table 14 Z-Fold Half Sheet

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>“A” Length</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>“B” Length</td>
<td>0.0</td>
<td>0.1</td>
<td>0.0 – 20.0 mm</td>
<td>Determined by test print output</td>
</tr>
</tbody>
</table>

Stock Properties Custom Paper Settings

Table 15 Stock By Name and Multifeed Detection

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stock By Name Only</td>
<td>Checked Box</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Multi Feed Detection</td>
<td>Checked Box</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

Table 16 Primary Transfer Current Adjustment

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow</td>
<td>100</td>
<td>1</td>
<td>10 % – 200 %</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Magenta</td>
<td>100</td>
<td>1</td>
<td>10 % – 200 %</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Option or Setting</td>
<td>Default Value</td>
<td>Adjustment Step Increments</td>
<td>Available Range</td>
<td>Recommended Incremental Adjustment</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------</td>
<td>-----------------------------</td>
<td>-----------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>Cyan</td>
<td>100</td>
<td>1</td>
<td>10% – 200%</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Black</td>
<td>100</td>
<td>1</td>
<td>10% – 200%</td>
<td>Determined by test print output</td>
</tr>
</tbody>
</table>

Table 17 Image Transfer Adjustment

<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side 1</td>
<td>150</td>
<td>1</td>
<td>10% – 300%</td>
<td>Perform Auto Adjustment</td>
</tr>
<tr>
<td>Side 2</td>
<td>150</td>
<td>1</td>
<td>10% – 300%</td>
<td>Perform Auto Adjustment</td>
</tr>
<tr>
<td>Adjust Air Assist Values</td>
<td>System Default</td>
<td>Distinct Selections Available</td>
<td>System Default Multi Feed Support Table Mis-Feed Support Table Forced Off Custom 1 through 8</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Tray Heater</td>
<td>Checked Box</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Adjustment of Image Transfer Trail Edge</td>
<td>100</td>
<td>1</td>
<td>0% – 100%</td>
<td>10%</td>
</tr>
<tr>
<td>Adjustment of Paper Speed at Transfer</td>
<td>0.00</td>
<td>0.01</td>
<td>-0.50% – 0.50%</td>
<td>0.05%</td>
</tr>
<tr>
<td>Fuser Temperature Adjustment</td>
<td>0</td>
<td>1</td>
<td>-10° – 10° C</td>
<td>1° or 2°</td>
</tr>
<tr>
<td>Fuser Speed Adjustment</td>
<td>0.0</td>
<td>0.1</td>
<td>-0.50% – 0.50%</td>
<td>0.1%</td>
</tr>
<tr>
<td>Adjustment of Regi-Loop</td>
<td>0</td>
<td>0.3</td>
<td>-3.0 mm – 3.0 mm</td>
<td>0.3 mm</td>
</tr>
<tr>
<td>Option or Setting</td>
<td>Default Value</td>
<td>Adjustment Step Increments</td>
<td>Available Range</td>
<td>Recommended Incremental Adjustment</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------</td>
<td>----------------------------</td>
<td>-----------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Alignment Adjustment</td>
<td>Default</td>
<td>Distinct Selections Available</td>
<td>Available selections will be based on the Profiles created by the user</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Fold Adjustment Profile</td>
<td>Default</td>
<td>Distinct Selections Available</td>
<td>Available selections will be based on the Profiles created by the user</td>
<td>Determined by test print output</td>
</tr>
<tr>
<td>Option or Setting</td>
<td>Default Value</td>
<td>Adjustment Step Increments</td>
<td>Available Range</td>
<td>Recommended Incremental Adjustment</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------</td>
<td>----------------------------</td>
<td>-----------------</td>
<td>------------------------------------</td>
</tr>
</tbody>
</table>
| 1 Sided- Face Up  | Default       | Distinct Selections Available | Default, Type A, Type B, Type C, Custom, Severe Upward, Medium Upward, Moderate Upward, Slight Upward, No Curl, Slight Downward, Moderate Downward, Medium Downward, Severe Downward | Follow recommended sequential order:  
  - Default  
  - Type A  
  - Type B  
  - Type C  
  - Custom Curl Correction: Slight (Very Small) Upward or Slight (Very Small) Downward  
  - Custom Curl Correction: Moderate (Small) Upward or Moderate (Small) Downward  
  - Custom Curl Correction: Medium Upward or Medium Downward  
  - Custom Curl Correction: Severe (Large) Upward or Severe (Large) Downward |
| 1 Sided- Face Down| Default       | Distinct Selections Available | Default, Type A, Type B, Type C, Custom, Severe Upward, Medium Upward, Moderate Upward, Slight Upward, No Curl, Slight Downward, Moderate Downward, Medium Downward, Severe Downward | Follow recommended sequential order:  
  - Default  
  - Type A  
  - Type B  
  - Type C  
  - Custom Curl Correction: Slight (Very Small) Upward or Slight (Very Small) Downward  
  - Custom Curl Correction: Moderate (Small) Upward or Moderate (Small) Downward  
  - Custom Curl Correction: Medium Upward or Medium Downward  
  - Custom Curl Correction: Severe (Large) Upward or Severe (Large) Downward |
<table>
<thead>
<tr>
<th>Option or Setting</th>
<th>Default Value</th>
<th>Adjustment Step Increments</th>
<th>Available Range</th>
<th>Recommended Incremental Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Moderate Downward</td>
<td>Follow recommended sequential order:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Medium Downward</td>
<td>• Default</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Severe Downward</td>
<td>• Type A</td>
</tr>
<tr>
<td>2 Sided</td>
<td>Default</td>
<td>Distinct Selections Available</td>
<td></td>
<td>• Type B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Type C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Custom Curl Correction: Slight (Very Small) Upward or Slight (Very Small) Downward</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Custom Curl Correction: Moderate (Small) Upward or Moderate (Small) Downward</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Custom Curl Correction: Medium Upward or Medium Downward</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Custom Curl Correction: Severe (Large) Upward or Severe (Large) Downward</td>
</tr>
</tbody>
</table>

**Paper Jams**

**Paper Jams Overview**

If a paper jam occurs, a fault screen displays a message on the press UI indicating in which area the jam is situated. Follow the instructions provided for clearing the jam and resuming press operation.
Information about Paper Jams

Review the following list to address paper jams:

- When paper jams inside the press, the press stops and a fault message displays.
- Follow the instructions displayed on the User Interface to remove the jammed paper.
- Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.
- If a piece of jammed paper remains inside the press, the paper jam message will remain on the display.
- Paper jams can be removed with the press still powered on. When the power is turned off, all information stored to the system memory will be erased.
- Do not touch components inside the press. This can cause print defects.
- After clearing a paper jam, printing is automatically resumed from the state before the paper jam occurred.
- If a paper jam occurred during printing, press the Start button. Printing is resumed from the state before the paper jam occurred.

**WARNING:** When removing jammed paper, make sure that no pieces of jammed paper are left in the press. A piece of paper remaining in the press can cause fire. If a piece of paper is stuck in a hidden area or paper is wrapped around the fuser unit or rollers, do not remove it forcefully. You can get injured or burned. Switch off the press immediately and contact the Customer Support Center.

Jam Recovery Offset Feature

The Jam Recovery Offset Feature helps users verify and / or monitor job integrity when a jam occurs while printing offset output.

The following two conditions are required in order for this feature to work:

- When an Offset mode is available with the finishing device, such as the Offset Catch Tray (OCT), High Capacity Stacker (HCS), Business Ready (BR) Finisher, Standard or Booklet Maker Finisher, or Standard Finisher Plus
- When the printed offset output is not stapled

If your system meets these two requirements, then the Jam Recovery Offset Feature can be set up and used.

**Important:** Before this feature can be set up and used, the associated NVM value is required to be changed by a Service Representative. To enable the feature, contact the Customer Support Center to schedule an appointment with a Service Representative.

How the Jam Recovery Offset Feature Works

When a jam occurs while printing offset output, the first sheet after recovery (jam clearance) is an insert that is pulled from a tray that is selected by the user. For example:
1. While setting up the Jam Recovery Offset Feature, the user selected Tray T1 (Post-Process Inserter) as the tray to use for offset jam recovery.

2. Tray T1 is loaded with colored stock, such as yellow paper.

3. A jam occurs while printing offset output.

4. The user removes the sheets in the paper path per the User Interface (UI) screens.

5. The press recovers by feeding first a yellow sheet from T1, then the offset in the set.

6. At that point, it is easy for the user to verify if all pages are present in the job by accessing the set with the Yellow insert.

**Conditions Required for the Jam Recovery Offset Feature to Work**

For the insert paper to work correctly, the following conditions needs to be met:

- A specific paper tray must be selected for the jam recovery insert sheet.
- The selected paper tray must be operational; the selected tray cannot be broken.
- The selected paper tray must be installed with your system.

In other words, you cannot assign the jam recovery insert sheet to the Top Tray of the Standard Finisher because your system only has a High Capacity Stacker (HCS) attached. Therefore, you must select the HCS for the insert sheet.

- The selected paper tray must support the desired paper size for the insert sheet. For example:
  - You want the jam recovery sheet to be 11 x 17 in., A3 size.
  - You try to assign it to the 1-Tray High Capacity Feeder (8.5 x 11 in., A4).
  - The 1-Tray HCF does not support 11 x 17 in., A3 size.

**Setting Up the Jam Recovery Offset Feature**

1. Press the **Log In/Out** button on the UI.

2. Enter the system administrator Login ID with the numeric keypad, then select **Enter**. Enter the password.

   To log in as system administrator with Login ID and password, refer to **System Administrator Guide**.

   - **Note**: By default, the password prompt is not enabled.

3. Press the **Machine Status** button on the UI.

4. Select the **Tools** tab.

5. Select **System Settings > Common Service Settings**.

6. Select **Other Settings**.

7. Select the item **Jam Recovery Separator Tray**.

8. Select **Change Settings**.
9. Select the desired tray to use for the jam recovery insert sheet.

   Note: Ensure that the selected tray meets all the required conditions for using that tray; refer to Conditions Required for the Jam Recovery Offset Feature to Work.

10. Select Save.
11. Select Close.

   The main Tools screen displays.

12. Exit the administrator mode.
   a. Press the Log In/Out button.
   b. When the Logout screen appears, select Logout.

**Paper Jams in the Document Feeder**

**Document Feeder Jams**

1. Gently lift the latch of the document feeder top cover until it is completely open.

2. Open the left cover until it comes to a stop.

3. If the document is not caught in the entry of the document feeder, then remove it.
4. If instructed to open the inner cover, lift up the lever, then open the inner cover. Remove the jammed document.

![Image]

Note: If the document is stuck, do not pull on it forcefully, as this could damage the document.

5. If the jam is inside of the left cover, remove the jammed document.

![Image]

6. Close the following open covers until they click into place. Close them in the following order:
   - Inner cover
   - Top cover
   - Left cover

7. If a document jam cannot be found, slowly raise the document feeder and, if the document is there, remove it.

![Image]

8. Close the document feeder.

9. If indicated, raise the feeder tray area and remove the document.

![Image]

10. Gently return the feeder tray to its original position.
11. After removing the jammed document, follow the instructions to reload the entire document set into the document feeder.

   \[\textbf{Note:}\] Ensure that there are not any torn, wrinkled, or folded documents in the document set. To scan torn, wrinkled or folded documents, use the Document Glass, only. The already scanned document sheets are automatically skipped and scanning resumes from the document sheet last scanned prior to the jam.

**Document Jams Under the Document Feeder Belt**

1. Open the document feeder.

   ![Image of document feeder being opened](image1)

2. Open the belt of the document cover while gripping the lever and remove the jammed document.

   ![Image of belt being opened and document removed](image2)

3. Gently return the belt to the original position.

   ![Image of belt being closed back to original position](image3)


5. Follow the instructions to reload the entire document set into the document feeder.

   \[\textbf{Note:}\] Ensure that there are not any torn, wrinkled, or folded documents in the document set. To scan torn, wrinkled or folded documents, use the Document Glass, only. The already scanned document sheets are automatically skipped and scanning resumes from the document sheet last scanned prior to the jam.
Press Paper Jams

Paper Jams Inside the Press

⚠️ WARNING: Never touch a labeled area, found on the fuser unit or nearby, indicating High Temperature and Caution. Contact can lead to burns.

1. Open the Press Front Door.

2. Rotate Handle 2 to the right until it is in the horizontal position, then pull out the transfer module.

3. Remove the visible jammed paper.

4. After clearing the jammed sheets, ensure that no torn paper pieces are left in the press.
5. Move Handle 2b and remove any jammed paper.

6. Return Handle 2b to its original position.

7. Move Handle 2e and remove any jammed paper.

8. Return Handle 2e to its original position.

9. Pull down Handle 2f and remove the jammed paper.

10. Return Handle 2f to its original position.

11. Push in the transfer module completely and rotate Handle 2 to the left.

13. Run five blank sheets to clean left-over toner from the fuser roll and resume the copying/printing process.

**Paper Jams in Trays 1-3**

*Note:* Paper is sometimes torn and remains inside the press if you open a tray without checking the paper jam position. This may cause a malfunction. Check where the paper jam occurred before clearing the problem.

1. Open the tray where the paper jam occurred.

2. Remove the jammed paper.
3. Push the tray in gently until it comes to a stop.

Paper Jams in the Bypass (Tray 5)

Paper Jams in the Standalone Bypass (Tray 5)

⚠️ Important: Use this procedure to clear paper jams in the Bypass (Tray 5) when it is a standalone feeding device and is not installed on any optional feeder (such as the Advanced Oversized High Capacity Feeder).

💡 Tip: Always ensure that all paper jams, including any small, ripped pieces of paper, are cleared before proceeding with any copy/print jobs.

1. Remove the jammed paper and any paper that is loaded from the Bypass tray.

Note: If paper is torn, check inside the press and remove it.

2. Open the Bypass Top Cover and remove jammed paper.
3. Close the cover.

4. Reload paper into the tray and resume copying / printing.

# Tray 6 Troubleshooting

## Tray 6 Paper Jams

### Clearing Paper Jams in the HCF (Tray 6)

1. Open Tray 6 and remove any jammed paper.

   ![Image](image1.png)

   **Note:** If paper is torn, check for any torn pieces of paper inside the machine.

2. Gently close the tray.

3. Gently move Tray 6 to the left until it stops.

4. Grasp the top cover handle and open the top cover.

![Image](image2.png)
5. Remove any jammed paper from the top cover area of Tray 6.
6. Close the Tray 6 top cover.
7. Return Tray 6 to its original position.

Clearing HCF Paper Jams in the Lower Left Cover
1. Gently move Tray 6 to the left until it stops.

2. Gently open the lower left cover while gripping the release handle.

3. Remove the jammed paper.
   
   **Note:** If paper is torn, check for any torn pieces of paper inside the machine.

4. Gently close the lower left cover.
5. Gently move Tray 6 back into position.

Tray 6 Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press UI. A graphical illustration shows the location of the fault with a brief explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to indicate the multiple locations and the required corrective actions.

Tray 6 Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press UI.

The UI also displays a Faults button which provides information about the fault and detailed instructions for correcting the fault.

Tip: Tray 6 faults are identified by the codes which start with the three-digit numbers 024 and 078.

Trays 6 and 7 Troubleshooting

Trays 6 and 7 Paper Jams

Paper Jams When the Bypass is Installed on Trays 6 and 7

Tip: Always ensure that all paper jams, including any small, ripped pieces of paper, are cleared before proceeding with any print jobs.

1. Remove the paper currently loaded in the Bypass (Tray 5).
2. Lift and open the Top Cover of the Bypass (Tray 5).

3. Remove any jammed paper.

   ⚠️ **Note:** If paper is torn, check inside the press and remove it.

4. Close the Top Cover of the Bypass (Tray 5).

5. Reload paper into the tray and resume printing.
Paper Jams Inside Trays 6 and 7

1. Pull out the tray where the paper jam occurred.

2. Remove the jammed paper.

   ![Removing jammed paper]

   **Note:** If paper is torn, check inside the machine and remove it.

3. Gently push in the tray until it comes to a stop.

Trays 6 and 7 Paper Jams at Lever 1a and Knob 1c

1. Open the front cover of the OHCF.

   ![Opening the front cover]

310
2. Move the lever 1a to the right and turn the knob 1c to the right. Remove the jammed paper.

⚠️ **Note:** If paper is torn, check inside the machine and remove it.

3. Return the lever 1a to the original position.

4. Close the front cover of the OHCF.

⚠️ **Note:** If the front cover of the OHCF is not completely closed, a message will appear and the machine will not operate.
Trays 6 and 7 Paper Jams at Lever 1b and Knob 1c

1. Open the front cover of the OHCF.

2. Move the lever 1b to the right and turn the knob 1c to the right. Remove the jammed paper.

   ![Diagram showing lever and knob]

   Note: If paper is torn, check inside the machine and remove it.

3. Return the lever 1b to the original position.
4. Close the front cover of the OHCF.

Note: If the front cover of the OHCF is not completely closed, a message will appear and the machine will not operate.

Trays 6 and 7 Paper Jams at Lever 1d and Knob 1c
1. Open the front cover of the OHCF.

2. Move the lever 1d upward and remove the jammed paper.

Note: If paper is torn, check inside the machine and remove it.
3. If the paper cannot be removed, turn the knob 1c clockwise, then remove the jammed paper.

![Image of machine with labeled parts]

*Note:* If paper is torn, check inside the machine and remove it.

4. Return the lever 1d to the original position.

![Image of lever being returned to position]

5. Close the front cover of the OHCF.

*Note:* If the front cover of the OHCF is not completely closed, a message will appear and the machine will not operate.

### Trays 6 and 7 Fault Messages

When an fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press UI. A graphical illustration shows the location of the fault with a brief explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to indicate the multiple locations and the required corrective actions.

### Trays 6 and 7 Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press UI.

The UI also displays a *Faults* button which provides information about the fault and detailed instructions for correcting the fault.
Tip: Trays 6 and 7 faults are identified by the codes which start with the three-digit number 078.

Trays 8 and 9 Troubleshooting

Trays 8 and 9 Paper Jams

Clearing Trays 8 and 9 Jams

Nip Release levers inside of the Transport area of the Feeder hold back large size sheets (such as A3, 11 x 17 inches, 12 x 18 inches) to reduce the chance of jamming as paper enters the print engine.

Note: Follow the jam clearance instructions displayed on the touch screen. Always ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with your print jobs.

Paper Jams When the Bypass is Installed on Trays 8 and 9

Tip: Always ensure that all paper jams, including any small, ripped pieces of paper, are cleared before proceeding with any print jobs.

1. Remove the paper currently loaded in the Bypass (Tray 5).
2. Lift and open the Top Cover of the Bypass (Tray 5).
3. Remove any jammed paper.

Note: If paper is torn, check inside the press and remove it.

4. Close the Top Cover of the Bypass (Tray 5).

5. Pull open the Top Drawer (located at the top of Trays 6 and 7).
6. Lift levers 2a and 2b, then remove any paper jams.

7. Close levers 2a and 2b.
8. Close the Top Drawer.
9. Reload paper into the tray and resume printing.

**Paper Jams Inside Trays 8 and 9**
1. Pull out the tray where the paper jam occurred.
2. Remove the jammed paper.

✏️ **Note:** If paper is torn, check inside the machine and remove it.
3. Gently push in the tray until it comes to a stop.

**Trays 8 and 9 Paper Jams at Lever 1a and Knob 1c**

1. Open the front cover of the feeder module.

![Image of lever and knob]

2. Move the lever 1a to the right and turn the knob 1c to the right. Remove the jammed paper.

![Image of feeder module]

> **Note:** If paper is torn, check inside the machine and remove it.

3. Return the lever 1a to the original position.

4. Close the front cover of the feeder module.

> **Note:** If the front cover of the feeder module is not completely closed, a message will appear and the press will not operate.
Trays 8 and 9 Paper Jams at Lever 1b and Knob 1c

1. Open the front cover of the feeder module.

2. Move the lever 1b to the right and turn the knob 1c to the right. Remove the jammed paper.

   Note: If paper is torn, check inside the machine and remove it.

3. Return the lever 1b to the original position.

4. Close the front cover of the feeder module.

   Note: If the front cover of the feeder module is not completely closed, a message will appear and the press will not operate.
Trays 8 and 9 Paper Jams at Lever 1d and Knob 1c

1. Open the front cover of the feeder module.

2. Move the lever 1d upward and remove the jammed paper.

   Note: If paper is torn, check inside the machine and remove it.

3. If the paper cannot be removed, turn the knob 1c clockwise, then remove the jammed paper.

4. Return the lever 1d to the original position.

5. Close the front door of the feeder module.

   Note: If the front cover of the feeder module is not completely closed, a message will appear and the press will not operate.
Trays 8 and 9 Fault Messages
When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press UI. A graphical illustration shows the location of the fault with a brief explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to indicate the multiple locations and the required corrective actions.

Trays 8 and 9 Fault Code Information
When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press UI.

The UI also displays a Faults button which provides information about the fault and detailed instructions for correcting the fault.

Tip: Trays 8 and 9 faults are identified by the codes which start with the three-digit number 178.

High Capacity XLS Vacuum Feeder (HCVF) Troubleshooting
For a printable flowchart of the HCVF Troubleshooting, that is described in the following section, refer to Troubleshooting Feed Errors in the Xerox® High Capacity XLS Vacuum Feeder in www.xerox.com. In the Customer Support > All Support and Drivers section of the web page, search for your Product. In the Documentation web page of your printer, you can find the HCVF Troubleshooting flowchart.

Troubleshooting Misfeeds and Multifeeds in the High Capacity XLS Vacuum Feeder (HCVF)
When using the optional High Capacity Vacuum XLS Feeder (HCVF) and a misfeed or multifeed condition occurs, check the press user interface for one of the following fault codes.

<table>
<thead>
<tr>
<th>Misfeed Fault Codes</th>
<th>Multifeed Fault Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>078–131</td>
<td>178–131</td>
</tr>
<tr>
<td>078–132</td>
<td>178–132</td>
</tr>
<tr>
<td>078–151</td>
<td>178–151</td>
</tr>
<tr>
<td>078–125</td>
<td></td>
</tr>
</tbody>
</table>
To resolve misfeed or multifeed conditions, adjust the Air Assist Values setting to a recommended value. For instructions on adjusting Air Assist Values, refer to Adjusting Air Assist Values.

To troubleshoot misfeeds, refer to Troubleshooting Misfeeds in the HCVF.

To troubleshoot multifeeds, refer to Troubleshooting Multifeeds in the HCVF.

Adjusting Air Assist Values

The Air Assist Values setting corresponds to a specific configuration of blower settings in the High Capacity XLS Vacuum Feeder (HCVF). An adjustment to the Air Assist Values setting results in a different configuration of blower settings.

To optimize blower settings in the HCVF, adjust the Air Assist Values setting. Make adjustments according to the recommended troubleshooting instructions only.

Note: Before you adjust the Air Assist Values setting, ensure that the media loaded in the HCVF adheres to the Paper and Media Guidelines for the HCVF.

To adjust the Air Assist Values setting, do the following:

1. At the press user interface, log in as an administrator.
3. At the Paper Tray Settings window, select Custom Paper Settings.
4. At the Custom Paper Settings window, a list of profiles is displayed. Each profile corresponds to a set of custom settings. Do one of the following:
   • To use an existing profile, select a named profile.
   • To create a new profile, select an unused profile, then type a name for the profile.
5. Select Change Settings.
6. At the Settings window, select Adjust Air Assist Values > Change Settings.
7. At the Adjust Air-Assist Values window, select Custom Table.
   Note: The Custom Table contains a set of numerical settings. Each numerical value in the Custom Table maps to a specific blower configuration in the HCVF.
8. To change the Custom Table setting, type the required number. Alternatively, use the up and down arrows to select the number.
9. To save the Custom Table setting, select Save.
10. To save the profile, select Save.
11. To close the Custom Paper Settings window, select Close.
12. To close the Paper Tray Settings window, select Close.

Troubleshooting Misfeeds in the HCVF

When using the optional High Capacity XLS Vacuum Feeder (HCVF), the following fault codes indicate a misfeed condition:

• 078–101, 078–131, 078–132, 078–151
For fault codes relating to multifeeds, refer to Troubleshooting Multifeeds in the HCVF.

To resolve a misfeed, follow the steps in the appropriate section.

**Misfeeds when using paper weight 177 g/m² or heavier**

When using paper of weights 177 g/m² or heavier, misfeed problems can occur.

1. Make the following adjustments:
   a. Change the Custom Table setting to 5. Save the setting.
   b. Run a test print. If no misfeed occurs, the problem is resolved.
   c. Increase the Custom Table value by one setting. Save the setting.
   d. Run a test print. If no misfeed occurs, the problem is resolved.
   e. If misfeeds continue, repeat steps 1c and 1d until the Custom Table setting reaches 8.

2. If the problem is not resolved, contact your Xerox representative.

**Misfeeds when using paper weight less than 177 g/m² and printing five or fewer sheets**

When using paper of weights less than 177 g/m² and printing five or fewer sheets, misfeed problems can occur.

Make the following adjustments:

1. Change the Custom Table setting to 32. Save the setting.
2. Run a test print. If no misfeed occurs, the problem is resolved.
3. If a misfeed occurs again, change the Custom Table setting to 33. Save the setting.
4. Run another test print. If the problem is not resolved, contact your Xerox representative.

**Misfeeds when using paper weight less than 177 g/m² and printing more than five sheets**

When using paper of weights less than 177 g/m² and printing more than five sheets, misfeed problems can occur.

1. Make the following adjustments:
   a. Change the Custom Table setting to 5. Save the setting.
   b. Run a test print. If no misfeed occurs, the problem is resolved.
   c. Increase the Custom Table value by one setting. Save the setting.
   d. Run a test print. If no misfeed occurs, the problem is resolved.
   e. If misfeeds continue, repeat steps 1c and 1d until the Custom Table setting reaches 8.

2. If a misfeed occurs again, change the Custom Table setting to 32. Save the setting.
3. Run a test print. If no misfeed occurs, the problem is resolved.
4. If a misfeed occurs again, change the Custom Table setting to 33. Save the setting.
5. Run another test print. If the problem is not resolved, contact your Xerox representative.
Troubleshooting Multifeeds in the HCVF

When using the optional High Capacity XLS Vacuum Feeder (HCVF), the following fault codes indicate a multifeed condition:

- 078–125, 078–126, 078–127.

For fault codes relating to misfeeds, refer to Troubleshooting Misfeeds in the HCVF.

To resolve a multifeed, follow the steps in the appropriate section.

Multifeeds when using coated paper weight 177 g/m² or heavier

Humidity levels of 50 percent or higher

When using coated paper of weight 177 g/m² or heavier in humidity levels of 50 percent or higher, multifeed problems can occur.

Make the following adjustments:

1. If the paper is coated on one side only, go to step 3.
2. If the paper is coated on both sides, do the following:
   a. Change the Custom Table setting to 5. Save the setting.
   b. Run a test print. If no multifeed occurs, the problem is resolved.
   c. Increase the Custom Table value by one setting. Save the setting.
   d. Run a test print. If no multifeed occurs, the problem is resolved.
   e. If multifeeds continue, repeat steps 2c and 2d until the Custom Table value reaches 8.
3. If using paper that is coated on one side only, or if multifeeds continue, do the following:
   a. Change the Custom Table setting to 9. Save the setting.
   b. Run a test print. If no multifeed occurs, the problem is resolved.
   c. Increase the Custom Table value by one setting. Save the setting.
   d. Run a test print. If no multifeed occurs, the problem is resolved.
   e. If multifeeds continue, repeat steps 3c and 3d until the Custom Table value reaches 12.
4. If the problem is not resolved, contact your Xerox representative.
Humidity levels below 50 percent

When using coated paper of weight 177 g/m² or heavier in humidity levels below 50 percent, multifeed problems can occur.

1. Make the following adjustments:
   a. Change the Custom Table setting to 9. Save the setting.
   b. Run a test print. If no multifeed occurs, the problem is resolved.
   c. Increase the Custom Table value by one setting. Save the setting.
   d. Run a test print. If no multifeed occurs, the problem is resolved.
   e. If multifeeds continue, repeat steps 1c and 1d until the Custom Table value reaches 12.

2. If multifeeds continue, do the following
   a. Change the Custom Table setting to 35. Save the setting.
   b. Run a test print. If no multifeed occurs, the problem is resolved.
   c. Increase the Custom Table value by one setting. Save the setting.
   d. Run a test print. If no multifeed occurs, the problem is resolved.
   e. If multifeeds continue, repeat steps 2c and 2d until the Custom Table value reaches 38.

3. If the problem is not resolved, contact your Xerox representative.
Multifeeds when using uncoated paper weight 177 g/m² or heavier

When using uncoated paper of weight 177 g/m² or heavier, multifeed problems can occur.

1. Make the following adjustments:
   a. Change the Custom Table setting to 9. Save the setting.
   b. Run a test print. If no multifeed occurs, the problem is resolved.
   c. Increase the Custom Table value by one setting. Save the setting.
   d. Run a test print. If no multifeed occurs, the problem is resolved.
   e. If multifeeds continue, repeat steps 1c and 1d until the Custom Table setting reaches 12.

2. If the problem is not resolved, contact your Xerox representative.
Multifeeds when using paper weight less than 177 g/m²

Humidity levels of 50 percent or higher

When using paper of weight less than 177 g/m² in humidity levels of 50 percent or higher, multifeed problems can occur.

1. Make the following adjustments:
   a. Change the Custom Table setting to 9. Save the setting.
   b. Run a test print. If no multifeed occurs, the problem is resolved.
   c. Increase the Custom Table value by one setting. Save the setting.
   d. Run a test print. If no multifeed occurs, the problem is resolved.
   e. If multifeeds continue, repeat steps 1c and 1d until the Custom Table value reaches 12.

2. If multifeeds continue, do the following:
   a. Change the Custom Table setting to 5. Save the setting.
   b. Run a test print. If no multifeed occurs, the problem is resolved.
   c. Increase the Custom Table value by one setting. Save the setting.
   d. Run a test print. If no multifeed occurs, the problem is resolved.
   e. If multifeeds continue, repeat steps 2c and 2d until the Custom Table value reaches 8.

3. If a multifeed occurs again, change the Custom Table setting to 32. Save the setting.

4. Run a test print. If no multifeed occurs, the problem is resolved.

5. If a multifeed occurs again, change the Custom Table setting to 33. Save the setting.

6. Run another test print. If the problem is not resolved, contact your Xerox representative.
Humidity levels below 50 percent

When using paper of weight less than 177 g/m² in humidity levels below 50 percent, multifeed problems can occur.

1. Make the following adjustments:
   a. Change the Custom Table setting to 5.
   b. Run a test print. If no multifeed occurs, the problem is resolved.
   c. Increase the Custom Table value by one setting. Save the setting.
   d. Run a test print. If no multifeed occurs, the problem is resolved.
   e. If multifeeds continue, repeat steps 1c and 1d until the Custom Table value reaches 8.

2. If a multifeed occurs again, change the Custom Table setting to 32. Save the setting.

3. Run a test print. If no multifeed occurs, the problem is resolved.

4. If a multifeed occurs again, change the Custom Table setting to 33. Save the setting.

5. Run a test print. If no multifeed occurs, the problem is resolved.

6. If multifeeds continue, do the following:
   a. Change the Custom Table setting to 9. Save the setting.
   b. Run a test print. If no multifeed occurs, the problem is resolved.
   c. Increase the Custom Table value by one setting. Save the setting.
   d. Run a test print. If no multifeed occurs, the problem is resolved.
   e. If multifeeds continue, repeat steps 6c and 6d until the Custom Table value reaches 12.

7. If the problem is not resolved, contact your Xerox representative.
Finishing Devices Troubleshooting

Business Ready Finisher Troubleshooting

BR Finisher Paper Jams

Clearing Jams in the BR Finisher at Position 3a

1. If the paper is visible at the output tray exit, remove the paper by pulling it gently in the direction shown.

2. Open the front door of the Business Ready Finisher.

3. Lift green handle 3a.

4. Carefully remove the paper.

- If the paper is torn, remove all torn pieces from the finisher.
- If the paper is inaccessible, or if the press User Interface (UI) prompts you to release the paper, turn green handle knob 3b in the direction shown.
5. Return green handle 3a to its original position.

6. Close the front door of the Business Ready Finisher.

**Clearing Jams in the BR Finisher at Position 3c**

1. Open the front door of the Business Ready Finisher.
2. Move green lever 3c to the left.

3. Carefully remove the paper.

- If the paper is torn, remove all torn pieces from the finisher.
- If the paper is inaccessible, or if the press User Interface (UI) prompts you to release the paper, turn green handle knob 3b in the direction shown.

4. Return green lever 3c to its original position.

5. Close the front door of the Business Ready Finisher.
Clearing Jams in the BR Finisher at Position 3d
1. Open the front door of the finisher and locate green lever 3d.

2. Move green lever 3d to the right.

3. Carefully remove the paper.

   ✷ Note: If the paper is torn, remove all pieces from the finisher.

4. Return green lever 3d to its original position.

5. Close the front door of the Business Ready Finisher.

Clearing Jams in the BR Finisher at Position 4
1. Open the front door of the Business Ready Finisher.
2. Using the green handle, pull out unit 4 until it stops.

3. To remove the jammed paper, turn green knob 4 in either direction as shown.

   ![Diagram 1]

   ![Diagram 2]

   **Note:** If the paper is torn, remove all torn pieces from the finisher.

4. Return unit 4 to its original position.

5. Close the front door of the Business Ready Finisher.

**Clearing Jams in the Booklet Tray**

1. Open the front door of the Business Ready Finisher.

2. To release the jammed paper, turn green knob 4 in the direction shown.
3. To remove the paper, pull it in the direction shown.

Note: If the paper is torn, remove all torn pieces from the finisher.


**BR Finisher Fault Messages and Fault Codes**

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press UI. A graphical illustration shows the location of the fault with a brief explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to indicate the multiple locations and the required corrective actions.

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press UI.

The UI also displays a **Faults** button which provides information about the fault and detailed instructions for correcting the fault.

Tip: BR Finisher and Booklet Maker faults are identified by the codes which start with the three-digit number **012**.
Interface Decurler Module Troubleshooting

Paper Jams on the Interface Decurler Module

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

- The press stops running and a fault message displays on the press touch screen.
- The message includes a graphical illustration showing the location of the fault along with a brief explanation of corrective actions for clearing the fault.
- Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this happens, the graphical illustration changes to show the multiple locations and the required corrective actions.
- Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

- Do not power off the press when removing paper jams.
- Paper jams can be removed with the press still powered on. When the power is turned off, all information stored to the system memory will be erased.
- Clear all paper jams before resuming print jobs.
- Do not touch components inside the press. This can cause print defects.
- Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print jobs.
- Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.
- After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.
- After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.
- If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any remaining jams, refer to the press touch screen for instructions and information.
Clearing Paper Jams on the Interface Decurler Module

1. Open the front cover on the Interface Decurler Module (IDM).

2. Remove jammed paper:
   a. Open lever 1a downward.
   b. Turn knob 1b counterclockwise.
      ⚠️ Important: To ensure the jammed paper exits the area, turn the knob a minimum of ten (10) times or more.
   c. Remove the jammed paper.
      ⚠️ Important: Remove the jammed paper by carefully pulling it out of the area.
3. Return lever 1a to its original position.

4. If you encounter difficulty when removing jammed paper, open lever 1c upward and carefully remove jammed paper.

5. Return lever 1c to its original position.

6. Close the IDM front cover.

7. If required, follow the instructions on the press touch screen to clear other areas of the system.
Fault Messages on the Interface Decurler Module

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to indicate the multiple locations and the required corrective actions.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions for correcting the fault.

Fault Code Information on the Interface Decurler Module

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions for correcting the fault.

Tip: Interface Decurler Module faults are identified by the codes which start with the three-digit number 048.

Inserter Device Troubleshooting

Inserter Paper Jams

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

- The press stops running and a fault message displays on the press touch screen.
- The message includes a graphical illustration showing the location of the fault along with a brief explanation of corrective actions for clearing the fault.
• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this happens, the graphical illustration changes to show the multiple locations and the required corrective actions.

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

- Do not power off the press when removing paper jams.
- Paper jams can be removed with the press still powered on. When the power is turned off, all information stored to the system memory will be erased.
- Clear all paper jams before resuming print jobs.
- Do not touch components inside the press. This can cause print defects.
- Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print jobs.
- Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.
- After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.
- After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.
- If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any remaining jams, refer to the press touch screen for instructions and information.

**Clearing Paper Jams from Inserter E1 Area**

1. Open the T1 cover (1), then remove the jammed papers (2) as well as all of the paper loaded in the tray (3).

   ![Note:](image)

   **Note:** When two or more sheets of paper are loaded, remove all sheets.

   Fan the paper you removed and make sure all four corners are aligned correctly.

2. Reload the paper into the tray.

3. Close the T1 cover.
Clearing Paper Jams from Inserter E2 Area

1. Open the Inserter front cover.

2. Open lever 1a upward (1) and turn knob 1b counterclockwise (2). Remove jammed paper (3).

3. Return lever 1a to its original position.
4. If you have difficulty when removing jammed paper, open lever 1c to the right (1) and turn knob 1b counterclockwise (2). Remove jammed paper (3).

5. Return lever 1c to its original position.

6. Close the Inserter front cover.

Clearing Paper Jams from Inserter E3 Area

1. Open the Inserter front cover.
2. Open lever 1d downward (1) and turn knob 1e counterclockwise (2). Remove the jammed paper (3).

   Note: The jammed paper may be hidden behind the upper-left cover area.

3. Return lever 1d to its original position.

4. If you have difficulty when removing jammed paper, open lever 1a upward (1) and turn knob 1e counterclockwise (2). Remove the jammed paper (3).
5. Return lever 1a to its original position.

6. Close the Inserter front cover.

**Inserter Fault Messages**

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to indicate the multiple locations and the required corrective actions.

The touch screen also displays a **Faults** button which provides information about the fault and detailed instructions for correcting the fault. The (E) code on the upper-left part of the Fault message displays which error indicator is lit on the Inserter control panel (E1, E2, E3).

**Inserter Fault Code Information**

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen.

The touch screen also displays a **Faults** button which provides information about the fault and detailed instructions for correcting the fault.

**Tip:** Inserter faults are identified by the codes which start with the three-digit numbers 012, 013, and 024.
High Capacity Stacker Troubleshooting

HCS Paper Jams

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

- The press stops running and a fault message displays on the press touch screen.
- The message includes a graphical illustration showing the location of the fault along with a brief explanation of corrective actions for clearing the fault.
- Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this happens, the graphical illustration changes to show the multiple locations and the required corrective actions.
- Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

- Do not power off the press when removing paper jams.
- Paper jams can be removed with the press still powered on. When the power is turned off, all information stored to the system memory will be erased.
- Clear all paper jams before resuming print jobs.
- Do not touch components inside the press. This can cause print defects.
- Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print jobs.
- Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.
- After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.
- After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.
- If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any remaining jams, refer to the press touch screen for instructions and information.
Clearing Paper Jams from HCS Area E1

1. Open the HCS top cover.

![Diagram of HCS top cover being opened](image)

2. Open lever 1b upward (1) and remove jammed papers (2).

![Diagram of lever 1b being opened](image)

3. Return lever 1b to its original position.

![Diagram of lever 1b being returned](image)

4. Close the HCS top cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.
Clearing Paper Jams from HCS Area E2

1. Open the HCS top cover.

2. Open lever 1b upward (1) and rotate knob 1a counterclockwise (2) and remove jammed papers (3).

3. Return lever 1b to its original position.

4. Close the HCS top cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.
Clearing Paper Jams from HCS Area E3

1. Open the HCS top cover.

2. Open lever 1b upward (1) and rotate knob 1a counterclockwise (2) and remove jammed papers (3).

3. Return lever 1b to its original position.

4. Open lever 2b upward (1) and turn knob 2c counterclockwise (2) and remove jammed papers (3).
5. Return lever 2b to its original position.

6. Close the HCS top cover.

7. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.

Clearing Paper Jams from HCS Area E4

1. Open the HCS top cover.

2. Open lever 2a downward (1) and remove jammed papers(2).

3. Return lever 2a to its original position.
4. Close the HCS top cover.
5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.

**Clearing Paper Jams from HCS Area E5**

1. Open the HCS top cover.

2. Open lever 2b upward (1) and turn knob 2c counterclockwise (2) and remove jammed papers (3).

3. Return lever 2b to its original position.

4. Close the HCS top cover.
5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.
Clearing Paper Jams from HCS Area E6

1. Press the **Unload** button.

2. Make sure the HCS front door is unlocked and then open it.

3. Pull out the stacker cart slowly and remove any jammed paper.
4. Push the stacker cart back into its original position.
5. Close the HCS front door.
6. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.

Clearing Paper Jams from HCS Area E7
1. Remove any output delivered to the top tray.

2. Open the HCS top cover.

3. Open lever 1b upward (1) and remove jammed papers (2).
4. Return lever 1b to its original position.

5. Open lever 2a downward (1) and remove jammed paper (2).

6. Return lever 2a to its original position.

7. Close the HCS top cover.

8. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.

**HCS Fault Messages**

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to indicate the multiple locations and the required corrective actions.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions for correcting the fault. The (E) code on the upper-left part of the Fault message displays which error indicator is lit on the HCS control panel (E1–E8).

**HCS Fault Code Information**

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions for correcting the fault.
Tip: HCS faults are identified by the codes which start with the three-digit numbers 049.

Additional HCS Troubleshooting Information

Hints and Tips for Using the High Capacity Stacker (HCS)

Refer to the following hints and tips when using the HCS:

1. Check the paper in the applicable HCS tray for curl.
   a. If no curl is present and if the output is acceptable and meets customer satisfaction, you are finished.
   b. If no curl is present and if the output is not acceptable, call for service.
   c. If curl is present, continue to the next step.

2. To correct the paper curl, use the paper curl correction controls on the top of the Interface Decurler Module (IDM).

3. If the output has not improved, adjust the paper curl again.

4. If the output still has not improved, call the Customer Support Center.
Crease and Two-Sided Trimmer Troubleshooting

Crease and Two-Sided Trimmer Paper Jams

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.
• The message includes a graphical illustration showing the location of the fault along with a brief explanation of corrective actions for clearing the fault.
• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this happens, the graphical illustration changes to show the multiple locations and the required corrective actions.
• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.
• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored to the system memory will be erased.
• Clear all paper jams before resuming print jobs.
• Do not touch components inside the press. This can cause print defects.
• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print jobs.
• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.
• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.
• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.
• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any remaining jams, refer to the press touch screen for instructions and information.

Clearing Paper Jams from Trimmer Area E1
1. Open the trimmer upper cover.

2. Open lever 1a downward (1), lever 1b downward (2) and lever 1d upward (3). Remove jammed paper (4).

   **Note:** Check behind the upper cover for any hidden jammed paper.
3. If you have difficulty removing any paper jams, rotate knob 1c clockwise (1), then remove the jammed paper (2).

4. Return levers 1a, 1b and 1d to their original positions.

5. Close the trimmer upper cover.

6. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.

Clearing Paper Jams from Trimmer Area E2

1. Open the trimmer upper cover.
2. Rotate knob 2 counterclockwise to align the mark on the knob with the unlock position (a mark resembling an open padlock).

3. Open lever 1a downward (1) and lever 1b downward (2).

4. Turn knob 1c clockwise (1) and remove jammed papers (2).
5. Return levers 1a and 1b to their original positions.

6. If you have difficulty removing any paper jams, open lever 1d upward (1) and lever 2a to the left (2).

7. Rotate knob 2b counterclockwise (1) and remove jammed papers (2).
8. Return levers 1d and 2a to their original positions.

9. Close the trimmer upper cover.

10. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.

**Clearing Paper Jams from Trimmer Area E3**

1. Open the trimmer upper cover.

2. Rotate knob 2 counterclockwise to align the mark on the knob with the unlock position (a mark resembling an open padlock).
3. Open lever 2c downward (1) and remove jammed paper (2).

   \[\textbf{Note:}\] Check behind the upper cover for any hidden jammed paper.

4. Return lever 2c to its original position.

5. Close the trimmer upper cover.

6. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.

**Clearing Paper Jams from Trimmer Area E4**

1. Open the trimmer upper cover.
2. Open lever 2c downward (1), lever 2d upward (2) and lever 2e to the right (3).

3. Rotate knob 2f clockwise (1) and remove jammed paper (2).

   Note: Grasp the lead edge of the jammed sheet and gently pull out the sheet to remove it.

4. If you have difficulty removing the jammed sheet, grasp the top edge at the inner-right side of the sheet and gently pull out the sheet to remove it.
5. Return levers 2e (1), 2d (2) and 2c (3) to their original positions.

6. Close the trimmer upper cover.

7. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.

**Clearing Paper Jams from Trimmer Area E5**

1. Open the trimmer upper cover.

2. Open lever 3a to the right (1), lever 3b to the left (2).
3. Rotate knob 3c clockwise (1) and remove jammed paper (2).

4. Rotate knob 2f counterclockwise (1) and remove jammed paper (2).

5. Return levers 3a and 3b to their original positions.

6. Close the trimmer upper cover.

7. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.
Clearing Paper Jams from Trimmer Area E6

1. Open the trimmer upper cover.

2. Open lever 3a to the right (1), lever 4b downward (2) and lever 4c to the right (3). Remove jammed paper (4).

3. Rotate knob 4d counterclockwise (1) and remove jammed paper (2).
4. Open lever 4a to the right (1) and rotate knob 2f counterclockwise (2). Remove jammed paper (3).

   *Note:* Hold lever 4a while rotating knob 2f.

5. Rotate knob 3c clockwise (1) and remove jammed paper (2).

6. Return levers 3a, 4b and 4c to their original positions.

7. Close the trimmer upper cover.

8. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.
Clearing Paper Jams from Trimmer Area E7

1. Open the trimmer upper cover.

2. Open lever 3a to the right (1) and rotate knob 2f counterclockwise (2).

   Note: Rotate the knob five times or more.

3. Pull out and push in the trimmer waste container continuously for three times or more.
4. Return lever 3a to its original position.

5. If indicator E7 remains lit, perform the following steps:
   a. Open the **lower cover**.
   b. Remove the supplied cleaning rod from its location inside the lower cover.
c. Open lever 3a to the right (1) and open lever 3d to the right (2).

d. Use the cleaning rod to sweep any remaining waste or debris from inside the trimmer into the trimmer waste container.

e. If you have difficulty sweeping waste into the trimmer waste container, use the cleaning rod to gather waste, then remove the waste by hand.

f. Return levers 3a and 3d to their original positions.

6. To ensure that all waste and debris is removed, especially beneath the frame that is located behind the container, use the cleaning rod to remove any remaining waste from inside the trimmer. For information, refer to Emptying the Crease and Two-Sided Trimmer Waste Container.
7. Close the trimmer upper and lower covers.

8. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.

Crease and Two-Sided Trimmer Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to indicate the multiple locations and the required corrective actions.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions for correcting the fault. The (E) code on the upper-left part of the Fault message displays which error indicator is lit on the Crease and Two-Sided Trimmer indicator panel (E1–E7).

Crease and Two-Sided Trimmer Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions for correcting the fault.

Tip: Crease and Two-Sided Trimmer faults are identified by the codes which start with the three-digit numbers 012, 013, 014, 024, and 028.
C/Z Folder Troubleshooting

C/Z Folder Paper Jams

- The press stops running and a fault message displays on the press touch screen.
- The message includes a graphical illustration showing the location of the fault along with a brief explanation of corrective actions for clearing the fault.
- Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this happens, the graphical illustration changes to show the multiple locations and the required corrective actions.
- Additionally, if a fault occurs with the C/Z Folder, an indicator lights on the PR Finisher control panel and shows the corresponding area on the C/Z Folder where the fault occurred.

Always refer to the following information when clearing paper jams:

- Do not power off the press when removing paper jams.
- Paper jams can be removed with the press still powered on. When the power is turned off, all information stored to the system memory is erased.
- Clear all paper jams before resuming print jobs.
- Do not touch components inside the press. This can cause print defects.
- Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print jobs.
- Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.
- After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.
- After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.
- If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any remaining jams, refer to the press touch screen for instructions and information.
Clearing Paper Jams from Folder Area E10

1. Open the folder front cover.

2. Open lever 2a upward (1) and lever 2b to the left (2). Remove jammed paper (3).

3. Return levers 2a and 2b to their original positions.

4. Close the folder front cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.
Clearing Paper Jams from Folder Area E11

1. Open the folder front cover.

2. Open lever 2g to the right (1) and rotate knob 2c counterclockwise (2). Remove jammed paper (3).

3. Return lever 2g to its original position.

4. Close the folder front cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.
Clearing Paper Jams from Folder Area E12

1. Open the folder front cover.

2. Pull open the C/Z fold output tray 2d.

3. Open lever 2e to the right (1) and rotate knob 2c counterclockwise (2). Remove jammed paper (3).
4. Return lever 2e to its original position.

5. If you have difficulty removing any paper jams, open lever 2f to the right (1) and rotate knob 2c counterclockwise (2). Remove jammed paper (3).

6. Return lever 2f to its original position.
7. Close the C/Z fold output tray 2d by pushing it in completely.

8. Close the folder front cover.

9. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.

C/Z Folder Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to indicate the multiple locations and the required corrective actions.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions for correcting the fault. The (E) code on the upper-left part of the Fault message displays which error indicator is lit on the C/Z Folder indicator panel (E1–E7).

C/Z Folder Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions for correcting the fault.

Tip: C/Z Folder faults are identified by the codes which start with the three-digit numbers 012 and 013.
Production Ready Finishers Troubleshooting

PR Finisher Paper Jams

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

- The press stops running and a fault message displays on the press touch screen.
- The message includes a graphical illustration showing the location of the fault along with a brief explanation of corrective actions for clearing the fault.
- Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this happens, the graphical illustration changes to show the multiple locations and the required corrective actions.
- Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

- Do not power off the press when removing paper jams.
- Paper jams can be removed with the press still powered on. When the power is turned off, all information stored to the system memory will be erased.
- Clear all paper jams before resuming print jobs.
- Do not touch components inside the press. This can cause print defects.
- Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print jobs.
- Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.
- After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.
- After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.
- If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any remaining jams, refer to the press touch screen for instructions and information.
Clearing Paper Jams from Finisher Area E1

1. Open the finisher front cover.

![Image of finisher front cover]

2. Open lever 1a to the left (1) and remove the jammed paper (2).

   *Note:* Grasp the leading edge of the jammed sheet and pull out the sheet to remove it.

![Image of lever 1a]

3. If you have difficulty removing any paper jams, rotate knob 1b clockwise (1) and remove the jammed paper (2).

![Image of knob 1b]
4. Return lever 1a to its original position.

5. Close the finisher front cover.

**Clearing Paper Jams from Finisher Area E2**

1. Open the finisher front cover.

2. Open lever 1c to the right (1) and rotate knob 1e clockwise (2). Remove the jammed paper (3).

   *Note:* The jammed paper may be hidden behind the upper cover.
3. Return lever 1c to its original position.

4. Close the finisher front cover.

**Clearing Paper Jams from Finisher Area E3**

1. Pull out the jammed paper from the finisher top tray.

2. Open and close the finisher front cover.
Clearing Paper Jams from Finisher Area E4

1. Open the finisher front cover.

2. Open lever 1d to the right (1) and rotate knob 1e clockwise (2). Remove the jammed paper (3).

3. Return lever 1d to its original position.

4. Close the finisher front cover.
Clearing Paper Jams from Finisher Area E5

1. Open the finisher front cover.

2. Open lever 1d to the right (1) and rotate knob 1f counterclockwise (2). Remove the jammed paper (3).

3. Return lever 1d to its original position.

4. Close the finisher front cover.
Clearing Paper Jams from Finisher Area E6
1. Pull out the jammed paper from the finisher stacker tray.

Clearing Paper Jams from Finisher Booklet Area E7
1. Open the finisher front cover.
2. Open lever 3a to the left (1) and remove the jammed paper (2).

3. If you have difficulty to remove the paper jam, pull out the Saddle Stitch Unit 3 (1) and remove the jammed paper (2).
4. Return lever 3a to its original position.

5. Gently push in the Saddle Stitch Unit 3 until it stops.

6. Close the finisher front cover.

Clearing Paper Jams from Finisher Booklet Area E8

1. Open the finisher front cover.
2. Pull out the **Saddle Stitch Unit 3** toward you until it stops.

   ![Note](image)
   **Note:** Check lever 3a for paper jam before pulling out the unit.

3. Rotate knob 3b counterclockwise (1) and remove the jammed paper (2).

4. Gently push in the **Saddle Stitch Unit 3** until it stops.

5. Close the finisher front cover.
Clearing Paper Jams from Finisher Booklet Area E9

1. Open the finisher front cover.

2. Rotate knob 3b clockwise (1) and remove the jammed paper from the booklet tray area (2).

3. Close the finisher front cover.

Production Ready Finisher Plus Troubleshooting

Clearing Paper Jams in PR Finisher Plus, Areas E1-E6

Refer to the following procedures for clearing paper jams the PR Finisher Plus, Finisher Module areas E1–E6:

- Clearing Paper Jams from Finisher Area E1
- Clearing Paper Jams from Finisher Area E2
- Clearing Paper Jams from Finisher Area E3
- Clearing Paper Jams from Finisher Area E4
- Clearing Paper Jams from Finisher Area E5
- Clearing Paper Jams from Finisher Area E6
Clearing Paper Jams in the PR Finisher Plus, Area E7

1. Open the finisher front cover.

2. Remove any jammed paper.

3. To clear paper jams from Area E7, perform the following:
   a. Open lever 3a to the left (1) and lever 3b to the left (2).
   b. Rotate knob 1b clockwise (1) and remove the jammed paper (2).
c. Return levers 3a and lever 3b to their original positions.

4. Close the finisher front cover.

Clearing Paper Jams in the PR Finisher Plus, Finishing Transport

Refer to the following procedures for clearing paper jams the PR Finisher Plus, Finisher Module areas 1-4:

- Clearing Paper Jams in Finishing Transport Area 1
- Clearing Paper Jams in Finishing Transport Area 2
- Clearing Paper Jams in Finishing Transport Area 3
- Clearing Paper Jams in Finishing Transport Area 4

Clearing Paper Jams in Finishing Transport Area 1

1. Open the Finishing Transport front cover.
2. Open lever 1 downward and remove the jammed paper.

3. Return lever 1 to its original position.

4. Close the Finishing Transport front cover.

**Clearing Paper Jams in Finishing Transport Area 2**

1. Open the Finishing Transport front cover.
2. Open lever 2 to the right (1) and rotate the knob counterclockwise (2). Remove the jammed paper.

3. Return lever 2 to its original position.

4. Close the Finishing Transport front cover.

**Clearing Paper Jams in Finishing Transport Area 3**

1. Open the Finishing Transport front cover.
2. Open lever 3 to the left (1) and rotate the knob clockwise (2). Remove the jammed paper.

3. Return lever 3 to its original position.

4. Close the Finishing Transport front cover.

Clearing Paper Jams in Finishing Transport Area 4
1. Open the Finishing Transport front cover.
2. Open lever 4 downward (1) and rotate the knob clockwise (2). Remove jammed papers.

3. Return lever 4 to its original position.

4. Close the Finishing Transport front cover.

**Finisher Staple Faults**

Use the following procedures when stapling issues occur with the printed output, such as when the sheets are not stapled or the staples are bent. Contact the service representative if the problems continue after you have tried the following solutions.

<table>
<thead>
<tr>
<th>Not stapled</th>
<th>Bent staple</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Not stapled Image" /></td>
<td><img src="image2.png" alt="Bent staple Image" /></td>
</tr>
</tbody>
</table>

If printed sheets are stapled as shown in the following figures, contact your service representative.

<table>
<thead>
<tr>
<th>One side of staple raised up</th>
<th>Staple bent in reverse direction</th>
<th>Flattened staple</th>
</tr>
</thead>
</table>
Important:

- Depending on the type of paper being stapled, the staple nails may be bent. If the bent nails are stuck inside the finisher, they may eventually cause paper jams.
- When you open the cover of the staple cartridge, remove any bent staples; otherwise staple jams may occur. Use the cover of the staple cartridge only when removing jammed staples.

Clearing Staple Jams in the Basic Stapler

If the staple cartridge accidentally detaches from its holder, refer to Reinserting the Basic Staple Cartridge.

Note: Ensure that the press is not running before performing this procedure.

1. Open the finisher front cover.
2. Pull out R1.

   \(\textbf{Note:}\) After removing the staple cartridge, check the inside of the finisher for any remaining staples.

3. Open the unit cover and remove the jammed staples.

   \(\textbf{WARNING:}\) To avoid personal injury, use care when removing jammed staples.

4. Reinsert the unit to its original position.

5. Close the finisher front cover.
Reinserting the Basic Staple Cartridge

If a staple cartridge has been inserted incorrectly or accidentally removed, perform the following procedure to correctly reinsert the staple cartridge into the cartridge unit.

1. Open the finisher front cover.

2. Pull out R1.

3. Open the unit cover and remove the jammed staples.

   **WARNING:** To avoid personal injury, use care when removing jammed staples.
4. Locate the lever on the back of the unit.

⚠️ **WARNING:** When moving the lever, be careful not to hurt your fingers and nails.

5. Turn the unit up while holding the lever, then take out the staple cartridge from the unit.

6. Remove the outside staples along the line.

⚠️ **WARNING:** When removing staples, be careful not to hurt your fingers.
7. Insert the staple cartridge into the unit.

8. Reinsert the unit to its original position.

9. Close the finisher front cover.

**Clearing Staple Jams in the Booklet Stapler**

*Note:* Ensure that the press is not running before performing this procedure.

1. Open the finisher front cover.
2. Pull out the **Saddle Stitch Unit 3** toward you until it stops.

3. While holding the tabs on the staple cartridge, pull out the cartridge to remove it.

4. Remove any jammed staples.

   ! **WARNING:** To avoid personal injury, use care when removing jammed staples.

5. While holding the tabs on the new staple cartridge, push in the cartridge until it seats.

   ! **Note:** Make sure that the marks are aligned.
6. Push the **Saddle Stitch Unit 3** gently into the finisher until it stops.

7. Close the finisher front cover.

**Stapler Faults in the PR Finisher Plus**

Refer to the following procedures for clearing staple jams the PR Finisher Plus, Basic Staple Cartridge:

- Finisher Staple Faults
- Clearing Staple Jams in the Basic Stapler
- Reinserting the Basic Staple Cartridge

**Finisher Fault Messages**

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to indicate the multiple locations and the required corrective actions.

The touch screen also displays a **Faults** button which provides information about the fault and detailed instructions for correcting the fault. The (E) code on the upper-left part of the Fault message displays which error indicator is lit on the Finisher indicator panel (E1–E9).

**Finisher Fault Code Information**

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen.

The touch screen also displays a **Faults** button which provides information about the fault and detailed instructions for correcting the fault.

**Tip:** Finisher faults are identified by the codes which start with the three-digit numbers 012, 013, 024, 041, 112, and 124.
PR Finisher Plus Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen.

The touch screen also displays a **Faults** button which provides information about the fault and detailed instructions for correcting the fault.

**Tip:** PR Finisher Plus faults are identified by the codes which start with the three-digit numbers **013** and **051**.

SquareFold® Trimmer Troubleshooting

SquareFold® Trimmer Paper Jams
The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

- The press stops running and a fault message displays on the press touch screen.
- The message includes a graphical illustration showing the location of the fault along with a brief explanation of corrective actions for clearing the fault.
- Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this happens, the graphical illustration changes to show the multiple locations and the required corrective actions.
- Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

- Do not power off the press when removing paper jams.
- Paper jams can be removed with the press still powered on. When the power is turned off, all information stored to the system memory will be erased.
- Clear all paper jams before resuming print jobs.
- Do not touch components inside the press. This can cause print defects.
- Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print jobs.
- Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.
- After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.
- After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.
- If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any remaining jams, refer to the press touch screen for instructions and information.

**Clearing Paper Jams from SquareFold® Trimmer Areas E1 and E2**

*Note: Ensure that the press is not running before performing this procedure.*

1. Open the left cover of trimmer device by pressing the button on the cover.
2. Remove the jammed paper.

3. If you have difficulty removing the jammed paper, open the front cover of the finisher.

4. Rotate the knob 3b to the right, then remove the jammed paper.

5. If necessary, close the front cover of the finisher.

6. Close the left cover of the trimmer device.

7. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.
Clearing Paper Jams from SquareFold® Trimmer Area E3

Note: Ensure that the press is not running before performing this procedure.

1. Open the right cover of trimmer device by pressing the button on the cover.

2. Remove the jammed paper.

3. Close the right cover of the trimmer device.

4. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume printing.

SquareFold® Trimmer Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to indicate the multiple locations and the required corrective actions.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions for correcting the fault. The (E) code on the upper-left part of the Fault message displays which error indicator is lit on the SquareFold® Trimmer control panel (E1–E3).
SquareFold® Trimmer Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and a message appears on the press touch screen.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions for correcting the fault.

Tip: SquareFold® Trimmer faults are identified by the codes which start with the three-digit number 013.

Guidelines for Using the SquareFold® Trimmer Device

Full-Page Images on Booklets

When using full-page images, ensure that the finished booklet size accommodates any full-page images and that when the booklet is trimmed, these images are not truncated.

The following are examples of a booklet with preprinted front/back covers with a full-page image but different sizes:
1. Booklet 1 is printed on 8.5 x 14 in./B4 paper: The front cover, which was trimmed, displays the entire image.

2. Booklet 2 is printed on 8.5 x 11 in./A4 paper: The image on the front cover is truncated after trimming it.

**Booklet Considerations**

Before you print any booklet, consider the following:

- Image location on the original as it will no longer be centered. Do you need to shift images in order to ensure they fit on the finished booklet?
- What is the desired size of the finished booklet?
- Does the booklet contain full-page images?
- Are you using preprinted covers with full-page images?
- Are you trimming the booklet?

**Considerations for Obtaining Desired Booklet Output**

Follow these tips to ensure you get your desired output:

- Always run one or more test prints of your job before running a larger output quantity.
- Review your test prints for truncated images/text.
- If any images or text need shifting, use the various selections from the print driver for your application. Refer to the Help information for your print driver.

>Note: It may take one or more test prints before you achieve your desired output.

**Troubleshooting Help**

**Locating the Press Serial Number**

The press serial number can be accessed from the User Interface (UI) or from the serial number plate which is located on the inside frame of Tray 1.

1. Press the **Machine Status** button on the UI.
2. From the Machine Status screen, ensure that the **Device Information** tab is displayed.
   - The press serial number is displayed under Device Serial Number near the bottom of the screen.
3. If there is a loss of power and it is not possible to access the **Machine Status** screen, the press serial number can also be found on the inside frame of the press near the Paper Tray 1 drawer:
   a. At the press, fully open Tray 1.
b. At the left of the tray, on the press frame, locate the plate with the serial number (**SER#**).

### Calling for Service

1. Record any displayed fault codes.
2. Record the press serial number.
   a. Select the **Machine Status** button at the press UI.
   b. From the Machine Status screen, select the **Device Information** tab to view the serial number listed.
      If the serial number is not displayed, open the press Paper Tray 1 drawer and locate the serial number plate on the left side of the frame (**SER #**).
3. If output quality is a problem, take a sample as a reference to assist you in describing the problem over the telephone when answering the questions from the customer support operator about the defects.
4. If possible, use a phone near the press when calling for assistance. Follow the instructions provided by the operator.
5. For system support, user help, and service support, call the appropriate number. For the specific number in your area, go to [www.xerox.com](http://www.xerox.com) and select the **Support** link.

### Fuser Hints and Tips

#### Extending Fuser Life

To extend the life of your fuser, discuss the usage of multiple fusers with your Service Representative. Multiple fusers provide maximum print output for longer periods of time and ensure image defects on output are avoided. Depending on the types of jobs run and their frequency, you may want more than one fuser available, such as the following for example:

- One fuser roll for narrower paper
- One fuser for wider paper
Preventing Fuser Damage

1. To reduce 11 in./279.4 mm lines and wear marks, you may require the use of two fusers - one when running 8.5x11 in./A4 stock and the other when running 12 x 18 in./304.8 x 457.2 mm or larger stock. This is especially true for the graphic arts people.

2. Image quality defects such as marks or spots will occur every 110 mm/4.3 in. on the prints if the fuser roll is damaged. Defects which occur every 98 mm/3.89 in. indicate a damaged fuser belt.

Fuser Paper Width Information

The press is delivered and installed with a standard type fuser that accommodates all paper width sizes. However, the press allows for the installation of other fuser assemblies and paper width types for printing specific paper width ranges. When installing a new fuser, the customer can indicate that the fuser be used for certain paper widths only. Identifying the fuser width type is performed by connecting the appropriate fuser jumpers provided in the nationalization kit as well as attaching a colored fuser width clip.

Before using the new fuser, the system administrator must update the NVM width setting values to match the specific width used for this fuser.

The following table defines the media sizes and width ranges that can be set for the fuser.

<table>
<thead>
<tr>
<th>Range No.</th>
<th>Bypass Connector</th>
<th>Media size</th>
<th>Width range</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>None</td>
<td>All paper widths</td>
<td>98.0 - 330.2 mm (3.858 - 13.0 in.)</td>
</tr>
<tr>
<td>2</td>
<td>Black Resistor Type</td>
<td>A4/Letter SEF A3 SEF A4/Letter LEF 11 x 17 in.</td>
<td>270.4 - 298.0 mm (9.84 - 11.69 in.)</td>
</tr>
<tr>
<td>3</td>
<td>Blue Type</td>
<td>SRA3 12 in. 13 in.</td>
<td>300.0 - 330.2 mm (12.09 - 13.00 in.)</td>
</tr>
<tr>
<td>4 See Note</td>
<td></td>
<td>Custom</td>
<td>100.0 - 330.2 mm (3.937 - 13.0 in.)</td>
</tr>
</tbody>
</table>

Note: Refer to the System Administrator Guide on how to set the NVM width.

Resource Center

The Resource Center contains links to supplemental information:

- Copyright
- Browser Requirements
Copyright

© 2022 Xerox Corporation. All rights reserved. Xerox® and Versant® are trademarks of Xerox Corporation in the United States and/or other countries.

Adobe®, the Adobe logo, InDesign®, Illustrator®, PageMaker®, Photoshop®, Acrobat®, Distiller®, PostScript, and the Acrobat logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Macintosh®, macOS®, Power Mac®, TrueType®, and Mac® are registered trademarks of Apple Computer, Inc. in the United States and/or other countries.

Microsoft®, Windows®, and Windows Server® are trademarks of Microsoft Corporation in the United States and/or other countries.

Mozilla and Firefox are trademarks of The Mozilla Foundation

The CentOS Marks are trademarks of Red Hat, Inc.

Changes are periodically made to this document. Changes, technical inaccuracies, and typographic errors will be corrected in subsequent editions.

Browser Requirements

For proper display and functionality, use one of these Web browsers to display the online documentation:

- Microsoft Edge
- Internet Explorer
- Mozilla Firefox
- Google Chrome
- Safari

In addition, for best results, set your screen resolution to 1366 x 768.

For Administrators

From the press, you can log into the Administrator mode. From the select Administrator mode, you can do the following:

- Customize the press screen
- Select the power saver mode settings
- Run the Clean the Fuser Assembly with Felt procedure
- Reset a High Frequency Service Item (HFSI) counter
- Select and edit Copy and Scan setting
- Select and edit other System Settings
- Perform Simple Image Quality Adjustment (SIQA) procedures
- Connect to Xerox® CentreWare® Internet Services
- Setup and use the Accounting features and functions
• Setup and use the Authentication/Security Settings

For more information, refer to the *System Administrator Guide*. 